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About This Guide

This SonicWall Secure Mobile Access Administration Guide provides network administrators with a high-level 
overview of SonicWall Secure Mobile Access (SMA) technology, including activation, configuration, and 
administration of SonicWall SMA appliances using the Secure Mobile Access management interface.

Topics: 

• Guide Conventions

Guide Conventions
The following conventions are used in this guide:

Conventions used in this guide

Convention Use

Bold Highlights field, button, and tab names. Also highlights window, dialog box, 
and screen names. Also used for file names and text or values you are being 
instructed to type into the interface.

Italic Indicates the name of a technical manual, emphasis on certain words in a 
sentence, or the first instance of a significant term or concept.

Menu Item > Menu Item Indicates a multiple step management interface menu choice. For example, 
System > Status means select the Status page under the System menu.
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Secure Mobile Access Overview

This section provides an overview of the SonicWall Secure Mobile Access (SMA) technology, concepts, basic 
navigational elements and standard deployment guidelines. 

Topics: 

• Overview of SMA Components

• Navigating the Management Interface

• Deployment Guidelines

Overview of SMA Components
The SMA appliances provide organizations with a simple, secure and client-less method of access to applications 
and network resources specifically for remote and mobile employees. Organizations can use SMA connections 
without the need to have a pre-configured, large-installation host. Users can easily and securely access email 
files, intranet sites, applications, and other resources on the corporate Local Area Network (LAN) from any 
location by accessing a standard Web browser.

Topics: 

• SMA Software Components

• SMA Hardware Components

• SMA 500v Virtual Appliance

• Increased Client Connections on SMA 210/410

• Always on VPN

• Encryption Overview

• SSL for Virtual Private Networking (VPN)

• SSL Handshake Procedure

• IPv6 Support Overview

• Portals Overview

• File Shares

• Domains Overview

• Application Offloading and HTTP(S) Bookmarks Overview

• Cross Domain Single Sign-On

• ActiveSync Authentication

• Network Resources Overview

• SNMP Overview
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• DNS Overview

• Network Routes Overview

• NetExtender Overview

• Two-Factor Authentication Overview

• One Time Password Overview

• End Point Control Overview

• Web Application Firewall Overview

• Restful API - Phase 1 Support

• Restful API - Phase 2 Support

SMA Software Components
SMA appliances provide client-less identity-based secure remote access to the protected internal network. Using 
the Virtual Office environment, SMA appliances can provide users with secure remote access to your entire 
private network, or to individual components such as File Shares, Web servers, FTP servers, remote desktops, or 
even individual applications hosted on Citrix or Microsoft Terminal Servers.

Although SMA protocols are described as clientless, the typical SMA portal combines Web, ActiveX components 
that are downloaded from the portal transparently, allowing users to connect to a remote network without 
needing to manually install and configure a VPN client application. In addition, SMA enables users to connect 
from a variety of devices, including Windows, Macintosh, and Linux PCs. ActiveX components are only 
supported on Windows platforms.

For administrators, the SMA web-based management interface provides an end-to-end SMA solution. This 
interface can configure SMA users, access policies, authentication methods, user bookmarks for network 
resources, and system settings.

For clients, web-based SMA customizable user portals enable users to access, update, upload, and download 
files and use remote applications installed on desktop machines or hosted on an application server. The 
platform also supports secure web-based FTP access, network neighborhood-like interface for file sharing, 
Secure Shell version 2 (SSHv2), Telnet emulation, VNC (Virtual Network Computing) and RDP (Remote Desktop 
Protocol) support, Citrix Web access, bookmarks for offloaded portals (external Web sites), and Web and HTTPS 
proxy forwarding. 

The SMA network extension client, NetExtender, is available through the SMA Web portal through an ActiveX 
control on Windows or we could Linux systems. It is also available through stand-alone applications for 
Windows, Linux, and MacOS platforms. The NetExtender standalone applications are automatically installed on 
a client system the first time the user clicks the NetExtender link in the Virtual Office portal. NetExtender 
enables end users to connect to the remote network without needing to install and configure complex software, 
providing a secure means to access any type of data on the remote network. NetExtender supports IPv6 client 
connections from Windows systems and from Linux clients.

SMA Hardware Components
The Secure Mobile Access 10.2 release supports SMA 100 Series platforms and virtual appliances. Refer to the 
latest SMA 10 Release Notes on MySonicWall, and the latest SMA 10 Upgrade Guide on the SonicWall Technical 
Documentation portal for more information about specific supported platforms. For more information, see SMA 
200/210/400/410 Quick Start Guides and Getting Started Guides available at: 
https://www.sonicwall.com/support/technical-documentation/.
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SMA 500v Virtual Appliance
The SMA 500v Virtual Appliance is a virtual machine that runs the SMA software on a VMware platform. All 
software components, features, and functionality described in this guide are supported by the SMA 500v Virtual 
Appliance, except High Availability and SSL Off-loading. 

Deploying SMA as a virtual appliance allows leveraging of shared computing resources to optimize utilization, 
easy migration and reduced capital costs. The SMA 500v Virtual Appliance provides the following benefits:

• Cost savings:

• Multiple virtual machines can run on a single server, reducing hardware costs, power 
consumption, and maintenance costs.

• Microsoft Windows Server is not required, eliminating the cost of the Windows license.

• Operational ease:

• In a virtual environment, it is easy to commission new servers or decommission old ones, or to 
bring servers up or down.

• Installation is accomplished by importing a file into the virtual environment, with no need to run 
an installer.

• Security:

• The SMA 500v Virtual Appliance provides the same hardened operating system that comes with 
the SMA/SRA hardware appliances.

The elements of basic VMware structure must be implemented prior to deploying the SMA 500v Virtual 
Appliance. For detailed information about deploying the SMA 500v Virtual Appliance, see the SonicWall Inc. 
SMA 500v Virtual Appliance Getting Started Guide, available at: SMA Documentation

Client Versions Released with 10.2
Topics:

• NetExtender Client Versions

• SMA Connect Agent Versions

NetExtender Client Versions
Description Version in 10.2.0.0 Version in 10.2.0.1 Version in 10.2.0.2

NetExtender Linux RPM 32-Bit 10.2.813 10.2.815 10.2.816

NetExtender Linux RPM 64-Bit 10.2.813 10.2.815 10.2.816

NetExtender Linux TGZ 32-Bit 10.2.813 10.2.815 10.2.816

NetExtender Linux TGZ 64-Bit 10.2.813 10.2.815 10.2.816

NetExtender Windows 10.2.292 10.2.0.299 10.2.300

https://support.sonicwall.com/sonicwall-secure-mobile-access/sma%206200/release-notes-guides
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SMA Connect Agent Versions
:

Increased Client Connections on SMA 210/410
SMA 10.2.0.1 increases the maximum concurrent client connections on SMA 210 and SMA 410 appliances. The 
new maximums apply to both licensed users and Spike licenses. The concurrent connections maximums are 
now:

• SMA 210 – Increased from 50 to 200

• SMA 410 – Increased from 250 to 400

Capture ATP Integration Overview
Capture Advanced Threat Protection (Capture ATP) is a cloud-based service that analyzes various types of 
content for malicious behavior. Capture Advanced Threat Protection (ATP) helps Secure Mobile Access (SMA) 
identify whether a file is malicious by transmitting the file to the cloud where the SonicWall Capture ATP service 
analyzes the file to determine if it contains a virus or other malicious elements. Capture ATP then sends the 
results to the SMA. The analysis and reporting are done in real time while the file is being processed by the SMA.

All files are sent to the Capture ATP cloud over an encrypted connection. Files are analyzed and deleted within 
minutes of a verdict being determined, unless a file is found to be malicious. Malicious files are submitted via an 
encrypted HTTPS connection to the SonicWall threat research team for further analysis and to harvest threat 
information. Files are not transferred to any other location for analysis. Malicious files are deleted after 
harvesting threat information within 30 days of receipt. Capture ATP provides a file analysis report (threat 
report) with detailed threat behavior information.

The administrator can modify Capture ATP settings at the user level, group level, and global level. 

Always on VPN
Always On VPN (AOV) is supported in SMA in conjunction with the Windows NetExtender client, which is 
installed from an MSI installer. Always on VPN provides continuous network access to remote users. AOV 
detection is triggered by a user logon event, and is ended when the user logs out of the computer. AOV settings 
apply to Domain, Group, and User, and they have an inherited relationship. In AOV mode, the VPN CLI tool 
cannot disconnect VPN or edit profiles.

Topics:

• Secure Network Detection

• AOV Controls

• AOV Logs

• Anti-Tampering Protection

Description Version in 10.2.0.0 Version in 10.2.0.1 Version in 10.2.0.2

SMA Connect Agent Windows 1.1.27 1.1.29 1.1.31

SMA Connect Agent macOS 1.1.22 1.1.22 1.1.25
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Secure Network Detection
AOV supports Secure Network Detection (SND), and provides the Don't connect VPN in Trusted Network setting 
to control VPN connections when SND is detected. If this option is enabled, in AOV mode a VPN is automatically 
disconnected when SND is detected. If the option is disabled, the VPN remains connected.

For SND, the DNS and suffixes applied to a VPN client are a subset of system DNS and suffixes. If only one of the 
DNS or suffixes match, it is used as the final match. If VPN suffixes are not set, then SND is confirmed if there is a 
match for at least one of the DNS results.

AOV Controls
When a VPN status is disconnected, AOV can block user access to network resources until the VPN connection is 
recovered. This is controlled by the AOV option Allow accessing network if VPN fail to connect:

• Enabled – User is allowed to access network.

• Disabled – User is not allowed to access network until VPN connection is recovered.

Users can request to temporarily disable AOV by inputting a challenge code received in configured email. This is 
controlled by the AOV option Allow User to disconnect:

• Enabled – User is allowed to disable AOV temporarily, and there is an unlock button available at client 
side for user to click and request unlocking.

• Disabled – User is not allowed to disable AOV and no unlock or disconnect button is available.

In case of client issues and to troubleshoot problems, there is a way for the SMA administrator to remotely 
disable the Always Running Client.

• The administrator can temporarily disable AOV by navigating to the Clients > Status page, selecting the 
VPN session, and then clicking the On switch.

• When AOV is disabled, no failure policy is applied and no automatic connection is established.

In regard to VPN Session control, when auto-reconnect is enabled for NetExtender on the client side, and an 
administrator kills the user session manually, the client does not try to reconnect. NetExtender tries to 
reconnect only when there is a network break which causes the VPN to disconnect.

AOV Logs
The VPN log viewer keeps logs of the AOV status change history. The user is notified via popup that a state 
change has occurred or action blocked, and can view the history of such messages in the logs.
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Anti-Tampering Protection
SMA Anti-tampering service is integrated in NetExtender to protect NEService, Installation directory and 
Registry.

Encryption Overview
Encryption enables users to encode data, making it secure from unauthorized viewers. Encryption provides a 
private and secure method of communication over the Internet.

A special type of encryption known as Public Key Encryption (PKE) comprises a public and a private key for 
encrypting and decrypting data. With public key encryption, an entity, such as a secure Web site, generates a 
public and a private key. A secure Web server sends a public key to a user who accesses the Web site. The public 
key allows the user’s Web browser to decrypt data that had been encrypted with the private key. The user’s 
Web browser can also transparently encrypt data using the public key and this data can only be decrypted by 
the secure Web server’s private key. 

Public key encryption allows the user to confirm the identity of the Web site through an SSL certificate. After a 
user contacts the SMA appliance, the appliance sends the user its own encryption information, including an SSL 
certificate with a public encryption key.

SSL for Virtual Private Networking (VPN)
A Secure Socket Layer-based Virtual Private Network (SSL VPN) allows applications and private network 
resources to be accessed remotely through a secure connection. Using SSL VPN, mobile workers, business 
partners, and customers can access files or applications on a company’s intranet or within a private local area 
network.

Organizations use Virtual Private Networks (VPNs) to establish secure, end-to-end private network connections 
over a public networking infrastructure, allowing them to reduce their communications expenses and to provide 
private, secure connections between a user and a site in the organization. By offering Secure Socket Layer (SSL) 
VPN, without the expense of special feature licensing, the SMA appliance provides customers with cost-effective 
alternatives to deploying parallel remote-access infrastructures. 

SSL Handshake Procedure
The following procedure is an example of the standard steps required to establish an SSL session between a user 
and an SMA gateway using the Secure Mobile Access web-based management interface:

1 When a user attempts to connect to the SMA appliance, the user’s Web browser sends information 
about the types of encryption supported by the browser to the appliance.

2 The appliance sends the user its own encryption information, including an SSL certificate with a public 
encryption key.

3 The Web browser validates the SSL certificate with the Certificate Authority identified by the SSL 
certificate.

4 The Web browser generates a pre-master encryption key, encrypts the pre-master key using the public 
key included with the SSL certificate and sends the encrypted pre-master key to the SMA gateway.

5 The SMA gateway uses the pre-master key to create a master key and sends the new master key to the 
user’s Web browser.
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6 The browser and the SMA gateway use the master key and the agreed upon encryption algorithm to 
establish an SSL connection. From this point on, the user and the SMA gateway encrypts and decrypts 
data using the same encryption key. This is called symmetric encryption.

7 After the SSL connection is established, the SMA gateway encrypts and sends the Web browser the SMA 
gateway login page.

8 The user submits their user name, password, and domain name.

9 If the user’s domain name requires authentication through a RADIUS, LDAP, or Active Directory Server, 
the SMA gateway forwards the user’s information to the appropriate server for authentication.

10 After being authenticated, the user can access the Secure Mobile Access portal.

IPv6 Support Overview
Internet Protocol version 6 (IPv6) is a replacement for IPv4 that is becoming more frequently used on networked 
devices. IPv6 is a suite of protocols and standards developed by the Internet Engineering Task Force (IETF) that 
provides a larger address space than IPv4, additional functionality and security, and resolves IPv4 design issues. 
You can use IPv6 without affecting IPv4 communications.

IPv6 supports stateful address configuration that is used with a DHCPv6 server, and stateless address 
configuration, where hosts on a link automatically configure themselves with IPv6 addresses for the link, called 
link-local addresses.

In IPv6, source and destination addresses are 128 bits (16 bytes) in length. For reference, the 32-bit IPv4 address 
is represented in dotted-decimal format, divided by periods along 8-bit boundaries. The 128-bit IPv6 address is 
divided by colons along 16-bit boundaries, where each 16-bit block is represented as a 4-digit hexadecimal 
number. This is called colon-hexadecimal.

The IPv6 address, 2008:0AB1:0000:1E2A:0123:0045:EE37:C9B4 can be simplified by removing the leading zeros 
within each 16-bit block, as long as each block has at least one digit. When suppressing leading zeros, the 
address representation becomes: 2008:AB1:0:1E2A:123:45:EE37:C9B4

When addresses contain contiguous sequences of 16-bit blocks set to zeros, the sequence can be compressed to 
::, a double-colon. For example, the link-local address of 2008:0:0:0:B67:89:ABCD:1234 can be compressed to 
2008::B67:89:ABCD:1234. The multicast address 2008:0:0:0:0:0:0:2 can be compressed to 2008::2.

The IPv6 prefix is the part of the address that indicates the bits of the subnet prefix. Prefixes for IPv6 subnets, 
routes, and address ranges are written as address/prefix-length, or CIDR notation. For example, 2008:AA::/48 
and 2007:BB:0:89AB::/64 are IPv6 address prefixes. 

Secure Mobile Access supports IPv6 in the following areas:

Services
• FTP Bookmark – Define a FTP bookmark using an IPv6 address.

• Telnet Bookmark – Define a Telnet bookmark using an IPv6 address.

• SSHv2 Bookmark – Define an SSHv2 bookmark using an IPv6 address.

• Reverse proxy for HTTP/HTTPS Bookmark – Define an HTTP or HTTPS bookmark using an IPv6 address.

• Citrix Bookmark – Define a Citrix bookmark using an IPv6 address.

• RDP Bookmark - Define an RDP bookmark using an IPv6 address.

• VNC Bookmark - Define a VNC bookmark using an IPv6 address.
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Settings
• Interface Settings – Define an IPv6 address for the interface. The link-local address is displayed in a 

tooltip on Interfaces page. 

• Route Settings – Define a static route with IPv6 destination network and gateway.

• Network Object – Define the network object using IPv6. An IPv6 address and IPv6 network can be 
attached to this network object.

NetExtender and IPv6
When a client connects to NetExtender, it can get an IPv6 address from the SMA appliance if the client machine 
supports IPv6 and an IPv6 address pool is configured on the SMA appliance. NetExtender supports IPv6 client 
connections from Windows systems and from Linux clients.

Portals Overview

Secure Mobile Access provides a mechanism called Virtual Office that is a web-based portal interface that 
provides clients with easy access to internal resources in your organization. Components such as NetExtender, , 
and bookmarks to file shares and other network resources are presented to users through the Virtual Office 
portal. For organizations with multiple user types, the SMA appliance allows for multiple customized portals, 
each with its own set of shared resource bookmarks. Portals also allow for individual domain and security 
certificates on a per-portal basis. The components in a portal are customized when adding a portal. 

Custom Portals
SMA appliances allow you to configure multiple portals, each with their own title, banner, login message, logo 
and set of available resources. Each portal also enables you to set individual Virtual Hosts/Domain Names to 
create a unique default portal URL. When a user logs into a portal, he or she sees a set of pre-configured links 
and bookmarks that are specific to that portal. You can configure whether or not NetExtender is displayed on a 
Virtual Office portal, and if you want NetExtender to automatically launch when users log in to the portal. The 
administrator configures which elements each portal displays through the Portal Settings window. 

File Shares
File shares provide remote users with a secure Web interface to Microsoft File Shares using the CIFS (Common 
Internet File System) or SMB3 (Server Message Block) protocols. Using a Web interface similar in style to 
Microsoft’s familiar Network Neighborhood or My Network Places, File Shares allow users with appropriate 
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permissions to browse network shares, rename, delete, retrieve, and upload files, and to create bookmarks for 
later recall. File shares can be configured to allow restricted server path access.

Domains Overview
A domain in the Secure Mobile Access environment is a mechanism that enables authentication of users 
attempting to access the network being serviced by the SMA appliance. Domain types include the Secure 
Mobile Access internal LocalDomain, and the external platforms Microsoft Active Directory, LDAP, and RADIUS. 
Often, only one domain suffices to provide authentication to your organization, although a larger organization 
might require distributed domains to handle multiple nodes or collections of users attempting to access 
applications through the portal.

Application Offloading and HTTP(S) Bookmarks 
Overview
SMA/SRA appliances use HTTP(S) bookmarks and application offloading to provide access to web-based 
applications running on servers within the intranet. This includes SharePoint 2007 and the enhanced versions of 
commonly-used Web mail interfaces, such as Microsoft OWA Premium and Domino Web Access 8.0.1, 8.5.1, 
and 8.5.2. SharePoint 2010 is supported with application offloading, but not with HTTP(S) bookmarks. 
SharePoint 2013 is supported with application offloading. Note that third-party modules that are not proxy 
friendly might not be supported by SharePoint.

Both application offloading and HTTP(S) bookmarks use an HTTP(S) reverse proxy. A reverse proxy is a proxy 
server that is deployed between a remote user outside an intranet and a target Web server within the intranet. 
The reverse proxy intercepts and forwards packets that originate from outside the intranet. An HTTP(S) reverse 
proxy specifically intercepts HTTP(S) requests and responses.

Application Offloading provides secure access to both internal and publicly hosted Web applications. An 
application offloading host is created as a special-purpose portal with an associated virtual host acting as a 
proxy for the backend Web application.

Unlike HTTP(S) bookmarks, access to offloaded applications is not limited to remote users. The administrator 
can enforce strong authentication and access policies for specific users or groups. For instance, in an 
organization certain guest users might need Two-factor or Client Certificate authentication to access Outlook 
Web Access (OWA), but are not allowed to access OWA public folders. If authentication is enabled, multiple 
layers of advanced authentication features such as One Time Password, Two-factor Authentication, Client 
Certificate Authentication and Single Sign-On can be applied on top of each other for the offloaded host. 

The offloaded application portal must be configured as a virtual host with a suitable Secure Mobile Access 
domain. It is possible to disable authentication and access policy enforcement for such an offloaded host.

Web transactions can be centrally monitored by viewing the logs. In addition, Web Application Firewall can 
protect offloaded application hosts from any unexpected intrusion, such as Cross-site scripting or SQL Injection.

Access to offloaded Web applications happens seamlessly as URLs in the proxied page are not rewritten in the 
manner used by HTTP or HTTPS bookmarks.

Topics: 

• Benefits of HTTP(S) Bookmarks

• Benefits of Application Offloading

• Software Prerequisites

• Supported Application Deployment Considerations
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Benefits of HTTP(S) Bookmarks
By using HTTP(S) bookmarks, users can access the full-featured versions of SharePoint 2007, Microsoft OWA 
Premium, and Domino Web Access 8.0.1, 8.5.1, and 8.5.2 Web mail interfaces. These interfaces are easier to use 
and provide more enhanced features than their basic counterparts.

Benefits of Application Offloading
An offloaded Web application has the following advantages over configuring the Web application as an HTTP(S) 
bookmark in Secure Mobile Access:

• No URL rewriting is necessary, thereby improving throughput significantly.

• The functionality of the original Web application is retained almost completely, while an HTTP(S) 
bookmark is a best-effort solution.

• Application offloading extends Secure Mobile Access security features to publicly hosted Web sites.

Application offloading can be used in any of the following scenarios: 

• To function as an SSL offloader and add HTTPS support to the offloaded Web application, using SSL 
acceleration of the SMA appliance. 

• In conjunction with the Web Application Firewall subscription service to provide the offloaded Web 
application continuous protection from malicious Web attacks. 

• To add strong or stacked authentication to the offloaded Web application, including Two-factor 
authentication, One Time Passwords and Client Certificate authentication. 

• To control granular access to the offloaded Web application using global, group or user based access 
policies. 

• To support Web applications not currently supported by HTTP/HTTPS bookmarks. Application Offloading 
does not require URL rewriting, thereby delivering complete application functionality without 
compromising throughput. 

• To authenticate ActiveSync Application Offloading technology that delivers Web applications using 
Virtual Hosting and Reverse Proxy. ActiveSync authentication does not require URL rewriting in order to 
deliver the Web applications seamlessly. As an example, the ActiveSync protocol is used by a mobile 
phone’s email client to synchronize with an Exchange server.

Appliance Platforms
Application Offloading and HTTP(S) bookmarks are supported on all the SMA appliances that support the 
SonicWall Secure Mobile Access 10.2 release:

• SMA 200/400

• SMA 210/410

• SMA 500v for ESXi

• SMA 500v for Hyper-V

• SMA 500v for AWS

• SMA 500v for Azure

HTTP Versions
HTTP(S) bookmarks and application offloading portals support both HTTP/1.0 and HTTP/1.1.
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Certain performance optimization features, such as caching, compression, SSL hardware acceleration, HTTP 
connection persistence, TCP connection multiplexing and transfer-chunk encoding for proxies are automatically 
enabled depending on the usage.

Applications
SharePoint 2010 and SharePoint 2013 are supported with application offloading, but not with HTTP(S) 
bookmarks. The following features have been tested and verified as working well on the indicated browsers:

The following Web applications have been tested and verified to work with HTTP(S) bookmarks and as offloaded 
applications:

• Microsoft Outlook Web Access 2013
Outlook Web Access 2010
Outlook Web Access 2007

• Windows SharePoint 2013 (supported only using App Offloading) 
Windows Sharepoint 2007 (supported only using App Offloading) 
Windows Sharepoint Services 3.0

• Lotus Domino Web Access 8.0.1
Lotus Domino Web Access 8.5.1
Lotus Domino Web Access 8.5.2 

• Novell Groupwise Web Access 7.0

• ActiveSync with Microsoft Exchange 2010 
ActiveSync with Microsoft Exchange 2007 
ActiveSync with Microsoft Exchange 2003 

Supported SharePoint features

SharePoint Features Browsers

Add Announcement
Delete Announcement
Download Document
Add Document
Delete Document
Add New Item
Delete Item

Internet Explorer 11
Firefox 79.0 and later
Chrome 80 and later

NOTE: Outlook Web Access is supported on the SMA 200/400, SMA 210/410, SMA 500v for ESXi, SMA 500v 
for Hyper-V, SMA 500v for AWS, and SMA 500v for Azure.

NOTE: The integrated client features of SharePoint are not supported.

NOTE: Lotus Domino Web Access is supported on the SMA 200/400, SMA 210/410, SMA 500v for ESXi, 
SMA 500v for Hyper-V, SMA 500v for AWS, and SMA 500v for Azure.

NOTE: Exchange ActiveSync is supported on Apple iPhone, Apple iPad, and the latest Android based 
phones.
NOTE: Application Offloading supports authentication for ActiveSync. ActiveSync is a protocol used by a 
mobile phone’s email client to synchronize with an Exchange server. The Administrator can create an 
offloading portal and set the application server host to the backend Exchange server. Then, a user can use 
the new virtual host name in a mobile phone’s email client, and synchronize with the backend Exchange 
server through the SMA/SRA appliance.
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Authentication Schemes
The following authentication schemes are supported for use with application offloading and HTTP(S) 
bookmarks:

• Basic – Collects credentials in the form of a username and password.

• Forms-based authentication – Uses a Web form to collect credentials.

Software Prerequisites
The following end-user requirements must be met in order to access the complete set of application offloading 
and HTTP(S) bookmarks features:

• Internet Explorer 9.0 or newer

• Windows 10 and Windows 7 

Supported Application Deployment Considerations
Be aware of these installation and general feature caveats when using application offloading and HTTP(S) 
bookmarks with the following software applications:

• SharePoint

• SharePoint 2013 and SharePoint 2010 are supported with application offloading, but not with 
HTTP(S) bookmarks.

• Outlook Anywhere

• SMA/SRS with Application Offloading.

• Outlook Anywhere uses Microsoft’s MS-RPCH proprietary protocol that could conflict with normal 
HTTP(S) protocol.

Application Offloading is only supported on SharePoint 2013 and with any application using HTTP/HTTPS. Secure 
Mobile Access has limited support for applications using Web services and no support for non-HTTP protocols 
wrapped within HTTP.

The application should not contain hard-coded self-referencing URLs. If these are present, the Application 
Offloading proxy must rewrite the URLs. Because Web site development does not usually conform to HTML 
standards, the proxy can only do a best-effort translation when rewriting these URLs. Specifying hard-coded, 
self-referencing URLs is not recommended when developing a Web site because content developers must 
modify the Web pages whenever the hosting server is moved to a different IP or hostname.

For example, if the backend application has a hard-coded IP address and scheme within URLs as follows. 
Application Offloading must rewrite the URL. 

<a href="http://1.1.1.1/doAction.cgi?test=foo"> 

This can be done by enabling the Enable URL Rewriting for self-referenced URLs setting for the Application 
Offloading Portal, but all the URLs might not be rewritten, depending on how the Web application has been 
developed. (This limitation is usually the same for other vendors employing reverse proxy mode.)

NOTE: The maximum number of users supported is limited by the number of applications being accessed 
and the volume of application traffic being sent.
NOTE: Feature support varies based on your hardware and installation, see the respective sections for 
more detailed information about specific application support.

TIP: If you are using the correct Web browser and operating system, and a supported application does not 
work, delete the browser session cookies, close and reopen all instances of your browser, clear the 
browser cache, and then try again.
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Cross Domain Single Sign-On
External Website Bookmarks can be created for application offloading portals to achieve a single point of access 
for users. This allows users to automatically log in to application offloading portals after logging into the main 
portal.

To use Cross Domain Single Sign-on (SSO):

1 Create two or more portals with the same shared domain (from Virtual Host Domain name) and that 
need authentication. One portal should be a regular portal. These portals are also in the same SMA 
appliance’s domain so that a user can log in to both of them with the same credentials. 

2 Log in to the portal and create a bookmark.

3 Set the service to External Web Site.

4 Enable Automatically log in for the bookmark that enables Cross Domain SSO for this bookmark.

5 Specify a Host that is a portal with the same shared domain name.

6 Save the bookmark and launch it. The new portal is logged in automatically without any credential.

The shared domain names do not need to be identical; a sub-domain also works. For example, one portal is a 
regular portal whose virtual host domain name is “www.example.com” and its shared domain name is 
“.example.com.” The other portal’s virtual host domain name is “intranet.eng.example.com” and the shared 
domain name is “.eng.example.com.” If a bookmark to xyz.eng.example.com is created in the 
www.example.com portal, Cross Domain SSO works because “.eng.example.com” is a sub-domain of 
“.example.com.”

ActiveSync Authentication
Application Offloading now supports authentication for ActiveSync. Application Offloading technology delivers 
Web applications using Virtual Hosting and Reverse Proxy. Users still need to authenticate with the SMA 
appliance before accessing the backend Web application. However, the proxy avoids URL rewriting in order to 
deliver the Web applications seamlessly.

ActiveSync is a protocol used by a mobile phone’s email client to synchronize with an Exchange server. The 
Administrator can create an offloading portal and set the application server host to the backend Exchange 
server. Then, a user can use the new virtual host name in a mobile phone’s email client, and synchronize with 
the backend Exchange server through the SMA appliance. 

ActiveSync is managed through the Portals > Offload Web Application > Offloading > Security Settings page.

To configure ActiveSync authentication, clear Disable Authentication Controls to display the authentication 
fields. Select Enable ActiveSync authentication and then type the default domain name. The default domain 
name cannot be used when the domain name is set in the email client’s setting.

Topics:

• ActiveSync Log Entries

• Configuring a Portal to Check Email From an Android Device

NOTE: On iPhones/iPads running versions earlier than iOS 6.1.2, initial account synchronization might fail 
if a calendar contains a recurring invite. 
NOTE: To provide better protection for the Exchange Server, anonymous ActiveSync access will not be 
supported in the future.
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ActiveSync Log Entries
The Log > View page is updated when a Web application is offloaded. Most mobile systems (iPhone, Android, 
and so on) support ActiveSync. These log entries identify when the client began to use ActiveSync through the 
offloading portal. The ActiveSync message identifies the device ID (ActiveSync: Device ID is…) for an ActiveSync 
request unless a client sets up the account and the request does not contain a device ID.

Configuring a Portal to Check Email From an Android 
Device
The following example shows how to set up ActiveSync to check emails from an Android device. Be sure to 
replace entries shown in the examples with entries for your environment, and be careful to input the correct 
password. Otherwise, the account is blocked.

1 Create a Domain name of webmail.example.com. Set the Active Directory domain and Server address 
to webmail.example.com. Set the Portal name to VirtualOffice.

2 In the Secure Mobile Access management interface, scroll down to the relevant section and create an 
offloading portal with the name sales.

3 Set the Scheme to Secure Web (HTTPS).

4 Set the Application Server Host to your Exchange server, for example webmail.example.com.

5 Set the virtual host name, for example, webmail.example.com. The virtual host name should be resolved 
by the DNS server. Otherwise, modify the hosts file in the Android phone.

6 Select Enable Email Clients Authentication. Leave the default domain name blank or input 
webmail.example.com.

7 Click the Virtual Host tab.

8 Turn on the Android phone, open the Email application, and type your email address and password. Click 
Next.

9 Choose Exchange.

10 Input your Domain\Username, Password, and Server. No domain name is displayed, so use the default 
domain name specified in the offloading portal’s setting. Select Accept all SSL certificates and click 
Next.

11 If the AD authentication times out, the Setup could not finish message is displayed. Wait about 20 
seconds and try again. You can also check the Secure Mobile Access log to see if the user logged in 
successfully. You might not encounter this problem if the AD authentication is fast.

12 When the authentication finishes, a security warning appears. Click OK to continue, modify your account 
settings, and click Next.

13 Try to send and receive emails, and ensure that ActiveSync entries are included in the Secure Mobile 
Access log.

Network Resources Overview
Network Resources are the granular components of a trusted network that can be accessed using the SMA 
appliance. Network Resources can be pre-defined by the administrator and assigned to users or groups as 
bookmarks, or users can define and bookmark their own Network Resources. 

The following sections describe types of network resources supported by the SMA appliance:

• HTTP (Web) and Secure HTTPS (Web) 
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• Telnet

• SSHv2

• FTP

• File Shares

• Remote Desktop Protocols

• Application Protocols Using RDP

• Microsoft Outlook Web Access

• Windows SharePoint Services

• Lotus Domino Web Access

• Citrix Portal

HTTP (Web) and Secure HTTPS (Web)
The SMA appliance provides proxy access to an HTTP or HTTPS server on the internal network, Internet, or any 
other network segment that can be reached by the appliance. The remote user communicates with the SMA 
appliance using HTTPS and requests a URL. The URL is then retrieved over HTTP by the SMA appliance. The URL 
is transformed as needed, and returned encrypted to the remote user.

The Secure Mobile Access administrator can configure Web (HTTP) or Secure Web (HTTPS) bookmarks to allow 
user access to web-based resources and applications such as Microsoft OWA Premium, Windows SharePoint 
2007, Novell Groupwise Web Access 7.0, or Domino Web Access 8.0.1, 8.5.1, and 8.5.2 with HTTP(S) reverse 
proxy support. Reverse-proxy bookmarks also support the HTTP 1.1 protocol and connection persistence.

HTTPS bookmarks on SMA appliances support keys of up to 2048 bits.

HTTP(S) caching is supported on the SMA appliance for use when it is acting as a proxy Web server deployed 
between a remote user and a local Web server. The proxy is allowed to cache HTTP(S) content on the SMA 
appliance which the internal Web server deems cacheable based on the HTTP(S) protocol specifications. For 
subsequent requests, the cached content is returned only after ensuring that the user is authenticated with the 
SMA appliance and is cleared for access by the access policies. However, Secure Mobile Access optimizes traffic 
to the backend Web server by using TCP connection multiplexing, where a single TCP connection is used for 
multiple user sessions to the same web server. Caching is predominantly used for static Web content like 
JavaScript files, style sheets, and images. The proxy can parse HTML/JavaScript/CSS documents of indefinite 
length. The administrator can enable or disable caching, flush cached content and set the maximum size for the 
cache.

Content received by the SMA appliance from the local Web server is compressed using gzip before sending it 
over the Internet to the remote client. Compressing content sent from the appliance saves bandwidth and 
results in higher throughput. Furthermore, only compressed content is cached, saving nearly 40-50 percent of 
the required memory. Note that gzip compression is not available on the local (clear text side) of the SMA 
appliance, or for HTTPS requests from the remote client.

Telnet
Java is being deprecated. Going forward, use HTML5 bookmarks. 8.6 utilizes HTML5 by default.

Telnet client is delivered through the remote user’s Web browser. The remote user can specify the IP address of 
any accessible Telnet server and the SMA appliance makes a connection to the server. Communication between 
the user over SSL and the server is proxied using native Telnet. The Telnet applet supports MS JVM (Microsoft 
Java Virtual Machine) in Internet Explorer, and requires Oracle Java Runtime Environment (JRE) 1.1 or higher for 
other browsers. Telnet also supports HTML5 and Smart Access selection.
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SSHv2
SSH clients delivered through the remote user’s Web browser. The remote user can specify the IP address of any 
accessible SSH server and the SMA appliance makes a connection to the server. Communication between the 
user over SSL and the server is proxied using natively encrypted SSH. SSHv2 provides stronger encryption and 
has other advanced features, and can only connect to a server that supports SSHv2. SSHv2 support sets the 
terminal type to VT100. SSHv2 requires JRE 1.6.0_10 or higher, available from 
https://www.oracle.com/java/technologies/. 

SSHv2 also supports HTML5 and Smart Access selection.

FTP 
Proxy access to an FTP server on the internal network, the Internet, or any other network segment that can be 
reached by the SMA appliance. The remote user communicates with the SMA appliance by HTTPS and requests 
a URL that is retrieved over HTTP by the SMA appliance, transformed as needed, and returned encrypted to the 
remote user. FTP supports 25 character sets, including four Japanese sets, two Chinese sets, and two Korean 
sets. The client browser and operating system must support the desired character set, and language packs might 
be required. FTP also supports HTML5 and Smart Access selection.

File Shares (CIFS)
File Shares provide remote users with a secure Web interface to Microsoft File Shares using the CIFS (Common 
Internet File System) or the older SMB (Server Message Block) protocols. Using a Web interface similar in style 
to Microsoft’s familiar Network Neighborhood or My Network Places, File Shares allow users with appropriate 
permissions to browse network shares, rename, delete, retrieve, and upload files, and to create bookmarks for 
later recall. File shares can be configured to allow restricted server path access.

Remote Desktop Protocols 
RDP is supported on Windows, Linux, and Mac operating systems. Most Microsoft workstations and servers 
have RDP server capabilities that can be enabled for remote access. HTML5 and Native, are the two methods 
offered for authorized user to access Remote Desktop.

Virtual Network Computing 
VNC is supported on Windows, Linux, and Mac operating systems. VNC was originally developed by AT&T, but is 
today widely available as open source software. There are a number of freely available VNC servers that can be 
downloaded and installed on most operating systems. An authorized user could use VNC HTML5 bookmark to 
access the Remote VNC server.
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RDP 7 Support
The SMA appliance supports connections with RDP 7 clients and supports the RDP 7 feature set. RDP 7 is 
available on following operating systems:

• Windows Server 2016

• Windows Server 2012

• Windows 10

• Windows 7

RDP 6 Support
The SMA appliance supports connections with RDP 6.1 and RDP 6 clients, and supports the RDP 5 feature set 
plus four RDP 6 features.

RDC 6.1 is included with the following operating systems: 

• Windows 7

• Windows Server 2008 

RDC 6.1 incorporates the following functionality in Windows Server 2008:

• Terminal Services RemoteApp

• Terminal Services EasyPrint driver

• Single Sign-On

Application Protocols Using RDP
Applications protocols are RDP sessions that provide access to a specific application rather than to an entire 
desktop. This allows defined access to an individual application, such as CRM or accounting software. When the 
application is closed, the session closes. The following RDP formats can be used as applications protocols:

• RDP Native – Uses the native RDP client to connect to the terminal server, and to automatically invoke 
an application at the specified path (for example, C:\programfiles\microsoft 
office\office11\winword.exe)

• RDP HTML5 – Uses the HTML5-based RDP client to connect to the terminal server, and to automatically 
invoke an application at the specified path (for example, C:\programfiles\wireshark\wireshark.exe).

Application Support for SSO, User Policies, Bookmarks
The following table provides a list of application-specific support for Single Sign-On (SSO), global/group/user 
policies, and bookmark Single Sign-On control policies. 
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Application Support Table

Microsoft Outlook Web Access
Secure Mobile Access includes reverse proxy application support for all versions of OWA 2013, 2010, and 2007.

Microsoft OWA Premium mode is a Web client for Microsoft Outlook that simulates the Microsoft Outlook 
interface and provides more features than basic OWA. Microsoft OWA Premium includes features such as spell 
check, creation and modification of server-side rules, Web beacon blocking, support for tasks, auto-signature 
support, and address book enhancements. Secure Mobile Access HTTP(S) reverse proxy supports Microsoft 
OWA Premium.

Windows SharePoint Services
The Secure Mobile Access reverse proxy application support for Windows SharePoint 2007 and Windows 
SharePoint Services 3.0 includes the following features: 

• Site Templates

• Wiki Sites

• Blogs

• RSS Feeds

• Project Manager

• Mobile Access to Content 

• My Site

• Search Center

• Document Center

• Document Translation Management

• Web Content Management 

• Workflows

• Report Center

Application Supports SSO Global/Group/
User Policies

Bookmark 
Policies

Terminal Services (RDP - Native) Yes Yes Yes

Terminal Services (RDP - HTML5) Yes Yes Yes

Virtual Network Computing (VNC - HTML5) Yes Yes Yes

File Transfer Protocol (FTP) Yes Yes Yes

Telnet Yes Yes Yes

Telnet (HTML5) Yes Yes Yes

Secure Shell (SSH) Yes Yes Yes

Web (HTTP) Yes Yes Yes

Secure Web (HTTPS) Yes Yes Yes

File Shares (CIFS) Yes Yes Yes

Citrix Portal (Citrix) Yes Yes Yes
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Lotus Domino Web Access
The SMA appliance reverse proxy application supports for Domino Web Access 8.0.1, 8.5.1, and 8.5.2 includes 
the following features:

Citrix Portal
Citrix is a remote access, application sharing service, similar to RDP. It enables users to remotely access files and 
applications on a central computer over a secure connection.

The Citrix Receiver clients for ActiveX are supported, as well as the earlier XenApp and ICA clients. In previous 
versions of Citrix, the Citrix ICA Client was renamed as the Citrix XenApp plug-in.

Secure Mobile Access supports Citrix XenApp Server 7.6, 6.5, XenApp Server 6.0, and XenApp Server 5.0.

Secure Mobile Access supports Citrix Receiver for Windows 4.2, 4.1, 4.0 (Online Plug-in 14.2, 14.1, 14.0). 

SNMP Overview
SMA appliances support Simple Network Management Protocol (SNMP) that reports remote access statistics. 
SNMP support facilitates network management for administrators, allowing them to leverage standardized 
reporting tools.

Lotus Domino Web Access: Supported Features

8.5.1 and 8.5.2 Features 8.0.1 Features

 Full Mode:

Email Email

Calendar Calendar

Contacts Contacts

To Do To Do

Notebook Notebook

Lite Mode:

Email Email

Calendar Calendar

Contacts

Ultra Lite Mode:

Inbox

Sent

All Docs

Day At a Glance

Contacts

Trash
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DNS Overview
The administrator can configure DNS on the SMA appliance to enable it to resolve host names with IP addresses. 
The Secure Mobile Access web-based management interface allows the administrator to configure a hostname, 
DNS server addresses, and WINS server addresses.

Network Routes Overview
Configuring a default network route allows your SMA appliance to reach remote IP networks through the 
designated default gateway. The gateway is typically the upstream firewall to which the SMA appliance is 
connected. In addition to default routes, it also possible to configure specific static routes to hosts and networks 
as a preferred path, rather than using the default gateway.

NetExtender Overview
This section provides an overview to the NetExtender feature. 

Topics: 

• What is NetExtender?

• Benefits of NetExtender

• NetExtender Concepts

What is NetExtender?
SonicWall Inc. NetExtender is a transparent software application for Windows and Linux users that enables 
remote users to securely connect to the remote network. With NetExtender, remote users can securely run any 
application on the remote network. Users can upload and download files, mount network drives, and access 
resources as if they were on the local network. The NetExtender connection uses a Point-to-Point Protocol (PPP) 
connection. NetExtender capabilities for Mac, Apple iPhone, iPad, and iPod Touch.

Benefits of NetExtender
NetExtender provides remote users with full access to your protected internal network. The experience is 
virtually identical to that of using a traditional IPSec VPN client, but NetExtender does not require any manual 
client installation. Instead, the NetExtender Windows client is automatically installed on a remote user’s PC by 
an ActiveX control when using the Internet Explorer browser or Firefox. On Linux systems, supported browsers 
use Java controls to automatically install NetExtender from the Virtual Office portal.

The NetExtender Windows client also has a custom-dialer that allows it to be launched from the Windows 
Network Connections menu. This custom-dialer allows NetExtender to be connected before the Windows 
domain login. The NetExtender Windows client also supports a single active connection, and displays real-time 
throughput and data compression ratios in the client.

After installation, NetExtender automatically launches and connects a virtual adapter for SSL-secure 
NetExtender point-to-point access to permitted hosts and subnets on the internal network.
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NetExtender Concepts

Stand-Alone Client
Secure Mobile Access provides a stand-alone NetExtender application. NetExtender is a browser-installed 
lightweight application that provides comprehensive remote access without requiring users to manually 
download and install the application. The first time a user launches NetExtender, the NetExtender stand-alone 
client is automatically installed on the user’s PC. The installer creates a profile based on the user’s login 
information. The installer window then closes and automatically launches NetExtender. If the user has a legacy 
version of NetExtender installed, the installer first uninstalls the old NetExtender and installs the new version.

After the NetExtender stand-alone client has been installed, Windows users can launch NetExtender from their 
PC’s Start > Programs menu and configure NetExtender to launch when Windows boots. 

NetExtender can establish a VPN session before the user logs into the Windows domain. Users can click Switch 
User on the Windows login screen and click the blue computer icon that appears at the right bottom of the 
screen to view the dialup connection list, and then can select NetExtender to connect.

On Linux systems, the installer creates a desktop shortcut in /usr/share/NetExtender. This can be dragged 
to the shortcut bar in environments like Gnome and KDE.

NetExtender is officially supported on the following client platforms:

• Fedora 14+

• Ubuntu 11.04+

• OpenSUSE 10.3+

• Windows 10, Windows 7, Windows 2012, Windows Server 2008 R2.

NetExtender might work properly on other Linux distributions, but they are not officially supported by 
SonicWall Inc.

Pre-filling the Server and Domain Fields while Installing NetExtender 
through Microsoft Installer
Installing NetExtender through Microsoft Installer (MSI) now supports the use of default profile settings during 
the installation process where the default server and default domain can be pre-filled along with additional 
options that control whether the server and domain fields can be edited by a standard user. This feature is 
designed specifically for administrators who want their default servers and domains pre-set during the 
installation process.

To set the default server and domain during the NetExtender Installation with Microsoft Installer: 

1 On the Default Profile Setting page, enter the IP address of the Default Server in the appropriate field 
and the location of the Default Domain in the second field.

2 Disable Allow connections to other profiles to prevent users from connecting to other profiles. This 
setting disables the Server and Domain fields for editing on the login page of NetExtender.

3 Enable this option to allow those connections. If this option is not enabled, users are not able to add or 
delete profiles on the NetExtender properties page.

Multiple Ranges and Routes
Multiple range and route support for NetExtender on SMA appliances enables network administrators to easily 
segment groups and users without the need to configure firewall rules to govern access. This user segmentation 
allows for granular control of access to the network—allowing users access to necessary resources while 
restricting access to sensitive resources to only those who require it. 
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For networks that do not require segmentation, client addresses and routes can be configured globally. 

IP Address User Segmentation
Administrators can configure separate NetExtender IP address ranges for users and groups. These settings are 
configured on the Users > Local Users and Users > Local Groups pages, using the NetExtender tab in the Edit 
User and Edit Group windows.

When configuring multiple user and group NetExtender IP address ranges, it is important to know how the SMA 
appliance assigns IP addresses. When assigning an IP address to a NetExtender client, the SMA appliance uses 
the following hierarchy of ranges:

1 An IP address from the range defined in the user’s local profile.

2 An IP address from the range defined in the group profile to which the user belongs.

3 An IP address from the global NetExtender range.

To reserve a single IP address for an individual user, the administrator can enter the same IP address in both the 
Client Address Range Begin and Client Address Range End fields on the NetExtender tab of the Edit Group 
window.

Client Routes
NetExtender client routes are used to allow and deny access to various network resources. Client routes can also 
be configured at the user and group level. NetExtender client routes are also configured on the Edit User and 
Edit Group windows. The segmentation of client routes is fully customizable, allowing the administrator to 
specify any possible permutation of user, group, and global routes (such as only group routes, only user routes, 
group and global routes, user, group, and global routes, and so on). This segmentation is controlled by Add 
Global NetExtender Client routes and Add Group NetExtender Client routes.

NetExtender with External Authentication Methods
Networks that use an external authentication server are not configured with local usernames on the SMA 
appliance. In such cases, when a user is successfully authenticated, a local user account is created when the Add 
Global NetExtender Client routes and Add Group NetExtender Client routes settings are enabled.

Point to Point Server IP Address
In Secure Mobile Access, the PPP server IP address is 192.0.2.1 for all connecting clients. This IP address is 
transparent to both the remote users connecting to the internal network and to the internal network hosts 
communicating with remote NetExtender clients. Because the PPP server IP address is independent from the 
NetExtender address pool, all IP addresses in the global NetExtender address pool are used for NetExtender 
clients.

Connection Scripts
SMA appliances provide users with the ability to run batch file scripts when NetExtender connects and 
disconnects. The scripts can be used to map or disconnect network drives and printers, launch applications, or 
open files or Web sites. NetExtender Connection Scripts can support any valid batch file commands.

Tunnel All Mode
Tunnel All mode routes all traffic to and from the remote user over the Secure Mobile Access NetExtender 
tunnel—including traffic destined for the remote user’s local network. This is accomplished by adding the 
following routes to the remote client’s route table:
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NetExtender also adds routes for the local networks of all connected Network Connections. These routes are 
configured with higher metrics than any existing routes to force traffic destined for the local network over the 
Secure Mobile Access tunnel instead. For example, if a remote user is has the IP address 10.0.67.64 on the 
10.0.*.* network, the route 10.0.0.0/255.255.0.0 is added to route traffic through the Secure Mobile Access 
tunnel.

Tunnel All mode can be configured at the global, group, and user levels.

Proxy Configuration
SMA appliances support NetExtender sessions using proxy configurations. Currently, only HTTPS proxy is 
supported. When launching NetExtender from the Web portal, if your browser is already configured for proxy 
access, NetExtender automatically inherits the proxy settings. The proxy settings can also be manually 
configured in the NetExtender client preferences. NetExtender can automatically detect proxy settings for proxy 
servers that support the Web Proxy Auto Discovery (WPAD) Protocol.

NetExtender provides three options for configuring proxy settings:

• Automatically detect settings - To use this setting, the proxy server must support Web Proxy Auto 
Discovery Protocol (WPAD)) that can push the proxy settings script to the client automatically.

• Use automatic configuration script - If you know the location of the proxy settings script, you can 
select this option and provide the URL of the script.

• Use proxy server - You can use this option to specify the IP address and port of the proxy server. 
Optionally, you can enter an IP address or domain in the BypassProxy field to allow direct connections to 
those addresses and bypass the proxy server. If required, you can enter a user name and password for 
the proxy server. If the proxy server requires a username and password, but you do not specify them, a 
NetExtender pop-up window prompts you to enter them when you first connect.

When NetExtender connects using proxy settings, it establishes an HTTPS connection to the proxy server instead 
of connecting to the SMA server directly. The proxy server then forwards traffic to the SMA server. All traffic is 
encrypted by SSL with the certificate negotiated by NetExtender, of which the proxy server has no knowledge. 
The connecting process is identical for proxy and non-proxy users.

Two-Factor Authentication Overview
Two-factor authentication is an authentication method that requires two independent pieces of information to 
establish identity and privileges. Two-factor authentication is stronger and more rigorous than traditional 
password authentication that only requires one factor (the user’s password).

SonicWall Inc.’s implementation of two-factor authentication partners with two of the leaders in advanced user 
authentication: RSA and VASCO.

Two RADIUS servers can be used for two-factor authentication, allowing users to be authenticated through the 
Web portal or with an Secure Mobile Access client such as NetExtender.

Tunnel All Mode: Routes to be Added to Remote Client’s Route Table  

IP Address Subnet mask

0.0.0.0 0.0.0.0

0.0.0.0 128.0.0.0

128.0.0.0 128.0.0.0

NOTE: {{hostname}} is to be replaced with the IP address of the SMA appliance.
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Topics: 

• Benefits of Two-Factor Authentication

• How Does Two-Factor Authentication Work?

• Supported Two-Factor Authentication Providers

• Two-Factor Authentication Login Processes

Benefits of Two-Factor Authentication
Two-factor authentication offers the following benefits:

• Greatly enhances security by requiring two independent pieces of information for authentication.

• Reduces the risk posed by weak user passwords that are easily cracked.

• Minimizes the time administrators spend training and supporting users by providing a strong 
authentication process that is simple, intuitive, and automated.

How Does Two-Factor Authentication Work?
Two-factor authentication requires the use of a third-party authentication service, or two separate RADIUS 
authentication servers.

With two-factor authentication, users must enter a valid temporary passcode to gain access. A passcode consists 
of the following:

• The user’s personal identification number (PIN)

• A temporary token code or password

When two RADIUS servers are used, the second stage PIN or password can be sent to the user through SMS or 
email. NetExtender login provide extra challenge(s) for entering it.

When a third-party authentication service is used, it consists of two components:

• An authentication server on which the administrator configures user names, assigns tokens, and 
manages authentication-related tasks.

• Physical tokens that the administrator gives to users which display temporary token codes.

Users receive the temporary token codes from their RSA or VASCO token cards. The token cards display a new 
temporary token code every minute. When the RSA or VASCO server authenticates the user, it verifies that the 
token code timestamp is current. If the PIN is correct and the token code is correct and current, the user is 
authenticated.

Because user authentication requires these two factors, the dual RADIUS servers solution, the RSA SecureID 
solution, and the VASCO DIGIPASS solution offers stronger security than traditional passwords (single-factor 
authentication).

Supported Two-Factor Authentication Providers

RSA
RSA is an algorithm for public-key cryptography. RSA utilizes RSA SecurID tokens to authenticate through an RSA 
Authentication Manager server. RSA is not supported on all hardware platforms and is supported through 
RADIUS only.
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VASCO
VASCO is a public company that provides user authentication products. VASCO utilizes Digipass tokens to 
authenticate through a VASCO IdentiKey server. VASCO is supported on all SMA platforms.

VASCO Data Security delivers reliable authentication through the use of One Time Password technology. VASCO 
IdentiKey combined with SMA and firewall VPN appliances creates an open-market approach delivered through 
VASCO IdentiKey technology. 

VASCO IdentiKey allows users to utilize the VASCO DIGIPASS concept that uses One Time Passwords that are 
assigned for time segments that provide easy and secure remote access. The One Time Password within the 
authentication request is verified on the VASCO IdentiKey. After verification, a RADIUS access-accept message is 
sent to the SMA server for authentication. 

Two-Factor Authentication Login Processes
This section provides examples of the two-factor authentication login prompts when using Web login and 
NetExtender.

With Web login, the Username and Password fields are used to enter the first-stage credentials.

When prompting the user to input the challenge code, the message “Please enter the M.ID PIN:” is the reply 
message from the RADIUS server in this example; different RADIUS servers can have different reply message 
formats.

Some RADIUS servers might require the user to respond to several challenges to complete the authentication. In 
this example, the M.ID server asks the user to supply two challenges. The following passcode can be received 
through email or cellphone (if SMS is configured).

When using two-factor authentication with the NetExtender Windows client, the login process through the 
client is very similar to logging in through the Web page. 

Initially, the Username and Password fields are used to enter the first-stage credentials.

One Time Password Overview
Topics: 

• What is One Time Password?

• Benefits of One Time Passwords

• How Does the One Time Password Feature Work?

• Configuring One Time Passwords for SMS-Capable Phones

• Verifying Administrator One Time Password Configuration

What is One Time Password?
The Secure Mobile Access One Time Password feature adds a second layer of login security to the standard 
username and password. A one-time password is a randomly generated, single-use password. The Secure 
Mobile Access One Time Password feature is a two-factor authentication scheme that utilizes one-time 
passwords in addition to standard user name and password credentials, providing additional security for Secure 
Mobile Access users.

The Secure Mobile Access One Time Password feature requires users to first submit the correct Secure Mobile 
Access login credentials. After following the standard login procedure, Secure Mobile Access generates a 
one-time password that is sent to the user at a pre-defined email address. The user must log in to that email 
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account to retrieve the one-time password and type it into the Secure Mobile Access login screen when 
prompted, before the one-time password expires. This can also be configured using methods such as TOTP and 
SMS One Time Password.

The supported one time password methods include Email, TOPTP, SMS, and Backup Code. 

Benefits of One Time Passwords
The Secure Mobile Access One Time Password feature provides more security than single, static passwords 
alone. Using a one-time password in addition to regular login credentials effectively adds a second layer of 
authentication. Users must be able to access the email address defined by the Secure Mobile Access 
administrator before completing the Secure Mobile Access One Time Password login process. Each one-time 
password is single-use and expires after a set time period, requiring that a new one-time password be generated 
after each successful login, canceled or failed login attempt, or login attempt that has timed out, thus reducing 
the likelihood of a one-time password being compromised.

How Does the One Time Password Feature Work?
The Secure Mobile Access administrator can enable the One Time Password feature on a per-user or per-domain 
basis with the one time password methods such as Email, TOTP, SMS, and Backup Code. To enable the One Time 
Password feature on a per-user basis, the administrator must edit the user settings in the Secure Mobile Access 
management interface. The administrator must also enter an external email address for each user who is 
enabled for One Time Passwords. For users of Active Directory and LDAP, the administrator can enable the One 
Time Password feature on a per-domain basis. 

Enabling the One Time Password feature on a per-domain basis overrides individual “enabled” or “disabled” One 
Time Password settings. Enabling the One Time Password feature for domains does not override manually 
entered email addresses that take precedence over those auto-configured by a domain policy and over AD/LDAP 
settings.

In order to use the Secure Mobile Access One Time Password feature, the administrator must configure valid 
mail server settings in the Log > Settings page of the Secure Mobile Access management interface. The 
administrator can configure the One Time Password feature on a per-user or per-domain basis, and can 
configure timeout policies for users. 

If the email addresses to which you want to deliver your One Time Passwords are in an external domain (such as 
SMS addresses or external webmail addresses), you might need to configure your SMTP server to allow relaying 
from the SMA appliance to the external domain. 

For users enabled for the One Time Password feature either on a per-user or per-domain basis, the login process 
begins with entering standard user name and password credentials in the Secure Mobile Access interface. After 
login, users receive a message that a temporary password has been sent to a pre-defined email account. The 
user must log in to the external email account and retrieve the one-time password, then type or paste it into the 
appropriate field in the Secure Mobile Access login interface. Any user requests prior to entering the correct 
one-time password re-directs the user to the login page.

The one-time password is automatically deleted after a successful login and can also be deleted by the user by 
clicking Cancel in the Secure Mobile Access interface, or it is automatically deleted when the user fails to login 
within that user’s timeout policy period.

Configuring One Time Passwords for SMS-Capable 
Phones
Secure Mobile Access One Time Passwords can be configured to be sent by email directly to SMS-capable 
phones. Contact your cell phone service provider for further information about enabling SMS (Short Message 
Service).
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To configure the SMA appliance to send one-time passwords to an SMS email address. 

Verifying Administrator One Time Password 
Configuration
To verify that an individual user account has been enabled to use the One Time Password feature, log in to the 
Secure Mobile Access Virtual Office user interface using the credentials for that account.

If you are able to successfully log in to Virtual Office, you have correctly used the One Time Password feature.

If you cannot login using One Time Password, verify the following:

• Are you able to login without being prompted to check your email for One-time Password? The user 
account has not been enabled to use the One-time Password feature. 

• Is the email address correct? If the email address for the user account has been entered incorrectly, log in 
to the management interface to correct the email address.

• Is there no email with a one-time password? Wait a few minutes and refresh your email inbox. Check 
your spam filter. If there is no email after several minutes, try to login again to generate a new one-time 
password.

• Have you accurately typed the one-time password in the correct field? Re-type or copy and paste the 
one-time password within the time allotted by the user’s timeout policy as set in the Log > Settings 
page. 

End Point Control Overview

This section provides an introduction to the End Point Control feature.
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Topics: 

• What is End Point Control?

• Benefits of End Point Control

• How Does End Point Control Work?

• Configuring End Point Control

What is End Point Control?
In traditional VPN solutions, accessing your network from an untrusted site like an employee-owned computer 
or a kiosk at an airport or hotel increases the risk to your network resources. EPC provides secure access from 
any Web-enabled system, including devices in untrusted environments.

Benefits of End Point Control
The SMA appliance supports End Point Control (EPC) that provides the following benefits:

• Verifies that the user’s environment is secure before establishing a connection. 

• Protects sensitive data.

• Ensures that your network is not compromised when accessed from devices in untrusted environments. 

• Protects the network from threats originating from client devices participating in the SMA. 

How Does End Point Control Work?
The SMA appliance provides end point security controls by completing host integrity checking and security 
protection mechanisms before a tunnel session is begun. Host integrity checks help ensure that the client 
system is in compliance with your organization’s security policy. SonicWall end point security controls are tightly 
integrated with access control to analyze the Windows client system and apply access controls based on the 
results. 

End Point Control is supported on Mac iOS and Android mobile devices using Mobile Connect, allowing device 
profiles to be created for these devices. This provides security protection from threats against client devices and 
protection to the SMA appliance from threats originating from client devices logged in to the appliance.

Configuring End Point Control

To configure End Point Control (EPC):

1 Configure Device Profiles that allow or deny user authentication based on various global, group, or user 
attributes. Refer to 

2 Add and configure groups and users to allow or deny End Point Control profiles. 

3 Configure users to inherit their group profiles. 

4 Enable End Point Control. 

5 Connect to NetExtender and monitor the End Point Control log. 
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Web Application Firewall Overview
This section provides an introduction to the Web Application Firewall feature. 

Topics: 

• What is Web Application Firewall?

• Benefits of Web Application Firewall

• How Does Web Application Firewall Work?

• How are Signatures Used to Prevent Attacks?

• How is Cross-Site Request Forgery Prevented?

• How is Information Disclosure Prevented?

• How are Broken Authentication Attacks Prevented?

• How are Insecure Storage and Communications Prevented?

• How is Access to Restricted URLs Prevented?

• How are Slowloris Attacks Prevented?

• What Type of PCI Compliance Reports Are Available?

• How Does Cookie Tampering Protection Work?

• How Does Application Profiling Work?

• How Does Rate Limiting for Custom Rules Work?

What is Web Application Firewall?
Web Application Firewall is subscription-based software that runs on the SMA appliance and protects Web 
applications running on servers behind the appliance. Web Application Firewall also provides real-time 
protection for resources such as HTTP(S) bookmarks, Citrix bookmarks, offloaded Web applications, and the 
Secure Mobile Access management interface and user portal that run on the SMA appliance itself. 

Web Application Firewall provides real-time protection against a whole suite of Web attacks such as Cross-site 
scripting, SQL Injection, OS Command Injection, and many more. The top ten vulnerabilities for Web 
applications are tracked by OWASP, an open source community that focuses its efforts on improving the security 
of Web applications. Secure Mobile Access Web Application Firewall protects against these top ten, defined as 
follows:

Name Description

A1 - Cross Site Scripting (XSS) XSS flaws occur whenever an application takes user supplied data and 
sends it to a Web browser without first validating or encoding that 
content. XSS allows attackers to execute scripts in the victim's browser 
which can hijack user sessions, deface Web sites, and possibly 
introduce worms. 

A2 - Injection Flaws Injection flaws, particularly SQL injection, are common in Web 
applications. Injection occurs when user-supplied data is sent to an 
interpreter as part of a command or query. The attacker's hostile data 
tricks the interpreter into executing unintended commands or 
changing data. 
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Slowloris Protection
In addition to the top ten threats listed previously, Web Application Firewall protects against Slowloris HTTP 
Denial of Service attacks. This means that Web Application Firewall also protects all the backend Web servers 
against this attack. Many Web servers, including Apache, are vulnerable to Slowloris. Slowloris is especially 
effective against Web servers that use threaded processes and limit the amount of threading allowed. 

Slowloris is a stealthy, slow-acting attack that sends partial HTTP requests at regular intervals to hold 
connections open to the Web server. It gradually ties up all the sockets, consuming sockets as they are freed up 
when other connections are closed. Slowloris can send different host headers, and can send GET, HEAD, and 
POST requests. The string of partial requests makes Slowloris comparable to a SYN flood, except that it uses 
HTTP rather than TCP. Only the targeted Web server is affected, while other services and ports on the same 
server are still available. When the attack is terminated, the Web server can return to normal within as little as 5 
seconds, making Slowloris useful for causing a brief downtime or distraction while other attacks are initiated. 
After the attack stops or the session is closed, the Web server logs can show several hundred 400 errors.

Offloaded Web Application Protection
Web Application Firewall can also protect an offloaded Web application that is a special purpose portal created 
to provide seamless access to a Web application running on a server behind the SMA appliance. The portal must 

A3 - Malicious File Execution Code vulnerable to remote file inclusion (RFI) allows attackers to 
include hostile code and data, resulting in devastating attacks, such as 
total server compromise. Malicious file execution attacks affect PHP, 
XML and any framework which accepts filenames or files from users. 

A4 - Insecure Direct Object Reference A direct object reference occurs when a developer exposes a 
reference to an internal implementation object, such as a file, 
directory, database record, or key, as a URL or form parameter. 
Attackers can manipulate those references to access other objects 
without authorization. 

A5 - Cross Site Request Forgery (CSRF) A CSRF attack forces a logged-on victim's browser to send a 
pre-authenticated request to a vulnerable Web application that then 
forces the victim's browser to do a hostile action to the benefit of the 
attacker. CSRF can be as powerful as the Web application that it 
attacks. 

A6 - Information Leakage and 
Improper Error Handling 

Applications can unintentionally leak information about their 
configuration, internal workings, or violate privacy through a variety 
of application problems. Attackers use this weakness to steal sensitive 
data, or conduct more serious attacks. 

A7 - Broken Authentication and 
Session Management 

Account credentials and session tokens are often not properly 
protected. Attackers compromise passwords, keys, or authentication 
tokens to assume other users' identities. 

A8 - Insecure Cryptographic Storage Web applications rarely use cryptographic functions properly to 
protect data and credentials. Attackers use weakly protected data to 
conduct identity theft and other crimes, such as credit card fraud. 

A9 - Insecure Communications Applications frequently fail to encrypt network traffic when it is 
necessary to protect sensitive communications. 

A10 - Failure to Restrict URL Access Frequently, an application only protects sensitive functionality by 
preventing the display of links or URLs to unauthorized users. 
Attackers can use this weakness to access and complete unauthorized 
operations by accessing those URLs directly.

Name Description
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be configured as a virtual host. It is possible to disable authentication and access policy enforcement for such an 
offloaded host. If authentication is enabled, a suitable domain needs to be associated with this portal and all 
SonicWall Inc. advanced authentication features such as One Time Password, Two-factor Authentication, and 
Single Sign-On apply to the offloaded host.

Application Profiling
Application Profiling (Phase 1) allows the administrator to generate custom rules in an automated manner based 
on a trusted set of inputs. This is a highly effective method of providing security to Web applications because it 
develops a profile of what inputs are acceptable by the application. Everything else is denied, providing positive 
security enforcement. This results in fewer false positives than generic signatures that adopt a negative security 
model. When the administrator places the device in learning mode in a staging environment, the SMA appliance 
learns valid inputs for each URL accessed by the trusted users. At any point during or after the learning process, 
the custom rules can be generated based on the “learned” profiles.

Rate Limiting for Custom Rules
You can track the rate at which a custom rule, or rule chain, is being matched. This is extremely useful to block 
dictionary attacks or brute force attacks. The action for the rule chain is triggered only if the rule chain is 
matched as many times as configured.

Cookie Tampering Protection
Cookie Tampering Protection is an important item in the Payment Card Industry Data Security Standard (PCI 
DSS) section 6.6 requirements and part of the Web Application Firewall evaluation criteria that offers strict 
security for cookies set by the backend Web servers. Various techniques such as encryption and message digest 
are used to prevent cookie tampering. 

Credit Card and Social Security Number Protection
Credit Card/SSN protection is a Data Loss Prevention technique that ensures that sensitive information, such as 
credit card numbers and Social Security numbers are not leaked within Web pages. After such leakage is 
detected, the administrator can choose to mask these numbers partially or wholly, present a configurable error 
page, or simply log the event.

Web Site Cloaking
Web Site Cloaking prevents guessing the Web server implementation and exploiting its vulnerabilities. 

PDF Reporting for WAF Monitoring and PCI DSS 6.5 and 6.6 Compliance 
PDF reporting is introduced for Web Application Firewall Monitoring and PCI DSS 6.5 and 6.6 Compliance. You 
can generate the reports on the Web Application Firewall > Status page. The time line for generating the data 
published in the reports is configurable on the Web Application Firewall > Monitoring page.
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Benefits of Web Application Firewall

Web Application Firewall is secure and can be used in various areas, including financial services, healthcare, 
application service providers, and e-commerce. Secure Mobile Access uses SSL encryption to encrypt data 
between the Web Application Firewall and the client. Secure Mobile Access also satisfies OWASP cryptographic 
storage requirements by encrypting keys and passwords wherever necessary.

Companies using Web Application Firewall can reduce the development cost required to create secure 
applications and also cut out the huge turnaround time involved in deploying a newly found vulnerability fix in 
every Web application by signing up for Web Application Firewall signature updates.

Resources accessed over Application Offloaded portals and HTTP(S) bookmarks can be vulnerable because of a 
variety of reasons ranging from badly designed architecture to programming errors. Web Application Firewall 
provides an effective way to prevent a hacker from exploiting these vulnerabilities by providing real-time 
protection to Web applications deployed behind the SMA appliance.

Deploying Web Application Firewall at the SMA appliance lets network administrators use application offloading 
even when it exposes Web applications needing security to internal and remote users. Application offloading 
avoids URL rewriting that improves the proxy performance and functionality.

There are several benefits of integrating Web Application Firewall with SMA appliances. Firstly, identity-based 
policy controls are core to Web Application Firewall and this is easily achievable using Secure Mobile Access 
technology. Secondly, there are lower latencies because of the existing hardware-based SSL offloading. Most 
importantly, SMA appliances run Web applications and must be protected from such attacks.

As small businesses adopt hosted services to facilitate supplier collaboration, inventory management, online 
sales, and customer account management, they face the same strict compliance requirements as large 
enterprises. Web Application Firewall on an SMA appliance provides a convenient, cost-effective solution.

Web Application Firewall is easy to configure in the Secure Mobile Access management interface. The 
administrator can configure Web Application Firewall settings globally, by attack priority, and on a per-signature 
basis. After custom configuration settings or exclusions are in place, you can disable Web Application Firewall 
without losing the configuration, allowing you to complete maintenance or testing and then easily re-enable it.

How Does Web Application Firewall Work?
To use the Web Application Firewall feature, the administrator must first license the software or start a free trial. 
Web Application Firewall must then be enabled on the Web Application Firewall > Settings page of the Secure 
Mobile Access management interface. Web Application Firewall can be configured to log or block detected 
attacks arriving from the Internet.

The following sections describe how Web Application Firewall and SMA appliances prevent attacks such as 
Slowloris or those listed in the OWASP top ten, how Web Application Firewall protects against information 
disclosure, and how other features work.
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How are Signatures Used to Prevent Attacks?
For Cross Site Scripting, Injection Flaws, Malicious File Execution, and Insecure Direct Object Reference 
vulnerabilities, the Web Application Firewall feature uses a black list of signatures that are known to make Web 
applications vulnerable. New updates to these signatures are periodically downloaded from a SonicWall Inc. 
signature database server, providing protection from recently introduced attacks.

How signatures are used to prevent attacks

When input arrives from the Internet, Web Application Firewall inspects HTTP/HTTPS request headers, cookies, 
POST data, query strings, response headers, and content. It compares the input to both a black list and a white 
list of signatures. If pattern matching succeeds for any signature, the event is logged and/or the input is blocked 
if so configured. If blocked, an error page is returned to the client and access to the resource is prevented. If 
blocked, an error page is returned to the client and access to the resource is prevented. The threat details are 
not exposed in the URL of the error page. If configured for detection only, the attack is logged but the client can 
still access the resource. If no signature is matched, the request is forwarded to the Web server for handling.

What happens when no signature is matched
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The Web Application Firewall process is outlined in the following flowchart.

Web Application Firewall process

In the case of a blocked request, the following error page is returned to the client:

This page is customizable under Web Application Firewall > Settings in the Secure Mobile Access management 
interface. Some administrators might want to customize the HTML contents of this page. Others might not want 
to present a user friendly page for security reasons. Instead, they might prefer the option to present an HTTP 
error code such as 404 (Not found) or 403 (Access Denied).

How is Cross-Site Request Forgery Prevented?
CSRF attacks are not detected with signature matching. Using this vulnerability, a hacker disguised as the victim 
can gain unauthorized access to application even without stealing the session cookie of a user. While a victim 
user is authenticated to a Web site under attack, the user can unwittingly load a malicious Web page from a 
different site within the same browser process context, for instance, by launching it in a new tab part of the 
same browser window. If this malicious page makes a hidden request to the victim Web server, the session 
cookies in the browser memory are made part of this request making this an authenticated request. 

The Web server serves the requested Web page as it assumes that the request was a result of a user action on its 
site. To maximize the benefits, typically, hackers targets actionable requests, such as data updates to carry out 
this attack.

To prevent CSRF attacks, every HTTP request within a browser session needs to carry a token based on the user 
session. To ensure that every request carries this token, the Web Application Firewall feature rewrites all URLs 
contained in a Web page similarly to how they are rewritten by the Reverse Proxy for HTTP(S) Bookmarks 
feature. If CSRF protection is enabled, this is also done for Application Offloading.
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If authentication is enforced for the portal, then the user is redirected to the login page for the portal.

How is Information Disclosure Prevented?
Web Application Firewall prevents Information Disclosure and Improper Error Handling by providing a way for 
the administrator to configure text containing confidential and sensitive information so that no Web site 
accessed through the Web Application Firewall reveals this text. These text strings are entered on the Web 
Application Firewall > Settings page. 

Beside the ability to pattern match custom text, signatures pertaining to information disclosure are also used to 
prevent these types of attacks.

Web Application Firewall protects against inadvertent disclosure of credit card and Social Security numbers 
(SSN) in HTML Web pages. 

Web Application Firewall can identify credit card and SSN numbers in various formats. For example, a SSN can 
be specified as XXX XX XXXX or XXX-XX-XXXX. Web Application Firewall attempts to eliminate false-positives by 
filtering out formats that do not conform to the credit card or SSN specification. For example, credit cards follow 
the Luhn’s algorithm to determine if an n-digit number could be a credit card number or not.

The administrator can set an appropriate action, such as detect (log), prevent, or just mask the digits that can 
reveal the user identity. Masking can be done fully or partially, and you can select any of the following 
characters for masking: #, *, -, x, X, ., !, $, and ?. The resulting masked number is similar to the appearance of 
credit card numbers printed on an invoice. 

How are Broken Authentication Attacks Prevented?
The requirement for Broken Authentication and Session Management requires Web Application Firewall to 
support strong session management to enhance the authorization requirements for Web sites. Secure Mobile 
Access already has strong authentication capabilities with the ability to support One Time Password, Two-factor 
Authentication, Single Sign-On, and client certificate authentication. 

For Session Management, Web Application Firewall pops up a session logout dialog box when the user portal is 
launched or when a user logs in to an application offloaded portal. This feature is enabled by default when Web 
Application Firewall is licensed and can be disabled from the Web Application Firewall > Settings page.
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How are Insecure Storage and Communications 
Prevented?
Insecure Cryptographic Storage and Insecure Communications are prevented by encrypting keys and passwords 
wherever necessary, and by using SSL encryption to encrypt data between the Web Application Firewall and the 
client. Secure Mobile Access also supports HTTPS with the backend web server.

How is Access to Restricted URLs Prevented?
Secure Mobile Access supports access policies based on host, subnet, protocol, URL path, and port to allow or 
deny access to Web sites. These policies can be configured globally or for users and groups.

How are Slowloris Attacks Prevented?
Slowloris attacks can be prevented if there is an upstream device, such as an SMA security appliance, that limits, 
buffers, or proxies HTTP requests. Web Application Firewall uses a rate-limiter to thwart Slowloris HTTP Denial 
of Service attacks.

What Type of PCI Compliance Reports Are Available?
Payment Card Industry Data Security Standard (PCI DSS) 6.5 (Version 2.0) and PCI DSS 6.6 (Version 1.2) are 
covered in PCI reporting. The administrator can configure Web Application Firewall to satisfy these PCI 
requirements.

You can generate and download the PCI report file on the Web Application Firewall > Status page.

In the report cover, the following information is displayed:

• The model, serial number, and firmware version of the appliance

• The user name of the person who downloaded the report, displayed as the author of the report

• Time when the report was generated

The following is an example:

NOTE: This is not an official PCI Compliance report. It is for your self-assessment only.
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Two tables are dynamically generated in the PCI compliance report to display the status of each PCI 
requirement. The format of the table is shown in the example that follows:

The first column describes the PCI requirement.

The second column displays the status of the PCI requirement under current Web Application Firewall settings. 
There are four possible values for the status, distinguished by color.

• Satisfied (Green)

• Partially Satisfied (Orange)

• Unsatisfied (Red)

• Unable to determine (Black)

The third column provides comments and details explaining the status rating. If the status is Satisfied, no 
comments are provided.

How Does Cookie Tampering Protection Work?
SMA appliances protect important server-side cookies from tampering.

There are two kinds of cookies:

• Server-Side Cookies – These cookies are generated by backend Web servers. They are important and 
have to be protected. They have optional attributes like Path, Domain, Secure, and HttpOnly.

• Client-Side Cookies – These cookies are created by client side scripts in user browsers. They are not safe, 
and can be easily tampered with. 

This feature is found on the Web Application Firewall > Settings page.
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This page contains the following options:

Portals – A list of all application offloading portals. Each portal has its own settings. The item Global is the 
default setting for all portals. 

Tamper Protection Mode – Three modes are available:

• Prevent – Strip all the tampered cookies and log them. 

• Detect only – Log the tampered cookies only. 

• Inherit Global – Use the global setting for this portal. 

Encrypt Server Cookies – Choose to encrypt name and value separately. This affects client-side script behavior 
because it makes cookie names or values unreadable. Only server-side cookies are encrypted by these options.

Cookie Attributes – The attributes HttpOnly and Secure are appended to server-side cookies if they are 
enabled. 

The attribute HttpOnly prevents the client-side scripts from accessing the cookies that is important in mitigating 
attacks such as Cross Site Scripting and session hijacking. The attribute Secure ensures that the cookies are 
transported only in HTTPS connections. Both together add a strong layer of security for the server-side cookies.

Allow Client Cookies – The Allow Client Cookies option is enabled by default. In Strict mode, the Allow Client 
Cookies option is disabled. When disabled, client-side cookies are not allowed to be sent to the backend 
systems. This option does not affect server-side cookies.

Exclusion List – If the Exclusion List is enabled and contains a cookie, the cookie is passed as usual and is not 
protected. You can exclude server-side cookies and client-side cookies.

Exclusion list items are case sensitive, and in the format ‘CookieName@CookiePath.’ Cookies with the same 
name and different paths are treated as different cookies. ‘CookiePath’ can be left empty to represent any path. 

Import Global – Application Offloading portals can import the Global exclusion list.

How Does Application Profiling Work?
The administrator can configure application profiling on the Web Application Firewall > Rules page. Application 
profiling is completed independently for each portal and can profile multiple applications simultaneously. 

After selecting the portal, you can select the type of application content that you want to profile. You can 
choose HTML/XML, JavaScript, CSS, or All that includes all content types such as images, HTML, and CSS. 
HTML/XML content is the most important from a security standpoint, because it typically covers the more 
sensitive Web transactions. This content type is selected by default.

Then the SMA appliance is placed in learning mode by clicking Begin Profiling (the button then changes to End 
Profiling). The profiling should be done while trusted users are using applications in an appropriate way. The 
Secure Mobile Access records inputs and stores them as URL profiles. The URL profiles are listed as a tree 
structure on the Web Application Firewall > Rules page in the Application Profiling section.

NOTE: By default, the attribute Secure is always appended to an HTTP connection even if Cookie 
Tampering Protection is disabled. This behavior is a configurable option, and can be turned off.
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Only the URLs presented as hyperlinks are accessible URLs on the backend server. You can click on the hyperlink 
to edit the learned values for that URL if the values are not accurate. You can then generate rules to use the 
modified URL profile.

The SMA appliance learns the following HTTP Parameters:

• Response Status Code

• Post Data Length – The Post Data Length is estimated by learning the value in the Content-Length header. 
The maximum size is set to the power of two that is closest to and higher than this value. This 
accommodates the amount of memory that could have been allocated by the backend application. For 
example, for a Content Length of 65, the next power of two greater than 65 is 128. This is the limit 
configured in the URL profile. If the administrator determines that this is not accurate, the value can be 
modified appropriately.

• Request Parameters – This is the list of parameters that a particular URL can accept.

When an adequate amount of input has been learned, you can click End Profiling and are ready to generate the 
rules from the learned input. You can set one of the following as a default action for the generated rule chains:

• Disabled – The generated rules are disabled rather than active.

• Detect Only – Content triggering the generated rule are detected and logged.

• Prevent – Content triggering the generated rule are blocked and logged.

If a rule chain has already been generated from a URL profile in the past, then the rule chain are overwritten 
only when Overwrite existing Rule Chains for URL Profiles is selected. When you click Generate Rules, the 
rules are generated from the URL profiles. If a URL profile has been modified, those changes are incorporated.

How Does Rate Limiting for Custom Rules Work?
The administrator can configure rate limiting when adding or editing a rule chain from the Web Application 
Firewall > Rules page. When rate limiting is enabled for a rule chain, the action for the rule chain is triggered 
only when the number of matches within a configured time period is above the configured threshold. 

This type of protection is useful in preventing Brute Force and Dictionary attacks. An example rule chain with a 
Rule Chain ID of 15002 is available in the Secure Mobile Access management interface for administrators to use 
as reference.

The associated fields are exposed when Enable Hit Counters is selected at the bottom of the New Rule Chain 
or Edit Rule Chain screen. 
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After a rule chain is matched, Web Application Firewall keeps an internal counter to track how many times the 
rule chain is matched. The Max Allowed Hits field contains the number of matches that must occur before the 
rule chain action is triggered. If the rule chain is not matched for the number of seconds configured in the Reset 
Hit Counter Period field, then the counter is reset to zero.

Rate limiting can be enforced per remote IP address or per user session or both. Track Per Remote Address 
enables rate limiting based on the attacker’s remote IP address. 

Track Per Session enables rate limiting based on the attacker’s browser session. This method sets a cookie for 
each browser session. Tracking by user session is not as effective as tracking by remote IP if the attacker initiates 
a new user session for each attack. 

The Track Per Remote Address option uses the remote address as seen by the SMA appliance. In the case 
where the attack uses multiple clients from behind a firewall that is configured with NAT, the different clients 
effectively send packets with the same source IP address and is counted together.

Restful API - Phase 1 Support
Restful API phase 1 includes the User Authentication API and Threat API. The target users of these APIs are the 
API consumers. 

User Authentication API
The actions for the User Authentication API include the following:

1 Configure information

• List Portals

• List Domains

2 Authentication flow

• Create a Login ID for one authentication process

• Post authentication information from the end user to the appliance

• Get response from the appliance and do the next step according to the response status

• Show the default message from the response

• Must support all of our authentication methods and user interactions

• Username/Password

• Client certificate authentication

• Password expiration notification

• Password changing

• One time password
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3 Post authentication

• Device authorization workflow

• End point check workflow

The document path is https://{{hostname}}/__api__/v1/threat/doc.json.

Threat API
The attributes of the Threat API include the following: 

• Access appliance failure

• Authenticate failure

• Geo IP and Botnet check failure

• Malicious file upload through our appliance

The document path is https://{{hostname}}/threat/__api__/v1/doc.json.
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Restful API - Phase 2 Support
Restful API phase 2 includes the Management API and Report API. The target users of these APIs are the 
front-end developers. 

Management API
With Management APIs, the front-end developers can query, add, modify, and delete the SMA appliance 
management configuration data.

The document path is https://{{hostname}}/__api__/v1/management/doc.json.

Report API
With Report APIs, the front-end developers can query current active users, sessions, and system status in the 
SMA appliance. 

The document path is https://{{hostname}}/__api__/v1/report/doc.json.

Navigating the Management Interface
The following sections describe how to navigate the Secure Mobile Access management interface:

• Browser Requirements
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• Management Interface Introduction

• Understanding the Management Interface

• Dashboard

Browser Requirements
The following web browsers and operating systems support the Secure Mobile Access web-based management 
interface and the user portal, Virtual Office.

For information about certain limitations, see the SMA 10.2 Release Notes available on MySonicWall.

Topics: 

• Browser Requirements for the Administrator

• Browser Requirements for the End User

Browser Requirements for the Administrator

To configure an SMA 10.2 appliance using the Secure Mobile Access web-based management interface, an 
administrator must use a web browser with Java, JavaScript, ActiveX, cookies, pop-ups, TLS 1.2, and TLS 1.3 
enabled. 

Browser Requirements for the End User
The following is a list of Web browser and operating system support for various Secure Mobile Access protocols 
including NetExtender and various Application Proxy elements. Minimum browser version requirements are 
shown for Windows, Linux, and MacOS.

The following table provides specific browser requirements for the Secure Mobile Access End User Interface:

Secure Mobile Access Administrator Browser Requirements

Browser Operating System

Edge (latest version) • Windows 10

Mozilla Firefox (latest 
version)

• Windows 10
• Linux
• macOS X

Google Chrome (latest 
version)

• Windows 10
• Linux
• macOS X

Browser Operating System

Edge • Windows 10

Mozilla Firefox
(latest version)

• Windows 10
• Linux
• macOS X
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Management Interface Introduction
The following is an overview of basic setup tasks that connect you to the Secure Mobile Access web-based 
management interface of the SMA appliance. 

Connect one end of a CAT-6 cable into the X0 port of your SMA appliance. Connect the other end of the cable 
into the computer you are using to manage the SMA appliance.

1 Set the computer you use to manage your SMA appliance to have a static IP address in the 
192.168.200.x/24 subnet, such as 192.168.200.20. For help with setting up a static IP address on your 
computer, refer to the Getting Started Guide for your model.

2 Open a Web browser and enter https://192.168.200.1 (the default LAN management IP address) in the 
Location or Address field.

3 A security warning can appear. Click Yes to continue.

4 The Secure Mobile Access management interface is displayed and prompts you to enter your user 
name and password. Enter admin in the User Name field, password in the Password field, select 
LocalDomain from the Domain drop-down list and click Login.

When you have successfully logged in, you see the default page, System > Status. 

The System, Network, Portals, NetExtender, Web Application Firewall, Users and Log menu headings on the 
left side of the browser window configure administrative settings. When you click one of the headings, its 
submenu options are displayed below it. Click on submenu links to view the corresponding management pages. 

The Virtual Office option in the navigation menu opens a separate browser window that displays the login page 
for the user portal, Virtual Office.

Help in the upper right corner of the management interface opens a separate browser window that displays 
Secure Mobile Access Help.

Logout in the upper right corner of the management interface terminates the management session and closes 
the browser window.

Understanding the Management Interface
The Secure Mobile Access web-based management interface allows the administrator to configure the SMA 
appliance. The Secure Mobile Access management interface contains top level, read-only windows and 
configuration windows: 

• Windows - Displays information in a read-only format.

• Configuration windows - Enables administrator interaction to add and change values that characterize 
objects. For example, IP addresses, names, and authentication types.

Google Chrome
(latest version)

• Windows 10
• Linux
• macOS X

Apple Safari
(latest version)

• macOS X

Browser Operating System
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The following sections provide details about the Secure Mobile Access web-based management interface. Note 
the various elements of a standard Secure Mobile Access interface window. 

Topics: 

• Dashboard

• Status Bar

• Accepting Changes

• Navigating Tables

• Restarting

• Common Icons in the Management Interface

• Tool tip in the Management Interface

• Getting Help

• Logging Out

Dashboard
The Overview > Dashboard page displays the overview of system health—total threat count, current & historic 
graph for CPU, memory, concurrent users, connected tunnel users, current users and application location info, 
and threat summary.

Navigation Bar
The Secure Mobile Access navigation bar is located on the left side of the Secure Mobile Access management 
interface and is comprised of a hierarchy of menu headings. Most menu headings expand to a submenu of 
related management functions, and the first submenu item page is automatically displayed. For example, when 
you click the System heading, the System > Status page is displayed.
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The navigation menu headings are: System, Network, Portals, Services, End Point Control, Web Application 
Firewall, High Availability, Users, Log.

Status Bar
The Status bar at the bottom of the management interface window displays the status of actions executed in 
the Secure Mobile Access management interface.

Accepting Changes
Click Accept at the top right corner of the main window to save any configuration changes you made on the 
page.

If the settings are contained in a secondary window within the Secure Mobile Access management interface, 
Accept is still available at the top right corner of the window.
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Navigating Tables
Navigating tables with large number of entries is simplified by navigation buttons located above the table. For 
example, the Log > View page contains an elaborate bank of navigation buttons:

Log > View

Restarting
The System > Restart page provides a Restart button for restarting the SMA appliance.

Common Icons in the Management Interface
The following icons are used throughout the Secure Mobile Access management interface:

Navigation Buttons in the Log View Page

Navigation Button Description

Find Allows the administrator to search for a log entry containing the content specified in the 
Search field. The search is applied to the element of the log entry specified by the 
selection in the drop-down list. The selections in the drop-down list correspond to the 
elements of a log entry as designated by the column headings of the Log > View table. 
You can search in the Time, Priority, Source, Destination, User, and Message elements of 
log entries.

Include Allows the administrator to display log entries including the type specified in the 
drop-down list.

Exclude Allows the administrator to display log entries excluding the type specified in the 
drop-down list.

Reset Resets the listing of log entries to their default sequence.

Message Log Allows the administrator to message a log.

Export Log Allows the administrator to export a log.

Clear Log Allows the administrators clear the log entries.
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• Clicking on the configure icon displays a window for editing the settings.

• Clicking on the delete  icon deletes a table entry.

• Moving the pointer over the comment  icon displays text from a Comment field entry.

Tool tip in the Management Interface
Many pages throughout the Secure Mobile Access management interface display popup tool tip with 
configuration information when the mouse cursor hovers over a check box, text field, or radio button. Some 
fields have a Help icon  that provides a tooltip stating related requirements.

Getting Help
Help in the upper right corner of the Secure Mobile Access management interface opens a separate Web 
browser that displays the main Secure Mobile Access Help. 

SMA appliances also include online context-sensitive Help, available from the management interface by clicking 
the question mark  button on the top-right corner of most pages. Clicking on the question mark button opens a 
new browser window that displays management page or feature-specific Help.

Logging Out

Logout in the upper right corner of the management interface terminates the management session.

When you click Logout, you are logged out of the Secure Mobile Access management interface and the Web 
browser is closed.

Deployment Guidelines
Topics: 

• Support for Numbers of User Connections

• Resource Type Support

• Integration with other SonicWall Products
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• Typical Deployment

• Two-armed Deployment

• Virtual Platforms

Support for Numbers of User Connections
The following table lists the maximum and recommended numbers of concurrent tunnels supported for each 
appliance. 

Factors such as the complexity of applications in use and the sharing of large files can impact performance.

Resource Type Support
The following table describes the types of applications or resources you can access for each method of 
connecting to the SMA appliance.

Concurrent tunnels supported based on appliance

Appliance Model Maximum Concurrent 
Tunnels Supported

SMA 400 250

SMA 200 50

SMA 410 400

SMA 210 200

SMA 500v Virtual Appliance 50

Supported application and resource types

Access Mechanism Access Types

Standard Web browser • Files and file systems, including support for FTP and Windows Network 
File Sharing, File Shares (CIFS), and SSH File Transfer Protocol (SFTP)

• Web-based applications including Web (HTTP), Secure Web (HTTPS), 
External Website, and Mobile Connect

• Remote desktop services including Terminal Services (RDP), Virtual 
Network Computing (VNC), and Citrix Portal (Citrix)

• Microsoft Outlook Web Access and other Web-enabled applications

• Terminal protocols including Telnet and Secure Shell Version 2 (SSHv2)

NetExtender • Any TCP/IP based application including:

• Email access through native clients residing on the user’s laptop 
(Microsoft Outlook, Lotus Notes, and so on.)

• Commercial and home-grown applications

• Flexible network access as granted by the network administrator
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Integration with other SonicWall Products
The SMA appliance integrates with other SonicWall Inc. products, complementing the SonicWall Inc. NSA, 
SuperMassive (9000 Series) and TZ Series product lines. Incoming HTTPS traffic is redirected by a SonicWall Inc. 
firewall appliance to the SMA appliance. The SMA appliance then decrypts and passes the traffic back to the 
firewall where it can be inspected on its way to internal network resources.

Typical Deployment
The SMA appliance is commonly deployed in tandem in one-armed mode over the DMZ or Opt interface on an 
accompanying gateway appliance, for example, a SonicWall Inc. network security appliance,

This method of deployment offers additional layers of security control plus the ability to use SonicWall Inc.’s 
Unified Threat Management (UTM) services, including Gateway Anti-Virus, Anti-Spyware, Content Filtering and 
Intrusion Prevention, to scan all incoming and outgoing NetExtender traffic. SonicWall Inc. recommends 
one-armed mode deployments over two-armed for the ease-of-deployment and for use in conjunction with 
UTM GAV/IPS for clean VPN.

As shown in the following figure, in one-armed mode the primary interface (X0) on the SMA appliance connects 
to an available segment on the gateway device. The encrypted user session is passed through the gateway to the 
SMA appliance (step 1). The SMA appliance decrypts the session and determines the requested resource. The 
Secure Mobile Access session traffic then traverses the gateway appliance (step 2) to reach the internal network 
resources. While traversing the gateway, security services, such as Intrusion Prevention, Gateway Anti-Virus and 
Anti-Spyware inspection can be applied by appropriately equipped gateway appliances. The internal network 
resource then returns the requested content to the SMA appliance through the gateway (step 3) where it is 
encrypted and returned to the client. 

Two-armed Deployment
The SMA appliances also support two-armed deployment scenarios, using one external (DMZ or WAN side) 
interface and one internal (LAN) interface. However, two-armed mode introduces routing issues that need to be 
considered before deployment. The SMA appliance does not route packets across interfaces, as there are IP 
tables rules preventing that, and therefore cannot be used as a router or default gateway. Any other machines 
connected to an internal interface of the SMA appliance in two-armed mode would need to access the Internet 
or other network resources (DNS, NTP) through a different gateway.

If you have an internal router as well as an Internet router, you can use a two-armed deployment to leverage 
your internal router to access your internal resources.

Sample Scenario: Company A has resources and a number of subnets on their internal network, and they 
already have a robust routing system in place. With two-armed deployment of the SMA appliance, client 
requests destined for internal resources on the corporate network can be delivered to an internal router.

Virtual Platforms
Users can now launch their own instances of SMA 500v in public cloud environment—AWS, Azure, EXSXi and 
Hyper-V. The hosted 500v supports the same features as a data center-hosted 500v.

For information on installing and configuring SMA 500v instance for AWS and Azure, see the SMA 500v Getting 
Started Guide for AWS and SMA 500v Getting Started Guide for Azure available at the Technical Documentation 
portal: https://www.sonicwall.com/support/technical-documentation/.

For information about certain limitations of this feature, see the SMA 10.2 Release Notes available on 
MySonicWall.
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Configuring Secure Mobile Access

• System Configuration

• Network Configuration

• Portals Configuration



SonicWall Secure Mobile Access 10.2 Administration Guide
System Configuration

3

64

System Configuration

This section provides information and configuration tasks specific to the System pages in the SonicWall Secure 
Mobile Access web-based management interface, including registering your SMA appliance, setting the date 
and time, configuring system settings, system administration and system certificates.

Topics: 

• System > Status

• System > Licenses

• System > Time

• System > Settings

• System > Administration

• External FTP/TFTP Server

• System > Certificates

• System > Monitoring

• System > Diagnostics

• System > Restart

• System > About

System > Status
This section provides an overview of the System > Status page and a description of the configuration tasks 
available on this page.

• System Status Overview

• Registering SMA Appliance with System Status

System Status Overview
The System > Status page provides the administrator with current system status for the SMA appliance, 
including information and links to help manage the SMA appliance and Security Services licenses. This section 
provides information about the page display and instructions to complete the configuration tasks on the System 
> Status page.
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Overview of each area of the System > Status page are provided in the following sections:

• System Messages

• System Information

• Latest Alerts

• Licenses & Registration

System Messages
The System Messages section displays text about recent events and important system messages, such as system 
setting changes. For example, if you do not set an outbound SMTP server, you will see the message, “Log 
messages and one-time passwords cannot be sent because you have not specified an outbound SMTP server 
address.”

System Information
The System Information section displays details about your specific SMA appliance. The following information is 
displayed in this section:

System Information

Field Description

Model The type of SMA appliance.

Serial Number The serial number or the MAC address of the SMA appliance.

Authentication Code The alphanumeric code used to authenticate the SMA appliance on the 
registration database at MySonicWall. 

Firmware Version The firmware version loaded on the SMA appliance.

CPU (Utilization) The type of the SMA appliance processor and the average CPU usage over the 
last 5 minutes.

https://mysonicwall.com/muir/login/step2
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Latest Alerts
The Latest Alerts section displays text about recent invasive events, irregular system behavior, or errors. Latest 
Alerts includes information about the date and time of the event, the host of the user that generated the event 
and a brief description of the event.

Any messages relating to system events or errors are displayed in this section. Clicking the arrow button located 
in upper right corner of this section displays the Show Log Messages.

Fields in the Latest Alerts section are:

• Date/Time - The date and time when the message was generated.

• User - The name of the user that generated the message.

• Message - A message describing the error.

Licenses & Registration
The Licenses & Registration section indicates the user license allowance and registration status of your SMA 
appliance. The status of your Analyzer, ViewPoint, Spike License, and Web Application firewall licenses are also 
displayed here.

Go to the System > Licenses page to register your appliance on MySonicWall and allow the appliance to 
automatically synchronize registration and license status with the SonicWall Inc. server. 

The Network Interfaces section provides the administrator with a list of SMA appliance interfaces by name. For 
each interface, the Network Interfaces tab provides the IP address that has been configured and the current link 
status.

Registering SMA Appliance with System Status
Register with MySonicWall to get the most out of your SMA appliance. Complete the steps in the following 
sections to register.

Topics: 

• Before You Register

• Registering with MySonicWall

Safemode version The safemode version loaded on the SMA appliance.

Total Memory The amount of RAM and Flash memory on the appliance.

System Time The current date and time.

Up Time The number of days, hours, minutes, and seconds, that the SMA appliance has 
been active since its most recent restart.

Active Users The number of users who are currently logged into the Secure Mobile Access 
management interface of the SMA appliance.

Anonymous Sessions The number of anonymous sessions, the sessions that are logged in without 
user name or password, on the SMA appliance.

System Information (Continued)

Field Description
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Before You Register
Verify that the time, DNS, and default route settings on your SMA appliance are correct before you register your 
appliance. These settings are generally configured during the initial SMA appliance setup process. To verify or 
configure the time settings, navigate to the System > Time page. To verify or configure the DNS setting, navigate 
to the Network > DNS page. To verify or configure the default route, navigate to the Network > Routes page. 

To create a MySonicWall account from System > Licenses:

1 On the System > Licenses page, click Activate, Upgrade, or Renew services. The License Management 
page is displayed.

2 If you do not have a MySonicWall account or if you forgot your user name or password, click the 
https://www.MySonicWall.com link at the bottom of the page. The MySonicWall User Login page is 
displayed. 

Do one of the following:

• If you forgot your user name, click the Forgot Username? link.

• If you forgot your password, click the Forgot Password? link.

• If you do not have a MySonicWall account, click the Not a registered user? link.

3 Follow the instructions to activate your MySonicWall account.

Registering with MySonicWall
There are two ways to register your SMA appliance:

• Log in to your MySonicWall account directly from a browser or click the SonicWall Inc. link on the 
System > Status page to access MySonicWall, enter the appliance serial number and other information 
there, and then enter the resulting registration code into the field on the System > Status page. 

• Use the link on the System > Licenses page to access MySonicWall, then enter the serial number and 
other information into MySonicWall. When finished, your view of the System > Licenses page shows 
that the appliance has been automatically synchronized with the licenses activated on MySonicWall

To register your SMA appliance:

1 If you are not logged into the Secure Mobile Access management interface, log in with the username 
admin and the administrative password you set during initial setup of your SMA appliance (the default is 
password).

2 If the System > Status page is not automatically displayed in the Secure Mobile Access management 
interface, click System in the left-navigation menu, and then click Status.

3 Record your Serial Number and Authentication Code from the SYSTEM INFORMATION section.

4 Do one of the following to access the MySonicWall Web page:

• Click the SonicWall Inc. link in the Licenses & Registration section.

• Type http://www.MySonicWall.com into the Address or Location field of your Web browser. 

http://www.mysonicwall.com
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5 Enter your MySonicWall account user name and password.

6 Navigate to Products in the left navigation bar.

7 Enter your Serial Number and Authentication Code in the appropriate fields.

8 Enter a descriptive name for your SMA appliance in the Friendly Name field.

9 Select the product group for this appliance, if any, from the Product Group drop-down list.

10 Click Register. When the MySonicWall server has finished processing your registration, the Registration 
Code is displayed along with a statement that your appliance is registered. 

11 Click Continue.

12 On the System > Status page of the Secure Mobile Access management interface, enter the Registration 
Code into the field at the bottom of the Licenses & Registration section, and then click Update.

Configuring Network Interfaces
The IP settings and interface settings of the SMA appliance can be configured by clicking on the blue arrow in 
the corner of the Network Interfaces section of the System > Status page. The link redirects you to the 
Network > Interfaces page that can also be accessed from the navigation bar. From the Network > Interfaces 
page, a SMA appliance administrator can configure the IP address of the primary (X0) interface, and also 
optionally configure additional interfaces for operation.

For a port on your SMA appliance to communicate with a firewall or target device on the same network, you 
need to assign an IP address and a subnet mask to the interface. 

System > Licenses
This section provides an overview of the System > Licenses page and a description of the configuration tasks. 

• System > Licenses Overview
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System > Licenses Overview
Services upgrade licensing and related functionality is provided by the License Manager that runs on the SMA 
appliance. The License Manager communicates periodically (hourly) with the SonicWall Inc. licensing server to 
verify the validity of licenses. The License Manager also allows the administrator to purchase licenses directly or 
turn on free trials to preview a product before buying. 

The System > Licenses page provides a link to activate, upgrade, or renew SonicWall Inc. Security Services 
licenses. From this page in the Secure Mobile Access management interface, you can manage all the SonicWall 
Inc. Security Services licenses for your SMA appliance. 

Topics: 

• Security Services Summary

• Manage Security Services Online

Security Services Summary
The Security Services Summary table lists the number of Nodes/Users licenses and the available and activated 
security services on the SMA appliance. 

The Security Service column lists all the available SonicWall Inc. Security Services and upgrades available for 
the security appliance. The Status column indicates if the security service is activated (Licensed), available for 
activation (Not Licensed, or for Spike License, Inactive), or no longer active (Expired). ViewPoint, Spike License, 
Stateful High Availability and Web Application Firewall are licensed separately as upgrades. 

The number of nodes (computer or other device connected to your appliance with an IP address) or users 
allowed by the license is displayed in the Count column. This number refers to the maximum number of 
simultaneous connections to the SMA appliance. 
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The Expiration column displays the expiration date for any licensed service that is time-based. For a Spike 
License, the Expiration column shows the number of days that the Spike License can be active before it expires. 
The days do not have to be consecutive. 

The information listed in the Security Services Summary table is updated from the SonicWall Inc. licensing 
server every time the SMA appliance automatically synchronizes with it (hourly), or you can click Synchronize to 
synchronize immediately. 

Manage Security Services Online
You can log in to MySonicWall directly from the System > Licenses page by clicking the link Activate, Upgrade, 
or Renew services. You can click this link to register your appliance, to purchase additional licenses for 
upgrading or renewing services, or to activate free trials.

Registering the SMA Appliance with System > 
Licenses
On a new SMA appliance or after upgrading your firmware from an earlier release, you can register your 
appliance from the System > Licenses page.

To register your appliance from the System > Licenses page:

1 Log in to the System > Licenses page. Click “Activate, Upgrade, or Renew services.

2 Enter your MySonicWall user name and password into the fields and then click Submit. 

3 The License Management page is displayed.

4 Click Activate, Upgrade, or Renew on your existing license. 

5 Enter your license key in the spaces provided.
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6 Click Submit.

7 The display changes to inform you that your SMA appliance is registered.

8 In the License Management page, your latest license information is displayed.

Activating or Upgrading Licenses
Topics: After your SMA appliance is registered, you can activate licenses for Analyzer/ViewPoint, End Point 
Control, Spike License, and Web Application Firewall on the System > Licenses page. Analyzer/ViewPoint, and 
Web Application Firewall also offer a free trial. You can also upgrade a license from this page.

• Using a Spike License

• Manual Upgrade

1 To activate or upgrade licenses or free trials on your appliance:

2 On the System > Licenses page, click Activate, Upgrade, or Renew services. The License Management 
page is displayed.

3 Enter your MySonicWall user name and password into the fields and then click Submit. The display 
changes to show the status of your licenses. The services can have a Try link, an Activate link, or an 
Upgrade link.

4 To activate a free trial, click Try next to the service that you want to try. The page explains that you will be 
guided through the setup of the service, and that you can purchase a SonicWall Inc. product subscription 
at any time during or after the trial. Click Continue, and follow the setup instructions.

5 To activate a new license which you have already purchased on MySonicWall or from your reseller, click 
Activate, Upgrade, or Renew services under the Manage Security Services Online section. Enter 
your license activation key into the <Product> Activation Key field, and then click Submit.

6 After completing the activation or upgrading process, click Synchronize to update the appliance license 
status from the SonicWall Inc. licensing server. Rebooting the appliance also updates the license status.
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Using a Spike License
A Spike License enables you to temporarily increase the number of remote users your appliance or can support 
if there is a sudden spike in remote access needs, such as during a period of severe weather or during a business 
event for remote participants. Licensed separately, this feature helps you accommodate spikes in remote access 
traffic during planned or unplanned events.

When you buy a Spike License, it is valid for a given number of users and days (total number of users supported 
when the Spike License is activated, not the number in addition to your base license number). You can suspend 
and resume the use of the license as needed. 

More than one Spike Licenses can be uploaded to your appliance, but only one can be active at a time.

An option is available to automatically enable and disable the license depending on the number of user 
connections. Select Automatically activate Spike License to enable it. If this option is enabled, the Spike 
License is automatically activated when the number of connected users exceeds your normal user license. The 
Spike License stays active until either the number of users decreases back to your normal licensed amount or 
the Spike License expires.

To activate or stop a Spike License:

1 Purchase your Spike License from MySonicWall and import it to the appliance. After licensing, the status 
is updated to Licensed, and the total users supported and number of usage days remaining in the Spike 
License are shown on the System > Licenses page.

2 After reloading the page, the Spike License is listed as Off on the System > Licenses page.

3 When you need to accommodate more users, click Activate. The status changes to Active.

4 To stop an active Spike License, click Stop. The status goes back to Off, and the number of days remaining 
is updated. 
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Manual Upgrade
To manually upgrade the your Security Services, scroll down to the Manual Upgrade section of the System > 
Licences page. You will need the Keyset for the service(s) you wish to upgrade. Enter the Keyset in the available 
field, then click Submit. Click Synchronize at the top of the page to refresh the Security Services Summary. You 
should now see the upgraded license in the Security Services Summary. 
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System > Time
This section provides an overview of the System > Time page: 

• System > Time Overview

• Setting the Time

• Enabling Network Time Protocol

System > Time Overview
This section provides an overview of the System > Time page and a description of the configuration tasks 
available on this page.The System > Time page provides the administrator with controls to set the 
SMA.appliance system time, date and time zone, and to set the SMA appliance to synchronize with one or more 
NTP servers. 

Topics: 

• System Time

• NTP Settings

System Time
The System Time section allows the administrator to set the time (hh:mm:ss), date (mm:dd:yyyy) and time zone. 
It also allows the administrator to select automatic synchronization with the NTP (Network Time Protocol) 
server and to display UTC (Coordinated Universal Time) instead of local time in logs.
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NTP Settings
The NTP Settings section allows the administrator to set an update interval (in seconds), an NTP server, and two 
additional (optional) NTP servers.

Setting the Time
To configure the time and date settings, navigate to the System > Time page. The appliance uses the time and 
date settings to timestamp log events and for other internal purposes. It is imperative that the system time be 
set accurately for optimal performance and proper registration. 

To configure the time and date settings:

1 Select your time zone in the Time Zone drop-down list. 

2 The current time, in 24-hour time format, appears in the Time (hh:mm:ss) field and the current date 
appears in the Date (mm:dd:yyyy) field.

3 Alternately, you can manually enter the current time in the Time (hh:mm:ss) field and the current date 
in the Date (mm:dd:yyyy) field.

4 Click Accept to update the configuration.

Enabling Network Time Protocol
If you enable Network Time Protocol (NTP), then the NTP time settings overrides the manually configured time 
settings. The NTP time settings are determined by the NTP server and the time zone that is selected in the Time 
Zone drop-down list.

To set the time and date for the appliance using the Network Time Protocol (NTP):

1 Navigate to the System > Time page.

2 Select Automatically synchronize with an NTP server.

3 In the NTP Settings section, enter the time interval in seconds to synchronize time settings with the NTP 
server in the Update Interval field. If no period is defined, the appliance selects the default update 
interval, 3600 seconds.

4 Enter the NTP server IP address or fully qualified domain name (FQDN) in the NTP Server 1 field.

5 For redundancy, enter a backup NTP server address in the NTP Server Address 2 (Optional) and NTP 
Server Address 3 (Optional) fields.

6 Click Accept to update the configuration.
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System > Settings
This section provides an overview of the System > Settings page and a description of the configuration tasks 
available.

• System > Settings Overview

• Managing Configuration Files

• Managing Firmware

System > Settings Overview
The System > Settings page allows the administrator to import and export the settings of the SMA appliance. 
Options to automatically send your settings to an external FTP server after a firmware upgrade and upon 
generation are included. SMA already had a period backup of the appliance settings, but these options provide a 
new method for backup.

On a physical appliance, the System > Settings page provides a way to upload new firmware, and to boot either 
the current firmware, newly uploaded firmware, or backup firmware.

Configure the FTP server on the System > Administration page to automatically send new settings to the 
external FTP server. 

The Settings page provides buttons to import and export settings along with email settings, and allows the 
administrator to encrypt the settings files. There is also an option to be notified when new firmware becomes 
available.
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Topics: 

• Firmware Management

Firmware Management
The Firmware Management section allows the administrator to control the firmware that is running on the SMA 
appliance. This section provides buttons for uploading new firmware, creating a backup of current firmware, 
downloading existing firmware to the management computer, rebooting the appliance with current or recently 
uploaded firmware, and rebooting the appliance with factory default settings.

Managing Configuration Files
SMA appliances allow you to save and import file sets that hold the SMA configuration settings. These file sets 
can be saved and uploaded through the System > Settings page in the Secure Mobile Access management 
interface.

Topics: 

• Encrypting the Configuration File

• Importing a Configuration File

• Importing Partial Configurations

• Exporting a Backup Configuration File

• Emailing Configuration Settings

• Enabling Scheduled Backups

• Emailing New Settings

Encrypting the Configuration File
For security purposes, you can encrypt the configuration files in the System > Settings page. However, if the 
configuration files are encrypted, they cannot be edited or reviewed for troubleshooting purposes. 

To encrypt the configuration files, select Encrypt settings file in the System > Settings page.

Importing a Configuration File
You can import the configuration settings that you previously exported to a backup configuration file. 

To import a configuration file:

1 Navigate to the System > Settings page. 

2 To import a backup version of the configuration, click Import Settings. The Import Settings dialog box is 
displayed.

3 Click Browse to navigate to a location that contains the file (that includes settings) you want to import. 
The file can be any name, but is named sslvpnSettings-serialnumber.zip by default.

4 Click Upload. Secure Mobile Access imports the settings from the file and configures the appliance with 
those settings.

5 After the file has been imported, restart the appliance to make the changes permanent.
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Importing Partial Configurations
This feature allows you to import settings on partial configurations while leaving some configurations 
unchanged; including interface settings, route settings, DNS settings, WINS settings, and Licenses.

To import the settings partially,

1 Navigate to System > Settings > Import Settings. The Import Settings page appears.

2 Choose the configuration file you would like to upload, and click Import the settings partially. 

3 Click Accept.

Exporting a Backup Configuration File
Exporting a backup configuration file allows you to save a copy of your configuration settings on your local 
machine. You can then save the configuration settings or export them to a backup file and import the saved 
configuration file at a later time, if necessary. The backup file is called sslvpnSettings-serialnumber.zip by 
default, and includes the contents shown in the following figure.

The backup directory structure contains the following elements:

• ca folder (not shown) – Contains CA certificates provided by a Certificate Authority. 

• cert folder – Contains the default folder with the default key/certification pair. Also contains 
key/certification pairs generated by Certificate Signing Requests (CSRs) from the System > Certificates 
page, if any.

• uiaddon folder – Contains a folder for each portal. Each folder contains portal login messages, portal 
home page messages, and the default logo or the custom logo for that portal, if one was uploaded. 
VirtualOffice is the default portal.

• firebase.conf file – Contains network, DNS and log settings.

• settings.json file – Contains user, group, domain and portal settings.

• fcrontab.config file – Only generated when the Schedule TSR is enabled. 
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To export a backup configuration file:

1 Navigate to the System > Settings page. 

2 To save a backup version of the configuration, click Export Settings. The browser you are working in 
displays a pop-up asking you if you want to open the configuration file.

3 Select the option to Save the file.

4 Choose the location to save the configuration file. The file is named sslvpnSettings-serialnumber.zip by 
default, but it can be renamed.

5 Click Save to save the configuration file.

Emailing Configuration Settings
You can email the current settings, auto-generated settings on upgrade, and scheduled settings to an email 
address as another way to back up your system. Specify an email address in the Email Settings to field. Then, 
click Email Settings.

You can also have the email settings sent automatically upon every firmware upgrade. Select the Automatically 
email settings on firmware upgrade check box. The Mail Server and Mail From Address values must be 
configured for automated email delivery. 

Enabling Scheduled Backups
You can set scheduled backups for your current settings by selecting Enable scheduled settings backup. Then, 
specify the frequency of back ups to be scheduled. You can specify for the back ups to occur Daily, Weekly, 
Fortnightly, or Monthly. 

Emailing New Settings
You can select Automatically email new settings upon generation to have emails sent to you of the newest 
settings after they are generated. 

Managing Firmware
The Firmware Management section of System > Settings provides the administrator with the option to be 
notified when new firmware becomes available. It provides the configuration options for firmware images.

Topics: 

• Setting Firmware Notification

• Creating a Backup

• Downloading Firmware

• Booting a Firmware Image

• Uploading New Firmware

Setting Firmware Notification
The administrator can be notified by email when a new firmware build is available. To be notified when new 
firmware is available, select Notify me when new firmware is available.
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Creating a Backup
To create a system backup of the current firmware and settings, click Create Backup. The backup might take up 
to two minutes. When the backup is complete, the Status at the bottom of the screen displays the message, 
“System Backup Successful.”

Downloading Firmware

To download firmware, click the download icon  next to the Firmware Image version you want to 

download.

Booting a Firmware Image
You can boot up (restart) the appliance with any firmware image that appears in the Firmware Management 
table on the System > Settings page. You have the choice of keeping current configuration settings or reverting 
to factory default settings.

To boot a firmware image:

1 Click the boot icon  in the row for the Firmware Image version that you want to run on the SMA 
appliance.

2 To reboot the image with factory default settings, select Boot with factory default settings. If this option 
is not selected, current configuration settings are kept.

3 The pop-up message is displayed: Are you sure you wish to boot this firmware? Click OK.

Uploading New Firmware

To upload new firmware:

1 Log in to MySonicWall.

2 Download the latest Secure Mobile Access firmware version.

3 In the Secure Mobile Access management interface, navigate to the System > Settings page.

4 Click Upload New Firmware under the Firmware Management section.

5 Click Browse.

6 Select the downloaded Secure Mobile Access firmware. It should have a .sig file extension.

7 Click Open.

8 Click Accept. Wait for the firmware to upload and be written to the disk.

9 The System > Settings page displays the firmware table, with the uploaded firmware listed in it. Click the 
Boot icon in the Uploaded Firmware row to boot the new firmware with existing settings.

System > Administration
This section provides an overview of the System > Administration page and a description of the configuration 
tasks available on this page.
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Topics: 

• System > Administration Overview

• Configuring Login Security

• Configuring HTTP DOS Settings

• Configuring Web Management Settings

• Configuring SNMP Settings

• Enabling GMS Management

System > Administration Overview
This section provides the administrator with information about and instructions to complete the configuration 
tasks on the System > Administration page. The System > Administration page allows the administrator to 
configure login security, Web management settings, SNMP settings, and GMS settings. 

Topics: 

• Login Security

• HTTP DOS Settings

• Global SSL/TLS Settings

• Transport Layer Security (TLS) 1.3 support
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• Capacity Matrix

• Web Management Settings

• SNMP Settings

• Enabling GMS Management

• Enabling Cloud Management

Login Security
The Login Security section provides a way to configure administrator/user lockout for a set period of time (in 
minutes) after a set number of maximum login attempts per minute.

HTTP DOS Settings
The HTTP DOS Settings section is used to configure the maximum concurrent TCP connections (20-100, default 
20) a client can open with the Secure Mobile Access web server. 

Global SSL/TLS Settings
The Global SSL/TLS settings section allows the administrator to configure Secure Sockets Layer (SSL) and 
Transport Layer Security (TLS) settings globally from the System > Administration page. 

Topics: 

• Transport Layer Security (TLS) 1.3 support

Configure the following settings:

• Customize TLS version - Specify the TLS version that will be supported by the web server for special 
security reasons. The TLS version is used for communication between the client and the web server. To 
specify the TLS version, select one of the following options from the Customize TLS version scroll menu:

• TLSv1.3

• TLSv1.2

• TLSv1.1

• TLSv1

• Ciphersuites - Specify cipher suites by selecting one of the following options from the Ciphersuites 
drop-down menu:

• Modern compatibility - provides a higher level of security, but may not be compatible with older 
clients. The oldest compatible clients are Firefox 27, Chrome 30, IE 11, on Windows 7, Edge, Opera 
17, Safari 9, Android 5.0, and Java 8.

• Intermediate compatibility (recommended) - supports a wide range of clients, but is not 
compatible with legacy clients (mostly WinXP). The oldest compatible clients are Firefox 1, 
Chrome 1, IE 7, Opera 5, Safari 1, Windows XP IE8, Android 2.3, and Java 7.

• Old backward compatibility (not recommended) - supports all clients back to Windows XP/IE6. 
Oldest compatible clients are Windows XP, IE6, Java 6.

• Custom ciphersuites- provides a customizable level of security. Select Custom ciphersuites and 
input a custom cipher list in the text field. 
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• Verify Backend SSL Server Certificate for Proxy connections — When this option is enabled, the 
connection is dropped if the backend SSL/TLS server certificate is not trusted. The verification depth is 
10. Alert level log messages are also generated when this option is enabled. 

Transport Layer Security (TLS) 1.3 support
SMA has been enhanced to support the latest secured protocol version TLS 1.3 for both incoming and outgoing 
connections.

To configure the TLS version:

1 Log in to the SMA management interface.

2 Navigate to System > Administration, select TLSv 1.3 in the Customize TLS version scroll menu.

3 Click Accept at the lower-right corner of the page.

Capacity Matrix
The Secure Mobile Access Capacity Matrix Report is a downloadable .PDF file that allows you to view the total 
number of various connections, interfaces, portals, domains, groups, users, and so on, available for your specific 
SMA appliance model. Click Download to have the report downloaded to your local system. 

NOTE: TLS 1.3 is supported on NetExtender for Linux but not on NetExtender for Windows.
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Web Management Settings
The Web Management Settings section allows the administrator to set the default page size for paged tables 
and the streaming update interval for dynamically updated tables in the Secure Mobile Access management 
interface.

The minimum for the Default Table Size field is 10 rows, the default is 100, and the maximum is 99,999. 

The following dynamically updated tables are affected by the Streaming Update Interval setting:

• System > Monitoring

• Network > Interfaces

• NetExtender > Status

• Users > Status

The minimum for the Streaming Update Interval field is one second, the default is 10 seconds, and the 
maximum is 99,999.

SNMP Settings
The SNMP Settings section allows the administrator to enable SNMP and specify SNMP settings for the 
appliance. A list of downloaded MIBs is displayed to the right of the fields. 

The GMS Settings section allows the administrator to enable GMS management, and specify the GMS host 
name or IP address, GMS Syslog server port and heartbeat interval (in seconds).

Configuring Login Security
SMA appliance login security provides an auto lockout feature to protect against unauthorized login attempts on 
the user portal. Complete the following steps to enable the auto lockout feature:

1 Navigate to System > Administration.

2 Select Enable Administrator/User Lockout.

3 In the Maximum Login Attempts Per Minute field, type the number of maximum login attempts 
allowed before a user is locked out. The default is five attempts. The maximum is 99 attempts.

4 In the Lockout Period (minutes) field, type a number of minutes to lockout a user that has exceeded the 
number of maximum login attempts. The default is five minutes. The maximum is 9999 minutes.

5 Click Accept to save your changes.

Configuring HTTP DOS Settings
HTTP DPS setting is used to configure the maximum concurrent TCP connections per IP address. Complete the 
following steps to change the maximum number of connections at any one time:

1 Navigate to System > Administration.

2 In the Max Concurrent TCP connections Per IP field, type the maximum number of concurrent TCP 
connections a client can open with the Secure Mobile Access web server. The default is 20 and the 
maximum is 100 connections.
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Configuring Web Management Settings
The Web Management Settings section allows the administrator to set the default page size for paged tables 
and the streaming update interval for dynamically updated tables in the Secure Mobile Access management 
interface.

To set the table page size and streaming update interval:

1 In the Default Table Size field, enter the number of rows per page for paged tables in the Secure Mobile 
Access management interface. The default is 100, the minimum is 10, and the maximum is 99,999.

2 In the Streaming Update Interval field, enter the number of seconds between updates for dynamically 
updated tables in the Secure Mobile Access management interface. The default is 10, the minimum is 1, 
and the maximum is 99,999.

3 Click Accept to save your changes.

Configuring SNMP Settings

To configure the SNMP Settings fields:

1 Navigate to System > Administration.

2 Select Enable SNMP.

3 Type the name (FQDN) of the system into the System Name field.

4 Type the email address of the system contact into the System Contact field.

5 Type the city or other identifying location of the system into the System Location field.

6 Type the asset number of the system into the Asset field. The asset number is defined by the 
administrator.

7 Type the public community name into the Get Community Name field. This name is used in SNMP GET 
requests.

8 Click Accept to save your changes.

Enabling GMS Management
The SonicWall Inc. Global Management System (GMS) is a web-based application that can configure and 
manage thousands of SonicWall Inc. Internet Security appliances, including global administration of multiple 
site-to-site VPNs from a central location.
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To enable GMS management of your SMA appliance, complete the following steps:

1 Navigate to System > Administration.

2 Select Enable GMS Management.

3 Type the host name or IP address of your GMS server in the GMS Host Name or IP Address field.

4 Type the port number of your GMS server in the GMS Syslog Server Port field. The default for 
communication with a GMS server is port 514.

5 Type the desired interval for sending heartbeats to the GMS server in the Heartbeat Interval (seconds) 
field. The maximum heartbeat interval is 86400 seconds (24 hours).

6 Click Accept to save your changes.

External FTP/TFTP Server
The External FTP/TFTP Server section allows you to configure an external FTP server to backup your settings and 
diagnostic data. 

To configure the External FTP/TFTP Server field:

1 Navigate to System > Administration | External FTP/TFTP Server.

2 Type the FTP/TFTP server address, port, user name, and password into the corresponding fields.

3 Click Accept to save your changes.

Enabling Cloud Management
The Capture Security Center acts as a single access point for the cloud services and
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the products you can license from SonicWall. Once you select the SMA tile, you can access analytics, activities, 
and the real-time threat reports on the registered SMA Devices. 

To enable CSC:

1 Enable CSC management on MSW for the specific tenant and appliance/license.

2 Login into the appliance and enable CSC reporting.

3 Verify and appliance state changed from registered to online. 

For more information, refer to Cloud SMA GSG. 

System > Certificates
This section provides an overview of the System > Certificates page and a description of the configuration tasks 
available on this page.

Topics:

• System > Certificates Overview

• Certificate Management

• Generating a Certificate Signing Request

• Generating a Certificate Using Let's Encrypt

• Importing a Certificate

• Adding Additional CA Certificates

System > Certificates Overview
The System > Certificates page allows the administrator to import server certificates and additional CA 
(Certificate Authority) certificates. 

Topics: 

• Server Certificates

• Additional CA Certificates

• SAML Certificates

Server Certificates
The Server Certificates section allows the administrator to import and configure a server certificate, and to 
generate a CSR (certificate signing request). 

A server certificate is used to verify the identity of the SMA appliance. The appliance presents its server 
certificate to the user’s browser when the user accesses the login page. Each server certificate contains the 
name of the server to which it belongs.

There is always one self-signed certificate (self-signed means that it is generated by the SMA appliance, not by a 
real CA), and there could be multiple certificates imported by the administrator. If the administrator has 
configured multiple portals, it is possible to associate a different certificate with each portal. 
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A CSR is a certificate signing request. When preparing to get a certificate from a CA, you first generate a CSR with 
the details of the certificate. Then the CSR is sent to the CA with any required fees, and the CA sends back a valid 
signed certificate. 

Additional CA Certificates
The Additional CA Certificates section allows the administrator to import additional certificates from a 
Certificate Authority server, either inside or outside of the local network. The certificates are in PEM encoded 
format for use with chained certificates, for example, when the issuing CA uses an intermediate (chained) 
signing certificate.

The imported additional certificates only take effect after restarting the SMA appliance.

SAML Certificates
The Security Assertion Markup Language (SAML) is a secured method for exchanging authentication and 
authorization data between an identity provider and a service provider. When a user logs in to an SAML enabled 
application, the service provider requests authorization from the identity provider. The identity provider 
authenticates the credentials of the user and returns the authorization for the user to the service provider. The 
user is able to use the application after this. 

You can download the SAML certificates from the Identity Provider (Azure, OneLogin, and so on) and upload to 
this field.

Certificate Management
The SMA appliance comes with a pre-installed self-signed X509 certificate for SSL functions. A self-signed 
certificate provides all the same functions as a certificate obtained through a well-known certificate authority 
(CA), but presents an “untrusted root CA certificate” security warning to users until the self-signed certificate is 
imported into their trusted root store. This import procedure can be completed by the user by clicking Import 
Certificate within the portal after authenticating.
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Generating a Certificate Signing Request
In order to get a valid certificate from a widely accepted CA such as RapidSSL, Verisign, or Thawte, you must 
generate a Certificate Signing Request (CSR) for your SMA appliance. 

To generate a certificate signing request:

1 Navigate to the System > Certificates page. 

2 Click Generate CSR to generate a CSR and Certificate Key. The Generate Certificate Signing Request 
dialog box is displayed.

3 Fill in the fields in the dialog box and click Accept.

4 If all information is entered correctly, a csr.zip file is created. Save this .zip file to disk. You need to 
provide the contents of the server.csr file, found within this zip file, to the CA.

Generating a Certificate Using Let's Encrypt 
Let's Encrypt is a non-profit certificate authority run by Internet Security Research Group that provides X.509 
certificates for Transport Layer Security encryption at no charge.

This feature enables you to generate a valid public certificate trusted by most browsers for different portals. 
Let’s Encrypt certificate is generated quickly, and you can use it in any portal.

To generate a Let’s Encrypt certificate:

1 Log in to the management interface of SMA appliance.

2 Navigate to System > Certificates and click GENERATE LET’S ENCRYPT CERT.

3 In the GENERATE LET’S ENCRYPT CERT dialog, select the appropriate portal from the Portal Name 
drop-down menu.

4 Click GENERATE.

The certificate is generated.
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To renew or revoke the Let’s Encrypt certificate, hover over the certificate and click the Edit icon. Select 
RENEW or REVOKE, enter the Private Key Password, and then click SUBMIT.

Viewing and Editing Certificate Information
The Current Certificates table in System > Certificates lists the currently loaded SSL certificates. 

To view certificate and issuer information and edit the Common Name in the certificate:

1 Click the configure icon for the certificate. The Edit Certificate window displays, showing issuer and 
certificate subject information.
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2 From the Edit Certificate window, you can view the issuer and certificate subject information. 

3 On self-signed certificates, type in the Web server host name or IP address in the Common Name field.

4 Click Submit to submit the changes.

You can also delete an expired or incorrect certificate. Delete the certificate by clicking Delete in the row for the 
certificate, on the System > Certificates page.
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Importing a Certificate
When importing a certificate you must upload either a PKCS #12 (.p12 or.pfx) file containing the private key and 
certificate, or a zip file containing the PEM-formatted private key file named “server.key” and the 
PEM-formatted certificate file named server.crt. The .zip file must have a flat file structure (no directories) and 
contain only server.key and server.crt files. 

You can import a CRL certificate under CA certificates that checks whether the user certificate is revoked from 
the server or not. So if you perform certificate authentication with a revoked certificate, a warning is displayed 
that the certificate has been revoked. 

To import a certificate:

1 Navigate to the System > Certificates page. 

2 Click Import Certificate. The Import Certificate dialog box is displayed.

3 Click Browse.

4 Locate the server certificate. If uploading from a PKCS #12 file, select the .p12 or .pfx file from your disk 
or network drive. If uploading a zipped file containing the private key and certificate select the .zip file 
from your disk or network drive. Any filename is accepted, but it must have the “.zip” extension. The 
zipped file should contain a certificate file named server.crt and a certificate key file named server.key. 
The key and certificate must be at the root of the zip, or the file is not uploaded.

5 Click Upload.

After the certificate has been uploaded, the certificate is displayed in the Certificates list in the System > 
Certificates page. 

Adding Additional CA Certificates
You can import additional CA certificates for use with chained certificates, for example, when the issuing CA uses 
an intermediate (chained) signing certificate. To import a CA certificate file, upload a PEM-encoded, 
DER-encoded, or PKCS #7 (.p7b) file.

To add additional certificates in PEM format:

1 Navigate to the System > Certificates page.
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2 Click Import CA Certificate in the Additional CA Certificates section. The Import Certificate dialog box is 
displayed.

3 Click Browse.

4 Locate the PEM-encoded, DER-encoded, or PKCS #7 CA certificate file on your disk or network drive and 
select it. Any filename is accepted. 

5 Click Upload.

After the certificate has been uploaded, the CA certificate is displayed in the Additional CA Certificates 
list in the System > Certificates page.

6 To add the new CA certificate to the Web server’s active CA certificate list, the Web server must be 
restarted. Restart the SMA appliance to restart the Web server.
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System > Monitoring
The SMA appliance provides configurable monitoring tools that enable you to view usage and capacity data for 
your appliance. The System > Monitoring page provides the administrator with four monitoring graphs:

• Active Concurrent Users

• Bandwidth Usage

• CPU Utilization (%)

• Memory Utilization (%)

The administrator can configure the following monitoring periods: last 30 seconds, last 30 minutes, last 24 
hours, last 30 days. For example, Last 24 Hours refers to the most recent 24 hour period.

Topics: 

• Monitoring Graphs

• Setting The Monitoring Period

• Refreshing the Monitors

Monitoring Graphs
The four monitoring graphs can be configured to display their respective data over a period of time ranging from 
the last hour to the last month.

Monitoring Graph Types

Graph Description

Active Concurrent Users The number of users who are logged into the appliance at the same time, 
measured over time by seconds, minutes, hours, or days. This figure is 
expressed as an integer, for example, 2, 3, or 5.

Bandwidth Usage (Kbps) Indicates the amount of data per second being transmitted and received by 
the appliance in Kbps measured over time by seconds, minutes, hours, or 
days.
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Setting The Monitoring Period
To set the monitoring period, select one of the following options from the Monitor Period 
drop-down list in the System > Monitoring page:

• Last 30 Seconds

• Last 30 Minutes

• Last 24 Hours

• Last 30 Days

Refreshing the Monitors
To refresh the monitors, click Refresh at the top right corner of the System > Monitoring page. 

System > Diagnostics
This section provides an overview of the System > Diagnostics page and a description of the configuration tasks 
available on this page.

Options to automatically send the TSR to an external FTP server after a restart and upon generation are 
included. Configure the FTP server in the System > Administration page to automatically send the TSR to an 
external FTP server. 

CPU Utilization (%) The amount of capacity usage on the appliance processor being used, 
measured over time by seconds, minutes, hours, or days. This figure is 
expressed as a percentage of the total capacity on the CPU.

Memory Utilization (%) The amount of memory available used by the appliance, measured over time 
by seconds, minutes, hours, or days. This monitoring graph displays memory 
utilization as a percentage of the total memory available.

Monitoring Graph Types (Continued)

Graph Description
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Topics: 

• Downloading & Generating the Tech Support Report

• Performing Diagnostic Tests

Downloading & Generating the Tech Support 
Report
Downloading a Tech Support Report records system information and settings that are useful to SonicWall Inc. 
Technical Support when analyzing system behavior. The following options are available for Tech Support 
Reports:

• Download Current Report—Clicking this button prompts a Windows pop-up to display confirming the 
download. Click Save to save the report. The Tech Support Report is saved as a .zip file, containing 
graphs, event logs and other technical information about your SMA appliance.

• Email Current Report— Click to email the TSR report to the Email address specified in the Email 
Reports to field. 

• Generate TSR on Restart—Enable this option by selecting the check box. When enabled, the SMA 
appliance generates a new TSR upon every restart of the appliance. The latest report generated from an 
appliance restart is available in the drop-down list, prefaced with “Restarted_TSR_.”

• Download—This button allows you to download the latest Restarted Tech Support Report to your 
local system.

• Delete—This button allows you to delete the latest Restarted Tech Support Report. 

• Email—Click this button to email the latest Restarted Tech Support Report to the values specified 
in the Mail Server field on the Log > Settings page. 
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• Automatically email new reports upon generation—Select this check box to enable automatic 
emailing of the latest Restarted Tech Support Report. You must specify the Mail Server and Mail 
From Address fields on the Log > Settings page for automated email delivery.

• Enable scheduled TSR generation—Click the check box to enable scheduled Tech Support Reports. 
After enabled, you can either have them generated Hourly or Daily. Note that a maximum of 12 TSRs are 
stored, with a total file size not exceeding 50 MB. Scheduled Tech Support Reports are mostly used for 
diagnostics or troubleshooting purposes by a SonicWall Inc. technician, if needed. 

• Download—This button allows you to download the latest scheduled Tech Support Reports to 
your local system.

• Delete—This button allows you to delete the latest scheduled Tech Support Reports. 

• Email—Click this button to email the latest scheduled Tech Support Reports to the values 
specified in the Mail Server field on the Log > Settings page.

•  Automatically email new reports upon generation—Select this check box to enable automatic 
emailing of the latest scheduled Tech Support Reports. You must specify the Mail Server and 
Mail From Address fields on the Log > Settings page for automated email delivery.

Performing Diagnostic Tests
Diagnostic tools allows the administrator to test SMA connectivity by performing a ping, TCP connection test, 
DNS lookup, or Traceroute for a specific IP address or Web site. You can also do a bandwidth test between the 
SMA appliance and your local computer, or do an SNMP query to display information about the appliance. 

You can do standard network diagnostic tests on the SMA appliance in the System > Diagnostics page. 

To run a diagnostic test:

1 Navigate to the System > Diagnostics page.

2 In the Diagnostic Tool drop-down list, select Bandwidth Test, TCP Connection Test, DNS Lookup, Ping, 
Ping6, Traceroute, Traceroute6, SNMP Query, or Botnet Test.
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3 If prompted for additional information like a Host or IP Address, type the requested information. 

4 Click Enter.The results display at the bottom of the page.

System > Restart
This section provides an overview of the System > Restart page and a description of the configuration tasks 
available on this page.

Topics: 

• System > Restart Overview

• Restarting the SMA Appliance

System > Restart Overview
The System > Restart page allows the administrator to restart the SMA appliance. 

A warning is displayed that restarting takes one or two minutes and causes all current users to be disconnected.

Diagnostic tools and their functions

Diagnostic Tool Function

Bandwidth Test Measures the upload and download speed of the network connection 
between your computer and the SMA appliance.

TCP Connection Test Tests the connectivity of a port that is specified by appending a colon and 
port number to the host name or IP address (for example, 10.9.9.19:83 
or www.myhost.com:83. If no port is specified, port 80 is tested.

DNS Lookup Translates a DNS name to an IP address and vice versa.

Ping Tests the connection to a host or IP address.

Ping6 Tests the connection to an IPv6 address or domain. Ping6 is meant for 
use with IPv6 addresses and networks.

Traceroute Identifies the route and number of hops needed to connect to a host or 
IP address.

Traceroute6 Identifies the route and number of hops needed to connect to an IPv6 
address or domain. Traceroute 6 is meant for use with IPv6 addresses 
and networks.

SNMP Query Looks up SNMP information from the selected MIB. SNMP must be 
enabled (System > Administration page) before a query can be 
completed. In the SNMP MIB drop-down list, select the MIB for which to 
display the values. The SNWL-SSLVPN-MIB is the Secure Mobile Access 
specific MIB that shows device statistics and licensing information. The 
SNWL-COMMON-MIB is a file common to all SonicWall Inc. products and 
shows product name, serial, firmware, ROM version, and asset number 
(user defined). The rest of the MIBs are standard SNMP MIBs including 
SNMPv2-MIB and All SNMP MIB-2, or you can select ALL MIBs.

Botnet Test Identifies whether an IP address is a Botnet IP address.
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Restarting the SMA Appliance
To restart the SMA appliance, complete the following steps: 

1 Navigate to System > Restart. 

2 Click Restart.

3 In the confirmation dialog box, click OK.

System > About
The System > About page provides the End-User License Agreement for using the SMA appliance. Click 
Download for SonicWall Inc. copyright Information. 
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Network Configuration

This section provides information and configuration tasks specific to the Network pages on the SonicWall 
Secure Mobile Access web-based management interface. Network tasks for the SMA appliance include 
configuring network interfaces, DNS settings, routes, and host resolution.

Topics: 

• Network > Interfaces

• Network > DNS

• Network > Routes

• Network > Host Resolution

• Network > Network Objects

Network > Interfaces
This section provides an overview of the Network > Interfaces page and a description of the configuration tasks 
available on this page.

• Network > Interfaces Overview

• Configuring Network Interfaces

Network > Interfaces Overview
The Network > Interfaces page allows the administrator to configure the IP address, subnet mask and view the 
connection speed of physical network interface ports on the SMA appliance.
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Network > Interfaces Page

Configuring Network Interfaces
To configure these settings for an interface on the SMA appliance:

1 Navigate to the Network > Interfaces page and click the edit icon next to the interface you want to 
configure. 

2 In the Edit Interfaces dialog box on the SMA appliance, type an unused static IP address in the IP 
Address field. This IP address should reside within the local subnet to which your SMA appliance is 
connected.

3 Type Subnet Mask in the corresponding field.
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4 In the IPv6 address/prefix field, optionally enter an IPv6 address for global scope. If you leave this field 
empty, IPv6-enabled devices can still automatically connect using a link-local address. The scope is 
indicated in a tooltip on the Network > Interfaces page.

5 In the Speed drop-down list, Auto Negotiate is selected by default to allow the SMA appliance to 
automatically negotiate the speed and duplex mode with the connected switch or other networking 
device. Ethernet connections are typically auto-negotiated. If you want to force a certain link speed and 
duplex mode, select one of the following options:

• 1000 Mbps - Full Duplex

• 100 Mbps - Full Duplex

• 100 Mbps - Half Duplex 

• 10 Mbps - Full Duplex

• 10 Mbps - Half Duplex

6 For the Management options, if you want to enable remote management of the SMA appliance from 
this interface, select the supported management protocol(s): HTTP, HTTPS, Ping,SNMP.

7 Click OK.

Network > DNS
This section provides an overview of the Network > DNS page and a description of the configuration tasks 
available on this page.

• Network > DNS Overview

• Configuring Hostname Settings

• Configuring DNS Settings

• Configuring WINS Settings

Network > DNS Overview
The Network > DNS page allows the administrator to set the SMA appliance hostname, DNS settings and WINS 
settings. The hostname section allows the administrator to specify the SMA gateway hostname.
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Topics: 

• DNS Settings

• WINS Settings

DNS Settings
The DNS settings section allows the administrator to specify a Primary DNS Server, Secondary DNS Server 
(optional). The Primary DNS Server is required.

For SMA appliances supporting connections from Apple iPhones, iPads, or other iOS devices using SonicWall Inc. 
Mobile Connect, the DNS Domain is a required field. This DNS domain is set on the VPN interface of the 
iPhone/iPad after the device makes a connection to the appliance. When the mobile device user accesses a URL, 
iOS determines if the domain matches the VPN interface’s domain, and if so, uses the VPN interface’s DNS 
server to resolve the hostname lookup. Otherwise, the Wi-Fi or 3G/4G DNS server is used that cannot resolve 
hosts within the company intranet.

WINS Settings
The WINS (Windows Internet Name Server) settings section allows the administrator to specify the primary 
WINS server and secondary WINS server (both optional). 

Configuring Hostname Settings
To configure a hostname:

1 Navigate to the Network > DNS page.

2 In the Hostname region, type a hostname for the SMA appliance in the SMA Gateway Hostname field.

3 Click Accept.
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Configuring DNS Settings
The Domain Name Server (DNS) is required to allow your SMA appliance to resolve host names and URL names 
with a corresponding IP address. This enables your SMA appliance to connect to hosts or sites using a Fully 
Qualified Domain Name (FQDN). 

To configure a DNS server:

1 Navigate to the Network > DNS page.

2 In the DNS Settings region, type the address of the primary DNS server in the Primary DNS Server field.

3 An optional secondary address can be provided in the Secondary DNS Server (optional) field.

4 Optionally, use the DNS Search List field to create a pool of domain names:

a Type the domain suffix in the Domain Search List and click Add. The suffix is appended with the 
host name to make a Fully Qualified Domain Name (FQDN) that is used in host resolution.

b To remove a DNS suffix, select the domain suffix from the list and click Remove.

c Use the up and down arrow keys to arrange the DNS domain suffixes in the order that is used to 
resolve host names.

For example, your host name is SonicPRS and the usa.n.sonicwall.com and rsc.sonicwall.com DNS 
suffixes are added to the search list. The first suffix is appended to SonicPRS to make the FQDN 
(SonicPRS.usa.n.sonicwall.com) that is used in name resolution. If the name is not resolved, the next 
suffix in the search list is used (SonicPRS.rsc.sonicwall.com).This process continues until the name is 
resolved or all suffixes have been tried.

5 Click Accept.

6 Restart the appliance to ensure new DNS settings take effect.

Configuring WINS Settings
WINS settings are optional. The SMA appliance can act as both a NetBIOS and WINS (Windows Internet Naming 
Service) client to learn local network host names and corresponding IP addresses.

To configure WINS settings:

1 Navigate to the Network > DNS page.

2 In the WINS Settings region, type a primary WINS address in the Primary WINS Server (optional) field.

3 In the WINS settings region, type a secondary WINS address in the Secondary WINS Server (optional) 
field.

4 Click Accept.

Network > Routes
This section provides an overview of the Network > Routes page and a description of the configuration tasks 
available on this page.

Topics: 

• Network > Routes Overview
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• Configuring a Default Route for the SMA Appliance

• Configuring Static Routes for the Appliance

Network > Routes Overview
The Network > Routes page allows the administrator to assign a default gateway and interface, and to add and 
configure static routes. For more information on default or static routes, refer to the Getting Started Guide for 
your appliance model.

Topics: 

• Default Route

• Static Routes

Default Route
The default route section allows the administrator to define the default network route by setting the default 
IPv4 gateway and interface, and/or default IPv6 gateway and interface. A default network route is required for 
Internet access. 

Static Routes
The static routes section allows the administrator to add and configure additional static routes by specifying a 
destination network, subnet mask, optional default gateway, and interface. 
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Configuring a Default Route for the SMA 
Appliance
You must configure a default gateway on your SMA appliance for it to be able to communicate with remote 
networks. A remote network is any IP subnet different from its own. In most cases, the default gateway is the 
LAN IP address of the firewall interface to which the SMA appliance is connected. This is the default route for 
the appliance.

To configure the default route: 

1 Navigate to the Network > Routes page.

2 In the Default IPv4 Gateway field, type the IP address of the firewall or other gateway device through 
which the SMA appliance connects to the network. This address acts as the default route for the 
appliance.

3 In the Interface drop-down list, select the interface that serves as the IPv4 connecting interface to the 
network. In most cases, the interface is X0.

4 In the Default IPv6 Gateway field, type the IPv6 address of the firewall or other gateway device through 
which the SMA appliance connects to the network. This address acts as the default IPv6 route for the 
appliance.

5 In the Interface drop-down list, select the interface that serves as the IPv6 connecting interface to the 
network.

6 Click Accept.

Configuring Static Routes for the Appliance
Based on your network’s topology, you might find it necessary or preferable to configure static routes to certain 
subnets rather than attempting to reach them through the default gateway. While the default route is the 
default gateway for the device, static routes can be added as needed to make other networks reachable for the 
SMA appliance. For more details on routing or static routes, refer to a standard Linux reference guide. 

To configure a static route to an explicit destination for the appliance, complete the following steps:

1 Navigate to the Network > Routes page and click Add Static Route...

2 In the Add Static Route dialog box, type the subnet or host to which the static route is directed into the 
Destination Network field (for example, 192.168.220.0 provides a route to the 192.168.220.X/24 
subnet). You can enter an IPv6 subnet (for example, 2017:1:2::).
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3 In the Subnet Mask/Prefix field, enter the number of bits used for the prefix.

4 In the Default Gateway field, type the IP address of the gateway device that connects the appliance to 
the network.You can enter an IPv6 address.

5 In the Interface drop-down list, select the interface that connects the appliance to the desired 
destination network.

6 Click Submit.

Network > Host Resolution
This section provides an overview of the Network > Host Resolution page and a description of the 
configuration tasks available.

• Network > Host Resolution Overview

• Configuring Host Resolution

Network > Host Resolution Overview
The Network > Host Resolution page allows the administrator to configure host names. 
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Network > Host Resolution Page

Host Name Settings
The host name settings section allows the administrator to add and configure a host name by specifying an IP 
address, host name (host or FQDN) and an optional alias.

Configuring Host Resolution
The Host Resolution page enables network administrators to configure or map host names or fully qualified 
domain names (FQDNs) to IP addresses. 

The SMA appliance can act as both a NetBIOS and WINS (Windows Internet Name Service) client to learn local 
network host names and corresponding IP addresses.

To resolve a host name to an IP address:

1 Navigate to the Network > Host Resolution page. The Network > Host Resolution page is displayed.

2 Click Add Host Name. 

3 In the Add Host Name window, in the IP Address field, type the IP address that maps to the hostname.

4 In the Host Name field, type the hostname that you want to map to the specified IP address.

5 Optionally, in the Alias field, type a string that is the alias for the hostname.

6 Click Submit. The Host Resolution page now displays the new host name.

7 Optionally select Configure auto-added hosts on the Network > Host Resolution page. If this option is 
selected, you can edit or delete automatically added Host entries (such as for IPv6). This option is not 
recommended, as host mis-configuration could lead to undesirable results.
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Network > Network Objects
This section provides an overview of the Network > Network Objects page and a description of the 
configuration tasks available on this page.

• Network > Network Objects Overview

• Adding Network Objects

• Editing Network Objects

Network > Network Objects Overview
The Network > Network Objects page allows the administrator to add and configure network resources, called 
objects. For convenience, you can create an entity that contains both a service and an IP address mapped to it. 
This entity is called a network object. This creates an easy way to specify a service to an explicit destination (the 
network object) when you are applying a policy, instead of having to specify both the service and the IP address. 

You can create IPv6 network objects using IPv6 object types and addresses.

Network > Network Objects Page

Network objects are set up by specifying a name and selecting one of the following services:

• Web (HTTP)

• Secure Web (HTTPS)

• NetExtender & Mobile Connect

• Terminal Services (RDP)

• Virtual Network Computing (VNC)

• File Transfer Protocol (FTP)

• Telnet, Secure Shell Version 2 (SSHv2)

• File Shares (CIFS)

• Citrix Portal (Web Access)

Port or port range settings are available for all services, allowing the administrator to configure a port range 
(such as 80-443) or a port number (80) for a Network Object. You can use this feature to create port-based 
policies. For example, you can create a Deny All policy and allow only HTTP traffic to reach port 80 of a Web 
server.
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Adding Network Objects
To add a network object:

1 Navigate to the Network > Network Objects page.

2 Click Add Network Object... The Add Network Object screen is displayed.

3 Type a string in the Name field that is the name of the network object you are creating.

4 Click on the Service list and select a service type: Web (HTTP), Secure Web (HTTPS), NetExtender, 
Terminal Services (RDP), Virtual Network Computing (HTML5), File Transfer Protocol, Telnet, Telnet 
(HTML5), Secure Shell Version 2 (SSHv2), File Shares (CIFS), or Citrix Portal.

5 Click Accept. The Edit Network Object screen is displayed, showing the network object name and the 
service associated with it. 

Editing Network Objects
To edit a network object, complete the following steps:

1 To edit an existing network object, navigate to the Network > Network Objects page and click the 
Configure icon or click the Incomplete link for the object you wish to edit. The Edit Network Object 
screen is displayed.

If you just created a network object, the Edit Network Object screen is displayed as soon as you clicked 
Accept.

The Edit Network Object shows the network object name and the service associated with it. It also 
contains an address list that displays existing addresses mapped to the network object.

2 To change the service, select the desired service from the Service drop-down list and then click Update 
Service. The Service column in the Network Objects table displays the new service, and the Edit 
Network Object dialog box remains open. You can click Done if finished.
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3 To add or edit Object Type and IP Address values for this Network Object, click Add. The Define Object 
Address page is displayed.

4 Select the desired Protocol. The available value options in the Protocol field include: TCP, UDP, ICMP, and 
ALL. You can select multiple items among TCP, UDP and ICMP. However, when ALL is selected, all others 
options are deselected.

5 Click Accept to add the Object Address to the Network Objects.

6 When finished adding addresses, click Done in the Edit Network Object screen.

7 The Network > Network Objects page is displayed with the new network object in the Network 
Objects list.

8 If the object is not fully defined with at least one IP address or network range, the status Incomplete 
displays. Click the Incomplete link or the Configure icon to edit the network object again, and then click 
Add to add Type and Address values for this network object. The Define Object Address page is 
displayed.

Defining an Object Address
1 In the Define Object Address page, click on the Object Type drop-down list and select an object type. 

The four object types are:

• IP Address - A single IP address.

• IP Network - A range of IP addresses, defined by a starting address and a subnet mask.

• IPV6 Address - A single IPv6 address.

• IPV6 Network - A range of IPv6 addresses.

2 Type in the appropriate information pertaining to the object type you have selected.

• For the IP Address object type, type an IP address in the IP Address field.
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• For the IP Network object type, in the Network Address field, type an IP Address that resides in 
the desired network subnet and type a subnet mask in the Subnet Mask field.In the Port 
Range/Port Number field, optionally enter a port range in the format 80-443, or enter a single 
port number.

• For the IPV6 Address object type, type an IP address in the IPv6 Address field.

• For the IPV6 Network object type, in the IPv6 Network Address field, type an IPv6 address that 
resides in the desired network subnet and type the number of bits to use as a prefix in the Prefix 
field.

3 When finished adding addresses, click Add in the Define Network Object dialog box.
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Portals Configuration

This section provides information and configuration tasks specific to the Portals pages on the SonicWall Secure 
Mobile Access web-based management interface, including configuring portals, assigning portals, and defining 
authentication domains, such as RADIUS, LDAP, and Active Directory.

Topics: 

• Portals > Portals

• Portals > Application Offloading

• Using Offloaded Applications

• Portals > Domains

• Portals > Load Balancing

• Portals > URL Based Aliasing

Portals > Portals
The Portals > Portals page allows the administrator to configure a custom portal for the Secure Mobile Access 
portal login page as well as the portal home page. 

Topics: 

• About Portal Home Page

• Adding Portals

• Configuring General Portal Settings

• Configuring Login Schedules

• Configuring the Home Page

• Configuring Virtual Host Settings

• Adding a Custom Portal Logo
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About Portal Home Page
The Portal Settings section allows the administrator to configure a custom portal by providing the portal name, 
portal site title, portal banner title, login message, virtual host/domain name and portal URL. This section also 
allows the administrator to configure custom login options for control over what is displayed/loaded on login 
and logout, HTTP meta tags for cache control, ActiveX Web cache cleaner, login uniqueness, and client source 
uniqueness.

For most Secure Mobile Access administrators, a plain text home page message and a list of links to network 
resources is sufficient. For administrators who want to display additional content on the user portal, review the 
following information:

• With the Tips/Help sidebar enabled, the width of the workspace is 561 pixels.

• With the Tips/Help sidebar disabled, the width of the workspace is 712 pixels.

• No IFRAME is used.

• You can upload a custom HTML file which is displayed following all other content on the home page. You 
can also add HTML tags and JavaScript to the Home Page Message field. 

• Because the uploaded HTML file is displayed after other content, do not include <head> or <body> tags 
in the file. 

Adding Portals
The administrator can customize a portal that appears as a customized landing page to users when they are 
redirected to the SMA appliance for authentication.

The network administrator might define individual layouts for the portal. The layout configuration includes 
menu layout, portal pages to display, portal application icons to display, and Web cache control options.

The default portal is the Virtual Office portal. Additional portals can be added and modified. 
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To add a portal:

1 Navigate to the Portals > Portals window and click Add Portal. The Portal Settings window is 
displayed. 

General Section Fields

Field Description

Portal Name The title used to refer to this portal. It is for internal reference only, and is not 
displayed to users.

Portal Site Title The title that appears on the Web browser title bar of users access this portal.

Portal Banner Title The welcome text that appears on top of the portal screen.

Login Message Optional text that appears on the portal login page above the authentication 
area.

Display custom login page Displays the customized login page rather than the default login page for this 
portal.

Display login message on 
custom login page

Displays the text specified in the Login Message text box.

Hide Domain list on portal 
login page

If enabled, this option replaces the Domain list box on the login page to a text 
box. The user can then type in the correct domain name. This option is only 
enabled for portal login through Web.

Enable HTTP meta tags for 
cache control

Enables HTTP meta tags in all HTTP/HTTPS pages served to remote users to 
prevent their browser from caching content.
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Configuring General Portal Settings
There are two main options for configuring a portal:

• Modify an existing layout.

• Configure a new portal.

Topics: 

• Enforcing Login Uniqueness

• Enforcing Client Source Uniqueness

To configure the settings in the General section for a new portal:

1 Navigate to the Portals > Portals page.

2 Click Add Portal or Configure next to the portal you want to configure. The Add Portal or Edit Portal 
screen displays.

3 In the General section, enter a descriptive name for the portal in the Portal Name field. This name is 
part of the path of the Secure Mobile Access portal URL. For example, if your Secure Mobile Access 
portal is hosted at https://vpn.company.com, and you created a portal named “sales,” then users are 
able to access the sub-site at https://vpn.company.com/portal/sales.

4 Enter the title for the Web browser window in the Portal Site Title field.

5 To display a banner message to users before they log in to the portal, enter the banner title text in the 
Portal Banner Title field.

6 Enter an HTML compliant message, or edit the default message in the Login Message field. This message 
is shown to users on the custom login page.

7 The Portal URL field is automatically populated based on your SMA appliance network address and 
Portal Name.

8 To enable visibility of your custom logo, message, and title information on the login page, select Display 
custom login page.

9 Select Enable HTTP meta tags for cache control to apply HTTP meta tag cache control directives to the 
portal. Cache control directives include:

<meta http-equiv="pragma" content="no-cache"> 
<meta http-equiv="cache-control" content="no-cache">
<meta http-equiv="cache-control" content="must-revalidate">

These directives help prevent clients browsers from caching SMA portal pages and other Web content. 

Enforce login uniqueness If enforced, login uniqueness restricts each account to one session at a time. 
Select to Automatically logout existing session or Confirm logout of existing 
session as the preferred Enforcement Method. 
If not enforced, each account can have multiple simultaneous sessions.

Enforce client source 
uniqueness

If enforced, client source uniqueness prevents multiple connections from a 
user with the same client source address when connecting with a SonicWall 
Inc. client (NetExtender, Mobile Connect, Virtual Assist, and so on). This 
prevents a user from consuming multiple licenses when a user reconnects 
after an unexpected network interruption.

General Section Fields (Continued)

Field Description
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10 Select Enable ActiveX Web cache cleaner to load an ActiveX cache control when users log in to the 
SMA appliance. The Web cache cleaner prompts the user to delete all session temporary Internet files, 
cookies and browser history when the user logs out or closes the Web browser window. The ActiveX Web 
cache control is ignored by Web browsers that do not support ActiveX.

11 Specify the link(s) for the Small / Medium / Wide / Large Logo to be used with Live Tile. 

12 Specify the Background Color for Live Tile. If no value is specified, the default color is #0085C3.

13 Specify the Site Name to be displayed for Live Tile. If no value is specified, the default is the Portal 
Name. 

Enforcing Login Uniqueness
Login uniqueness, when enforced, restricts each account to a single session at a time. When login uniqueness is 
not enforced, each account can have multiple, simultaneous, sessions. 

To enforce login uniqueness:

1 Navigate to Portals > Portals.

2 For an existing portal, click the configure icon next to the portal you want to configure. Or, for a new 
portal, click Add Portal.

3 Select Enforce login uniqueness.

4 Click Accept.

Enforcing Client Source Uniqueness
Client source uniqueness, when enforced, prevents multiple connections from a user with the same client 
source address when connecting with a SonicWall Inc. client (NetExtender, Mobile Connect, and so on). This 
prevents a user from consuming multiple licenses when a user reconnects after an unexpected network 
interruption. 

For example, a user on an unreliable network is disconnected because of a network issue. If login uniqueness is 
NOT enabled, the user session on the appliance stays active for this type of disconnect until the timeout value is 
reached. The user reconnects and consumes a second license with the potential of consuming more licenses 
before the timeout disconnects them.

To enforce client source uniqueness:

1 Navigate to Portals > Portals.

2 For an existing portal, click the configure icon next to the portal you want to configure. Or, for a new 
portal, click Add Portal.

3 Select Enforce client source uniqueness.

4 Click Accept.

Configuring Login Schedules
The login schedules section allows you to restrict access to a portal based on the time specified. 

To enable login schedules:

1 Navigate to Portals > Portals.
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2 Select the existing portal you want to configure. 

3 Go to the Login Schedule section. The Login Schedule displays.

4 Click Enable Login Schedule. 

5 Set the login schedule by clicking the time slot on the day you wish to permit or deny access. To select 
multiple items, hold the Ctrl key down. You can also click Day to select the whole day. 

6 Click OK to save changes made to the login schedule. 

Configuring the Home Page
The home page is an optional starting page for the Secure Mobile Access appliance portal. The home page 
enables you to create a custom page that mobile users see when they log in to the portal. Because the home 
page can be customized, it provides the ideal way to communicate remote access instructions, support 
information, technical contact information or Secure Mobile Access-related updates to remote users.

The home page is well-suited as a starting page for restricted users. If mobile users or business partners are only 
permitted to access a few files or Web URLs, the home page can be customized to show only those links.

You can edit the title of the page, create a home page message that is displayed at the top of the page, show all 
applicable bookmarks (user, group, and global) for each user, and optionally upload an HTML file.

Topics: 

• Enabling NetExtender to Launch Automatically in the User Portal

• Configuring Virtual Host Settings
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To configure the home page:

1 Navigate to the Portals > Portals page.

2 Click Add Portal or Configure next to the portal you want to configure. The Add Portal or Edit Portal 
screen displays.

3 Go to the Home Page section.

The following table provides a description of the configurable options in the Home Page section.

Home Page Section Fields

Field Description

Display Home Page 
Message

Displays the customized home page message after a user successfully 
authenticates to the SMA appliance.

Allow 
NetExtender/Mobile 
Connect connections to 
this portal

If selected, activates the following two check box options. If not selected, 
NetExtender and Mobile Connect are not available on the portal. 

Display 
NetExtender/Mobile 
Connect Icon

Displays the icon to NetExtender or Mobile Connect, allowing users to 
install and invoke the clientless NetExtender virtual adapter, or the Mobile 
Connect application for mobile devices. 

Display Mobile Connect 
banner on login page for 
iOS devices

Displays the Mobile Connect banner on the login page for devices running 
iOS 6 or higher.

Launch NetExtender after 
login

Launches NetExtender automatically after a user successfully authenticates 
to the SMA appliance. 

Allow File Shares on this 
portal

If selected, activates the following two check box options. If not selected, 
File Shares are not accessible from the portal.

Display File Shares portal 
button

Provide a button to link to the File Shares (Windows CIFS/SMB) Web 
interface according to their domain permissions. 
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4 Click Accept to update the home page content.

Enabling NetExtender to Launch Automatically in the 
User Portal
NetExtender can be configured to start automatically when a user logs into the user portal. You can also 
configure whether or not NetExtender is displayed on a Virtual Office portal. 

To configure NetExtender portal options:

1 Navigate to Portals > Portals

2 Click Add Portal or Configure next to the portal you want to configure. The Add Portal or Edit Portal 
screen displays.

3 Click the Home Page section.

4 To prevent users from accessing NetExtender through this portal, clear Allow NetExtender connections 
to this portal. Because Mobile Connect acts as a NetExtender client when connecting, clearing this 
check box also prevents Mobile Connect users on this portal.

5 To launch NetExtender automatically when users log in to the portal, select Launch NetExtender after 
login.

6 Click Accept.

Configuring Virtual Host Settings
Creating a virtual host allows users to log in using a different hostname than your default URL. For example, 
sales members can access https://sales.company.com instead of the default domain, 
https://vpn.company.com that you use for administration. The Portal URL (for example, 
https://vpn.company.com/portal/sales) still exists even if you define a virtual host name. Virtual host names 
enable administrators to give separate and distinct login URLs to different groups of users. 

To create a Virtual Host Domain Name:

1 Navigate to Portals > Portals.

Default File Shares path Specify the specific file share path when allowing file shares on the portal. If 
nothing is specified, the file share provides a link for the user to find all 
available domains. The file share also lists all available file share bookmarks 
for the user to launch.

Display Bookmark Table If selected, activates the following two check box options. If not selected, 
Bookmarks are not available from the portal.

Home Page Message Optional text that can be displayed on the home page after successful user 
authentication.

Home Page Section Fields (Continued)

Field Description
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2 Click Add Portal or Configure next to the portal you want to configure.

3 Go to the Virtual Host section.

4 Enter a host name in the Virtual Host Domain Name field, for example, sales.company.com. This field 
is optional. 

Only alphanumeric characters, hyphen (-) and underscore (_) are accepted in the Virtual Host Domain 
Name field.

5 Select a specific Virtual Host Interface for this portal if using IP based virtual hosting. 

If your virtual host implementation uses name based virtual hosts — where more than one hostname 
resides behind a single IP address — choose All Interfaces from the Virtual Host interface.

6 If you selected a specific Virtual Host Interface for this portal, enter the desired Virtual Host IP Address 
in the field provided. This is the IP address users use in order to access the Virtual Office portal.

7 If you selected a specific Virtual Host Interface for this portal, you can specify an IPv6 address in the 
Virtual Host IPv6 Address field. You can use this address to access the virtual host. Enter the IPv6 
address using decimal or hexadecimal numbers in the form:
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2001::A987:2:3:4321

8 If you plan to use a unique security certificate for this sub-domain, select the corresponding port 
interface address from the Virtual Host Certificate list.

Unless you have a certificate for each virtual host domain name, or if you have purchased a *.domain SSL 
certificate, your users might see a Certificate host name mismatch warning when they log in to the 
Secure Mobile Access Virtual Office portal. The certificate hostname mismatch affects the login page, 
NetExtender; Other Secure Mobile Access client applications are not affected by a hostname mismatch.

To achieve a single point of access for users, configure External Website Bookmarks for application 
offloading portals by selecting Enable Virtual Host Domain SSO to enable cross domain Single Sign-On 
(SSO). Cross Domain SSO shares the credentials for all portals in the same shared domain. Enabling 
Virtual Host Domain SSO automatically sets the Shared Domain Name one level up from the Virtual Host 
Domain name and displays it in the Shared Domain Name field. For example, the Shared Domain Name 
is example.com if the Virtual Host Domain is webmail.example.com.

9 Under the Advanced SSL/TLS settings section, the Enforce Forward Secrecy field allows you to: Use 
Global Setting, Enable, or Disable the feature. Enable this option to allow current information to be kept 
in secrecy, even if the private key is compromised in the future. Note that browsers that do not support 
Forward Secrecy might not be able to connect to the SMA appliance. The performance of this feature can 
decline depending on the ciphers that the client browser supports. 

10 Verify Backend SSL Server Certificate for Proxy connections — When this option is enabled, the 
connection is dropped if the backend SSL/TLS server certificate is not trusted. The verification depth is 
10. Alert level log messages are also generated when this option is enabled.

11 Enable Force SSL/TLS version for Proxy connections to enable communication between the Virtual Host 
and the Backend Server.

Adding a Custom Portal Logo
The Custom Logo Settings section allows the administrator to upload a custom portal logo and to toggle 
between the default SonicWall Inc. logo and a custom uploaded logo. You can also upload a custom portal 
favicon in this section. You must add the portal before you can upload a custom logo or custom favicon. In the 
Add Portal screen, the Logo section does not have an option to upload a custom logo or custom favicon.

The supported formats for logo include SVG, JPG, PNG, GIF, BMP and JPEG. The logo resolution is recommended 
not to be less than 180 x 30.

The recommended format for favicon is the ICO not larger than 32 x 32.

To add a custom portal logo:

1 Navigate to Portals > Portals and click Configure next to the existing portal to which you want to add a 
custom logo. The Edit Portal screen displays.
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2 Go to the Logo section.

3 Click Please select File to Upload Logo field. The file browser window displays.

4 Select an appropriate-sized .gif format logo in the file browser and click Open.

5 Select Light or Dark from the Background drop-down list. Select a background shade that helps set off 
your logo from the rest of the portal page.

6 Click Update Logo to transfer the logo to the SMA appliance.

7 Click Default Logo to revert to the default SonicWall Inc. logo.

8 Click OK to save changes.

To add a custom favicon:

1 Navigate to Portals > Portals and click Configure next to the existing portal to which you want to add a 
custom favicon. The Edit Portal screen displays.

2 Go to the Logo section. Navigate to the Portal Favicon Settings section.

3 Click Choose File by the Upload Favicon field. The file browser window displays.
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4 Select an appropriate-sized ICO format favicon in the file browser and click Open. 

5 Click Update Favicon to transfer the favicon to the SMA appliance.

6 Click Default Favicon to revert to the default SonicWall Inc. favicon. 

7 If authentication control of the portal is disabled, Reuse Favicon to Offload Server is available. Enabling 
this option allows the favicon of the backend server to display in the client browser.

8 Click OK to save changes.

Portals > Application Offloading
The Portals > Application Offloading page in the Secure Mobile Access management interface provides an 
overview of the Application Offloading functionality available from the Portals > Portals page. No configuration 
is available on this page.

Topics: 

• Configuring with the Offloading Portal Wizard

• General Server Settings

• Load Balancing Server Settings

• URL-based Aliasing Server Settings

• Remote Desktop Web Access Server Settings

• Configuring the Security Settings

• Configuring the Miscellaneous Settings

Application Offloading provides secure access to both internal and publicly hosted Web applications. An 
application offloading host is created as a special-purpose portal with an associated virtual host acting as a 
proxy for the backend Web application.

Unlike HTTP(S) bookmarks, access to offloaded applications is not limited to remote users. The administrator 
can enforce strong authentication and access policies for specific users or groups. For instance, in an 
organization certain guest users might need Two-factor or Client Certificate authentication to access Outlook 
Web Access (OWA), but are not allowed to access OWA public folders. If authentication is enabled, multiple 
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layers of SonicWall advanced authentication features such as One Time Password, Two-factor Authentication, 
Client Certificate Authentication and Single Sign-On can be applied on top of each other for the offloaded host. 

The portal must be configured as a virtual host with a suitable Secure Mobile Access domain. It is possible to 
disable authentication and access policy enforcement for such an offloaded host.

Web transactions can be centrally monitored by viewing the logs. In addition, Web Application Firewall can 
protect these hosts from any unexpected intrusion, such as Cross-site scripting or SQL Injection.

Access to offloaded Web applications happens seamlessly as URLs in the proxied page are not rewritten in the 
manner used by HTTP or HTTPS bookmarks.

An offloaded Web application has the following advantages over configuring the Web application as an HTTP(S) 
bookmark in Secure Mobile Access:

• No URL rewriting is necessary, thereby improving the throughput tremendously.

• The functionality of the original Web application is retained almost completely, while an HTTP(S) 
bookmark is only a best-effort solution.

• Application offloading extends Secure Mobile Access security features to publicly hosted Web sites.

Application offloading can be used in any of the following scenarios: 

• To function as an SSL offloader and add HTTPS support to the offloaded Web application, using the 
integrated SSL accelerator hardware of the SMA appliance. 

• In conjunction with the Web Application Firewall subscription service to provide the offloaded Web 
application continuous protection from malicious Web attacks. 

• To add strong or stacked authentication to the offloaded Web application, including Two-factor 
authentication, One Time Passwords and Client Certificate authentication. 

• To control granular access to the offloaded Web application using global, group or user based access 
policies. 

• To support Web applications not currently supported by HTTP/HTTPS bookmarks. Application Offloading 
does not require URL rewriting, thereby delivering complete application functionality without 
compromising throughput. 
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Configuring with the Offloading Portal Wizard
To configure a portal with Offloading Portal Wizard:

1 Navigate to Portals > Portals and click Offload Web Application. The Offloading Portal Wizard opens.

2 Begin by selecting the Application Offloading Portal type.

The options include:

• General portal - Can be selected for most scenarios.

• Load Balancing portal - This type of portal is used to setup a Load Balancing Offloading portal.

• URL-based Aliasing portal - Use to setup a URL-based Aliasing Offloading portal. Select URL Based 
Aliasing if you want the ability to access several Web sites using one portal and domain name. If 
this option is enabled, the screen options will change.

• Remote Desktop Web Access (RD Web Access) - The Remote Desktop (RD) Web Access page uses 
the SMA Agent to proxy the RDP connection to the private network to make the resource list on 
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the RD Web site function more efficiently. Another advantage in using the RD Web Access option 
is that the it works for all browsers (Chrome, Firefox, and Internet Explorer).

3 Click This is an Exchange Portal which will be accessed by OWA, ActiveSync or Outlook Anywhere if 
using an Exchange portal.

4 Click Next.

General Server Settings
When General is selected on the initial page, the Server page appears as follows. The portal and application 
server settings can be set on this page.

1 In the Portal Name field, enter a unique name to identify different portals.

2 In the Portal Domain Name field, enter the domain name used to access the offloading portal.

3 In the Portal Interface field, enter the network interface to which the portal is bound. If one specific 
network interface is selected, a new IP address is assigned to the portal.

4 In the Portal IP Address field, enter the IP address where the portal is located.

5 The Portal Certificate drop-down lists all certificates that have been imported.

6 The Application Server Address field accepts settings relevant to the application server. This can simply 
be the IP address of the application server. The scheme of the address is “HTTPS” by default. The port 
and default path can also be set in this single field.

All these settings are verified instantly from the Appliance when the mouse leaves the input field (green check). 
If the input fails, the reason it failed is shown. Only when all fields are satisfied, can you click Next to go to the 
next tab.
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Load Balancing Server Settings
When Load Balancing is selected on the initial page, the Server page appears as follows.

1 In the Portal Name field, enter a unique name to identify different portals.

2 In the Portal Domain Name field, enter the domain name used to access the offloading portal.

3 In the Portal Interface field, enter the network interface to which the portal is bound. If one specific 
network interface is selected, a new IP address is assigned to the portal.

4 In the Portal IP Address field, enter the IP address where the portal is located.

5 The Portal Certificate drop-down lists all certificates that have been imported.

6 The Load Balancing Group field replaces the Application Server Address field to show the existing Load 
Balancing Group to which you can assign to this portal. If no Load Balancing Group exists, you can create 
a new one by clicking “click here to create.”

All these settings are verified instantly from the Appliance when the mouse leaves the input field (green check). 
If the input fails, the reason it failed is shown. Only when all fields are satisfied, can you click Next to go to the 
next tab.

URL-based Aliasing Server Settings
Select URL Based Aliasing on the initial page when you want the ability to access several Web sites using one 
portal and domain name. When this option is enabled, the screen options change. You will need to select the 
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URL Based Aliasing Group from the drop down list. When URL Based Aliasing is selected on the initial page, the 
Server step appears as follows:

1 In the Portal Name field, enter a unique name to identify different portals.

2 In the Portal Domain Name field, enter the domain name used to access the offloading portal.

3 In the Portal Interface field, enter the network interface to which the portal is bound. If one specific 
network interface is selected, a new IP address is assigned to the portal.

4 The Portal IP Address field is not required if All Interfaces is selected in the Portal Interface field, but you 
need to enter the Portal IP Address of specific X0, X1, X2, and X3 interfaces.

5 The Portal Certificate drop-down lists all certificates that have been imported.

6 Any existing URL Based Aliasing Group(s) are listed in the drop-down and available to assign to this 
portal. If no URL Based Aliasing Group exists, you can create a new one by clicking the “click here to 
create” hyperlink.

All these settings are verified instantly from the Appliance when the mouse leaves the input field (green check). 
If the input fails, the reason it failed is shown. Only when all fields are satisfied, can you click Next to go to the 
next tab.

Remote Desktop Web Access Server Settings
Select Remote Desktop Web Access (RD Web Access) on the initial page when you want the ability to use the 
SMA Agent to proxy the RDP connection to the private network to make the resource list on the RD Web site 
function more efficiently. When this option is enabled, the screen options change. You will need to select 
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Remote Desktop Web Access (RD Web Access) from the drop down list. When Remote Desktop Web Access 
(RD Web Access) is selected on the initial page, the Server step appears as follows.

1 In the Portal Name field, enter a unique name to identify different portals.

2 In the Portal Domain Name field, enter the domain name used to access the offloading portal.

3 In the Portal Interface field, enter the network interface to which the portal is bound. If one specific 
network interface is selected, a new IP address is assigned to the portal.

4 The Portal IP Address field is not required if All Interfaces is selected in the Portal Interface field, but you 
need to enter the Portal IP Address of specific X0, X1, X2, and X3 interfaces.

5 The Portal Certificate drop-down lists all certificates that have been imported.

6 The Application Server Address field accepts settings relevant to the application server. This can simply 
be the IP address of the application server. The scheme of the address is “HTTPS” by default. The port 
and default path can also be set in this single field.

All these settings are verified instantly from the Appliance when the mouse leaves the input field (green check). 
If the input fails, the reason it failed is shown. Only when all fields are satisfied, can you click Next to go to the 
next tab.
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Configuring the Security Settings
The third step is for the Security settings, including Enable Web Application Firewall and Disable 
Authentication Controls. However, both options require a Web Application Firewall license.

Configuring the Miscellaneous Settings
The fourth and last step includes the general portal settings.

Portal Site Title, Portal Banner Title, and Login Message are set by default, but they can still be customized.

Restart Now - Gracefully restarts the appliance immediately after clicking Finish. 

More advanced options can be fine-tuned by editing this portal after the wizard has finished. Changing the 
Portal settings requires a web server restart that could disconnect any active NetExtender connections and 
certain Bookmarks. If you want to proceed with restarting the web server for the settings to take effect 
immediately, check Restart now. Otherwise, uncheck the check box to save the changes without web server 
restarting. You can restart the appliance later from the System > Restart page.

The wizard ends after clicking Finish. The page is blocked and you are redirected to the portal list page after the 
App Offloading portal is successfully created.

Using Offloaded Applications
An offloaded application has its own portal page on the SMA appliance. The portal can be accessed directly by 
entering the URL in a Web browser. You can also create an External Web site Bookmark on the SMA Virtual 
Office portal that takes you to the offloaded application portal. 

Topics: 

• Configuring Application Offloading with SharePoint 2013

• Microsoft Outlook Anywhere with Autodiscover Overview
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To use an offloaded application:

1 For direct access, point your Web browser to the URL of the offloaded application portal.

2 For access through an External Web site Bookmark, log in to the SonicWall Inc. Virtual Office and then 
click on the bookmark.

A new window is launched in your default browser that connects to the offloaded application portal 
specified in the bookmark.

3 On the portal page, enter your login credentials to access the application if authentication is required.

Configuring Application Offloading with 
SharePoint 2013
When the SharePoint 2013 server is accessed through an offloaded portal, basic functionalities, such as adding, 
editing, or deleting documents, tasks, or calender events are supported. The client integration is supported if 
the offloaded portal’s authentication controls are enabled or disabled. However, when the Authentication 
Controls are enabled, the client is only supported on Internet Explorer under the following caveats:

• The offloaded portal created for SharePoint must use a valid certificate.

• The Scheme used by the offloaded portal and the back end SharePoint must be the same. If the back end 
SharePoint is running on HTTP, the offloaded portal must enable HTTP access and be accessed with HTTP.

• The same Scheme between the offloaded portal and the back end SharePoint means that URL Rewriting 
for the offloaded portal does not need to be enabled.

• The Share session with other local application option must be enabled. This check box is located on the 
Portals > Portals > Offloading tab.

• The Restrict Request Headers option must be disabled. This check box is located on the Services > 
Settings page. 

• If using Windows Vista or Windows 7 with the client, the offloaded portal should be added as a “Trusted 
Site” on the Internet Explorer browser. To configure your trusted sites, navigate to Tools > Internet 
Options. On the Security tab, click the Trusted Sites icon. 

• The Share session with other local applications option must be enabled at login. 

Microsoft Outlook Anywhere with Autodiscover 
Overview
The Outlook Anywhere with Autodiscover Application Offloading is a feature that provides the ability for clients 
using Outlook 2013, Outlook 2010, or Outlook 2007 to access the Outlook Exchange Server from the Internet. 
Autodiscover support provides a simple configuration of the user’s account by only requiring the user’s email 
address and password. Autodiscover also helps to update settings on the client side when Outlook Exchange 
server settings have changed. 

Outlook Anywhere with Autodiscover is supported by the Application Offloading portal; both Access Policy and 
Authentication can be enforced. 
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Portals > Domains
The Portals > Domains page allows the administrator to add and configure a domain, including settings for:

• Authentication type (local user database, Active Directory, LDAP, or RADIUS)

• Domain name

• Portal name

• Group (AD, RADIUS) or multiple Organizational Unit (LDAP) support (optional)

• Client digital certificate requirements (optional)

• One-time passwords (optional)

Topics: 

• Viewing the Domains Table

• Removing a Domain

• Adding or Editing a Domain

• Adding or Editing a Domain with Local User Authentication

• Adding or Editing a Domain with Active Directory Authentication

• Adding or Editing a Domain with RADIUS Authentication

• Adding or Editing a Domain with Digital Certificates

• Adding a Domain with SAML 2.0 Authentication

• Configuring SAML Authentication

• Adding a Domain with SAML 2.0 Authentication

Viewing the Domains Table
All of the configured domains are listed in the table in the Portals > Domains window. The domains are listed in 
the order in which they were created. You can reverse the order by clicking the up/down arrow next to the 
Domain Name column heading.

Removing a Domain
To delete a domain:

1 Navigate to Portals > Domains.
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2 In the table, click the delete icon in the same row as the domain that you wish to delete. 

3 Click OK in the confirmation dialog box. 

After the SMA appliance has been updated, the deleted domain is no longer be displayed in the table.

Adding or Editing a Domain
To edit an existing domain, click the Configure icon to the right of the domain you wish to edit.

The interface provides the same fields for both adding and editing a domain, but the Authentication Type and 
Domain Name fields cannot be changed when editing an existing domain.

In order to create access policies, you must first create authentication domains. By default, the LocalDomain 
authentication domain is already defined. The LocalDomain domain is the internal user database. Additional 
domains can be created that require authentication to remote authentication servers. The SMA appliance 
supports RADIUS, LDAP, Active Directory, and Digital Certificate authentication in addition to internal user 
database authentication. 

You can create multiple domains that authenticate users with user names and passwords stored on the SMA 
appliance to display different portals (such as a Secure Mobile Access portal page) to different users.

For convenient configuration of SMA appliance administrator accounts, you can create a domain that provides 
administrator access for all users who log in to that domain. Either LDAP or Active Directory authentication is 
used for this type of domain.
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Adding or Editing a Domain with Local User 
Authentication
To add or edit a domain for local database authentication:

1 Navigate to the Portals > Domains window and click Add Domain or the Configure icon for the domain 
to edit. The Add Domain or Edit Domain window is displayed. 

2 If adding the domain, select Local User Database from the Authentication Type drop-down list.

3 If adding the domain, enter a descriptive name for the authentication domain in the Domain Name field 
(maximum 24 characters). This is the domain name users select to log in to the Secure Mobile Access 
portal.

4 Select the name of the layout in the Portal Name field. Additional layouts can be defined in the Portals 
> Portals page.

5 All newly created domains in the local database user type should be set with a default password 
expiration value, as well as the “show expiration warning days” option set to 15. You can manually 
change it upon creation. Optionally, force all users in the Local User Database to change their password 
at set intervals or the next time they login. To force users to change their password at set intervals, type 
the expiration interval in the Passwords expire in x days field. To force users to change their password 
the next time they log in, check Require password change on next logon.

If the domain is set with concrete password expiration days, you should also set the user expiration to 0. 
That means using the domain expiration setting. The domain setting detection is automatic after 
submitting the “adding user” request. Also, you can manually change it on creation.

The default password expiration value is two years (730 days).

On upgrade, the existing values for password expiration should remain as they are.

6 If you set a password expiration interval, type the number of days before expiration that users should 
receive notifications in the Show warning x days before password expiration field.
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When configured and a password is expiring, a notification is displayed on the user’s Virtual Office page 
or the Administrator’s management console identifying the number of days before their password 
expires. Notifications also include a link to a screen where the password can be changed.

7 Optionally add the number of unique new passwords that is associated with a user account before an old 
password can be re-used for the account in the Enforce password history, x passwords remembered 
field. The value specified must be between 0 and 10 passwords.

8 Optionally Enforce password minimum length by entering a value between 1 and 14 characters. This is 
the minimum amount of characters accepted for a user password. 

9 Optionally select Enforce password complexity. When this option is enforced, at least three of the four 
following parameters must be met when setting a password:

• English uppercase characters (A through Z)

• English lowercase characters (a through z)

• Base 10 digits (0 through 9)

• Non-alphabetic characters (for example, !, $, #, %)

10 Optionally select Allow password changes. This allows users to change their own passwords after their 
account is set up.

11 Optionally select Require password change on next login. This requires users to change their passwords 
during their next login.

12 Optionally select Enable client certificate enforcement to require the use of client certificates for login. 
By checking this box, you require the client to present a client certificate for strong mutual 
authentication. Two additional fields appear:

• Verify user name matches Common Name (CN) of client certificate - Select this check box to 
require that the user’s account name match their client certificate.

• Verify partial DN in subject - Use the following variables to configure a partial DN that matches 
the client certificate:

• User name: %USERNAME%

• Domain name: %USERDOMAIN%

• Active Directory user name: %ADUSERNAME%

• Wildcard: %WILDCARD%

13 Optionally select One-time passwords to enable the one-time password feature. A drop-down list 
appears, in which you can select User discretion, Use E-mail, and Use Mobile App. 

These are defined as:

• User discretion - Users in this domain can edit one-time password settings from the Portals > 
Domains > Add Domain page. 

• Use E-mail - Optionally select Use E-mail to enable this one-time password method. The Email 
domain: window appears, in which you can enter an email address to send the one-time 
password.

• Use Mobile App - Optionally select Use Mobile App to enable this one-time password method to 
force users to use a one-time password. Users can use Google Authenticator, Duo Mobile, or any 
other compliant two-factor authentication service.

14 If Enable Always on VPN is enabled, users have uninterupted access to the network.

15 Optionally select Enable Always on VPN to enable the Always on VPN feature. A drop-down list appears, 
in which you can select from the following:

• Allow user to disconnect and enter a domain in the E-mail domain: window.
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• Allow accessing network if VPN fail to connect.

• Don’t connect VPN in Trusted Network.

16 Select one of the following options from the Require Device Register: drop -down menu:

• Select Use Global Setting to apply the global setting to this domain. 

• Select Enable this feature, no matter what is selected for the global setting.

• Select Disable this feature, no matter what is selected for the global setting.

17 Click Accept to update the configuration. After the domain has been added, the domain is added to the 
table on the Portals > Domains page.

Adding or Editing a Domain with Active 
Directory Authentication
To configure Windows Active Directory authentication:

1 Click Add Domain or the Configure icon for the domain to edit. The Add Domain or Edit Domain 
window is displayed.If adding the domain, select Active Directory from the Authentication type 
drop-down list. The Active Directory configuration fields are displayed. 

2 If adding the domain, enter a descriptive name for the authentication domain in the Domain name field. 
This is the domain name users select in order to log in to the SMA appliance portal. It can be the same 
value as the Server address field or the Active Directory domain field, depending on your network 
configuration.

3 Enter the Active Directory domain name in the Active Directory domain field.

4 Enter the IP address or host and domain name of the Active Directory server in the Server address field.
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5 Enter the IP address or host and domain name of the back up server in the Backup Server address field.

6 Enter the user name for login in the Login user name field.

7 Enter the password for login in the Login password field. 

8 Optionally select Allow password changes. Enabling this feature allows a user to change their password 
through the Virtual Office portal by selecting Options on the top of the portal page. User must submit 
their old password, along with a new password and a re-verification of the newly selected password.

9 Optionally select Use SSL/TLS. This option allows for the needed SSL/TLS encryption to be used for 
Active Directory password exchanges. This check box should be enabled when setting up a domain using 
Active Directory authentication.

10 Optionally select Enable client certificate enforcement to require the use of client certificates for login. 
By checking this box, you require the client to present a client certificate for strong mutual 
authentication. Two additional fields appear:

• Verify user name matches Common Name (CN) of client certificate - Select this check box to 
require that the user’s account name match their client certificate.

• Verify partial DN in subject - Use the following variables to configure a partial DN that matches 
the client certificate:

• User name: %USERNAME%

• Domain name: %USERDOMAIN%

• Active Directory user name: %ADUSERNAME%

• Wildcard: %WILDCARD%

11 Select Delete external user accounts on logout to delete users who are not logged into a domain 
account after they log out.

12 Select Only allow users listed locally to allow only users with a local record in the Active Directory to 
login.

13 Select Auto-assign groups at login to assign users to a group when they log in.

Users logging into Active Directory domains are automatically assigned in real time to Secure Mobile 
Access groups based on their external AD group memberships. If a user’s external group membership has 
changed, their Secure Mobile Access group membership automatically changes to match the external 
group membership.

14 Optionally, select One-time passwords to enable the One Time Password feature. A drop-down list 
appears, in which you can select User discretion, Use E-mail, Use Mobile App. These are defined as:

• User discretion - Users in this domain can edit one-time password settings from the Portals > 
Domains > Add Domain page. 

• Use Mobile App - Optionally select Use Mobile App to enable this one-time password method to 
force users to use a one-time password. Users can use Google Authenticator, Duo Mobile, or any 
other compliant two-factor authentication service.

15 If you selected if configured or required for all users in the One-time passwords drop-down list, the 
Active Directory AD e-mail attribute drop-down list appears, in which you can select mail, mobile, 
pager, userPrincipalName, or custom. These are defined as:

• mail - If your AD server is configured to store email addresses using the “mail” attribute, select 
mail.

• mobile or pager - If your AD server is configured to store mobile or pager numbers using either of 
these attributes, select mobile or pager, respectively. Raw numbers cannot be used, however, 
SMS addresses can.
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• userPrincipalName - If your AD server is configured to store email addresses using the 
“userPrincipalName” attribute, select userPrincipalName. 

• custom - If your AD server is configured to store email addresses using a custom attribute, select 
custom. If the specified attribute cannot be found for a user, the email address assigned in the 
individual user policy settings is used. If you select custom, the Custom attribute field appears. 
Type the custom attribute that your AD server uses to store email addresses. If the specified 
attribute cannot be found for a user, the email address is taken from their individual policy 
settings.

If you select using domain name, an E-mail domain field appears following the drop-down list. Type in 
the domain name where one-time password emails are sent (for example, abc.com).

16 Select the type of user from the User Type drop-down list. All users logging in through this domain are 
treated as this user type. The choices depend on user types defined already. Some possible choices are:

• External User – Users logging into this domain are treated as normal users without administrative 
privileges.

• External Administrator – Users logging into this domain are treated as administrators, with local 
Secure Mobile Access admin credentials. These users are presented with the admin login page.

This option allows the Secure Mobile Access administrator to configure a domain that allows 
Secure Mobile Access admin privileges to all users logging into that domain. 

SonicWall Inc. recommends adding filters that allow administrative access only to those users 
who are in the correct group. You can do so by editing the domain on the Users > Local Groups 
page.

• Read-only Administrator – Users logging into this domain are treated as read-only 
administrators and can view all information and settings, but cannot apply any changes to the 
configuration. These users are presented with the admin login page.

17 Click Accept to update the configuration. After the domain has been added, the domain is added to the 
table on the Portals > Domains page.

Adding or Editing a Domain with RADIUS 
Authentication
To configure a domain with RADIUS authentication: 

1 On the Portals > Domains page, 

2 click Add Domain or the Configure icon for the domain to edit. 



SonicWall Secure Mobile Access 10.2 Administration Guide
Portals Configuration 140

3 The Add Domain or Edit Domain 

4 If adding the domain, select RADIUS from the Authentication type menu. The RADIUS configuration 
fields are displayed.

5 If adding the domain, enter a descriptive name for the authentication domain in the Domain name field. 
This is the domain name users selects in order to log in to the Secure Mobile Access portal.

6 Select the proper Authentication Protocol for your RADIUS server. Choose from PAP, CHAP, MSCHAP, 
or MSCHAPV2.

7 Under Primary Radius server, enter the IP address or domain name of the RADIUS server in the RADIUS 
server address field.

8 Enter the RADIUS server port in the RADIUS server port field.

9 If required by your RADIUS configuration, enter an authentication secret in the Secret password field.

10 Under Backup Radius Server, enter the IP address or domain name of the backup RADIUS server in the 
RADIUS server address field.

11 Enter the backup RADIUS server port in the RADIUS server port field.

12 If required by the backup RADIUS server, enter an authentication secret for the backup RADIUS server in 
the Secret password field.

13 Enter the test user ID in the Test User ID field.

14 Enter the test password in the Test Password field.

15 Enter a number (in seconds) for RADIUS timeout in the RADIUS Timeout (Seconds) field.

16 Enter the maximum number of retries in the Max Retries field.

17 Optionally, if using RADIUS for group-based access, select Use Filter-ID for RADIUS Groups.

18 Optionally, select User Client IP for RADIUS Server Logging to use the client IP instead of the SMA IP 
address for RADIUS logging.

19 Click the name of the layout from the Portal name drop-down list. 
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20 If you selected the Authentication Protocol for your RADIUS server as MSCHAP or MSCHAPV2, you have 
the option to select Allow password changes. Note that if you enable password changes, you must also 
deploy the LAN Manager authentication.

21 Optionally select Enable client certificate enforcement to require the use of client certificates for login. 
By checking this box, you require the client to present a client certificate for strong mutual 
authentication. Two additional fields appear:

• Verify user name matches Common Name (CN) of client certificate - Select this check box to 
require that the user’s account name match their client certificate.

• Verify partial DN in subject - Use the following variables to configure a partial DN that matches 
the client certificate:

• User name: %USERNAME%

• Domain name: %USERDOMAIN%

• Active Directory user name: %ADUSERNAME%

• Wildcard: %WILDCARD%

22 Select Delete external user accounts on logout to delete users who are not logged into a domain 
account after they log out.

23 Select Only allow users listed locally to only allow users that are configured locally, but to still use 
RADIUS to authenticate.

24 Select Auto-assign groups at login to assign users to a group when they log in.

Users logging into RADIUS domains are automatically assigned in real time to Secure Mobile Access 
groups based on their external RADIUS filter-IDs. If a user’s external group membership has changed, 
their Secure Mobile Access group membership automatically changes to match the external group 
membership.

25 Optionally select One-time passwords to enable the One-time password feature. A drop-down list 
appears, in which you can select if configured, required for all users, or using domain name. These 
are defined as:

• if configured - Only users who have a One Time Password email address configured uses the One 
Time Password feature.

• required for all users - All users must use the One Time Password feature. Users who do not have 
a One Time Password email address configured is not allowed to login.

• using domain name - Users in the domain use the One Time Password feature. One Time 
Password emails for all users in the domain is sent to username@domain.com.

26 If you select using domain name, an E-mail domain field appears following the drop-down list. Type in 
the domain name where one-time password emails are sent (for example, abc.com).

27 Optionally select Always on VPN to allow uninterrupted VPN access. Three additional fields appear:

• Allow user to disconnect and enter a domain in the E-mail domain: window.

• Allow accessing network if VPN fail to connect.

• Don’t connect VPN in Trusted Network.

28 Select an option from the Require Device Register drop-down menu:

• Select Use Global Settings to apply global settings to domain.

• Select Enable to enable this feature, no matter what is selected for global setting.

• Select Disable to disable this feature, no matter what is selected for global setting.
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29 Click Accept to update the configuration. After the domain has been added, the domain is added to the 
table on the Portals > Domains page.

30 Click Configure next to the RADIUS domain you added. 

31 Enter your RADIUS user ID in the User ID field and your RADIUS password in the Password field.

32 Click Test. The SMA appliance connects to your RADIUS server.

33 If you receive the message Server not responding, check your user ID and password and click the 
General tab to verify your RADIUS settings. Try running the test again.

Portal Name Added to Client Identifier for RADIUS
In SMA 10.2.0.1, portal information is now automatically included in the RADIUS client identifier. The client 
identifier format is [sma hostname]/[portal name]. No additional configuration is needed for this. The portal 
name is attached automatically.

This enhancement provides the ability to distinguish between different SMA portals on the RADIUS server. In 
previous releases, the RADIUS server used only the IP address of the SMA appliance and could not differentiate 
between portals. This interfered with the ability to define multiple RADIUS domains on the SMA while pointing 
to the same RADIUS server.
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Adding or Editing a Domain with Digital 
Certificates
To add or edit a domain for digital certificate authentication:

1 Navigate to the Portals > Domains window and click Add Domain or Configure for the domain to edit. 
The Add Domain or Edit Domain window is displayed.

2 If adding the domain, select Digital Certificate from the Authentication Type menu. The Digital 
Certificate configuration field is displayed.

3 If adding the domain, enter a descriptive name for the authentication domain in the Domain name field. 
This is the domain name users selects in order to log in to the Secure Mobile Access portal.

4 Select one or more certificates from the All CA certificates list to be added to the Trusted CA certificates 
list. The All CA certificates list displays all available certificates for the SMA appliance that were imported 
from the system certificate setting. 

5 Enter the Username Attribute as CN. This uses the CN attribute of the client certificate as the login 
username. 

6 Click Accept to save changes. Next, you need to import the client certificate to your Web browser. 



SonicWall Secure Mobile Access 10.2 Administration Guide
Portals Configuration 144

To import the client certificate:

1 Navigate to the Certificate details on your Web browser’s settings. 

2 Select the CA domain. A dialogue window displays. Choose a client certificate to authenticate. Click OK.

The authentication completes if the CA of the client certificate is on the Trusted CA certificates list. If the 
client certificate is not on the Trusted CA certificates list, the appliance blocks access and displays an 
error message. 

3 Next, the client certificate user must be authorized. 

To authorize the client certificate:

1 Navigate to the Portals > Domains window and click the Configure icon for the domain to edit. 

2 Select Enable group affinity checking.

3 Select one of the available domains from the drop-down list to designate as the Server. 

4 Click Accept.
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Adding a Domain with SAML 2.0 Authentication
Security Assertion Markup Language (SAML) is a standard protocol used by web browsers to enable Single Sign-
On (SSO) through secure tokens.

SAML eliminates the need for passwords during sign-in by implementing a secure method of passing user 
authentications and authorizations between the identity provider and service providers. When a user logs into a 
SAML enabled application, the service provider requests authorization from the appropriate identity provider. 
The identity provider authenticates the user’s credentials and then returns the authorization for the user to the 
service provider, and the user is now able to use the application.

SAML 2.0 specifies a Web Browser SSO Profile that involves exchanging information among an identity provider 
(IDP), a service provider (SP), and a principal (user) on a web browser. SMA100 works as a Service Provider (SP); 
Microsoft Azure Active Directory and onelogin server work as Identity Providers.

To add a domain with SAML 2.0 authorization:

Prerequisite: You need to add the SMA application to an IDP that you wish to use as the SMA 
Authentication server. For information on adding the SMA application to an IDP and configuring SAML 
authentication on your SMA appliance, see Configuring SAML Authentication.

1 In the SMA management interface, navigate to Portals > Domains.

2 In the Domains page, click ADD DOMAIN.

3 Select SAML 2.0 Identity Provider from the Authentication type drop-down menu. 

4 Enter a descriptive name for the authentication domain in the Domain Name field. 

This is the domain name users select in order to log in to the Secure Mobile Access user portal. It can be 
the same value as the Server address field

5 Enter the SAML entity ID of the appliance in the Appliance ID field.

6 Enter the SAML entity ID of the IDP in the Server ID field.

7 Enter the HTTP/S URL where IDP hosts the SAML SSO service in the Authentication service URL box.

8 Enter the HTTP/S URL where IDP hosts the SAML logout service in the Logout service URL box.
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9 From the Trusted Certificates drop-down box, select the SAML certificate (used for SAML message 
verification) downloaded from the IDP server. The SAML certificates that can be selected are uploaded 
under System > Certificates > SAML certificates.

10 Enter the customized user name for SAML users in the User Name box.

11 Enter the custom name for groups in the Group Name box.

12 Select the appropriate portal in the Portal Name box.

13 Configure all the other optional fields displayed in the page.

14 Click Submit.

Configuring SAML Authentication
Topics:

• Configuring SAML Authentication With Azure

• Configuring SAML Authentication With OneLogin

• Configuring SAML Authentication With G Suite

• Configuring SAML Authentication With Office 365

• Configuring SAML Authentication With Okta

Configuring SAML Authentication With Azure
1 Navigate to https://portal.azure.com, create a trial/paid account, and register a domain.

2 Log in to your Azure account using admin credentials.

3 To add SMA application to your Azure account:

a On the Applications menu of the directory, click + New application.

b Select Non-gallery application to add your own application.
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c In the Add your own application dialog, enter a display name.

d Click Add.

e Assign users to the new added SMA application:

• Click Users and groups below Manage.

• Click + Add user.

• Select a User and Role.

• Click Assign.

f Navigate to Enterprise applications in AZURE and select the application you have created 
“Sma100 VPN”.

g Click single sign on and select SAML.

h Configure basic SAML configurations:

Issuer URL: https://{appliance ‘s IP address or HostName}.

Reply URL: https://{appliance ‘s IP address or HostName}/__api__/v1/logon/saml2ssoconsumer.

SSO URL: https://{appliance ‘s IP address or HostName}/__api__/v1/logon/saml2ssoconsumer.

i Click save.

j Download the Certificate.

4 To configure SAML on SMA appliance:

a Import SAML Certificate on System > Certificates.

b Create a SAML domain.

c Enter a valid domain name.

d Appliance ID is https://{appliance ‘s IP address or HostName}

e Server ID is Azure AD identifier value present in Azure.
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f Authentication service URL is Login URL value present in Azure.

You can now proceed with authentication from Virtual Office portal and NetExtender. When you 
select Azure domain in the login page, you will be redirected to the Azure login, and after 
providing correct credentials, the authentication will be successful.

Configuring SAML Authentication With OneLogin
1 Access https://www.onelogin.com/ and create Trial/paid account.

2 Log in to your OneLogin account and create a domain when prompted. For example: 
sonicwall.onelogin.com.

3 To add SMA application to your OneLogin account:

a Select Apps > Add Apps.

p
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b Search SAML and add it by clicking SAML Test Connector (Advanced).

c Enter appropriate name into the Display Name field (e.g. SAML Test Connector (IdP)) and then 
click Save.

d Click SSO tab.

e Click View Details below X.509 Certificate in Enable SAML 2.0 section.

f Download the certificate to upload as ‘Certificate Authority’ cert in SMA appliance.

g Click Configuration.

h Set Audience, Recipient, ACS URL Validator, ACS URL, Single Logout URL as per the following:

• Relay state: SMA100 does not support

• Audience: This is same as Appliance ID in SAML Domain configure page

• Recipient: It is SMA100 receive SAML message path, the format is: https://{appliance ‘s IP 
address or Hostname}/__api__/v1/logon/saml2ssoconsumer

• ACS URL Validator: same as Recipient: https://{appliance ‘s IP address or 
Hostname}/__api__/v1/logon/saml2ssoconsumer

• ACS URL: https://{appliance ‘s IP address or 
Hostname}/__api__/v1/logon/saml2ssoconsumer
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• Single Logout URL: https://{appliance‘s IP address or 
Hostname}/__api__/v1/logon/saml2ssoco

i To add parameter and group user:

a) Click Add parameter.

b) Enter a name for Field name, select Include in SAML assertion, and click SAVE.

c) The dialog will bind the field name to user’s attribute.

You can select an attribute relevant to this field and select Include in SAML assertion, then 
this attribute will be present in AUTH Response messages.

For example in step 1 we have customized some parameters, for example:
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parameter name: GGNAME ,the value of GGNAME is the value of user’s attribute 
Department

parameter name: UUNAME ,the value of UUNAME is value of user’s attribute First Name

d) Now you will see the parameter that you have set.

j To sync appliance date/time with NTP server:

a) Navigate to Users

b) Add more users for the SAML domain.

c) Click Change Password for changing password of the newly created user.

4 Configure SAML Domain on your SMA appliance:

a Navigate to System > Certificates and import SAML certificates.

b Configure SAML domain with OneLogin data.
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You can now proceed with authentication from Virtual Office portal and NetExtender. When you 
select OneLogin domain in the login page, you will be redirected to the OneLogin login page, and 
after providing correct credentials, the authentication will be successful.

Configuring SAML Authentication With G Suite
1 Access https://gsuite.google.com/, create a G suite account and register a domain. 

2 To add SMA application to your G Suite account:

a Click Apps.

b Click SAML apps.

c Configure ACS URL as https://{ApplianceIP or Hostname}/__api__/v1/logon/saml2ssoconsumer.

d Configure Entity ID as https://{ApplianceIP or Hostname}.
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e Click manage certificates and fetch “SSO URL” and “Entity ID”.

f Download SAML Certificate.

3 Configure SAML on your SMA appliance:

a Import SAML Certificate on System > Certificates page.

b Create a SAML domain with G suite data:

• Enter a name, for example: SAML Google.

• Server ID is https:// {appliance ‘s IP address or Hostname}.

• Server ID is Entity ID of G suite account.

• Authentication service URL and Logout service URL is SSO URL of the G-Suite account.
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You can now proceed with authentication from Virtual Office portal and NetExtender. When you select G 
Suite domain in the login page, you will be redirected to the G suite login page, and after providing 
correct credentials, the authentication will be successful.

Configuring SAML Authentication With Office 365
1 Download and Install ADSelfService Plus:

a Download ADSelfService Plus from https://www.manageengine.com/products/ad-manager/.

b Install the application.

2 To add SMA application to your Office 365 account:

a Log in to ADSelfService Plus account with valid credentials.

b Click Password Sync/Single Sign On.

Synchronize IDP date/time with NTP server to avoid any date-time related SAML errors.
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c Click Office 365 application.

d Select Single Sign On in the Modules drop-down menu.

e Specify Domain Name, Display Name and Available Policies.

f Click Download SSO Certificate.

g Fetch the Details of Login URL, Logout URL and Download the SAML certificate.

3 Configuring SAML on your SMA appliance:

a Navigate to System > Certificates and import SAML Certificate.

b Create a SAML domain:

• Enter a suitable Domain Name, for example: SAML Office 365

• Appliance ID should be in the format http://{Appliance IP or Hostname}.

• Server ID and Authentication Service URL is Login URL of the SAML Domain

• Logout Service URL is the Logout Service URL of SAML Domain

c During login, provide the correct Gsuite credentials.
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You can now proceed with authentication from Virtual Office portal and NetExtender. When you 
select Office 365 domain in the login page, you will be redirected to the ADSelfService Plus login 
page, and after providing correct credentials, the authentication will be successful.

Configuring SAML Authentication With Okta
1 Access https://www.okta.com/ and create a trial account.

2 Log in to your Okta account, create a domain when prompted. For example: sonicwallsk.okta.com.

3 To add SMA application to your Okta account:

a Login to Okta account with proper credentials.

b Click Admin at the upper-right corner of the page.

c Click Add App under Use single sign on.
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d Click Create New App button to create a new app.

e In the dialog, select SAML 2.0, and then click Create.

f In General Settings, enter “SMA100 VPN” (Just an example) in the App name box, and then click 
Next.

g In Configure SAML, under SAML Settings, paste the URL: https://{appliance ‘s IP address or 
Hostname}/__api__/v1/logon/saml2ssoconsumer in Single sign on URL, Recipient URL, 
Destination URL and Audience Restriction (SP Entity ID) fields.

h In the Attribute Statements section, add three attribute statements:

a) FirstName set to “user.firstName”

b) LastName set to “user.lastName”

c) Email set to “user.email”
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i Click Next to continue.

j In Feedback, select I’m an Okta customer adding an internal app, and This is an internal app that 
we have created, and then click Finish.

k The Sign On section of created “SMA100 VPN” application appears. Keep this page open in a 
separate tab or browser window. You need to return to this page and copy the “Identity Provider 
metadata” link later. (To copy that link, right-click on the Identity Provider metadata link and 
select Copy).

l Click View setup Instructions and download the certificate. (This information will be required 
while configuring authentication server in SMA100 appliance).

m Right-click on the Assignments section of the “SMA100 VPN” application and select Open Link in 
New Tab (so that you can come back to the Sign On section later).

n In the new tab that opens, click on the Assign button and select Assign to People.
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4 To configure SAML on your SMA appliance:

a Upload Okta SAML certificate in the SMA 100 appliance on system > certificates page.

b Create a SAML domain with data of Okta IDP:

• Give any valid name like “SAML OKTA”.

• Server ID is Identity Provider Issuer value present in Okta.

• Authentication service URL is Identity Provider Single Sign-On URL value present in Okta.

You can now proceed with authentication from Virtual Office portal and NetExtender. When you select 
Okta domain in the login page, you will be redirected to the Okta login page, and after providing correct 
credentials, the authentication will be successful.
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Configuring Two-Factor Authentication
Two-factor authentication is an authentication method that requires two independent pieces of information to 
establish identity and privileges. Two-factor authentication is stronger and more rigorous than traditional 
password authentication that only requires one factor (the user’s password).

SonicWall Inc.’s implementation of two-factor authentication either uses two separate RADIUS authentication 
servers, or partners with two of the leaders in advanced user authentication: RSA and VASCO. If you are using 
RSA, you must have the RSA Authentication Manager and RSA SecurID tokens. If you are using VASCO, you must 
have the VASCO IdentiKey and Digipass tokens.

Portals > Load Balancing
This section provides an overview of the Portals > Load Balancing page and a description of the configuration 
tasks available on this page.

The Portals > Load Balancing page allows the administrator to configure back end Web servers for a load 
balanced deployment. This default landing page for the load balancing feature allows the administrator to 
configure load balancing groups, and lists general properties of any existing load balancing groups.
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Configuration Scenarios
Load Balancing for Secure Mobile Access is a robust feature that has multiple uses, including:

• Balancing a Farm of Web Servers – This is useful when the SMA appliance with a higher horse power is 
offering protection and balancing the load of a relatively low powered farm of Web servers. In this case, 
Web Application Firewall, URL rewriting and other CPU intensive operations are enabled on the Load 
Balancer.

• Balancing a Low-Powered Cluster – A relatively low powered SMA cluster can be balanced for 
improved scalability. In this case, Web Application Firewall, URL rewriting, and other scalable features are 
enabled on the low powered SMA appliances.

• Load Balanced Pair – In this scenario, the Load Balancer can have one portal configured for the 
front-end, and another Application Offloading portal configured to act as a Virtual Backend Server. This 
Virtual Backend Server and the second SMA device are configured as the Load Balancing Members and 
also take up the load of the Security Services. The Load Balancer in the previous two scenarios is 
essentially a dummy proxy without the load of any Security Services to burden it.

Load Balancing Settings

Load balancing configuration options

Option Description

Enable Load Balancing Enables the load balancing feature across all currently active groups.

Enable Fail Over Enables/disables all probing, monitoring, and failover features.

Probe Interval Determines the frequency (in seconds) at which the load balancing feature checks 
the status of backend nodes.



SonicWall Secure Mobile Access 10.2 Administration Guide
Portals Configuration 162

Configuring a Load Balancing Group
This section provides configuration details for creating a new load balancing group and consists of the following 
sections:

• Adding a New Load Balancing Group

• Configuring Probe Settings

• Adding New Members to a Load Balancing Group

Adding a New Load Balancing Group
1 In the Portals > Load Balancing Group page, click Add Group. 

2 Enter a friendly LB Group Name for this load balancing group.

3 Select a load balancing method from the LB Method drop-down list. Options include:

• Weighted Requests – Keeps track of the number of incoming requests (including successfully 
completed requests) to decide which member should handle the next incoming request. The LB 
Ratio decides the percentage distribution.
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• Weighted Traffic – Keeps track of the number of bytes of inbound/outbound data to decide 
which member should handle the next incoming request. 

• Least Requests – Keeps track of the number of incoming requests (excluding successfully 
completed requests) that are currently being serviced to decide which Member should handle the 
next incoming request.

4 Select Enable Load Balancing to enable this group for load balancing.

5 The Enable Session Persistence option is automatically selected when the group is enabled. This option 
allows the administrator to enable continuous user sessions by forwarding the “requests” part of the 
same session to the same backend member.

6 Select Enable Failover to enable probing, monitoring, and failover features.

Configuring Probe Settings
To configure probe settings for this load balancing group in the Probe Settings section of the Portals > Load 
Balancing screen:

1 Select a Probe Method from the drop-down list. Options include:

• HTTP/HTTPS GET – The Load Balancer sends a HTTP(S) GET request periodically (based on the 
configured Probe interval) to see if the HTTP response status code is not greater than or equal to 
500 to ensure there are no Web server errors. This is the most reliable method to determine if a 
Web server is alive. This method ignores SSL Certificate warnings while probing.

• TCP Connect – The Load Balancer completes a 3-way TCP handshake periodically to monitor the 
health of a backend node. 

• ICMP Ping – The Load Balancer sends a simple ICMP Ping request to monitor if a backend node is 
alive.

2 In the Deactivate Member after field, enter the number of missed intervals required to fail the node. 
The default value is 2.

3 In the Reactivate Member after field, enter the number of successful intervals required to reinstate the 
node as functional. The default value is 2.

4 In the Display error page when there is no resource available to fail over text box, enter a custom 
message or Web page to display in the event that all of the configured backend nodes have failed. HTML 
formatting is allowed in this field.

Adding New Members to a Load Balancing Group

To add members to a new or existing load balancing group:

1 When editing or adding a group from the Portals > Load Balancing page, click Add Member. The Load 
Balancing Member screen displays.

2 Enter a Member Name to uniquely identify this member within the Load Balancing Group.

3 Enter a friendly name or description in the Comment field to identify this group by mousing over the 
group’s page.

4 Select a Scheme to connect to the backend server. Select one of the following options from the 
drop-down list: HTTP, HTTPS, or AUTO. The default value is HTTPS.

If AUTO is selected, specify two port numbers for HTTPS and HTTP.

5 Enter the back end HTTP(S) server IP address in the IPv4/IPv6 Address field.
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6 Enter the Port for the backend server. The default value for an HTTPS connection is 443 and HTTP is 80. 
For Auto schemes, the default port numbers for HTTPS and HTTP are accepted. 

7 Enter the LB Ratio, the proportion of requests a Load Balancing Member could process. The total LB 
Ratio should be equal to 100.

8 Check the LB Status to see whether the server is up and processing the request. The gray button 
indicates that the LB member is just added and there is not communication between the appliance and 
the server. The red button indicates that the server is down. The green button indicates that the server is 
up. 

9 Check the Probe Status to see whether the server is healthy or not.

10 Check the Statistics to know the requests, inbound traffic, and outbound traffic processed by a Load 
Balancing Member. 

11 Click Accept to add this member to the group.

Portals > URL Based Aliasing
This section provides an overview of the Portals > URL Based Aliasing page and a description of the 
configuration tasks available on this page.

URL Based Aliasing provides the ability to access several different Web sites through one portal using one 
domain name. This feature is designed to be consistent with the Load Balancing setting. Because URL Based 
Aliasing involves rewriting URLS found in the content served by the backend Web server, the backend Web 
application should be compatible with third-party proxies. If a Web application does not render properly using 
URL Based Aliasing, you might need to set up access to the application using App Offloading without URL 
rewriting or using NetExtender. 

Topics: 

• Adding a URL Based Aliasing group

• Default Site Settings

Adding a URL Based Aliasing group
Topics: 

• Adding Members

• Deleting a Group

• Deleting a Member
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To add a URL Based Aliasing group:

1 Navigate to the Portals > URL Based Aliasing page.

2 Under the URL Based Aliasing Groups section, click Add Group. The New URL Based Aliasing Group page 
displays. 

3 Enter a Group Name in the field provided. Then, click Accept. The newly added group displays on the 
URL Based Aliasing Groups list.
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Adding Members
URL Based Aliasing allows you to add up to 100 members to a group. 

To add members to a URL Based Aliasing group:

1 Navigate to the Portals > URL Based Aliasing page. 

2 Click the Configure icon of the group you want to modify. The Group URL Based Aliasing Settings page 
displays.

3 Click Add Member. The Add URL Based Aliasing Member page displays.

Configure the following fields:

• URL — Enter the URL or name of the member.

• Comments — Enter any additional information. Anything entered in this field displays on the 
Index page.

• Scheme — Select from the drop-down list the scheme of the backend server. Select between 
HTTP, HTTPS, or AUTO.

• Application Server Host — Enter a Hostname, IPv4 address, or IPv6 address of the host.

• Port — Specify the port number. The default value is 443.

4 Click Accept to save changes and add a member to the group. The newly added member appears on the 
URL Based Aliasing Settings page. 

Deleting a Group

To delete a specific group:

1 Navigate to the Portal > URL Based Aliasing page.

2 Click the Delete icon of the group you wish to delete. A confirmation for deleting the group appears. Click 
OK.
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Deleting a Member

To delete a specific member from a group:

1 Navigate to the URL Based Aliasing group settings page in which the member belongs.

2 Click the Delete icon of the member you wish to delete. 

3 A confirmation for deleting the member appears. Click OK. 

Default Site Settings
The Default Site Settings section provides the ability to set a default site when accessing the portal without any 
URL specified. The default value in the drop-down list is Index Page. 

The Default Site Settings can be customized by editing the HTML, and then clicking Accept.

• Click Preview... to view the Index Page. To modify how this page appears, edit the HTML in the Default 
Site Settings section and click Accept.

• Click the Default Index Page to indicate the default page. 
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Configuring Services and Clients

• Services Configuration

• Device Management Configuration

• Clients Configuration

• End Point Control

• Web Application Firewall Configuration

• Capture ATP

• Geo IP and Botnet Filter

• High Availability Configuration
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Services Configuration

This section provides information and configuration tasks specific to the Services pages on the SonicWall Secure 
Mobile Access web-based management interface, including configuring settings, bookmarks, and policies for 
various application layer services, such as HTTP/HTTPS, Citrix, RDP, and VNC.

Topics: 

• Services > Settings

• Services > Bookmarks

• Services > Policies

Services > Settings
This section provides an overview of the Services > Settings page and a description of the configuration tasks 
listed on this page:

• HTTP/HTTPS Service Settings

• Citrix Service Settings

• NetExtender/Mobile Connect Service Settings

• Mobile Connect Default Policy Settings

• Global Portal Settings

• One Time Password Settings

• Policy Match Log Settings

The Services > Settings page allows the administrator to configure various settings related to HTTP/HTTPS, 
Citrix, Global Portal character sets, and one-time passwords. 
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HTTP/HTTPS Service Settings
Administrators can take the following steps to configure HTTP/HTTPS Service Settings:

1 Enable Content Caching is selected by default. Administrators can disable the check box if they choose 
to do so. However, changing the Enable Content Cache setting restarts Secure Mobile Access Services, 
including the web server.

In the Cache Size field, define the size of the desired content cache. 5 MB is the default setting, but 
administrators can set any size in the valid range from two to 20 MB. Select Flush to flush the content 
cache.

2 Check Enable Custom HTTP/HTTPS Response Buffer Size, if you wish to establish a response buffer. 
Set the desired buffer size using the Buffer size drop-down menu. This limit is enforced for HTTP and 
HTTPS responses from the backend Web server for plain text, Flash, and Java applets. The default size of 
the buffer is 1024 KB.

3 Check Insert Proxy Request Headers to insert these types of headers into the HTTP/HTTPS requests to 
the backend Web server. The following headers are inserted:

• X-Forwarded-For: Specifies the client IP address of the original HTTP/HTTPS request.

• X-Forwarded-Host: Specifies the “Host” in the HTTP/HTTPS request from the client.

• X-Forwarded-Server: Specifies the host name of the SMA proxy server.

4 Check Restrict Request Headers to strip unrecognized HTTP request headers.

5 Check Enable Flash Rewriting to rewrite URLs contained in Flash files. Rewriting URLs in Flash might 
work only with a few websites. Application Offloading is recommended for unsupported Web sites. This 
feature is disabled by default.

Citrix Service Settings
The administrator needs to host the Citrix clients on a local Web server and have Secure Mobile Access 
download these clients from there. For example, place the following Citrix Receiver clients on the Web server:

• For ActiveX: Receiver for Windows 3.0 – CitrixReceiver.exe 

• For Java: Receiver for Java 10.1 – JICAComponents.zip

To configure Citrix Service Settings, complete the following steps:

1 Select Enable custom URL for Citrix Java client downloads to use your own HTTP URL to download the 
Citrix Java client. Fill-in the custom URL in the URL field. If this option is not enabled, the default URL is 
used.

2 Select Enable custom URL for Citrix ActiveX client downloads to use your own HTTP URL to download 
the Citrix ActiveX client. Fill-in the custom URL in the URL field. If this option is not enabled, the default 
URL is used.
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NetExtender/Mobile Connect Service Settings
1 Enable Compression to reduce file size when desired.

2 Enable verbose NetExtender debug logging. The mcd.log file would be part of Tech Support Reports 
(TSRs) generated from the System > Diagnostics page. Select the default log level from the Log Level 
drop-down menu; levels are listed from lowest to highest:

• Debug

• Info

• Notice – default

• Warning

• Error

All logs adhere to the default level set here unless specifically overridden.

3 To make changes to the logs in the Overrides section, deselect the Adhere to default level checkbox. All 
drop-down menus for all service categories become active.

4 Enable Packet Capture for NetExtender/Mobile Connect connections. Click Download All to download 
all of the saved Packet Captures. Click Delete All to delete all of the saved Packet Captures. Use this 
option for troubleshooting only, as it can affect the throughput adversely. 

5 Based on the Packet Capture Type specified, a unique Pcap file is saved. Select the capture type from the 
Capture Type drop-down menu; types include:

• Per User - Selecting Per User saves a unique Pcap file for each user while Packet Capture is on.

• Per NetExtender Client IP - Selecting Per NetExtender Client IP saves a unique Pcap file for each 
Remote IP assigned by the SMA.

• Per User Session - Selecting Per User Session saves a unique Pcap file for each User Session.

• Per Client IP - Selecting Per Client IP saves a unique Pcap file for each Client IP that originally 
initiated a connection to the SMA.

Mobile Connect Default Policy Settings

Select from the following Mobile Connect default policy settings:

• Allow Open in - Allow a file to be opened in other apps, however, the Mobile Connect policies will not be 
enforced by other apps.

• Allow Copy - Allows portions of the file to be copied onto the clipboard,

• Allow Print - Allows a file to be printed.

• Allow Caching - Allows a file to be cached on the client, stored securely, and encrypted.
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Global Portal Settings

Use the Default Character Set drop-down menu to set the language compatibility character set to be used with 
standard and non-standard FTP servers. The character set only applies to FTP sessions and bookmarks. Standard 
encoding (UTF-8), the default setting, should work for most FTP servers.

European Keyboards
Some European characters cannot be input using US language keyboards. The keyboard type must be set and 
match on the Remote Server, the HTML5 server, or the Local Client computers.

The available keyboards are listed as follows:

To parse the input correctly, set the same language for the HTML5 Canvas (<canvas>) element by clicking the 
language identifier beside the S shield to trigger the language selection menu.

Language Selection Menu
Keep the keyboard language settings consistent between these three areas: 

1 Local client machine

2 HTML5 settings

3 Remote RDP server machine

The Bookmark administrator can set the default language keyboard in the bookmark settings. When the 
bookmark is launched, the default language identifier is shown beside the S shield.
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One Time Password Settings
The One Time Password Settings section allows administrators to configure settings relating to the creation 
and communication of one-time passwords. 

One-time passwords are dynamically generated strings of characters, numbers or a combination of both. For 
compatibility with mail services that allow a limited number of characters in the email subject (such as SMS), 
the administrator can customize the email subject to either include or exclude the one-time password. The 
email message body can also be configured in the same way. The administrator can also select the format (such 
as characters and numbers) for the password. 

To configure the One Time Password email subject format, email body format, and change the 
default character types used when generating one time passwords, complete the following tasks:

1 In the Email Subject field, type the desired text for the one-time password email subject. The default 
subject consists of OTP plus the actual one-time password (represented here with the parameter 
placeholder %OneTimePassword%).

2 In the Email Body field, type the desired text for the one-time password email message body. The 
default message is simply the one-time password itself (represented here as %OneTimePassword%).

Variables can be used in the subject or body of a one-time password email:

• %OneTimePassword% - The user’s one-time password. This should appear at least once in either 
the email subject or body.

• %AD:mobile% - The user’s mobile phone as configured in Active Directory (AD).

• %AD:________% - Any other Active Directory (AD) user attribute. See the Microsoft 
documentation link following the Email Body field for additional attributes.

3 In the One Time Password Format drop-down list, select one of the following three options:

• Characters – Only alphabetic characters are used when generating the one-time password.

• Characters and Numbers – Alphabetic characters and numbers are used when generating the 
one-time password.

• Numbers – Only numbers are used when generating the one-time password.

4 Use the One Time Password Length fields to adjust the range of characters allowed for one-time 
passwords.

5 Click Accept in the lower right corner of the Services > Settings page to save your changes.
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Policy Match Log Settings
The Policy Match Log Settings allows you to access statistic information for policies. Policy Match Log Settings 
logs who matches set policies, where the user is from, and what destination the user is accessing. This 
information is then logged in the Services > Policies page. 

To enable Policy Match Log:

1 Navigate to the Services > Settings page and scroll to Policy Match Log Settings section.

2 Enable Policy Match by selecting the respective check box. 

3 Enable Policy Match for Allow Action allows you to set the server log matched information for Allow 
types. 

4 Enable Policy Match for Deny Action allows you to set the server log matched information for Deny 
types.

5 In the Keep log data field, specify the amount of days you want the data to be kept in the log. The default 
value is 0. 

Services > Bookmarks
The Services > Bookmarks page within the Secure Mobile Access web-based management interface provides a 
single interface for viewing bookmarks and access to configure bookmarks for users and groups. 

Topics: 

• Terminal Services (RDP-HTML5 and Native)

• Terminal Services (RDP-HTML5)

• Virtual Network Computing (VNC-HTML5)

• Citrix Portal (Citrix)
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• Web (HTTP)

• Secure Web (HTTPS)

• External Web Site

• Mobile Connect

• File Shares (CIFS)

• File Transfer Protocol (FTP) and SSH File Transfer Protocol (SFTP)

• Telnet HTML5 Settings

• Secure Shell Version 2 (SSHv2)

To add a bookmark, navigate to the Services > Bookmarks screen within the Secure Mobile Access 
management interface and select Add Bookmark... The Add Bookmark window opens.

To add a service bookmark:

1 Use the Bookmark Owner drop-down menu to select whether the bookmark is owned as a Global 
Bookmark, a LocalDomain Group Bookmark, or a bookmark assigned to an individual User.

2 Specify the Bookmark Name field with a friendly name for the service bookmark.

3 Fill-in the Name or IP Address field with hostname, IP address, or IPv6 address for the desired 
bookmark. IPv6 addresses should begin with “[“ and end with “].” 

4 Use the Service drop-down menu to select the desired bookmark service. Use the following information 
for the chosen service to complete the building of the bookmark.
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Terminal Services (RDP-HTML5 and Native)

1 In the Screen Size drop-down list, select the default terminal services screen size to be used when users 
execute this bookmark.

Because different computers support different screen sizes, when you use a remote desktop application, 
you should select the size of the screen on the computer from which you are running a remote desktop 
session. Additionally, you might want to provide a path to where your application resides on your remote 
computer by typing the path in the Application Path field.

2 In the Colors drop-down list, select the default color depth for the terminal service screen when users 
execute this bookmark. 

3 Optionally, enter the local path for this application in the Application and Path field.

4 In the Start in the following folder field, optionally enter the local folder in which to execute 
application commands. 

5 Select Login as console/admin session to allow login as console or admin. Login as admin replaces login 
as console in RDC 6.1 and newer. 

6 Select Enable wake-on-LAN to enable waking up a computer over the network connection. Selecting 
this check box causes the following new fields to be displayed:

• MAC/Ethernet Address – Enter one or more MAC addresses, separated by spaces, of target hosts 
to wake.

• Wait time for boot-up (seconds) – Enter the number of seconds to wait for the target host to 
fully boot up before cancelling the WOL operation.

• Send WOL packet to host name or IP address – To send the WOL packet to the hostname or IP 
of this bookmark, select Send WOL packet to host name or IP address that can be applied in 
tandem with a MAC address of another machine to wake.

7 Check Server is TS Farm if the bookmark is used to launch a terminal service farm. A terminal service 
bookmark requires the client to have a compatible client installed to connect to the terminal server. 

Terminal Services (RDP-HTML5)
1 In the Screen Size drop-down list, select the default terminal services screen size to be used when users 

execute this bookmark.
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Because different computers support different screen sizes, when you use a remote desktop application, 
you should select the size of the screen on the computer from which you are running a remote desktop 
session. Additionally, you might want to provide a path to where your application resides on your remote 
computer by typing the path in the Application Path field. 

2 In the Colors drop-down list, select the default color depth for the terminal service screen when users 
execute this bookmark. 

3 Select Enable wake-on-LAN to enable waking up a computer over the network connection. Selecting 
this check box causes the following new fields to be displayed:

• MAC/Ethernet Address – Enter one or more MAC addresses, separated by spaces, of target hosts 
to wake.

• Wait time for boot-up (seconds) – Enter the number of seconds to wait for the target host to 
fully boot up before cancelling the WOL operation.

• Send WOL packet to host name or IP address – To send the WOL packet to the hostname or IP 
of this bookmark, select Send WOL packet to host name or IP address that can be applied in 
tandem with a MAC address of another machine to wake.

4 Select Login as console/admin session to allow login as console or admin. Login as admin replaces login 
as console in RDC 6.1 and newer. 

5 Check Server is TS Farm if the bookmark is used to launch a terminal service farm. A terminal service 
bookmark requires the client to have a compatible client installed to connect to the terminal server. 

6 Click Show Advanced Windows options and select the desired check boxes for the following options: 
Desktop background, Menu/window animation, Show window contents while dragging/resizing, 
Redirect clipboard, Redirect ports, Display connection bar, Redirect printers, Remote audio, Auto 
reconnection, Visual styles, Remote copy, Redirect drives, Redirect smartcards, and Bitmap caching.

7 Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the RDP server. Select Use 
custom credentials to enter a custom username, password, and domain for this bookmark. Virtual 
Network Computing (VNC)

8 In the Encoding drop-down menu, select the desired encoding transfer format. Options include Raw, 
RRE, CoRRE, Hextile, Zlib, and Tight.

9 Use the Compression Level drop-down menu to select the desired compression level for data.

10 Select the JPEG image file quality level using the JPEG Image Quality drop-down menu.

11 In the Cursor Shape Updates drop-down menu, select to either Enable, Disable, or Ignore.

12 In the Remote Paste Keys drop-down menu, select either Ctrl + V, Meta + V, or Alt + V.

13 Enable or disable the Use CopyRect function using the associated check box.

14 Enable or disable the use of only Restricted Colors (256 Colors) by using the associated check box.

15 Enable View Only to control to prevent taking control over VNC.

16 Enable Share Desktop to allow desktop view to be shared over VNC.

17 Enable Remote Copy to copy text between the VNC client and the server.

18 Enable the Display Bookmark to Mobile Connect clients option to display your bookmark in Mobile 
Connect clients. Mobile Connect must be running version 2.0 or newer to view and access the Bookmark. 
Support varies by device and could require supported third-party applications being installed. 
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Virtual Network Computing (VNC-HTML5)
To enable Virtual Network Computing:

1 Enable View Only to control to prevent taking control over VNC.

2 Enable Share Desktop to allow desktop view to be shared over VNC.

Citrix Portal (Citrix)
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To enable the Citrix Portal:

1 In the Resource Window Size drop-down list, select the default screen size to be used for Citrix sessions 
when users execute this bookmark.

2 Select to have a Smart or Manual Access Type selection for this bookmark. A new Citrix bookmark is 
Smart by default. The launch sequence is as follows: HTML5, Native, and ActiveX. Selecting Manual 
allows you to change, enable, or disable the Access Type launch methods. 

3 Select Disable client detection by Citrix server to disable the client detection done by the Citrix server 
when using the bookmark. The SMA appliance always completes a Citrix client detection when using 
Citrix. Enabling client detection on the Citrix server makes this client detection redundant.

4 If the Citrix Web server is configured with SSL, to enable SSL encryption for communication between the 
SMA appliance and the Citrix server, select HTTPS Mode.

5 To explicitly set the Citrix ICA server address for the Citrix ICA session, select Always use specified Citrix 
ICA Server and then type the server IP address into the ICA Server Address field. 

6 Some Citrix deployments have the Citrix Web Interface on one IP address and the ICA server listening on 
a different address. If the Citrix Web Interface and Citrix ICA server do not share the same IP address, use 
this setting to explicitly set the ICA server address.

7 Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the Web server. Select Use 
custom credentials to enter a custom username, password, and domain for this bookmark. 

8 Select Display Bookmark to Mobile Connect clients to display this Citrix bookmark in Mobile Connect 
clients. Support varies between devices and could require supported third-party applications to be 
installed. 

9 Select Force MC Secure Web Browser to force Mobile Connect user to utilize the in-app Secure Web 
Browser instead of the configured third-party app. Mobile Connect must be running version 5.0 or newer 
for this option to be in effect. This setting overrides the user setting for HTTP and HTTPS bookmarks, and 
is only available for RDP, VNC, SSH, Telnet, HTTP, HTTPS, and External Website services. 

10 Select Allow Edit URL in Secure Web Browser to allow the user to edit the URL in the Mobile Connect 
Secure Web Browser. Mobile Connect must be running version 5.0 or newer for this option to take effect. 
Enabling this option overrides the Mobile Connect client Bookmark settings for Web Bookmarks 
(HTTP/HTTPS). This setting is only available for HTTP/HTTPS bookmarks.

Web (HTTP)
To set up Web (HTTP):

1 Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the Web server. Select Use 
custom credentials to enter a custom username, password, and domain for this bookmark. For more 
information about custom credentials, 

2 Select Forms-based Authentication to configure Single Sign-On for forms-based authentication. 
Configure the User Form Field to be the same as the ‘name’ and ‘id’ attribute of the HTML element 
representing User Name in the Login form, for example: <input type=text name=’userid’>. Configure the 
Password Form Field to be the same as the ‘name’ or ‘id’ attribute of the HTML element representing 
Password in the Login form, for example: <input type=password name=’PASSWORD’ id=’PASSWORD’ 
maxlength=128>.

3 Select Display Bookmark to Mobile Connect clients to display this bookmark in Mobile Connect clients. 
Support varies between devices and could require supported third-party applications to be installed. 



SonicWall Secure Mobile Access 10.2 Administration Guide
Services Configuration 180

4 Select Force MC Secure Web Browser to force Mobile Connect user to utilize the in-app Secure Web 
Browser instead of the configured third-party app. Mobile Connect must be running version 5.0 or newer 
for this option to be in effect. This setting overrides the user setting for HTTP and HTTPS bookmarks.

5 Select Allow Edit URL in Secure Web Browser to allow the user to edit the URL in the Mobile Connect 
Secure Web Browser. Mobile Connect must be running version 5.0 or newer for this option to take effect. 
Enabling this option overrides the Mobile Connect client Bookmark settings for Web Bookmarks 
(HTTP/HTTPS).

Secure Web (HTTPS)
To set up Web (HTTP):

1 Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the secure Web server. Select Use 
custom credentials to enter a custom username, password, and domain for this bookmark. 

2 Select Forms-based Authentication to configure Single Sign-On for forms-based authentication. 
Configure the User Form Field to be the same as the ‘name’ and ‘id’ attribute of the HTML element 
representing User Name in the Login form, for example: <input type=text name=’userid’>. Configure the 
Password Form Field to be the same as the ‘name’ or ‘id’ attribute of the HTML element representing 
Password in the Login form, for example: <input type=password name=’PASSWORD’ id=’PASSWORD’ 
maxlength=128>.

3 Select Display Bookmark to Mobile Connect clients to display this HTTPS bookmark in Mobile Connect 
clients. Support varies between devices and could require supported third-party applications to be 
installed. 

4 Select Force MC Secure Web Browser to force Mobile Connect user to utilize the in-app Secure Web 
Browser instead of the configured third-party app. Mobile Connect must be running version 5.0 or newer 
for this option to be in effect. This setting overrides the user setting for HTTP and HTTPS bookmarks.

5 Select Allow Edit URL in Secure Web Browser to allow the user to edit the URL in the Mobile Connect 
Secure Web Browser. Mobile Connect must be running version 5.0 or newer for this option to take effect. 
Enabling this option overrides the Mobile COnnect client Bookmark settings for Web Bookmarks 
(HTTP/HTTPS).

External Web Site

To set up an External Web Site:

1 Enable HTTPS mode is to encrypt Web communication by using the SSL protocol.
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2 Select whether you wan to Disable security warning. If this bookmark does not refer to an Application 
Offloaded Web site and this check box is disabled, then a security warning dialog is displayed.

3 Select the option to Automatically log in and enable Virtual Host Domain SSO for this bookmark. If the 
host in the bookmark refers to a portal which has the same shared domain with this portal, it could be 
logged in automatically with this portal’s credential.

4 Select Display Bookmark to Mobile Connect clients to display this External Web Site bookmark in 
Mobile Connect clients. Support varies between devices and could require supported third-party 
applications to be installed. 

5 Select Force MC Secure Web Browser to force Mobile Connect user to utilize the in-app Secure Web 
Browser instead of the configured third-party app. Mobile Connect must be running version 5.0 or newer 
for this option to be in effect. This setting overrides the user setting for HTTP and HTTPS bookmarks.

6 Select Allow Edit URL in Secure Web Browser to allow the user to edit the URL in the Mobile Connect 
Secure Web Browser. Mobile Connect must be running version 5.0 or newer for this option to take effect. 
Enabling this option overrides the Mobile Connect client Bookmark settings for Web Bookmarks.

Mobile Connect
The Mobile Connect bookmark allows a custom bookmark to be defined for display in Mobile Connect after the 
user is connected. This bookmark is meant to support any third-party app, whether an in-house app or a public 
app in the App Store or Google Play. The bookmark also enables calling third-party apps that have defined a 
custom URL scheme, for example ‘comgoogleearth://’ for Google Earth. The Mobile Connect bookmark is only 
available for edit from normal browsers and is intended for use only on mobile devices. 

Enter the Bookmark Name and the Name or IP Address. The Name or IP Address field is the custom URL 
scheme. 

Enable Display Bookmark to Mobile Connect clients to send bookmark information to Mobile Connect 
clients. 

After the Mobile Connect bookmark on Secure Mobile Access is successfully configured, the bookmark displays 
on your mobile device:

NOTE: The Mobile Connect bookmark can also be used for ‘http://’ or ‘https://’ URL schemes, 
however, SonicWall Inc. recommends using HTTP or HTTPS bookmarks for these schemes. 
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The following example of a Mobile Connect bookmark shows how you can create a bookmark using Google 
Earth to display a map with specific directions. 

First, you must create the bookmark with the URL scheme:

This bookmark is now available to access from your mobile device. 

Click the newly added bookmark. For the “Directions to Office” bookmark, a Google Map displays.

The following example shows another way to use the Mobile Connect bookmark. In this example, you add a 
bookmark that launches the Phone app on iOS to make a call to the IT Support Hotline. 
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This bookmark is now available to access from your mobile device. 

Click the newly added bookmark. For the “IT Support Hotline” bookmark, the iOS Phone app begins a call to the 
IT Support Hotline:

File Shares (CIFS) 
To restrict access on the client UI, select Set user to access the specific files/folders. To completely restrict 
access, navigate to the Services > Policies page to set a policy for access constraints. 

Optionally select Automatically log in and select Use SSL-VPN account credentials to forward credentials 
from the current Secure Mobile Access session for log in to the RDP server. Select Use custom credentials to 
enter a custom username, password, and domain for this bookmark. Enable Display Bookmark to Mobile 
Connect clients to send bookmark information to Mobile Connect clients.

When creating a File Share, do not configure a Distributed File System (DFS) server on a Windows Domain Root 
system. Because the Domain Root allows access only to Windows computers in the domain, doing so disables 
access to the DFS file shares from other domains. The SMA appliance is not a domain member and is not able to 
connect to the DFS shares.

NOTE: DFS file shares on a stand-alone root are not affected by this Microsoft restriction.
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File Transfer Protocol (FTP) and SSH File 
Transfer Protocol (SFTP)
Expand Show advanced server configuration to select an alternate value in the Character Encoding 
drop-down list. The default is Standard (UTF-8).

Optionally select Automatically log in and select Use SSL-VPN account credentials to forward credentials 
from the current Secure Mobile Access session for log in to the FTP server. Select Use custom credentials to 
enter a custom username, password, and domain for this bookmark. For more information about custom 
credentials, Enable Display Bookmark to Mobile Connect clients to send bookmark information to Mobile 
Connect clients.

Telnet HTML5 Settings
1 Optionally select Automatically log in and select Use SSL VPN account credentials to forward 

credentials from the current Secure Mobile Access session for log in to the secure Web server. Select Use 
custom credentials to enter a custom username, password, and domain for this bookmark. 

2 Select Display Bookmark to Mobile Connect clients to display this External Web Site bookmark in 
Mobile Connect clients. Support varies between devices and could require supported third-party 
applications to be installed. 

3 Select Force MC Secure Web Browser to force Mobile Connect user to utilize the in-app Secure Web 
Browser instead of the configured third-party app. Mobile Connect must be running version 5.0 or newer 
for this option to be in effect. This setting overrides the user setting for HTTP and HTTPS bookmarks.

4 Select Allow Edit URL in Secure Web Browser to allow the user to edit the URL in the Mobile Connect 
Secure Web Browser. Mobile Connect must be running version 5.0 or newer for this option to take effect. 
Enabling this option overrides the Mobile Connect client Bookmark settings for Web Bookmarks 
(HTTP/HTTPS).

Secure Shell Version 2 (SSHv2)
Use the Secure Shell Version 2 (SSHv2) bookmark option to perform an SSH to a back-end resource:

To edit an SSH to a back-end resource: 

1 Enter Bookmark Name for the SSH.
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2 Enter Name or IP Address. This field accepts host names, IP addresses, and IPv6 addresses. Provide the 
IPv6 address with in the square brackets. You can also use Wildcard variable %USERNAME%. It uses the 
current user name to access. The Wildcard variables are case sensitive.

3 Enter Description to be displayed in the bookmark table. 

4 Enter Categories where the bookmarks should appear, separated by commas. You do not have to specify 
the standard categories including Desktop, Web, Files, Terminal, Mobile, and so on. 

5 Select Service for the Secure Shell Version 2 (SSHv2).

6 Select Default Font Size. The supported font size is in between 12 to 99.

7 Enable the Automatically Accept Host Key if required. 

8 Enable Automatically log in to perform authentication through SSL VPN account credentials, Custom 
Credentials, or Forms-based Authentication. 

9 Enable Display Bookmark in Mobile Connect clients, if required. The mobile connect support for 
displaying bookmarks require the supported third-party applications to be installed, and may vary 
between different platforms. 

Services > Policies
The Services > Policies page within the Secure Mobile Access web-based management interface provides a 
single interface for viewing service policies and access to configure policies for users and groups. 

Topics: 

• Adding a Policy

• Editing a Policy

• Deleting a Policy

• Adding an SMS Template
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Adding a Policy
To add a policy, navigate to the Services > Policies screen within the Secure Mobile Access management 
interface and select Add Policy....

To add a service policy:

1 Use the Policy Owner drop-down menu to select whether the policy is owned as a Global Policy, a Local 
Domain group policy, or a policy assigned to an individual User.

2 In the Apply Policy To drop-down menu, select whether the policy is applied to an individual host, a 
range of network addresses, all addresses, a network object, a server path, or a URL object. You can also 
select an individual IPv6 host, a range of IPv6 addresses, or all IPv6 addresses. The Add Policy dialog box 
changes depending on what type of object you select in the Apply Policy To drop-down list.

3 Complete the appropriate step that follows depending on your selection in the Apply Policy To menu.

• IP Address - If your policy applies to a specific host, enter the IP address of the local host machine 
in the IP Address field. Optionally enter a port range (for example, 4100-4200) or a single port 
number into the Port Range/Port Number field. 

• IP Network - If your policy applies to a range of addresses, enter the beginning IP address in the 
IP Network Address field and the subnet mask that defines the IP address range in the Subnet 
Mask field. Optionally, enter a port range (for example, 4100-4200) or a single port number into 
the Port Range/Port Number field. 

• All Addresses - If your policy applies to all IPv4 addresses, you do not need to enter any IP 
address information. .

• Network Object - If your policy applies to a predefined network object, select the name of the 
object from the Network Object drop-down list. A port or port range can be specified when 
defining a Network Object. 

• Server Path - If your policy applies to a server path, select one of the following radio buttons in 
the Resource field: 
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• Share (Server path) - When you select this option, type the path into the Server Path field.

• Network (Domain list)

• Servers (Computer list)

• URL Object - If your policy applies to a predefined URL object, type the URL into the URL field. 
See .

• All IPv6 Address - If your policy applies to all IPv6 addresses, you do not need to enter any IP 
address information. .

• IPv6 Address - If your policy applies to a specific host, enter the IPv6 address of the local host 
machine in the IPv6 Address field. Optionally enter a port range (for example, 4100-4200) or a 
single port number into the Port Range/Port Number field. IPv6 Network - If your policy applies 
to a range of addresses, enter the beginning IPv6 address in the IPv6 Network Address field and 
the prefix that defines the IPv6 address range in the IPv6 Prefix field. Select the desired Protocol. 
The available value options in the Protocol field include: TCP, UDP, ICMP, and ALL. You can select 
multiple items among TCP, UDP and ICMP. However, when ALL is selected, all others options are 
deselected.

4 Select the service type in the Service drop-down list. If you are applying a policy to a network object, the 
service type is defined in the network object.

5 Select ALLOW or DENY from the Status drop-down list to either allow or deny SMA connections for the 
specified service and host machine.

6 Click Accept to update the configuration. After the configuration has been updated, the new policy is 
displayed in the Services > Policies window.

Editing a Policy

To edit a service-related policy:

1 Navigate to the Services > Policies screen.

NOTE: SonicWall Inc. recommends that administrators set up a Global Deny ALL policy that allows access 
to only trusted hosts. This prevents outbound requests to malicious hosts from Secure Mobile Access. 

To create a Global Deny ALL policy:
1 From the Services > Policy page, click Add Policy.
2 For Policy Owner, select Global Policy from the drop-down list.
3 For Apply Policy To, select All Addresses from the drop-down list.
4 For Policy Name, create a friendly name for this policy, such as “Deny ALL.”
5 Select the desired Protocol. The available value options in the Protocol field include: TCP, UDP, ICMP, 

and ALL. You can select multiple items among TCP, UDP, and ICMP. However, when ALL is selected, all 
others options are deselected.

NOTE: The protocol setting only appears when the Service is set to NetExtender & Mobile Connect or All 
Services.
6 The IP Address Range automatically defaults to All IP Addresses.
7 For Service, select All Services from the drop-down list.
8 For Status, select Deny from the drop-down list. 
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2 Click on the Add icon in the Configure column. A new Edit Policy window opens with the bookmark’s 
current configuration. 

3 Make all desired adjustments.

4 Select Accept. The edited bookmark still displays in the Services > Policies window.

Deleting a Policy
To delete a configured policy:

1 Navigate to the Services > Policies screen. 

2 Click on the delete icon in the Configure column. A dialog box opens and asks if you are sure you want to 
delete the specified policy. 

3 Click OK to delete the policy. The policy no longer appears in the Services > Policies screen.

Adding an SMS Template
You can use this feature to send short message with a one-time password (OTP) code to the users to log in to the 
appliance. 

To add an SMS Template:

1 To add a policy, navigate to the Services > SMS Templates screen within the Secure Mobile Access 
management interface and select SMS Templates.

2 Provide the necessary SMS Template information. Select the SMS Provider. The two providers are Aliyun 
and Twilio. You can add multiple provider templates in the appliance and use them in different domains 
or user levels. 

3 Enter Name.

4 Enter Description for the SMS Template. Select the International check box, if applicable.

5 Enter Access Key ID.

6 Enter Access Key Secret code.

7 Enter Signature Name.

8 Enter Template/Content Code.
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9 You can test the newly created SMS template. Enter Phone Number in the TEMPLATE TEST field, and 
click Test. 

10 Click Accept to confirm the changes.
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Device Management Configuration

This section provides information and configuration tasks specific to the Device Management pages on the 
SonicWall Secure Mobile Access web-based management interface.

Topics: 

• Device Management > Devices

• Device Management > Settings

• Device Management > Policies

Device Management > Devices
SonicWall Secure Mobile Access obtains the client device's unique Device ID. With that information, you can 
view all devices, change device status, and delete unwanted devices. This section provides an overview of the 
Device Management > Devices page. 

Topics: 

• Adding a Device

• Importing a Device

• Exporting Selected Devices

• Deleting Selected Devices

• Approving Selected Devices

• Rejecting Selected Devices
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Adding a Device
The Device Management > Devices page allows you to Add, Import and Export client devices.

To add a new device:

1 Navigate to the Device Management > Devices page and click ADD DEVICE. The Add Device window 
appears.

 

2 In the Add Device window, enter the user name for the user in the User Name field. This is the name the 
user enters in order to log in to the Secure Mobile Access user portal.

3 Select the name of the domain to which the user belongs in the Domain drop-down list.

4 In the OS Type window, enter the device operating system information. Compatible operating systems 
include Windows, Android, and iOS.

5 In the Device ID window, enter the Device ID. 

6 Select the device status from the Status drop-down menu. The available status types are Rejected, 
Approved, and Pending.

7 Click ACCEPT to update the configuration. The new device is displayed on the Device Management > 
Devices page.
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Importing a Device
To import a new device:

1 Navigate to the Device Management > Devices page and click IMPORT DEVICES. The Import Devices 
page appears.

2 Enable Keep device settings if the device has existed to keep device settings. Otherwise the deleted 
device settings are deleted.

3 Under Device Status, select one following devices statuses for the imported device:

• Keep Unchanged - the status of all imported devices will be kept as those in the file.

• Approved - the status of all imported devices will be set to Approved.

• Rejected - the status of all imported devices will be set to Rejected.

• Pending - the status of all imported devices will be set to Pending.

4 Select the file and click Open to import the device.

5 Click UPLOAD to update the configuration. The imported device is displayed on the Device Management 
> Devices page.

Exporting Selected Devices
To export a selected device:

1 Select the check box next to the device user name.

2 Click EXPORT DEVICES. A file with .json extension is saved on your hard drive.
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Deleting Selected Devices
To delete a selected device:

1 Navigate to the Device Management > Devices page.

2 Select the check box next to the device user name and click on the delete icon. The device is 
removed from the table on the Device Management > Devices page.

Approving Selected Devices
To approve a selected device:

1 Navigate to the Device Management > Devices page. 

2 To approve a device, select the check box next to the device user name and click APPROVE (tick 
mark in the above options ). A window appears asking Are you sure you want to approve all of the 
selected devices?

3 Click OK. The device status is listed as Approved on the Device Management > Devices page.

4 Optionally, select Approved from the device Status drop-down menu to approve the device.

Rejecting Selected Devices
To reject a selected device:

1 Navigate to the Device Management > Devices page. 

2 To reject a device, select the check box next to the device user name and click REJECT SELECTED 
DEVICES. A window appears asking Are you sure you want to reject all of the selected devices?
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3 The device status is listed as Rejected on Device Management > Devices page.

4 Optionally, select Rejected from the device Status drop-down menu to reject the device.

Device Management > Settings

Topics: 

• Register Settings

• ActiveSync Provision Settings

• Notification Settings
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Register Settings
You can enforce device registration by enabling the Personal Device Authorization (PDA). It is disabled by 
default.

To register device settings:

1 Enable the Enforce Device Register option. 

2 Select Approve Method. You can set automatic or manual intervention for the policy. The options are 
Auto or Manual. 

3 Enter Maximum Devices per User to set the maximum number of devices allowed for a particular user. 
The value should be in between one to ten.

4 Enter Security Statement to set the statements to make the user decide whether to proceed or decline 
the policy check.

5 Enable Allow logins from apps without device registration capability if required. This option is 
applicable for the devices that do not have the SMA Connect Agent, such as Linux, Android, iOS, and so 
on. 

ActiveSync Provision Settings
ActiveSync Provision Settings can be applied specifically to ActiveSync devices. Provision settings can override 
the settings on a back-end Exchange server. Mobile devices are not able to sync when the Provision settings are 
not satisfied.

Notification Settings
You can list a set of email addresses here. When a new registration request arrives, an email notification is sent 
to these addresses notifying the recipients to handle the request. The notification email's Subject and Message 
can be customized.
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Device Management > Policies
Device policies are global and initially apply to each device register request. The device takes the policy’s defined 
action when matching policies. When unmatched, the device gets it’s status according to the option of the 
approved method. This can reduce the workload of administrator.

There are two types of device policies: Device Id and OS. The Device Id has a higher priority than OS by default.

There are also two Operators: Matches Regex and Equals String. Equals String is case sensitive. Equals String has 
priority to Matches Regex by default.

The Action option has three choices: Reject, Approve, and Pending. The device takes on the defined action 
when it matches the policies.
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Clients Configuration

This section provides information and configuration tasks specific to the Clients pages on the SonicWall Secure 
Mobile Access web-based management interface. 

NetExtender/MobileConnect is a Secure Mobile Access client for Windows, Mac, Linux, or Android smart phone 
users that is downloaded transparently and allows you to run any application securely on the company’s 
network.

It uses Point-to-Point Protocol (PPP). NetExtender/MobileConnect allows remote clients to have seamless 
access to resources on your local network. 

Users can access NetExtender/MobileConnect three ways: Using NetExtender/MobileConnect on the Secure 
Mobile Access user portal, using the Microsoft Installer (MSI), or by using the NetExtender standalone client 
that is installed by clicking one of the NetExtender Clients in the Secure Mobile Access web-based management 
interface. The NetExtender/MobileConnect standalone client application can be accessed directly from the 
Windows Start menu, from the Application folder or dock on Mac systems, by path name or from the shortcut 
bar on Linux systems, and with the icon on Android smart phones. 

The SMA appliance supports client certificates in both the standalone Windows  NetExtender/MobileConnect 
client and the NetExtender/MobileConnect Mobile client.

On Windows systems, NetExtender/MobileConnect supports establishing a VPN session before logging in to 
Windows. NetExtender/MobileConnect supports IPv6 client connections from Windows systems running Vista 
or newer, and from Linux clients. An IPv6 address pool for NetExtender/MobileConnect is optional, while an 
IPv4 address pool is necessary.

Topics: 

• Clients > Status

• Clients > Settings

• Clients > Routes

• Clients > Advanced Settings

• Clients > Log

Clients > Status 
The Clients > Status page allows the administrator to view active NetExtender/MobileConnect sessions, 
including the name, IP address, login time, length of time logged in and logout time. 
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The Clients > Status page allows the administrator to view active NetExtender/MobileConnect sessions, 
including the name, IP address, OS, client, version, and connection duration. 

Clients > Settings 
The Clients > Settings page allows the administrator to specify the client address range.

Topics: 

• Configuring the Global NetExtender/MobileConnect IP Address Range

• Configuring Global NetExtender/MobileConnect Settings

• Configuring Internal Proxy Settings

• Configuring Post-Connection Scripts

Configuring the Global 
NetExtender/MobileConnect IP Address Range
The Clients > Settings page allows the administrator to specify the global client address range. The address 
range can be specified for both IPv4 and IPv6. An IPv6 address pool for NetExtender/MobileConnect is optional, 
while an IPv4 address pool is required. The global NetExtender/MobileConnect IP range defines the IP address 
pool from which addresses is assigned to remote users during NetExtender/MobileConnect sessions. The range 
needs to be large enough to accommodate the maximum number of concurrent NetExtender/MobileConnect 
users you wish to support plus one (for example, the range for 15 users requires 16 addresses, such as 
192.168.200.100 to 192.168.200.115).

The range should fall within the same subnet as the interface to which the SMA appliance is connected, and in 
cases where there are other hosts on the same segment as the SMA appliance, it must not overlap or collide 
with any assigned addresses. You can determine the correct subnet in one of the following ways:

• You can leave the NetExtender/MobileConnect range at the default (192.168.200.100 to 
192.168.200.200).

• Select a range that falls within your existing DMZ subnet. For example, if your DMZ uses the 
192.168.50.0/24 subnet, and you want to support up to 30 concurrent NetExtender/MobileConnect 
sessions, you could use 192.168.50.220 to 192.168.50.250, providing they are not already in use.

Status Item Description

Name The user name.

OS The operating system on which the connection is made (For example, 
Windows 10).

Client Specifies if the client is Windows or Linux.

Version Specifies the version of the NetExtender used. 

User’s Source IP Address The IP address of the workstation which the user is logged into.

Connection Duration The amount of time since the user first established connection with the SMA 
appliance expressed as number of days and hours, minutes, and seconds 
(HH:MM:SS).



SonicWall Secure Mobile Access 10.2 Administration Guide
Clients Configuration 200

• Select a range that falls within your existing LAN subnet. For example, if your LAN uses the 
192.168.168.0/24 subnet, and you want to support up to 10 concurrent NetExtender/MobileConnect 
sessions, you could use 192.168.168.240 to 192.168.168.250, providing they are not already in use.

To specify your global NetExtender/MobileConnect address range using a Static IP:

1 Navigate to the Clients > Settings page.

2 Under Client Address Range, select Use Static Pool from the drop-down list. 

3 Supply a beginning client IPv4 address in the Client Address Range Begin field.

4 Supply an ending client IPv4 address in the Client Address Range End field.

5 Under Client IPv6 Address Range, optionally select Use Static Pool from the drop-down list. 

6 Supply a beginning client IPv6 address in the Client Address Range Begin field.

7 If using IPv6, supply an ending client IPv6 address in the Client Address Range End field.

8 Click Accept.

9 The Status message displays Update Successful. Restart for current clients to obtain new addresses.

To specify your global NetExtender/MobileConnect address range using a DHCP:

1 Navigate to the Clients > Settings page.

2 Under Client Address Range, select Use DHCP from the drop-down list. 

3 Under Select Interface, use the drop-down list to select the interface to use for DHCP.

4 Supply the DHCP Server in the field provided. 
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5 Under Client IPv6 Address Range, optionally select Use DHCP from the drop-down list. 

6 Under Select Interface, use the drop-down list to select the interface to use for DHCPv6.

7 Supply the DHCPv6 Server in the field provided. 

8 Click Accept. 

9 The Status message displays Update Successful. Restart for current clients to obtain new addresses.

Configuring Global NetExtender/MobileConnect 
Settings
The SMA appliance provides several settings to customize the behavior of NetExtender/MobileConnect when 
users connect and disconnect. 

To configure global NetExtender/MobileConnect client settings, complete the following steps:

1 Navigate to the Clients > Settings page. The following options can be enabled or disabled for all users:

• Exit Client After Disconnect - The NetExtender/MobileConnect client exits when it becomes 
disconnected from the SMA server. To reconnect, users have to either return to the Secure Mobile 
Access portal or launch NetExtender/MobileConnect from their Programs menu. This option 
applies to all supported platforms except Android smart phones.

• Uninstall Client After Exit - The NetExtender/MobileConnect client automatically uninstalls 
when the user exits the client user interface. This occurs when the user right-clicks the 
NetExtender/MobileConnect tray icon and selects Exit. To reconnect, users have to return to the 
Secure Mobile Access portal and select NetExtender/MobileConnect to reinstall it. This option 
only applies to Windows clients. It does not apply to Android, Mac, or Linux clients.

• Allow Client to Turn Off Auto Update - The NetExtender/MobileConnect client disables the 
automatic update feature.

• Create Client Connection Profile - The NetExtender/MobileConnect client creates a connection 
profile recording the SMA Server name, the Domain name and optionally the username and 
password.

2 The User Name & Password Caching options provide flexibility in allowing users to cache their 
usernames and passwords in the NetExtender/MobileConnect client. The three options are Allow 
saving of user name only, Allow saving of user name & password, and Prohibit saving of user name 
& password. These options enable administrators to balance security needs against ease of use for 
users.

3 In the Allow client to use Touch ID on IOS devices, the control only blocks future attempts to log in with 
fingerprint technology on IOS devices when the option is disabled as there is no method for the server to 
change the client settings until the client attempts a connection. So in some cases, a client might not be 
conforming to previous policies for the initial connection. Configuration is allowed globally, by group, or 
per user.

4 In the Allow client to use Fingerprint Authentication on Android devices, the control only blocks future 
attempts to log in with fingerprint technology on Android devices when the option is disabled as there is 
no method for the server to change the client settings until the client attempts a connection. So in some 
cases, a client might not be conforming to previous policies for the initial connection. Configuration is 
allowed globally, by group, or per user.

5 In the Allow client to use Touch ID on macOS devices, the control only blocks future attempts to log in 
with fingerprint technology on macOS devices when the option is disabled as there is no method for the 
server to change the client settings until the client attempts a connection. So in some cases, a client 
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might not be conforming to previous policies for the initial connection. Configuration is allowed globally, 
by group, or per user.

6 In the Allow Face ID on iOS devices, the control only blocks future attempts to log in with Face ID 
technology on macOS devices when the option is installed as there is no method for the server to change 
the client settings until the client attempts a connection.

7 In the Disconnect on inactivity timeout, the NetExtender/MobileConnect client disconnects when the 
session reaches predefined inactivity limits. To reconnect, users have to either return to the Secure 
Mobile Access portal or launch NetExtender/MobileConnect from their Programs menu. This option only 
applies to NetExtender Windows client.

8 Click Accept.

Configuring Internal Proxy Settings
NetExtender/MobileConnect supports the provisioning of connections so that all user traffic is routed through a 
designated internal proxy server. After enabling the Internal Proxy feature, users are able to specify which Proxy 
server to use. After NetExtender/MobileConnect connects to the SMA appliance, the internal proxy settings are 
pushed to the client and used as proxy settings for the NetExtender/MobileConnect virtual adapter. 

To configure Internal Proxy settings:

1 Navigate to the Clients > Settings page.

2 Under Internal Proxy Settings, select Enabled for Enable Internal Proxy.

3 Select one of the following for the Internal Proxy Server:

• Automatic Configuration Script—Select this option to set the script to auto configure the proxy.

• Proxy Server—Manually set the proxy server.

• Bypass Proxy—Set the host that is bypassed to the proxy server.

4 Click Accept to save all changes. 

Configuring Post-Connection Scripts
To run post-connection scripts for a Windows, Linux, or Mac system:

1 Navigate to the Clients > Settings page. 

2 Under Post-Connection Scripts, find the operating system you want to run post-connection scripts to. 
Then, select Run a post-connection script for that operating system.

3 Select Run Local File if you have the post-connection script(s) available on your local client machine. 
Select the Run Files for the radio button if you have post-connection script(s) uploaded to the server. 

4 For local files, set the script path on the Run this file field.

5 For local files, set the Command line arguments.
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6 For local files, set the directory in the Working directory field. 

7 For remote files, you can select the Available Files to move into the In Use Files boxes, and vice versa. 
The script files in the In Use Files box runs after the client is connected. 

8 Click Accept to save settings. 
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Clients > Routes
This section provides an overview of the Clients > Routes page and a description of the configuration tasks 
available on this page.

Topics: 

• Clients > Routes Overview

• Adding Clients Routes

Clients > Routes Overview
The Clients > Routes page allows the administrator to add and configure clients routes. 

Adding Clients Routes
The client routes are passed to all NetExtender/MobileConnect clients and are used to govern which private 
networks and resources remote user can access by way of the Secure Mobile Access connection.

Group-level routes should be assigned from both primary and additional groups if the user-level option to Add 
Client Routes is enabled. User-level Routes must always be pushed to the NX client, and global routes must still 
depend on the Add Client Routes option as they did before. IPv4 and IPv6 routes both follow these rules. 

Additional allow and deny policies can be created by destination address or address range and by service type.

To add client routes

1 Navigate to the Clients > Routes page.

2 Select Enabled from the Tunnel All Mode drop-down list to force all traffic for this user—including 
traffic destined to the remote users’ local network—over the Secure Mobile Access 
NetExtender/MobileConnect tunnel.

3 Click Add Client Route. The Add Client Route dialog box displays.
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4 In the Add Client Route dialog box, in the Destination Network field, type the IP address of the trusted 
network to which you would like to provide access with NetExtender/MobileConnect. For example, if you 
are connecting to an existing DMZ with the network 192.168.50.0/24 and you want to provide access to 
your LAN network 192.168.168.0/24, you would enter 192.168.168.0.

You can enter an IPv6 route in the Destination Network field, in the form 2007::1:2:3:0.

5 For an IPv4 destination network, type the subnet mask in the Subnet Mask/Prefix field using decimal 
format (255.0.0.0, 255.255.0.0, or 255.255.255.0). For an IPv6 destination network, type the prefix, such 
as 112.

6 Click Submit.

7 Repeat this procedure for all necessary routes.

Clients > Advanced Settings
The Clients > Advanced Settings page allows you to set traffic log settings and upload post connection script 
files. 

Topics: 

• NetExtender/MobileConnect Traffic Log

• Post Connection Script Files

NetExtender/MobileConnect Traffic Log
Traffic logging allows you log traffic information over the NetExtender/MobileConnect tunnel by enabling the 
Allow logging Nx Traffic. You can configure how many days to keep the log data, where expired data is 
automatically removed. Leave the value as 0 to keep log data forever. View the log data in the Clients > Log 
page.

. 

Enable Mobile Connect Version Check options to provide the build version for the platforms like Windows, iOS, 
macOS, Android, Chrome OS, and so on. This is to qualify the authentication through NetExtender. 
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Post Connection Script Files
Administrators are now able to upload or delete post connection script files for NetExtender/MobileConnect. 
Navigate to the Clients > Advanced Settings page and scroll down to the Post Connection Script Files section. 

Click Choose File to upload a file from your local system. Then, click UPLOAD. After uploaded, the file displays 
in a list. 

To delete a script file, locate the file you want to delete, and click the ‘X’ delete icon. 

Clients > Log
The Clients > Log page allows you to view and search for data logs. If you enabled logging 
NetExtender/MobileConnect traffic on the Clients > Advanced Settings page, you are able to view the data 
logs on this page. 

The following options are available:

• Search—Enter a value you want to search for in the Logs, then click Search. Optionally, you can select a 
specific field in the drop-down list to narrow your search:

• All Fields 

• User

• Domain 

• From

• Platform

• Login Time

• Sent

• Received

• Exclude—Excludes the value you has specified in the search.

• Reset—Clears the search field as well as any search results. 
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End Point Control

This section provides information and configuration tasks specific to the End Point Control pages on the 
SonicWall Secure Mobile Access web-based management interface. 

Topics: 

• End Point Control > Status

• Configuring End Point Control Settings

• Configuring EPC Device Profiles

End Point Control > Status
The End Point Control > Status page allows you to configure auto updates, view the current EPC version being 
used, update the EPC version, and the service expiration date.

1 Select Allow auto update to enable the OPSWAT to update automatically.

2 The Installed version displays the current version being used.

3 Click Check Update to instantly query if there are any available updates. If there is a new update 
available, the button changes to Apply Update. 

4 The Service Expiration Date displays when the current service expires.

5 Click Revert To to apply the previous version of the service. End Point Control > Settings

Configuring End Point Control Settings
In traditional VPN solutions, accessing your network from an untrusted site like an employee-owned computer 
or a kiosk at an airport or hotel increases the risk to your network resources. The SMA/SRA appliance provides 
secure access from any Web-enabled system, including devices in untrusted environments. Secure Mobile 
Access supports End Point Control (EPC), a default service available on SMA 400/200, SRA 4600/1600, and SMA 
500v Virtual Appliance.

EPC verifies that the user’s environment is secure before establishing a connection. EPC protects sensitive data 
and ensures that your network is not compromised when accessed from devices in untrusted environments. EPC 
also protects the network from threats originating from client devices participating in the SMA. 

EPC is checked when users log in to the web portal from a web browser that blocks any access to the private 
network from untrusted sites. The EPC portal checking process uses the browser plug-ins on your system.

EPC is supported on iOS and Android mobile devices using Mobile Connect, allowing device profiles to be 
created for these mobile devices. This provides security protection from threats against client devices and 
protection to the SMA/SRA appliance from threats originating from client devices participating in the SSL VPN. 
For more information on Mobile Connect, refer to the Mobile Connect User Guides. 
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Secure Mobile Access provides these end point security controls by completing host integrity checking and 
security protection mechanisms before a tunnel session is begun. Host integrity checks help ensure that the 
client system is in compliance with your organization’s security policy. SonicWall Inc. end point security controls 
are tightly integrated with access control to analyze the client system and apply access controls based on the 
results. 

EPC supports the Windows, Linux, and NetExtender client. It also supports Mobile Connect for iOS, Android, 
OSX, Windows Phone, and Windows Next. For Web Portal login, EPC is supported only on Windows platforms. 
EPC enhancements are supported on the SonicWall Inc. SMA 400/200, SRA 4600/1600, and SMA 500v Virtual 
Appliance platforms.

EPC is globally enabled or disabled on the End Point Control > Settings page. When EPC is disabled, it is disabled 
at the global, group, and user level. The Settings page also is used to customize the message displayed when a 
NetExtender client login fails EPC security checking.

Configuring EPC Device Profiles
Create device profiles to configure authentication guidelines for users or groups of users based on various 
global, group, or user attributes. For example, you can select groups that use an Antivirus program or users with 
a specific Windows version.

Two kinds of profiles are available: Allow profiles and Deny profiles. Allow profiles identify attributes of the 
client’s network that must be present before a user is authenticated, and Deny profiles identify attributes of the 
network that cannot be present. If multiple profiles are defined for a group or user, connection to the SMA 
appliance is granted only when a client’s environment fulfills all Allow profiles for the group or user and does 
not fulfill any Deny profiles. 

NOTE: When the EPC feature is active other features might run slower because of the increased traffic. 
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The End Point Control > Device Profiles page lists all device profiles and identifies the platform where the 
profile can be used. This page also contains buttons that allow you to add, edit, or delete profiles. Hover the 
mouse over an icon or button to identify it.
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To create a device profile:

1 On the End Point Control > Device Profiles page, click Add Device profile.

2 In the Name field, type the name that is used to identify the profile.

3 In the Description field, optionally type a brief description of the profile that helps identify the profile.

4 Select whether the profile is being created for Windows, Mac, Linux, iOS, or Windows & Android 
Phone clients.

5 Click  to add the device profile. 

6 Use the Type drop-down list to select the attribute used to select users. The options are Antivirus 
program, Antimalware, Personal firewall program, Client certificate, Application, Directory name, File 
name, registry entry details, Domain, Version, Equipment ID, and Windows Patches. You should select 
the remaining fields on this page, as the fields vary based on your selection of the type. 

7 Click Add to current attribute. Repeat 5 & 6 for each attribute that should be included in the profile.

8 You can optionally enter a custom message that shows the user the EPC check has failed. The 
Administrator could enter text to indicate how to fix the issue or the reason the policy failed.

9 To complete the profile, click Accept at the upper right of the page.

10 To edit the Device profile click on the edit.

11 Click on Submit on the lower right to save your changes.
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Users > Local Groups > Edit EPC Settings
After creating device profiles, assign them to the local groups that uses them to authenticate users. Device 
profiles can be Allow profiles and Deny profiles. Allow profiles identify attributes of the client’s network that 
must be present before a user is authenticated, and Deny profiles identify attributes of the network that cannot 
be present. If multiple profiles are defined for a group, connection to the SMA/SRA appliance is granted only 
when a client’s environment fulfills all Allow profiles for the group and does not fulfill any Deny profiles. Use 
the EPC page on the Users > Local Groups > Edit page to assign device profiles to a group.

NetExtender login can be disabled on platforms where EPC is enabled. 

EPC portal checking uses the NetExtender browser plug-in. EPC is checked when users log in to the web portal 
from a web browser that blocks any access to the private network from untrusted sites. 

To configure device profiles to be used when authenticating users in a local group:

1 Navigate to the Users > Local Groups page and click  Edit for the Global group or a local group to be 
configured for EPC.

2 When the Edit Local Group page appears, go to the EPC settings section. Use the EPC page to enable or 
disable EPC for the group, select how to handle authentication requests from unsupported clients, and to 
add or remove device profiles.

3 In the Enable EPC field, select Enabled to enable EPC for the group, Disabled to disable EPC for the 
group, or Use Global Settings to either enable or disable EPC based on whether EPC is enabled on the 
Users > Local Users > Edit Global Policies or Users > Local Groups > Edit Global Policies page.

4 In the Allow Web Login On Device Without EPC field, set the default action to Enabled to allow, 
Disabled to block logins from these portals when EPC is enabled, or Use Global Settings.

5 EPC is supported for iOS and Android mobile clients. In the Allow Login From MobileConnect Without 
EPC field, set the default action to Enabled to allow or Disabled to block logins from these clients when 
EPC is enabled, or Use Global Settings.

6 Fields in the Recurring EPC section vary, depending on whether you are configuring EPC for the Global 
group or a local group. To configure EPC for the Global group, select Check at login to do EPC checks only 
when users login, or select Check Periodically to also do EPC checks at set intervals. For example, to do 
EPC checks whenever a user logs in and every x minutes thereafter while the user is logged in, select 
Check Periodically and type the number of minutes to wait between EPC checks.

OR

To configure EPC for a local group, select Use Global Settings or Custom Settings from the Recurring 
EPC drop-down list. If you select Use Global Settings, the local group inherits the EPC settings from the 
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Global group. If you select Custom Settings, the Check at login and Check Periodically prompts are 
displayed and you can configure EPC, as explained for the Global group.

7 Either select Inherit global device profiles to use all defined Allow and Deny device profiles for the 
group.

OR

Add or remove profiles using the Edit EPC page:

a To add an Allow profile for the group, click Add Profile below the Allow Profiles heading.

b Select the profiles from the Available Profiles list that you want to add to the group and click Add. 
Selected profiles are then moved to the Allow Profiles list on the page that lists all device profiles 
that are used for the group.

c To remove an Allow profile from the group, select the profile from the Allow Profiles list and click 
the delete icon. 

d To add a Deny profile for the group, click Add Profiles below the Deny Profiles heading and follow 
the preceding steps b and c.

8 Click Accept to save your changes.
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Users > Local Users > Edit EPC Settings
After creating device profiles, assign them to the local users. Device profiles can be Allow profiles and Deny 
profiles. Allow profiles identify attributes of the client’s network that must be present before a user is 
authenticated, and Deny profiles identify attributes of the network that cannot be present. If multiple profiles 
are defined for a user, connection to the SMA/SRA appliance is granted only when a client’s environment fulfills 
all Allow profiles for the user and does not fulfill any Deny profiles. Use the EPC page on the Users > Local Users 
> Edit page to assign device profiles to a user.

NetExtender login can be disabled on platforms where EPC is enabled.

To configure device profiles to be used when authenticating a local user:

1 Navigate to the Users > Local Users page and click  Edit for the user to be configured for EPC.

2 When the Edit Local Userpage appears, go to the EPC settings section. Use the EPC page to enable or 
disable EPC for the user, select how to handle authentication requests from unsupported clients, and to 
add or remove device profiles.

3 In the Enable EPC field, select Enabled to enable EPC for the user, Disabled to disable EPC for the user, 
or Use Global Settings to either enable or disable EPC based on whether EPC is enabled on the End 
Point Control > Settings page.
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4 In the Allow Web Login On Device Without EPC field, set the default action to Enabled to allow, 
Disabled to block logins from these portals when EPC is enabled, or Use Global Settings.

5 EPC is supported for iOS and Android mobile clients. In the Allow Login From MobileConnect Without 
EPC field, set the default action to Enabled to allow or Disabled to block logins from these clients when 
EPC is enabled, or Use Global Settings.

6 In the Specify how often EPC checks should be done on client systems section, configure when EPC 
checks should be conducted. Select Check at login to do EPC checks only when users login, or select 
Check Periodically to also do EPC checks at set intervals. For example, to do EPC checks whenever a user 
logs in and every x minutes thereafter while the user is logged in, select Check Periodically and type the 
number of minutes to wait between EPC checks.

7 Fields in the Specify how often EPC checks should be done on client systems section vary, depending 
on whether you are configuring EPC for the Global group or a local user. To configure EPC for the Global 
group, select Check at login to do EPC checks only when users login, or select Check Periodically to also 
do EPC checks at set intervals. For example, to do EPC checks whenever a user logs in and every x 
minutes thereafter while the user is logged in, select Check Periodically and type the number of 
minutes to wait between EPC checks.

OR

To configure EPC for a local user, select Use Global Settings or Custom Settings from the Recurring EPC 
drop-down list. If you select Use Global Settings, the local user inherits the EPC settings from the Global 
group. If you select Custom Settings, the Check at login and Check Periodically prompts are displayed 
and you can configure EPC, as explained for the Global group.

8 Either select Inherit global device profiles to use all defined Allow and Deny device profiles for the user.

OR

Add or remove profiles using the Edit EPC page:

a To add an Allow profile for the user, click Add Profile below the Allow Profiles heading.

b Select the profiles from the Available Profiles list that you want to add to the user and click Add. 
Selected profiles are then moved to the Allow Profiles list on the page that lists all device profiles 
that are used for the user.

c To remove an Allow profile from the user, select the profile from the Allow Profiles list and click 
the delete icon. 

d To add a Deny profile for the user, click Add Profiles below the Deny Profiles heading and follow 
the preceding steps b and c.

9 Click Accept to save your changes.
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End Point Control > Status
The End Point Control > Status page allows you to configure auto updates, view the current EPC version being 
used, update the EPC version, and the service expiration date.

End Point Control > Status

1 Select Allow auto update to enable the OPSWAT to update automatically.
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2 The Installed version displays the current version being used.

3 Click Check Update to instantly query if there are any available updates. If there is a new update 
available, the button changes to Apply Update. 

4 The Service Expiration Date displays when the current service expires.

5 Click Previous Settings to apply the previous version of the service. 



SonicWall Secure Mobile Access 10.2 Administration Guide
Web Application Firewall Configuration

10

217

Web Application Firewall
Configuration

This section provides information and configuration tasks specific to the Web Application Firewall pages on 
the SonicWall Secure Mobile Access (web-based management interface). 

Topics: 

• Viewing and Updating Web Application Firewall Status

• Configuring Web Application Firewall Settings

• Configuring Web Application Firewall Signature Actions

• Configuring Custom Rules and Application Profiling

• Using Web Application Firewall Monitoring

• Licensing Web Application Firewall

Web Application Firewall is subscription-based software that runs on the SMA appliance and protects Web 
applications running on servers behind the SMA. A Web Application Firewall also provides real-time protection 
for resources such as HTTP(S) bookmarks, Citrix bookmarks, offloaded Web applications, and the Secure Mobile 
Access management interface and user portal that run on the SMA appliance itself.

Viewing and Updating Web Application 
Firewall Status
The Web Application Firewall > Status page provides status information about the Web Application Firewall 
service and signature database, and displays the license status and expiration date. Synchronize allows you to 
download the latest signatures from the SonicWall Inc. online database. You can use Download to generate and 
download a PCI compliance report file.

Topics: 

• Viewing Status and Synchronizing Signatures

• Downloading a PCI Compliance Report
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Viewing Status and Synchronizing Signatures
To view the status of the signature database and Web Application Firewall service license, and 
synchronize the signature database:

1 Navigate to Web Application Firewall > Status. The WAF Status section displays the following 
information:

• Status of updates to the signature database

• Timestamp of the signature database

• Time that the system last checked for available updates to the signature database 

• Expiration date of the Web Application Firewall subscription service

• Status of the Web Application Firewall license

2 If updates are available for the signature database, Apply is displayed. Click Apply to download the 
updates.

You can select an option to update and apply new signatures automatically on the Web Application 
Firewall > Settings page. If this automatic update option is enabled, Apply disappears from the Web 
Application Firewall > Status screen as soon as the new signatures are automatically applied.
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Downloading a PCI Compliance Report
To download a PCI DSS 6.5/6.6 compliance report:

1 Navigate to Web Application Firewall > Status.

2 Click Download.

3 In the File Download dialog box, click Open to create the PCI report as a temporary file and view it with 
Adobe Acrobat, or click Save to save the report as a PDF file.
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Configuring Web Application Firewall 
Settings
The Web Application Firewall > Settings page allows you to enable and disable Web Application Firewall on 
your SMA appliance globally and by attack priority. You can individually specify detection or prevention for three 
attack classes: high, medium, and low priority attacks. 

This page also provides configuration options for other Web Application Firewall settings. The following sections 
describe the procedures for enabling and configuring Web Application Firewall settings:

• Enabling Web Application Firewall and Configuring General Settings

• Configuring Global Exclusions

• Configuring Intrusion Prevention Error Page Settings

• Configuring Cross-Site Request Forgery Protection Settings

• Configuring Cookie Tampering Protection Settings

• Configuring Web Site Cloaking

• Configuring Information Disclosure Protection

• Configuring Session Management Settings

Enabling Web Application Firewall and 
Configuring General Settings
To enable and activate Web Application Firewall, you must select the check box to globally enable it and select 
at least one of the check boxes in the Signature Groups table. The settings in the General Settings section on this 
page allow you to globally manage your network protection against attacks by selecting the level of protection 
for high, medium, or low priority attacks. You can also clear Global Enable Web Application Firewall to 
temporarily disable Web Application Firewall without losing any of your custom configuration settings.

You can enable automatic signature updates in the General Settings section, so that new signatures are 
automatically downloaded and applied when available. A log entry is generated for each automatic signature 
update. If a signature is deleted during automatic updating, its associated Exclusion List is also removed. A log 
entry is generated to record the removal. You can view the log entries on the Web Application Firewall > Log 
page.
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To configure global settings for Web Application Firewall:

1 On the Web Application Firewall > Settings page, expand the General Settings section.

2 Select Enable Web Application Firewall.

3 A warning dialog box is displayed if none of the signature groups have Prevent All already selected. Click 
OK in the dialog box to set all signature groups to Prevent All, or click Cancel to leave the settings as 
they are or to manually continue the configuration.

4 Select Apply Signature Updates Automatically to enable new signatures to be automatically 
downloaded and applied when available. You do not have to click Apply on the Web Application Firewall 
> Status page to apply the new signatures.

5 Select the desired level of protection for High Priority Attacks in the Signature Groups table. Select one 
of the following options:

• Select Prevent All to block access to a resource when an attack is detected. Selecting Prevent All 
automatically selects Detect All, turning on logging. 

• Clear Prevent All and select Detect All to log attacks while allowing access to the resource. 

• To globally disable all logging and prevention for this attack priority level, clear both check boxes.

6 Select the desired level of protection for Medium Priority Attacks in the Signature Groups table.

7 Select the desired level of protection for Low Priority Attacks in the Signature Groups table.

8 When finished, click Accept.

Configuring Global Exclusions
There are three ways that you can exclude certain hosts from currently configured global Web Application 
Firewall settings. You can completely disable Web Application Firewall for certain hosts, you can lower the 
action level from Prevent to Detect for certain hosts, or you can set Web Application Firewall to take no action.

The affected hosts must match the host names used in your HTTP(S) bookmarks and Citrix bookmarks, and the 
Virtual Host Domain Name configured for an offloaded Web application.

To configure global exclusions:

1 On the Web Application Firewall > Settings page, expand the General Settings section.

2 Click Global Exclusions.
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3 In the Edit Global Exclusions page, the action you set overrides the signature group settings for the 
resources configured on these host pages. Select one of the following from the Action drop-down list:

• Disable – Disables Web Application Firewall inspection for the host.

• Detect – Lowers the action level from prevention to only detection and logging for the host.

• No Action – Web Application Firewall inspects host traffic, but takes no action.

4 In the Host field, type in the host entry as it appears in the bookmark or offloaded application. This can 
be a host name or an IP address. Up to 32 characters are allowed. To determine the correct host entry for 
this exclusion, 

5 You can configure a path to a particular folder or file along with the host. The protocol, port, and the 
request parameters are simply ignored in the URL. If a path is configured, then the exclusion is recursively 
applied to all subfolders and files. For instance, if Host is set to webmail.company.com/exchange, then 
all files and folders under exchange are also excluded.

6 Click + to move the host name into the list box.

7 Repeat the process to add more hosts to this exclusion.

8 When finished, click Accept. 

Configuring Intrusion Prevention Error Page 
Settings
To configure the error page to use when intrusions are detected:

1 Click on the Intrusion Prevention Error Page Settings tab section.

2 In the Intrusion Prevention Response drop-down list, select the type of error page to be displayed 
when blocking an intrusion attempt.

3 To create a custom page, select Custom Intrusion Prevention Page and modify the sample HTML in the 
text box. 

4 To view the resulting page, click Preview.

5 To reset the current customized error page to the default error page, click Default Blocked Page and 
then click OK in the confirmation dialog box.

6 If you do not want to use a customized error page, select one of the following for the error page:
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• HTTP Error Code 400 Bad Request

• HTTP Error Code 403 Forbidden

• HTTP Error Code 404 Not Found

• HTTP Error Code 500 Internal Server Error

7 When finished, click Accept.

Configuring Cross-Site Request Forgery 
Protection Settings
Cross-Site Request Forgery (CSRF) is configured independently for each Application Offloading portal. It provides 
a seamless solution and results in less false positives. Optionally, you can select the original Protection Method, 
URL Rewrite-based Protection Method.

To configure the settings for CSRF protection with the URL Rewrite-based Protection Method:

1 Navigate to Cross-Site Request Forgery (CSRF/XSRF) Protection section.

2 In the Portals drop-down list, select the Portal to which these CSRF protection settings apply. To make 
these CSRF settings the default for all portals, select Global.

3 For Protection Mode, select the desired level of protection against CSRF attacks. You can select Detect 
Only to log these attacks, or Prevent to log and block them. Select Disabled to disable CSRF protection 
on the portal.

4 When finished, click Accept.
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Configuring Cookie Tampering Protection 
Settings
Cookie tampering protection is configured independently for each Application Offloading portal. 

To configure the settings for cookie tampering protection:

1 Navigate to the Cookie Tampering Protection section.

2 To make these cookie tampering settings the default for all portals, select Global.

3 For Tamper Protection Mode, select the desired level of protection against cookie tampering. You can 
select Detect Only to log these attacks, or Prevent to log and block them. Select Disabled to disable 
cookie tampering protection on the portal.

4 For Encrypt Server Cookies, select Name to encrypt cookie names, and/or select Value to encrypt 
cookie values. This affects client-side script behavior because it makes cookie names or values 
unreadable. Only server-side cookies are encrypted by these options.

5 For Cookie Attributes, select Http Only to append the Http Only attribute to server-side cookies, and/or 
select Secure to append the Secure attribute to server-side cookies. The attribute Http Only prevents the 
client-side scripts from accessing the cookies that are important in mitigating attacks such as Cross Site 
Scripting and session hijacking. The attribute Secure ensures that the cookies are transported only in 
HTTPS connections. Both together add a strong layer of security for the server-side cookies.

6 For Client Cookies, select Allow if an application on the portal needs all of the client cookies. When 
disabled, client-side cookies are not allowed to be sent to the backend systems. This option does not 
affect server-side cookies.

7 For the Exclusion List, select Enabled to display additional fields for configuration.



SonicWall Secure Mobile Access 10.2 Administration Guide
Web Application Firewall Configuration 225

8 To enter a custom cookie name and path to the Exclusion List, click in the Cookie Name field to type in 
the name of the cookie, and click in the Cookie Path field to type in the path. Then click > Add.

9 To add one or more already-detected cookies to the Exclusion List, select the desired cookies in the 
Detected Cookies list, holding the Ctrl key while clicking multiple cookies, and then click < Add to add 
them to the Exclusion List.

10 To remove cookies from the Exclusion List, select the cookies to be removed and then click Remove.

11 To clear the Detected Cookies list, click Clear.

12 When finished, click Accept.

Configuring Web Site Cloaking
Under Web Site Cloaking, you can filter out headers in response messages that could provide information to 
clients about the backend Web server that could possibly be used to find a vulnerability. 
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To configure Web site cloaking:

1 Expand the Web Site Cloaking section.

2 In the Block Response Header fields, select Manual and type the server host name into the first field 
and type the header name into the second field, then click Add.

For example, if you set the host name to “webmail.xyz.com” and the header name to “X-OWA-version,” 
headers with the name “X-OWA-version” from host “webmail.xyz.com” is blocked. In general, listed 
headers are not sent to the client if an HTTP/HTTPS bookmark or off-loaded application is used to access 
a listed Web server.

To block a certain header from all hosts, set the host name to an asterisk (*). You can add up to 64 
host/header pairs. In the HTTP protocol, response headers are not case-sensitive.

3 To remove a host/header pair from the list to be blocked, select the pair in the text box and then click 
Delete.

4 When finished, click Accept.

Configuring Information Disclosure Protection
Under Information Disclosure Protection, you can protect against inadvertent disclosure of credit card and 
Social Security numbers (SSN) in HTML Web pages. You can also enter confidential text strings that should not 
be revealed on any Web site protected by Web Application Firewall. 

To configure information disclosure protection:

1 Expand the Information Disclosure Protection section. The table contains a row for each possible 
pattern or representation of a social security number or credit card number that Web Application 
Firewall can detect in the HTML response.

2 Select Enable Credit Card/SSN Protection.

3 In the Mask Character drop-down list, select the character to be substituted when masking the SSN or 
credit card number.
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4 In the table, select the level of protection desired for each representation of a SSN or credit card number. 
You can select one of the following in each row:

• Disabled – Do not match numbers in this format. No logging or masking is done.

• Detect – Detect numbers in this format and create a log entry when detected.

• Mask Partially – Substitute the masking character for the all digits in the number, except the last 
few digits such that the confidentiality of the number is still preserved.

• Mask Fully – Substitute the masking character for all digits in the number.

• Block – Do not transmit or display the number at all, even in masked format.

5 Below the table, in the Block sensitive information within HTML pages text box, type confidential text 
strings that should not be revealed on any Web site protected by Web Application Firewall. This text is 
case insensitive, can include any number of spaces between the words, but cannot include wildcard 
characters. Add new phrases on separate lines. Each line is pattern matched within any HTML response.

6 When finished, click Accept.

Configuring Session Management Settings
Under Session Management, you can control whether the logout dialog window is displayed when a user logs 
into the user portal or into an application offloaded portal. You can also set the inactivity timeout for users in 
this section.

To configure session management settings:

1 Expand the Session Management section.

2 Select Launch Logout Dialog Window after Login to display the session logout popup dialog box when 
the user portal is launched or when a user logs into an application offloaded portal. 

3 When finished, click Accept.

Configuring Web Application Firewall 
Signature Actions
The Web Application Firewall > Signatures page allows you to configure custom handling or exclusion of certain 
hosts on a per-signature basis. You can use signature-based exclusions to apply exclusions for all hosts for each 
signature.
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You can also revert back to using the global settings for the signature group to which this signature belongs 
without losing the configuration details of existing exclusions.

The list of signatures can be sorted by the contents of any column in ascending or descending order by clicking 
the column heading. In addition, signatures can be divided into pages and filtered by searching for a key word. 
To display only signatures containing a key word in all fields or a specific field, type the key word in the Search 
field, select All Fields or a specific field to search, and click Search. Or, click Exclude to display only signatures 
that do not contain the key word. Click Reset to display all signatures. All matches are highlighted. The default is 
50 signatures per page.

On the Web Application Firewall > Settings page, global settings must be set to either Prevent All or Detect All 
for the Signature Group to which the specific signature belongs. If neither is set, that Signature Group is globally 
disabled and cannot be modified on a per-signature basis. 

Topics: 

• Enabling Performance Optimization

• Configuring Signature Based Custom Handling and Exclusions

• Reverting a Signature to Global Settings

• Removing a Host from a Per-Signature Exclusion

Enabling Performance Optimization
The Performance Optimization option allows you to disable some relatively less severe signatures that 
significantly affect the performance of certain Web applications. These signatures are identified by the 
SonicWall Inc. signature team and the list is pushed out to SMA appliances. When you select Enable 
Performance Optimization, these signatures are disabled for Web Application Firewall. 
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Configuring Signature Based Custom Handling 
and Exclusions
You can disable inspection for a signature in traffic to an individual host, or for all hosts. You can also change the 
handling of detected threats for an individual host or for all hosts. If the signature group to which the signature 
belongs is set globally to Detect All, you can raise the level of protection to Prevent for the configured hosts. If 
no hosts are configured, the action is applied to the signature itself and acts as a global setting for all hosts. This 
change blocks access to a host when the attack signature is detected. Similarly, you can lower the level of 
protection to Detect if the associated signature group is globally set to Prevent All.

To configure one or more hosts with an exclusion from inspection for a signature, or to configure 
custom handling when Web Application Firewall detects a specific signature for one or more hosts, 
complete the following steps:

1 On the Web Application Firewall > Signatures page, click Configure  for the signature that you wish 
to change. The Edit WAF Signature-based Exclusions screen displays.

2 In the Edit WAF Signature-based Exclusions screen, select one of the following actions from the Action 
drop-down list: 

• DISABLE – Disable Web Application Firewall inspections for this signature in traffic from hosts 
listed in this exclusion

• DETECT – Detect and log threats matching this signature from hosts listed in this exclusion, but do 
not block access to the host

• PREVENT – Log and block host access for threats matching this signature from hosts listed in this 
exclusion

• Inherit Global- Allows to inherit the global settings and inspect on any threats involved.

3 To apply this action globally to all hosts, leave the Host field blank. To apply this action to an individual 
host, type the host entry as it appears in the bookmark or offloaded application into the Host field. This 
can be a host name or an IP address. 

4 You can configure a path to a particular folder or file along with the host. The protocol, port, and the 
request parameters are simply ignored in the URL. If a path is configured, then the exclusion is recursively 
applied to all subfolders and files. For instance, if Host is set to webmail.yourcompany.com/exchange, 
then all files and folders under exchange are also excluded.

5 If you specified a host, click Add to move the host name into the list box.
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6 Click Accept. If the Host list contains host entries, Secure Mobile Access verifies that each host entry is 
valid. If no hosts were specified, a dialog box confirms that this is a global action to be applied to the 
signature itself.

7 Click OK in the confirmation dialog box.

8 Click Accept on the Web Application Firewall > Signatures page to apply the updated settings. New 
settings are applied to any new HTTP connections and requests. The existing HTTP connections and 
requests continues to use the old settings until they are terminated.

Reverting a Signature to Global Settings
You can revert to using global signature group settings for a signature that was previously configured with an 
exclusion, without losing the configuration. This allows you to leave the host names in place in case you need to 
re-enable the exclusion.

To revert to using global signature group settings for a signature:

1 On the Web Application Firewall > Signatures page, click Configure  for the signature that you wish 
to change.

2 In the Edit WAF Signature-based Exclusions screen, select INHERIT GLOBAL from the Action drop-down 
list.

3 The Host field might be blank if global settings were previously applied to this signature. To revert to 
global signature settings for all hosts, leave the Host field blank. To apply this action to one or more 
individual hosts, leave these host entries in the Host field and remove any host entries that are not to be 
reverted.

4 Click Accept. Secure Mobile Access verifies that each host entry is valid.

5 Click OK in the confirmation dialog box.

6 Click Accept on the Web Application Firewall > Signatures page to apply the updated settings. New 
settings are applied to any new HTTP connections and requests. The existing HTTP connections and 
requests continue to use the old settings until they are terminated.

Removing a Host from a Per-Signature Exclusion
To remove a host from a configured exclusion for a signature:

1 On the Web Application Firewall > Signatures page, click Configure  for the signature that you wish 
to change.

2 Select the host entry in the list box under the Host field, and then click Remove.

3 Click Accept. Secure Mobile Access verifies that each host entry is valid.

4 Click OK in the confirmation dialog box.

5 Click Accept on the Web Application Firewall > Signatures page to apply the updated settings. New 
settings are applied to any new HTTP connections and requests. The existing HTTP connections and 
requests continue to use the old settings until they are terminated.
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Configuring Custom Rules and Application 
Profiling
The Web Application Firewall > Rules page allows you to configure custom rules and application profiling. 

Application profiling allows you to generate custom rules in an automated manner based on a trusted set of 
inputs acceptable by an application. Other inputs are denied, providing a positive security enforcement. You can 
use this feature for profiling the websites accessed through SMA100 WAF, and record all the selected content 
type to generate the WAF rules automatically.

When you place the SMA appliance in learning mode in a staging environment, it learns valid inputs for each 
URL accessed by the trusted users. At any point during or after the learning process, custom rules can be 
generated based on the “learned” profiles. Custom rules created on this page have all the same properties as 
the signatures that SonicWall Inc. pushes out to Web Application Firewall-enabled appliances. 

To add a rule manually, you create a rule chain and then add rules within it. A rule chain is a collection of rules 
and includes additional attributes such as the severity rating, name, description, hit counters for rate limiting, 
and the action to take when the rule chain matches some traffic. 

Rules in the Web Application Firewall > Rules page can be divided into pages and filtered by searching for a key 
word. To display only rules containing a key word in all fields or a specific field, type the key word in the Search 
field, select All Fields or a specific field to search, and click Search. Or, click Exclude to display only rules that do 
not contain the key word. Click Reset to display all rules. All matches are highlighted. The default is 50 rules per 
page.

Custom rules and rule chains can be used to distinguish between legitimate and illegitimate traffic as defined by 
a Web application that is using a certain URI or running on a certain portal. One rule in the chain is configured to 
match the URI or portal host name, while another rule is created that matches an undesirable value for another 
element of the HTTP(S) traffic. When the rule chain (both rules) matches some traffic, the configured action is 
done to block or log the bad traffic from that URI or portal. When the request is blocked, the user sees a custom 
block page.

The Web Application Firewall > Monitoring page also shows the activity in the graphs. 
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Rules are matched against both inbound and outbound HTTP(S) traffic. When all rules in a rule chain find a 
match, the action defined in the rule chain is done. You can also enable rate limiting in rule chains to trigger an 
action only after the number of matching attacks exceeds a threshold within a certain time period. You can 
configure the action to block the traffic and log the match, or to simply log it. You can also set the action to 
Disabled to remove the rule chain from active status and stop comparing traffic against those rules.

The Custom Rules feature can be enabled or disabled using the Enable Custom Rules global setting.

• Configuring Rule Chains

• Adding or Editing a Rule Chain

• Cloning a Rule Chain

• Deleting a Rule Chain

• Correcting Rule Chains

Configuring Rule Chains
You can add, edit, delete and clone rule chains. Example rule chains (with Rule Chain ID greater than 15000) are 
available in the Secure Mobile Access management interface for administrators to use as reference. These 
cannot be edited or deleted. You can view the rules associated with the rule chain by clicking its Edit Rule Chain 
icon under Configure.

For ease of configuration, you can clone example rule chains or regular rule chains. Cloning a rule chain clones 
all rules associated with the chain. After cloning the rule chain, you can edit it by clicking its Edit Rule Chain icon 
under Configure.

Adding or Editing a Rule Chain
To add or edit a rule chain:

1 On the Web Application Firewall > Rules page, click Add Rule Chain to add a new rule chain.

To edit an existing rule chain, click its Edit Rule Chain icon  under Configure.
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The New Rule Chain screen or the screen for the existing rule chain displays. Both screens have the same 
configurable fields in the Rule Chain section. 

2 On the New Rule Chain page, type a descriptive name for the rule chain in the Name field.

3 Select a threat level from the Severity drop-down list. You can select HIGH, MEDIUM, or LOW.

4 Select Disabled, Detect Only, or Prevent from the Action drop-down list. 

• Disabled – The rule chain should not take effect. 

• Detect Only – Allow the traffic, but log it.

• Prevent – Block traffic that matches the rule and log it.

The Disabled option allows you to temporarily deactivate a rule chain without deleting its configuration.

5 In the Description field, type a short description of what the rule chain matches or other information.

6 Select a category for this threat type from the Category drop-down list. This field is for informational 
purposes, and does not change the way the rule chain is applied.

7 Under Counter Settings, to enable tracking the rate at which the rule chain is being matched and to 
configure rate limiting, select Enable Hit Counters. Additional fields are displayed.

8 In the Max Allowed Hits field, enter the number of matches for this rule chain that must occur before 
the selected action is triggered.

9 In the Reset Hit Counter Period field, enter the number of seconds allowed to reach the Max Allowed 
Hits number. If Max Allowed Hits is not reached within this time period, the selected action is not 
triggered and the hits counter is reset to zero.

10 Select Track Per Remote Address to enforce rate limiting against rule chain matches coming from the 
same IP address. Tracking per remote address uses the remote address as seen by the SMA appliance. 
This covers the case where different clients sit behind a firewall with NAT enabled, causing them to 
effectively send packets with the same source IP.

11 Select Track Per Session to enable rate limiting based on an attacker’s browser session. This method sets 
a cookie for each browser session. Tracking by user session is not as effective as tracking by remote IP if 
the attacker initiates a new user session for each attack. 
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12 Click Accept to save the rule chain. A Rule Chain ID is automatically generated.

13 Next, add one or more rules to the rule chain. 

Cloning a Rule Chain
To clone a rule chain:

1 On the Web Application Firewall > Rules page, click its Clone Rule Chain icon  under Configure.

2 Click OK in the confirmation dialog box.

You can now edit the rule chain to customize it. 

Deleting a Rule Chain
To delete a rule chain:

1 On the Web Application Firewall > Rules page, click the Delete Rule Chain icon  under Configure for the 
rule chain you want to delete.

2 Click OK in the confirmation dialog box.

3 Click Accept.

Correcting Rule Chains
Mis-configured rule chains are not automatically detected at the time of configuration. When a 
misconfiguration occurs, the administrator must log in and fix or delete the bad rules. 

It is difficult to detect a false positive from a misconfigured rule chain unless a user runs into it and reports it to 
the administrator. If the rule chain has been set to PREVENT, then the user sees the Web Application Firewall 
block page (as configured on the Web Application Firewall > Settings page). If not, there is a log message 
indicating that the “threat” has been detected. 

Consider a scenario in which the administrator inadvertently creates a custom rule chain that blocks access to all 
portals of the SMA. For example, the admin might have wanted to enforce a rule for an Application Offloading 
portal. However, he or she forgot to add another rule to narrow the criteria for the match to requests for that 
portal, host or URL. If the first rule was too broad, then this means a denial of service for the appliance. 
Specifically, the administrator creates a rule chain to deny using the GET HTTP method for a specific URL that 
expects a POST request. 
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For this, the administrator needs to create two rules:

1 The first rule is to match GET requests. 

2 The second rule is to match a specific URL. 

If the administrator forgets to create the second rule, then access to the SMA appliance is denied, because the 
Secure Mobile Access web-based management interface depends on the GET method. 

To fix a misconfigured rule chain, complete the following tasks:

1 Point your browser to https://<SMA IP>/cgi-bin/welcome. 

If you try to reach the welcome page by simply using the URL https://<SMA IP>/, the usual redirect to 
https://<SMA IP>/cgi-bin/welcome might not work. To repair misconfigured rules, you need to 
explicitly go to https://<SMA IP>/cgi-bin/welcome, where <SMA IP> is the host name or IP address of 
your SMA

2 Log in as admin.

3 Navigate to the Web Application Firewall > Rules page.

4 Edit or delete the bad rules. 

5 Click Accept.

Using Web Application Firewall 
Monitoring
The Web Application Firewall > Monitoring page provides two pages: Local and Global. The pages for both 
display statistics and graphs for detected/prevented threats over time and top 10 threats. The Local page also 
displays Web server status statistics and graphs of the number of requests and the amount of traffic during the 
selected monitoring period. 

Topics: 

• Monitoring on the Local page

• Monitoring on the Global Page

Monitoring on the Local page
The Local page displays statistics and graphs for the local appliance. Graphs are displayed for Web Server Status 
and WAF Threats Detected & Prevented. For the latter, you can use the Perspective options to change the view 
between Signature, Severity, and Server, and you can display the statistics in list format rather than as graphs.

Topics: 

• Using the Control Buttons

• Monitoring Web Server Status

• Monitoring Detected and Prevented Threats

• Viewing Threats in List Format
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Using the Control Buttons
The control buttons are displayed at the top of the page. They control the statistics that are displayed on this 
page. On the Local page, you can use the control buttons to turn streaming updates on or off, refresh the data 
on the page, clear the graphs, and download a report. If streaming is turned on, Web Application Firewall 
statistics information is fetched periodically, and displayed in the graphs and threat list. If streaming is turned 
off, no new information can be displayed.

Monitoring Web Server Status
On the Local page, below the control buttons, this page displays graphs for Web server status. One graph shows 
the number of Web requests detected over time, and another graph shows the amount of traffic in kilobytes 
(KB). 

The Web servers tracked are those servers within the local network of the SMA appliance that provide 
HTTP/HTTPS bookmarks, offloaded applications, and other Web services. The Traffic graph indicates the amount 
of HTTP/HTTPS payload data that is sent to client browsers. 

You can view Web server activity on the Local page over different time periods by selecting one of the following 
options from the Monitoring Period drop-down list:

• Last 60 Seconds

• Last 60 Minutes

• Last 24 Hours

• Last 30 Days

Monitoring Detected and Prevented Threats
On the Local page below the Web server status graphs, the Web Application Firewall > Monitoring page 
displays graphs indicating the number of detected and prevented threats. Two graphs are presented, one 
showing the number of threats over time, and the other showing the top ten threats that were detected and 
prevented during that time frame. 

You can change the time frame displayed in both graphs or change the view to display all threats in list format by 
selecting one of the following options from the Monitoring Period drop-down list:

• Last 12 Hours

• Last 14 Days

• Last 21 Days

• Last 6 Months

• All in Lists

Threats Over Last 21 Days shows the number and severities of threats detected and prevented over the last 21 
days.
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Threats Over Last 21 Days

When displaying the top 10 threats graph with Perspective set to Signature, hovering your mouse pointer over 
the signature ID causes a tooltip to appear with details about the threat.

Viewing Threats in List Format
To see the threats in list format rather than as a graph, select All in Lists from the Monitoring Period 
drop-down list. Threats in List Format shows the list format.

The Severity column of the threat list is color coded for quick reference, as follows:

• High severity threats – Red

• Medium severity threats – Orange

• Low severity threats – Black

The initial, default sorting order lists the high severity threats with highest frequency values first. You can 
change the order of listed threats by clicking on the column headings to sort them by ID, signature name, 
classification, severity, or frequency. Click again to toggle between ascending and descending order. The active 
sorting column is marked by an arrowhead pointing upwards for ascending order, and downwards for 
descending order.

Threats in List Format

To view and hide threat details:

1 On the Web Application Firewall > Monitoring page, select All in Lists from the Monitoring Period 
drop-down list. The list of detected or prevented threats is displayed in the WAF Threats Detected & 
Prevented table.

2 To display details about a threat, click on the threat. The details include the following:

• URL – The URL to the SonicWall Inc. knowledge base for this threat

• Category – The category of the threat

• Severity – The severity of the threat, either high, medium, or low

• Summary – A short description of how the threat behaves

3 To collapse the threat details, click the threat link again.
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Monitoring on the Global Page
The Global page displays statistics and graphs for threats reported by all SMA appliances with Web Application 
Firewall enabled. Graphs are displayed for WAF Threats Detected & Prevented. 

The control buttons are displayed at the top of the page. They control the statistics that are displayed on this 
page. On the Global page, you can use the control buttons to turn streaming updates on or off, refresh the data 
on the page, and download a report. If streaming is turned on, Web Application Firewall statistics information is 
fetched periodically, and displayed in the graphs and threat list. If streaming is turned off, no new information 
can be displayed.

To use the control buttons, complete the following steps:

1 Select the Global page. The active page name is displayed in red or pink, while the inactive page name is 
blue. The control buttons act on the page that is currently displayed. 

2 To turn streaming on or off, click the ON or OFF indicator next to Streaming Updates.

3 To refresh the display, click Refresh.

4 To generate a PDF report containing Web Application Firewall statistics, click Download Report.

5 If prompted to install Adobe Flash Player, click Get Flash and then after the installation click Try Again to 
generate the PDF report from Internet Explorer.

Licensing Web Application Firewall
The Secure Mobile Access Web Application Firewall must be licensed before you can begin using it. You can 
access the MySonicWall Web site directly from the Secure Mobile Access management interface to obtain a 
license. 

The Web Application Firewall > Licensing page in the Secure Mobile Access management interface provides a 
link to the System > Licenses page, where you can connect to MySonicWall and purchase the license or start a 
free trial. You can view all system licenses on the System > Licenses page of the Secure Mobile Access 
management interface.

To view license details and obtain a license on MySonicWall for Web Application Firewall:

1 Log in to your SMA appliance and navigate to Web Application Firewall > Licensing.

2 If Web Application Firewall is not licensed, click the System > Licenses link. The System > Licenses page is 
displayed.

3 Under Manage Security Services Online, click the Activate, Upgrade, or Renew services link. The 
MySonicWall Login page is displayed.
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4 Type your MySonicWall account credentials into the fields to log into MySonicWall. This must be the 
account to which the appliance is, or will be, registered. If the serial number is already registered through 
the MySonicWall web interface, you will still need to log in to update the license information on the 
appliance itself. 
MySonicWall automatically retrieves the serial number and authentication code.

5 Type a descriptive name for the appliance into the Friendly Name field, and then click Submit.

6 Click Continue after the registration confirmation is displayed.

7 Optionally upgrade or activate licenses for other services.

8 After activation, view the System > Licenses page on the appliance to see a cached version of the active 
licenses.
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Capture ATP

This section provides information and configuration tasks specific to the Capture ATP pages on the SonicWall 
Secure Mobile Access web-based management interface. Capture Advanced Threat Protection (Capture ATP) is a 
cloud-based service that analyzes various types of content for malicious behavior. 

Topics: 

• Capture ATP > Settings

• Capture ATP > Report

• Capture ATP > Licensing

Capture ATP > Settings
This section provides an overview of the Capture ATP > Settings page and the configuration tasks listed on this 
page.

Topics: 

• General Settings

• File Type Settings

• File Size Settings

• Custom Blocking Behavior

General Settings
To configure Capture ATP general settings:

1 Navigate to the Capture ATP > Settings page.

2 Select Enable Capture ATP service to enable the Capture ATP service. 
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File Type Settings
To configure file type settings:

1 Navigate to the Capture ATP > Settings page.

2 Select the types of files that will be transfered to Capture ATP service for analysis. Available file types 
include:

• Executables (PE, Mach-O, and DMG)

• PDF

• Office 97-2003 (.doc, .xls, ...) 

• Office (.docx, .xlsx, ...)

• Archives (.jar, .apk, .rar, .gz, and .zip)

File Size Settings
To configure file size settings:

1 Navigate to the Capture ATP > Settings page.

2 To specify the maximum size of the file that will be sent to Capture ATP service, enter a value in the 
Maximum size for a file window. Valid maximum size is 0 - 100 MB for user level and group level, and 1 - 
100 MB for global level.

• If the value is set to 0 at user level, SMA uses the maximum file size of the group setting.

• If the value is set to 0 at group level, SMA uses the maximum file size of the global setting.

• If the value is set to 0 at global level, the file is not sent to Capture ATP service to check.

• If a file size is less than the maximum value, the file is sent to Capture ATP service to check.

3 Select Don’t send the file to backend server if the file size exceed the size limitation, if you don’t want 
to send the exceeding file to the backend server. 
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Custom Blocking Behavior
To configure custom blocking behavior:

1 Navigate to the Capture ATP > Settings page. 

2 Select Block uploads when there is a failure communicating with the Capture ATP service to allow or 
block file upload to the backend server when there is a failure communicating with the Capture ATP 
service.

Capture ATP > Report
This section provides an overview of the Capture ATP > Report page and the configuration tasks available on 
this page. When a good or malicious file is uploaded, Capture ATP logs and reports the event on the Capture ATP 
> Report page.

The Capture ATP > Report page is divided into the following sections:

• Files Scanned in the Last 30 Days

• Viewing Files Scanned

• Filtering Files

• Adding a New Filter

• Uploading a File
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Files Scanned in the Last 30 Days
The Files scanned in the last 30 days bar-graph provides a visual representation of the number of files scanned 
over the last 30 days. The y-axis displays the total number of files scanned. 

To view information about a specific date:

From the Capture ATP > Report screen, hover the mouse over the bar correlating to a specific date to see the 
following:

• Date

• Number of files scanned

• Percentage of malicious files

Viewing Files Scanned
The Viewing scanned files section provides the following detailed information about the files scanned in the last 
30 days.

• Status - Clean or Malicious file

• Filename - Name of file

• Date - Date of file scan

• Source - Source IP of file

• Destination - Destination IP of file

• Country - Country from where file is uploaded

• Total Bytes - Size of the malicious file uploaded

Filtering Files
To Filter scanned files by category:

1 Click a category heading at the top of the table, to sort the files in descending order. 

2 Click the category a second time to filter the files in ascending order. 
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Adding a New Filter
To Add a new Filter:

1 Click on Add Filter. The Add Filter window appears.

2 Click the drop-down list and select from the following:

• Category

• Status

• IP Address

• Source IP Address

• Destination IP Address

• Filename

• Date

• Status

• Malicious

• Clean

• Scan pending

• Scan failed

3 Report is generated based on filters that are selected.

Uploading a File
To upload a file to be scanned:

1 Click Upload a file. The Upload a file to be scanned window appears.

2 Enter the file name in the Select a file... window or select Browse to search for a file.

3 Click Upload to import the file.
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Capture ATP > Licensing
This section provides an overview of the Capture > Licensing page and the configuration tasks available on this 
page. The Capture ATP > Licensing page is divided into the following sections:

• SonicWall Capture ATP Service

• License Status

SonicWall Capture ATP Service
Capture Advanced Threat Protection (Capture ATP) is an add-on security service to the firewall that helps a 
firewall identify whether a file is malicious. Before you can enable Capture ATP you must first get a license. 

To Activate Licenses:

1 Navigate to Capture ATP > Licensing and click on ACTIVATE LICENSE. The System > Licenses page 
appears.
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2 Click the Activate, Upgrade, or Renew services link. The MySonicWall Login page appears.

3 Enter your MySonicWall credentials and click Submit. The Licenses > Licenses Management page 
appears.

License Status
The License Status section displays the current license status and expiration date.
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Geo IP and Botnet Filter

This section provides information and configuration tasks specific to the Geo IP and Botnet Filter page on the 
SonicWall Secure Mobile Access management interface. The Geo IP feature enables administrators to monitor 
and enforce policies effectively based on the geographical locations of remote users. The Botnet Filter feature 
enforces a strong and anti-evasive defense against any rogue activity from Botnets using a dynamically updated 
database maintained by SonicWall Inc.. Botnets pose huge security risks such as Denial of Service (DoS) attacks 
and Data Leakage. They are hard to identify and control because of the transient nature of their origins. These 
features are disabled by default. 

Topics: 

• Status

• Settings

• Policies

• Licensing

Status
The Geo IP & Botnet Filter > Status page contains two sections of information: General Status and Botnet 
Status. 
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Topics: 

• General Status

• Botnet Status

General Status
The General Status page shows general information about the Geo IP & Botnet filter and offers an option to 
synchronize the database. When the Geo IP & Botnet Filter is enabled, the General Status page provides the 
following information:

• Database shows the update status and provides Synchronize to manually synchronize updates. When 
Synchronize is clicked, the server immediately checks for new updates on the backend server.

• Protection Status shows whether the backend server is connected. Offline status might indicate that the 
network settings need to be changed. 

• Cache Size shows the total number of Geo IP and Botnet caches. All caches are managed automatically 
by the server. 

• Last checked displays the most recent timestamp of the cache.

• Service Expiration Date shows the license expiration date of the Geo IP & Botnet Filter service. 

• License Status identifies whether the Geo IP & Botnet Filter service is licensed. The Geo IP & Botnet 
Filter is a subscription service that includes a free trial.

When the Geo IP & Botnet Filter is licensed but disabled, the Status page displays a warning that contains a link 
to the Settings page where the feature can be enabled:

Botnet Status
The Botnet Status page shows traffic statistics for Botnet IP addresses for the current reporting period. 
Statistics are shown for the top 10 IP addresses detected by the Botnet Filter during the selected period. 

Use the Monitoring Period drop-down list to select the reporting period: Last 12 Hours, Last 14 Days, Last 21 
Days, Last 6 Months, or All recorded traffic data.

Click Clear to clear statistics that are beyond the selected Monitoring Period. 

Settings
The Geo IP & Botnet Filter > Settings page is used to enable/disable the Geo IP and Botnet Filter and 
configure Remediation Settings. The Geo IP & Botnet Filter > Settings page contains the General Settings and 
Remediation Settings sections.
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Topics: 

• General Settings

• Remediation Settings

General Settings
Use the General Settings section of the Geo IP & Botnet Filter > Settings page to globally enable or disable the 
Geo IP & Botnet Filter that is disabled by default. 

To enable the Geo IP & Botnet Filter:

1 Select Enable Geo IP & Botnet Filter to globally enable this feature. When enabled, a Location column is 
added to the NetExtender > Status, User > Status pages that identifies the location of users’ source IP 
addresses. Mousing over an icon in the Location column displays the City (if applicable), Region, and 
Country of the source IP.

2 Click Accept.

When this feature is enabled, the General Settings section displays four sub-features that can be individually 
enabled or disabled:

• Enforce Geo IP Policy — Select this option to enforce Geo IP policies.

• Enforce Botnet Filter Policy — Select this option to enable blocking of IP addresses in the SonicWall 
Botnet Database (for which no defined Policy is required) and enforce Botnet Filter policies. If this is 
disabled, Botnet IP addresses are not blocked, however, they are still detected and included in the Botnet 
Filter Statistics.

• Find Geo IP Location for Logs — When this option is enabled, a column indication the location of the 
source IP is added to the following screens: Log > Views.

• Enable Packet Log (Debug mode) — Select this option to generate logs for allowed or denied packets. 
This option is for debug purposes only. Enabling the Packet Log makes logs increase rapidly if the log level 
is set to Debug.
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Remediation Settings
Access to resources protected by an SMA appliance from aggressive IP addresses is denied when Geo IP & 
Botnet Filter is enabled. Remediation provides valid users an opportunity to prove that they are real users rather 
than “bots” and be allowed access. 

To enable Remediation and configure the settings:

1 Click Enable Remediation Settings.

2 Click Enable Remediation. Denied users cannot access resources protected by the appliance without 
CAPTCHA-based remediation. Remediation can be enforced separately for the IP addresses defined by 
your Geo IP Policy, Botnet Filter Policy, and/or in the backend Botnet Database. Select additional options 
as needed.

3 In the Max allowed time for CAPTCHA entries (s) field, enter the number of seconds that the user has 
to complete Remediation. The minimum/maximum range is 30-300 seconds, the default is 60 seconds.

4 In the Allowed/Blocked duration after CAPTCHA validation (m) field, enter the number of minutes 
that the user is allowed/blocked after completing the CAPTCHA validation. The minimum value is five 
minutes and the maximum is 30, the default is 15 minutes.

Policies
The Geo IP & Botnet Filter > Policies page is used to view, add, edit, and delete Geo IP and Botnet Filter access 
policies. Up to a total of 64 Geo IP and Botnet Filter access policies can be created.
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Each policy is automatically assigned a different priority with 1 being the highest priority. A policy’s priority 
determines the order of enforcement, which is identified by the order policies are listed on the Settings page. 

• Botnet Filter policies have a higher priority than Geo IP policies. Geo IP policies are prioritized according 
to the time they were created with those created first having the higher priority. 

• Botnet Filter policies defined for a single IP address have a higher priority than Botnet Filter policies 
defined for a subnet, and each type is then prioritized based on the time they were created with those 
created first having the higher priority. 

• Custom created policies are enforced first, which means if an IP address is listed in the SonicWALL Botnet 
Filter database, but the administrator defines an allow policy for this IP, then access from this IP is 
allowed.

A policy can be modified by clicking the edit  button, but a policy name cannot be modified. 

A policy can be deleted by clicking the delete  button. 

To create a new access policy, click the Add policy... button. Two types of policies can be added: 

• Geo IP Policy tab

A Geo IP policy allows or denies traffic from specified countries. Enter a Policy Name, then select the 
Countries you want to allow or deny. You can sort countries by continent, just click the drop-down and 
select the desired continent, to display all the countries within that continent in the Apply Policy To list. 
You can also select countries directly from the map.

The map displays selected/deselected countries by color. The deselected countries display gray, while the 
selected countries display in color. Mouse over a country in the Apply Policy To list and the 
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corresponding country blinks on the map. Use the Zoom tool to zoom in or out on the map. If you do not 
wish to use the map, hide it by clicking the Map icon to the left of the map.
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• Botnet Policy

A Botnet Policy allows or denies access from a specified IPv4 IP address or IP address range. Up to 64 
policies can be created. Enter a Policy Name, then select an IP address or IP range you want to allow or 
deny (based on your selection in the Action drop-down.

Licensing
Geo IP & Botnet Filter is a subscription service that includes a free trial that expires one year after the release 
date. The licensing status of the Geo IP & Botnet Filter subscription service is shown on the Geo IP & Botnet 
Filter > Licensing page.

The Licensing page also includes a brief description of the feature and a link to the System > Licenses page 
where you can activate, upgrade, and renew licenses.
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High Availability Configuration

This section provides information and configuration tasks specific to High Availability on the SonicWall Secure 
Mobile Access (SMA) web-based management interface. 

High Availability allows two identical SMA appliances or SMA 500v Virtual Appliances to provide a reliable, 
continuous connection to the Internet. The two SMA appliances are deployed at the same time and connected 
to each other. Two SMA appliances in such a configuration are called a High Availability Pair (HA Pair).

Topics: 

• High Availability Overview

• Preparing for High Availability

• Configuring Settings

• Synchronizing Licenses

• High Availability FAQS

High Availability Overview
High Availability requires one SMA appliance configured as the primary device, and an identical SMA appliance 
configured as the backup device. During normal operation, the primary device is in an active state, and services 
all connections. The backup device is in an idle state. When the primary device loses connectivity, the backup 
appliance transitions to the active state and begins to service outside connections. This transition is called 
“failover”. 

Since all data and settings are synchronized at all times between the primary and backup devices, including 
settings and data from the current session, when failover occurs, the backup device can take over seamlessly. 

Failover occurs any time there is a loss of functionality or network-layer connectivity on the primary appliance. 
The failover to the backup unit transfers critical services when a physical (or logical) link failure is detected, or 
when the primary unit loses power.

Supported Platforms
High Availability is supported on the SMA 400, SMA 410, SMA 500v for Hyper-V, and SMA 500v for ESXi 
platforms.

NOTE: SMA 200, SMA 210, SMA 500v for AWS and SMA 500v for Azure do not support High Availability. 
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Preparing for High Availability
You can select the interface to use for HA control traffic. The HA link should connect the identical ports of the HA 
pair, for example, X3 of both appliances. 

Before configuring the options on the High Availability > Settings page, prepare your devices for High 
Availability with the following steps:

1 Configure both SMA appliances as separate devices with independent IP addresses on your subnet.

2 Upload the latest Secure Mobile Access firmware to both devices. High Availability does not work unless 
both devices have the same firmware version installed.

3 Connect the X3 interfaces of the two appliances together with a CAT 5E or better cable to ensure a 
gigabit connection. 

In a browser, log into the primary unit and navigate to the Network > Interfaces page. Confirm that the X3 port 
is active by checking the Status. It should show 1000 Mbps Full Duplex.

Configuring Settings
Topics: 

• Enabling Interface Monitoring

• Configuring Network Monitoring Addresses

• Configuring Management Settings for Idle Unit

• Synchronizing Firmware

• Synchronizing Settings

NOTE: SMA appliances in an HA pair cannot be deployed behind a proxy.

NOTE: SonicWall Inc. recommends that you backup and download the settings for both 
SMA appliances at this stage.
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The High Availability > Settings page provides settings for configuring SMA appliances for High Availability, as 
seen below:

To enable High Availability and configure the options in the High Availability Settings section, 
perform the following steps:

1 In a browser, log into the primary unit and navigate to the High Availability > Settings page. 

2 Select Enable High Availability.

3 Select the High Availability Interface from the drop-down list. The HA interface can only be set when 
the unit is in the HA unconnected mode, and the interface must be set to the same interface on both 
units.

4 Enter a number of milliseconds for the Heartbeat Interval. The heartbeat is used to maintain the 
connectivity between the primary and backup devices. The heartbeat interval controls how often the 
two units communicate. The minimum is 500 milliseconds (a half second), and the maximum is 300,000 
milliseconds (five minutes).

5 Enter a value for the Failover Trigger Level. This is the number of heartbeats that must be missed before 
failover occurs. The minimum is four, and the maximum is 99.

6 In the Primary Serial Number field, type in the serial number of the primary device. The maximum 
length is 12 characters.

7 In the Backup Serial Number field, type in the serial number of the backup device. The maximum length 
is 12 characters.

8 Click Accept.

9 In the browser, open a new page and point it to the IP address of the backup unit. Log into the backup.

10 Repeat 1 through 8 on the backup unit.

When you click Accept, the backup device becomes idle, and you are no longer able to access it with its 
former IP address. The primary device is now active, with the same settings it had before the HA 
configuration.

The appliances in the HA Pair immediately begin to synchronize data from the primary to the backup 
unit. When failover occurs and the primary is down, the backup unit becomes active, with the same 
settings as the primary had before it went down.
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Enabling Interface Monitoring
In the Interface Monitoring section of the page, you can enable monitoring of the working interfaces to which 
VPN users connect. 

The monitored interfaces available for selection are X0, X1, and X2. When Interface Monitoring is enabled and 
configured, if any of the monitored interfaces loses connectivity on the active unit and is still reachable on the 
idle unit, failover occurs. 

To enable interface monitoring:

1 On the High Availability > Settings page under Interface Monitoring, select Enable Interface Monitor.

2 In the Monitor Interfaces list, select the interfaces you want to monitor.

3 Click Accept.

Configuring Network Monitoring Addresses
In the Network Monitoring Address section, you can configure monitoring of the LAN and WAN IP addresses. 
When Network Monitoring is configured, if the LAN or WAN connection is lost on the active unit but is reachable 
on the idle unit, failover occurs and the idle unit takes the active role. 

When configured, the LAN and WAN connection status is detected and displayed in the High Availability Status 
section at the top of the page.

To configure network monitoring:

1 On the High Availability > Settings page under Network Monitoring Address, type the LAN IP address in 
the LAN Monitoring Address field.

2 Type the WAN IP address in the WAN Monitoring Address field.

3 Click Accept.
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Configuring Management Settings for Idle Unit
In the Network Monitoring Address section, you can configure management settings for the idle unit. 

High Availability configuration is limited for SMA 500v Virtual Appliances. Use the High Availability > Settings 
page to enable High Availability on the SMA 500v Virtual Appliance, designate it as the primary or secondary 
unit, and select the interface. Note the following limitations when configuring management settings for an SMA 
500v Virtual Appliance:

• High Availability is not supported on an SMA 500v Virtual Appliance in Single Network Interface mode.

• The Synchronize Firmware function is not supported for an SMA 500v Virtual Appliance.

To configure management settings for the idle unit:

1 On the High Availability > Settings page under Management Settings for Idle Unit, check Enable To 
Manage Idle Unit.

2 Select the Management Interface using the drop-down list.

3 Type the idle unit’s management IP address in the Management Address field.

4 Click Accept.

Synchronizing Firmware
You can synchronize firmware from the active unit to the idle unit in the HA pair by clicking Synchronize 
Firmware. 

This allows you to synchronize firmware between the units after upgrading the active unit to a different version. 

Synchronizing Settings
Synchronize settings by clicking Accept. Synchronizing settings does not synchronize firmware, but synchronizes 
settings from the active to the idle unit.

The appliances in the HA Pair immediately begin to synchronize data from the primary to the backup unit. When 
failover occurs and the primary is down, the backup unit becomes active with the same settings as the primary 
had when failover occurred.
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Synchronizing Licenses
To synchronize licenses between two SMA appliances in an HA pair, log into MySonicWall.com and bind the two 
SMA appliances together. Both appliances share the primary unit's license information. There is no function in 
the Secure Mobile Access management interface to synchronize licenses between the two units in the HA pair. 
All license synchronization is controlled through MySonicWall.

High Availability FAQS
1 After HA is enabled, can the idle device be used separately?

No. After HA is configured, only one device can be in use at any one time. During failover the idle device 
becomes active. Two devices in HA mode cannot be used as separate SMA appliances.

2 What happens if we remove the HA interface cable from the devices?

If you remove the HA interface cable, then the IDLE device can be re-configured to work as a standalone. 
However, this causes an IP conflict, as both the primary and backup devices have the same IP 
configuration. 

3 Can the HA interface settings be amended, after HA is enabled?

When HA is configured, the ‘Edit’ button for the HA interface is dimmed and disabled. So the HA 
interface setting cannot be changed after the devices are in HA mode.

4 Can the X0, X1 and X2 interface settings be amended after HA mode is set up?

Yes. The X0, X1 and X2 interface settings can be amended on the primary device, and these new settings 
are copied to the backup device.

5 Can the synchronization status between the devices be viewed in the Secure Mobile Access management 
interface?

Yes. These can be viewed on the Active SMA in the Log > View page. The log message: “Finish 
synchronizing all data,” appears.

6 Is there any provision to make sure that the backup device is working correctly?

Yes. There are many messages on the Log > View page regarding active and idle device transitions.

You can check the High Availability page for the device status; one should be ACTIVE and the other is 
IDLE, as indicated in the image that follows:

https://www.mysonicwall.com
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If the LAN and WAN monitoring IP addresses are configured in the Network Monitoring Address section, 
the status of those interfaces is displayed.

You can also check the Network > Interfaces page for the X3 interface status, this should be “HA 
Link-Connected.”

7 Are firmware and settings synchronized to the Idle unit?

Yes. Both firmware and settings are synchronized between Active and Idle nodes. The Synchronize 
Firmware button allows you to synchronize firmware from the Active to the Idle unit. When settings are 
changed, clicking Accept synchronizes settings.

8 Does the HA configuration for SMA appliances differ from the HA configuration of SonicWall Inc. firewall 
devices?

Yes. HA configuration on a firewall is very different. Along with other items, firewall HA is also available in 
Active/Active state and can be assigned a virtual IP address. HA with SMA appliances is currently 
available only in Active/Passive mode.

9 How are settings applied to the Idle device?

Settings from the Active device are copied over to the Idle device as soon as HA configuration is 
complete. You can check the success of this in the active device logs.

10 What happens to the backup device settings?

The backup device settings are deleted and replaced with the primary device settings. If you wish to keep 
any settings from the backup device, it is recommended that you download a backup of the settings 
before switching to HA.

11 How do I view the status of the Backup unit?

On the High Availability > Settings page under Management Settings for Idle Unit section, select the 
Enable to Manage Idle Unit option. Select the Management Interface and type the IP address of the idle 
unit in the Management Address field. 

12 Can I deploy an HA pair behind a proxy?

No. SMA appliances in an HA pair cannot be deployed behind a proxy. They communicate with the 
backend servers directly to download signatures and perform synchronization.
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Users Configuration

This section provides information and configuration tasks specific to the Users pages on the SonicWall Secure 
Mobile Access web-based management interface, including access policies and bookmarks for the users and 
groups. Policies provide you access to the different levels of objects defined on your SMA appliance. 

Topics: 

• Users > Status

• Users > Local Users

• Users > Local Groups

• Global Configuration

Users > Status
The Users > Status page provides information about users and administrators who are currently logged into the 
SMA appliance. This section provides general information about how the SMA appliance manages users through 
a set of hierarchical policies.

When Streaming Updates is set to ON, the Users > Status page content is automatically refreshed so that the 
page always displays current information. Toggle to OFF by clicking ON.

The Active User Sessions table displays the current users or administrators logged into the SMA appliance. 
Each entry displays the name of the user, the group in which the user belongs, the portal the user is logged into, 
the IP address of the user, a time stamp indicating when the user logged in, the duration of the session, and the 
cumulative idle time during the session. An administrator could terminate a user session and log the user out by 
clicking the Logout icon at the right of the user row. The Active User Session table includes the following 
information:

Active User Information

Column Description

Name A text string that indicates the ID of the user.

Group The group to which the user belongs.

Portal The name of the portal that the user is logged into.
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Topics: 

• Access Policies Concepts

• Access Policy Hierarchy

Access Policies Concepts
The Secure Mobile Access web-based management interface provides granular control of access to the SMA 
appliance. Access policies provide different levels of access to the various network resources that are accessible 
using the SMA appliance. There are three levels of access policies: global, groups, and users. You can block and 
permit access by creating access policies for an IP address, an IP address range, all addresses, or a network 
object.

Access Policy Hierarchy
An administrator can define user, group and global policies to predefined network objects, IP addresses, address 
ranges, or all IP addresses and to different Secure Mobile Access services. Certain policies take precedence.

The Secure Mobile Access policy hierarchy is:

• User policies take precedence over group policies

• Group policies take precedence over global policies

• If two or more user, group or global policies are configured, the most specific policy takes precedence

For example, a policy configured for a single IP address takes precedence over a policy configured for a range of 
addresses. A policy that applies to a range of IP addresses takes precedence over a policy applied to all IP 
addresses. If two or more IP address ranges are configured, then the smallest address range takes precedence. 
Host names are treated the same as individual IP addresses. 

Network objects are prioritized just like other address ranges. However, the prioritization is based on the 
individual address or address range, not the entire network object.

For example:

• Policy 1: A Deny rule has been configured to block all services to the IP address range 10.0.0.0 - 
10.0.0.255

• Policy 2: A Deny rule has been configured to block FTP access to 10.0.1.2 - 10.0.1.10

IP Address The IP address of the workstation which the user is logged into.

Location The geographical location of the source IP for each user. 

Login Time The time when the user first established connection with the SMA appliance expressed as 
day, date, and time (HH:MM:SS).

Logged In The amount of time since the user first established a connection with the SMA appliance 
expressed as number of days and time (HH:MM:SS).

Idle Time The amount of time the user has been in an inactive or idle state with the SMA appliance.

Logout Displays an icon that enables the administrator to log the user out of the appliance.

Active User Information (Continued)

Column Description
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• Policy 3: A Permit rule has been configured to allow FTP access to the predefined network object, FTP 
Servers. The FTP Servers network object includes the following addresses: 10.0.0.5 - 10.0.0.20. and 
ftp.company.com that resolves to 10.0.1.3. 

Assuming that no conflicting user or group policies have been configured, if a user attempted to access:

• An FTP server at 10.0.0.1, the user would be blocked by Policy 1

• An FTP server at 10.0.1.5, the user would be blocked by Policy 2

• An FTP server at 10.0.0.10, the user would be granted access by Policy 3. The IP address range 10.0.0.5 - 
10.0.0.20 is more specific than the IP address range defined in Policy 1.

• An FTP server at ftp.company.com, the user would be granted access by Policy 3. A single host name is 
more specific than the IP address range configured in Policy 2.

Users > Local Users
This section provides an overview of the Users > Local Users page and a description of the configuration tasks 
available on this page.

The Users > Local Users page allows you to Import, Export, Add, Configure, and Delete users. 

Topics: 

• Local Users

• Editing User Settings

• Adding User Policies

• Adding or Editing User Bookmarks

• Creating a Citrix Bookmark for a Local User

• Creating Bookmarks with Custom SSO Credentials

• Configuring Login Policies

• Denying Mobile App Binding when Login is Attempted from any External Network

• Reusing Mobile App Binding Text Code

• Flexibility in Choosing Two-Factor Authentication method for NetExtender Login

• Configuring End Point Control for Users
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• Configuring Capture ATP

Local Users
The Local Users page allows the administrator to add and configure users by specifying a User Name, selecting a 
Domain and Group, creating and confirming password, and selecting user type (user, administrator, or read-only 
administrator).

Topics: 

• Removing a User

• Adding a Local User

• Importing Local Users

• Exporting Local Users

Removing a User
To remove a user, navigate to Users > Local Users and click the delete icon next to the name of the user that 
you wish to remove. After deleted, the user is removed from the Local Users window.

Adding a Local User

To create a new local user:

1 Navigate to the Users > Local Users page and click Add User. The Add Local User window is displayed.

2 In the Add Local User window, enter the user name for the user in the User Name field. This is the name 
the user enters in order to log in to the Secure Mobile Access user portal.

3 Select the name of the domain to which the user belongs in the Domain drop-down list.



SonicWall Secure Mobile Access 10.2 Administration Guide
Users Configuration 267

4 Select the name of the group to which the user belongs in the Group drop-down list.

5 Type the user password in the Password field.

6 Retype the password in the Confirm Password field to verify the password. The password of imported 
local users will be set to 'password' by default, and changing password is required for next login.

7 Optionally, force a user in the Local User Database to change their password at set intervals or the next 
time they login. To force a user to change their password at set intervals, type the expiration interval in 
the Passwords expire in x days field. 

8 If you set a password expiration interval, type the number of days before expiration that users should 
receive notifications in the Show warning x days before password expiration field.

When configured and a password is expiring, a notification is displayed on the user’s Virtual Office page 
or the Administrator’s management console identifying the number of days before their password 
expires. Notifications also include a link to a screen where the password can be changed.

9 Optionally, use Require password change on next logon to force a user to change their password the 
next time they log in by selecting Use Domain Setting or Enabled. Selecting Use Domain Setting uses 
the setting configured on the Portals > Domains page.

10 With the Account expires end of setting, you can set an expiration date with a pull-down calendar. No 
setting indicates the account never expires.

11 From the User Type drop-down list, select a user type option. The available user types are User, 
Administrator, or Read-only Administrator.

12 Click Accept to update the configuration. After the user has been added, the new user is displayed on 
the Local Users window.

Importing Local Users
Import Local Users allows you to import new users from external files using the JSON format, which can be used 
later to provide useful information on those users and their attributes.

To import new local users,

1 Navigate to Users > Local Users.

2 Select IMPORT LOCAL USERS. The Import Local Users page appears.

3 Using Browse, navigate to location of the JSON-formatted local users file, select it, and click Import.
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4 Enable Keep user settings if the user has existed to keep existing users. Otherwise, existing users are 
overridden.

Exporting Local Users
Export Local Users allows you to export a JSON file of all added users, which can be used later to provide useful 
information on those users and their attributes.

To export a file of all local users,

1 Navigate to Users > Local Users.

2 Click EXPORT LOCAL USERS. All local users (except the default “admin” user) are downloaded to your 
local directory.

Editing User Settings
To edit a user’s attributes, navigate to the Users > Local Users window and click the Configure icon next to the 
user whose settings you want to configure. The Edit User Settings window displays.

Topics: 

• Modifying General User Settings

• Modifying Group Settings

• Modifying Portal Settings

• Modifying Clients Settings

• To select user-mapped address settings for a user:

The Edit Local User page has several pages as described in the following table:

Edit Local User pages

Tab Description

General Enables you to create a password and an inactivity timeout, and specify Single 
Sign-On settings for automatic log in to bookmarks for this user.

Groups Enables you to add a group membership, configure a primary group, and control 
whether groups are automatically assigned at login.

Portal Enables you to enable, disable, or use group settings on this portal for 
NetExtender, File Shares, Virtual Assist, and Bookmark settings. 

Clients Enables you to specify a NetExtender client address range, including for IPv6, 
Always on VPN, as well as Mobile Connect Default Policy Settings, and to 
configure client settings.

Routes Enables you to specify Tunnel All mode and NetExtender client routes.

Policies Enables you to create access policies that control access to resources from user 
sessions on the appliance.

Bookmarks Enables you to create user-level bookmarks for quick access to services.

Login Policies Enables you to create user login policies, including policies for specific source IP 
addresses and policies for specific client browsers. You can disable the user’s 
login, require One Time Passwords, edit One Time Password settings, and specify 
client certificate enforcement.
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If the user authenticates to an external authentication server, then the User Type and Password fields are not 
shown. The password field is not configurable because the authentication server validates the password. The 
user type is not configurable because the SMA appliance only allows users that authenticate to the internal user 
database to have administrative privileges. Also, the user type External is used to identify the local user 
instances that are auto-created to correspond to externally authenticating users.

Modifying General User Settings
The General page provides configuration options for a user’s password, inactivity timeout value, and bookmark 
single sign-on (SSO) control. 

To modify general user settings:

1 In the left column, navigate to the Users > Local Users.

2 Click the configure icon next to the user you want to configure. The General page of the Edit User 
Settings window displays. The General page displays the following non-configurable fields: User Name, 
Primary Group, In Domain, and User Type. To set or change the user password, type the password in 
the Password field. Re-type it in the Confirm Password field.

3 Optionally, force a user in the Local User Database to change their password at set intervals or the next 
time they login. To force a user to change their password at set intervals, type the expiration interval in 
the Passwords expire in x days field. To force a user to change their password the next time they log in, 
check Change password at next logon.

4 If you set a password expiration interval, type the number of days before expiration that users should 
receive notifications in the Show warning x days before password expiration field.

When configured and a password is expiring, a notification is displayed on the user’s Virtual Office page 
or the Administrator’s management console identifying the number of days before their password 
expires. Notifications also include a link to a screen where the password can be changed.

EPC Enables you to configure End Point Control profiles used by local groups.

Capture Enables you to configure General Settings, File Settings, and Custom Blocking 
Behavior.

Application Support

Application Supports SSO Global/Group/User 
Policies Bookmark Policies

Terminal Services (RDP - Native) Yes Yes Yes

Terminal Services (RDP - HTML5) Yes Yes Yes

Virtual Network Computing (VNC - HTML5) Yes Yes Yes

File Transfer Protocol (FTP) Yes Yes Yes

Telnet Yes Yes Yes

Secure Shell (SSH) Yes Yes Yes

Web (HTTP) Yes Yes Yes

Secure Web (HTTPS) Yes Yes Yes

File Shares (CIFS) Yes Yes Yes

Citrix Portal (Citrix) Yes Yes Yes

Edit Local User pages (Continued)

Tab Description



SonicWall Secure Mobile Access 10.2 Administration Guide
Users Configuration 270

5 To set the inactivity timeout for the user, meaning that they are signed out of the Virtual Office after the 
specified time period, enter the number of minutes of inactivity to allow in the Inactivity Timeout field. 
The timeout value also controls the number of minutes that a one-time password remains valid, when 
One Time Passwords are configured for a user.

The inactivity timeout can be set at the user, group and global level. If one or more timeouts are 
configured for an individual user, the user timeout setting takes precedence over the group timeout and 
the group timeout takes precedence over the global timeout. Setting the global settings timeout to 0 
disables the inactivity timeout for users that do not have a group or user timeout configured.

6 To allow users to edit or delete user-owned bookmarks, select Allow from the Allow user to 
edit/delete bookmarks drop-down menu. To prevent users from editing or deleting user-owned 
bookmarks, select Deny. To use the group policy, select Use group policy.

7 To allow users to add new bookmarks, select Allow from the Allow user to add bookmarks drop-down 
menu. To prevent users from adding new bookmarks, select Deny. To use the group policy, select Use 
group policy.

Bookmark modification controls provide custom access to predetermined sources, and can prevent users 
from needing support.

8 Under Single Sign-On Settings, select one of the following options from the Automatically log into 
bookmarks drop-down menu:

• Use Group Setting: Select this option to use the group policy settings to control single sign-on 
(SSO) for bookmarks.

• User-controlled: Select this option to allow users to enable or disable single sign-on (SSO) for 
bookmarks.

• Enabled: Select this option to enable single sign-on for bookmarks.

• Disabled: Select this option to disable single sign-on for bookmarks.

9 Click Accept to save the configuration changes.

Modifying Group Settings
On the Groups page, you can add a group membership for users, configure a primary group, and control 
whether groups are automatically assigned at user login.

Users logging into Active Directory, LDAP, and RADIUS domains are automatically assigned in real time to Secure 
Mobile Access groups based on their external AD group memberships, LDAP attributes, or RADIUS filter-IDs.

To configure settings on the Groups page:

1 To set a group as the primary group, click the “Set Primary Group” star corresponding to the group you 
wish to set as the primary.

2 To add a group of which users are a member, click Add Group. The group must be already configured 
from Users > Local Groups.

3 Select the desired group from the drop-down list.

4 Select Make primary group to make this the primary group membership for users.

5 Click Add Group to add the selected group to the Group Memberships list.

6 Under Group Settings, select one of the following from the Auto-assign groups at login drop-down list:

• Use group setting – Use the setting configured for the group.

• Enabled – Enable automatic assignment of users to groups upon login.

• Disabled – Disable automatic assignment of users to groups upon login.
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7 Click Accept.

Modifying Portal Settings
The Portal page provides configuration options for portal settings for this user. 

To configure portal settings for this user:

1 On the Portal page under Portal Settings, select one of the following portal settings for this user:

• Use group setting – The setting defined in the group to which this user belongs are used to 
determine if the portal feature is enabled or disabled. Group settings are defined by configuring 
the group in the Users > Local Groups page.

• Enabled – Enable this portal feature for this user.

• Disabled – Disable this portal feature for this user.

You can configure one of the previous settings for each of the following portal features:

• NetExtender – Because Mobile Connect acts as a NetExtender client when connecting to the 
appliance, this setting applies to both NetExtender and Mobile Connect.

• Launch NetExtender after login

• File Shares

• Virtual Assist Technician

• Virtual Assist Request Help

• Virtual Access Setup Link

• Allow User to Add Bookmarks

• Allow User to Edit/Delete Bookmarks – Applies to user-owned bookmarks only.

2 Click Accept.

Modifying Clients Settings
This feature is for external users, who inherits the settings from their assigned group upon login. NetExtender 
client settings can be specified for the user, or use the group settings. To enable NetExtender/Mobile Connect 
ranges and configure Static client settings for a user:

1 Navigate to Users > Local Users.

2 Click the configure icon next to the user you want to configure.

3 In the Edit Local User page, select the Clients page.

a Under Client Address Range, select Use Static Pool from the drop-down list. 

b Supply a beginning client IPv4 address in the Client Address Range Begin field.

c Supply an ending client IPv4 address in the Client Address Range End field.

d Under Client IPv6 Address Range, optionally select Use Static Pool from the drop-down list. 

e Supply a beginning client IPv6 address in the Client Address Range Begin field.

f If using IPv6, supply an ending client IPv6 address in the Client Address Range End field.
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4 Under DNS Settings: 

Enter the following:

• Primary DNS Server: Type the address of the primary DNS server in the Primary DNS Server 
field.

• Secondary DNS Server: Optionally, type the IP address of the secondary server in the Secondary 
DNS Server field.

• DNS Search List (in order): Type the DNS domain suffix and click Add. Next, use the up and down 
arrows to prioritize multiple DNS domains in the order they should be used.

• For SMA appliances supporting connections from Apple iPhones, iPads, or other iOS 
devices using SonicWall Mobile Connect, use this DNS Search List. This DNS domain is set 
on the VPN interface of the iPhone/iPad after the device makes a connection to the 
appliance. When the mobile device user accesses a URL, iOS determines if the domain 
matches the VPN interface’s domain, and if so, uses the VPN interface’s DNS server to 
resolve the hostname lookup. Otherwise, the Wi-Fi or 3G/4G DNS server is used that is not 
able to resolve hosts within the company intranet.
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5 Under Client Settings:

Select one of the following from the Exit Client After Disconnect drop-down list:

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

6 In the Uninstall Client After Exit drop-down list, select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

7 In the Allow Client to Turn Off Auto Update drop-down list, select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

8 In the Create Client Connection Profile drop-down list, select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

9 In the User Name & Password Caching drop-down list, select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Allow saving of user name only - Allow caching of the user name. The user only needs to enter 
a password when starting NetExtender. Overrides the group setting.

• Allow saving of user name & password - Allow caching of the user name and password. The 
user is automatically logged in when starting NetExtender. Overrides the group setting.
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• Prohibit saving of user name & password - Do not allow caching of the user name and 
password. The user is required to enter both user name and password when starting NetExtender. 
Overrides the group setting.

10 In the Allow client to use Touch ID on IOS devices, the control only blocks future attempts to log in with 
fingerprint technology on IOS devices when the option is disabled as there is no method for the server to 
change the client settings until the client attempts a connection. So in some cases, a client might not be 
conforming to previous policies for the initial connection. Configuration is allowed globally, by group, or 
per user.

11 In the Allow client to use Fingerprint Authentication on Android devices, the control only blocks future 
attempts to log in with fingerprint technology on Android devices when the option is disabled as there is 
no method for the server to change the client settings until the client attempts a connection. So in some 
cases, a client might not be conforming to previous policies for the initial connection. Configuration is 
allowed globally, by group, or per user.

12 In the Allow client to use Touch ID on macOS devices, the control only blocks future attempts to log in 
with fingerprint technology on macOS devices when the option is disabled as there is no method for the 
server to change the client settings until the client attempts a connection. So in some cases, a client 
might not be conforming to previous policies for the initial connection. Configuration is allowed globally, 
by group, or per user.

13 In the Allow client to use Face ID on iOS devices, the control only block future attempts to log in with 
Face ID technology on iOS devices when the option is disabled there is no method for the server to 
change client settings until the client attempts connection. So in some cases, a client might not be 
conforming to previous policies for the initial connection. Configuration is allowed globally, by group, or 
per user.

14 In the Always on VPN section, configure the following:

• For Enable Always on VPN, select one of the following:

• Use global setting - Take the action specified by the global setting. 

• Enabled - Enable this action for the user. Overrides the global setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

• For Allow User to Disconnect select one of the following: 

• Use global setting - Take the action specified by the global setting. 

• Enabled - Enable this action for the user. Overrides the global setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

• For Allowing accessing network if VPN fail to connect select one of the following: 

• Use global setting - Take the action specified by the global setting. 

• Enabled - Enable this action for the user. Overrides the global setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

• For Don’t connect VPN in trusted network select one of the following:

• Use global setting - Take the action specified by the global setting. 

• Enabled - Enable this action for the user. Overrides the global setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

15 In the Internal Proxy Settings section, select from the drop-down list to apply global settings or to 
enable or disable the Internal Proxy feature. Click Accept.
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To enable client ranges and configure DHCP client settings for a user:

1 Navigate to Users > Local Users.

2 Click the configure icon next to the user you want to configure.

3 In the Edit Local User page, select the Clients page.

a Under Client Address Range, select Use DHCP from the drop-down list. 

b Under Select Interface, use the drop-down list to select the interface to use for DHCP.

c Supply the DHCP Server in the field provided. 

d Under Client IPv6 Address Range, optionally select Use DHCPv6 from the drop-down list. 

e Under Select Interface, use the drop-down list to select the interface to use for DHCPv6.

f Optionally supply the DHCPv6 Server in the field provided.

4 Under DNS Settings: 

Enter the following:

• Primary DNS Server: Type the address of the primary DNS server in the Primary DNS Server 
field.

• Secondary DNS Server: Optionally, type the IP address of the secondary server in the Secondary 
DNS Server field.

• DNS Search List (in order): Type the DNS domain suffix and click Add. Next, use the up and down 
arrows to prioritize multiple DNS domains in the order they should be used.

For SMA appliances supporting connections from Apple iPhones, iPads, or other iOS devices using 
SonicWall Mobile Connect, use this DNS Search List. This DNS domain is set on the VPN interface of the 
iPhone/iPad after the device makes a connection to the appliance. When the mobile device user 
accesses a URL, iOS determines if the domain matches the VPN interface’s domain, and if so, uses the 
VPN interface’s DNS server to resolve the hostname lookup. Otherwise, the Wi-Fi or 3G/4G DNS server is 
used that is not able to resolve hosts within the company intranet.

5 Under Client Settings, select one of the following from the Exit Client After Disconnect drop-down list:

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

6 In the Uninstall Client After Exit drop-down list, select one of the following:

• Use group setting - Take the action specified by the group setting. 
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• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

7 In the Create Client Connection Profile drop-down list, select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

8 In the User Name & Password Caching drop-down list, select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Allow saving of user name only - Allow caching of the user name. The user only needs to enter 
a password when starting NetExtender. Overrides the group setting.

• Allow saving of user name & password - Allow caching of the user name and password. The 
user is automatically logged in when starting NetExtender. Overrides the group setting.

• Prohibit saving of user name & password - Do not allow caching of the user name and 
password. The user is required to enter both user name and password when starting NetExtender. 
Overrides the group setting.

9 In the Allow client to use Touch ID on IOS devices, the control only blocks future attempts to log in with 
fingerprint technology on IOS devices when the option is disabled as there is no method for the server to 
change the client settings until the client attempts a connection. So in some cases, a client might not be 
conforming to previous policies for the initial connection. Configuration is allowed globally, by group, or 
per user.

10 In the Allow client to use Fingerprint Authentication on Android devices, the control only blocks future 
attempts to log in with fingerprint technology on Android devices when the option is disabled as there is 
no method for the server to change the client settings until the client attempts a connection. So in some 
cases, a client might not be conforming to previous policies for the initial connection. Configuration is 
allowed globally, by group, or per user.

11 In the Allow client to use Touch ID on macOS devices, the control only blocks future attempts to log in 
with fingerprint technology on macOS devices when the option is disabled as there is no method for the 
server to change the client settings until the client attempts a connection. So in some cases, a client 
might not be conforming to previous policies for the initial connection. Configuration is allowed globally, 
by group, or per user.

12 In the Allow client to use Face ID on iOS devices, the control only block future attempts to log in with 
Face ID technology on iOS devices when the option is disabled there is no method for the server to 
change client settings until the client attempts connection. So in some cases, a client might not be 
conforming to previous policies for the initial connection. Configuration is allowed globally, by group, or 
per user.

13 In the Always on VPN section, configure the following:

• For Enable Always on VPN, select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

• For Allow User to Disconnect select one of the following: 

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.
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• For Allowing accessing network if VPN fail to connect select one of the following: 

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

• For Don’t connect VPN in trusted network select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

14 In the Internal Proxy Settings section, select from the drop-down list to enable or disable the Internal 
Proxy feature. 

15 Click Accept. 

To select user-mapped address settings for a user:

1 In the SMA management interface, navigate to Users > Local Users.

2 Hover over a user and click the Edit icon.

3 Click Clients tab. 

4 In the CLIENT ADDRESS RANGE section, select Use user-mapped address.

5 Click Submit.

Modifying NetExtender Client Routes
The Routes page provides configuration options for NetExtender client routes. For procedures on modifying 
NetExtender client route settings

Adding User Policies
The Policies page provides policy configuration options. 

Topics: 

• Adding a Policy for an IP Address

• Adding a Policy for an IP Network

• Adding a Policy for All Addresses
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• Setting File Shares Access Policies

• Adding a Policy for a File Share

• Adding a Policy for a URL Object

• Policy URL Object Field Elements

• Adding a Policy for All IPv6 Addresses

• Adding a Policy for an IPv6 Address

• Adding a Policy for an IPv6 Network

To add a user access policy:

1 On the Policies page, click Add Policy. The Add Policy window is displayed.

2 In the Apply Policy To drop-down list, select whether the policy is applied to an individual host, a range 
of addresses, all addresses, a network object, a server path, or a URL object. You can also select an 
individual IPv6 host, a range of IPv6 addresses, or all IPv6 addresses. The Add Policy window changes 
depending on what type of object you select in the Apply Policy To drop-down list.

• IP Address - If your policy applies to a specific host, enter the IP address of the local host machine 
in the IP Address field. Optionally enter a port range (for example, 4100-4200) or a single port 
number into the Port Range/Port Number field. 

• IP Network - If your policy applies to a range of addresses, enter the beginning IP address in the 
IP Network Address field and the subnet mask that defines the IP address range in the Subnet 
Mask field. Optionally enter a port range (for example, 4100-4200) or a single port number into 
the Port Range/Port Number field. 

• All Addresses - If your policy applies to all IPv4 addresses, you do not need to enter any IP 
address information. 

• Network Object - If your policy applies to a predefined network object, select the name of the 
object from the Network Object drop-down list. A port or port range can be specified when 
defining a Network Object. 

• Server Path - If your policy applies to a server path, select one of the following radio buttons in 
the Resource field: 

• Share (Server path) - When you select this option, type the path into the Server Path field.

• Network (Domain list)
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• Servers (Computer list)

• URL Object - If your policy applies to a predefined URL object, type the URL into the URL field. 

• All IPv6 Address - If your policy applies to all IPv6 addresses, you do not need to enter any IP 
address information. 

• IPv6 Address - If your policy applies to a specific host, enter the IPv6 address of the local host 
machine in the IPv6 Address field. Optionally enter a port range (for example, 4100-4200) or a 
single port number into the Port Range/Port Number field.

• IPv6 Network - If your policy applies to a range of addresses, enter the beginning IPv6 address in 
the IPv6 Network Address field and the prefix that defines the IPv6 address range in the IPv6 
Prefix field. Optionally enter a port range (for example, 4100-4200) or a single port number into 
the Port Range/Port Number field. .

3 Select the desired Protocol. The available value options in the Protocol field include: TCP, UDP, ICMP, and 
ALL. You can select multiple items among TCP, UDP, and ICMP. However, when ALL is selected, all others 
options are deselected.

4 Select the service type in the Service drop-down list. If you are applying a policy to a network object, the 
service type is defined in the network object.

5 Select Allow or Deny from the Status drop-down list to either permit or deny SMA connections for the 
specified service and host machine.

6 Click Accept to update the configuration. After the configuration has been updated, the new policy is 
displayed in the Edit Local User page.

The user policies are displayed in the Current User Policies table in the order of priority, from the 
highest priority policy to the lowest priority policy.

Adding a Policy for an IP Address
1 Navigate to Users > Local Users.

2 Click the configure icon next to the user you want to configure.

3 Select the Policies page.

4 Click Add Policy...

5 In the Apply Policy to field, click the IP Address option.

6 Define a name for the policy in the Policy Name field.

7 Type an IP address in the IP Address field.

8 Select the desired Protocol. The available value options in the Protocol field include: TCP, UDP, ICMP, and 
ALL. You can select multiple items among TCP, UDP, and ICMP. However, when ALL is selected, all others 
options are deselected.

9 In the Port Range/Port Number field, optionally enter a port range or an individual port.

10 In the Service drop-down list, click on a service object.

11 In the Status drop-down list, click on an access action, either Allow or Deny.

12 Click Accept.

Adding a Policy for an IP Network
1 In the Apply Policy to field, click the IP Network option.

2 Define a name for the policy in the Policy Name field.
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3 Type a starting IP address in the IP Network Address field.

4 Type a subnet mask value in the Subnet Mask field in the form 255.255.255.0.

5 Select the desired Protocol. The available value options in the Protocol field include: TCP, UDP, ICMP, and 
ALL. You can select multiple items among TCP, UDP, and ICMP. However, when ALL is selected, all others 
options are deselected.

6 In the Port Range/Port Number field, optionally enter a port range or an individual port.

7 In the Service drop-down list, click on a service option.

8 In the Status drop-down list, click on an access action, either Allow or Deny.

9 Click Accept.

Adding a Policy for All Addresses
1 In the Apply Policy to field, select the All Addresses option.

2 Define a name for the policy in the Policy Name field.

3 Select the desired Protocol. The available value options in the Protocol field include: TCP, UDP, ICMP, and 
ALL. You can select multiple items among TCP, UDP, and ICMP. However, when ALL is selected, all others 
options are deselected.

4 The IP Address Range field is read-only, specifying All IP Addresses.

5 In the Service drop-down list, click on a service option.

6 In the Status drop-down list, click on an access action, either Allow or Deny.

7 Click Accept.

Setting File Shares Access Policies

To set file share access policies:

1 Navigate to Users > Local Users.

2 Click the configure icon next to the user you want to configure.

3 Select the Policies page.

4 Click Add Policy.
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5 Select Server Path from the Apply Policy To drop-down list.

6 Type a name for the policy in the Policy Name field.

7 Select Share in the Resource field.

8 Type the server path in the Server Path field.

9 From the Status drop-down list, select Allow or Deny.

10 Click Accept.

Adding a Policy for a File Share

To add a file share access policy:

1 Navigate to Users > Local Users.

2 Click the configure icon next to the user you want to configure.

3 Select the Policies page.

4 Click Add Policy...

5 Select Server Path from the Apply Policy To drop-down list.

6 Type a name for the policy in the Policy Name field.
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7 In the Server Path field, enter the server path in the format servername/share/path or 
servername\share\path. The prefixes \\, //, \ and / are acceptable.

8 Select Allow or Deny from the Status drop-down list.

9 Click Accept.

Adding a Policy for a URL Object

To create object-based HTTP or HTTPS user policies:

1 Navigate to Users > Local Users.

2 Click the configure icon next to the user you want to configure.

3 Select the Policies page.

4 Click Add Policy.

5 In the Apply Policy To drop-down menu, select the URL Object option.

6 Define a name for the policy in the Policy Name field.

7 In the Service drop-down list, choose either Web (HTTP) or Secure Web (HTTPS).

8 In the URL field, add the URL string to be enforced in this policy.

9 In the Status drop-down list, click on an access action, either Allow or Deny.

10 Click Accept.

Policy URL Object Field Elements
When creating an HTTP/HTTPS policy, the administrator must enter a valid host URL in the URL field. In addition, 
the administrator can enter the port, path and wildcard elements to this field. The following chart provides an 
overview of standard URL field elements: 
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Adding a Policy for All IPv6 Addresses

Standard URL field elements

Element Usage

Host Can be a hostname that should be resolved or an IP address. Host information 
has to be present.

Port If port is not mentioned, then all ports for that host are matched. Specify a 
specific port or port range using digits [0-9], and/or wildcard elements. Zero “0” 
must not be used as the first digit in this field. The least possible number 
matching the wildcard expression should fall within the range of valid port 
numbers such as [1-65535].

Path This is the file path of the URL along with the query string. A URL Path is made of 
parts delimited by the file path separator ‘/’. Each part might contain wildcard 
characters. The scope of the wildcard characters is limited only to the specific 
part contained between file path separators.

Usernames %USERNAME% is a variable that matches the username appearing in a URL 
requested by a user with a valid session. Especially useful if the policy is a group 
or a global policy.

Wildcard Characters The following wildcard characters are used to match one or more characters 
within a port or path specification.
* – Matches one or more characters in that position.
^ – Matches exactly one character in the position.
[!<character set>] – Matches any character in that position not listed in 
character set. For example [!acd], [!8a0]
[<range>] – Matches any character falling within the specified ASCII range. Can 
be an alphanumeric character. For example, [a-d], [3-5], [H-X]
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To add a policy for all IPv6 addresses:

1 In the Apply Policy To field, select the All IPv6 Address option.

2 Define a name for the policy in the Policy Name field.

3 The IPv6 Address Range field is read-only, specifying all IPv6 addresses.

4 In the Service drop-down list, click on a service option.

5 In the Status drop-down list, click on an access action, either Allow or Deny.

6 Click Accept.

Adding a Policy for an IPv6 Address

To add a policy for an IPv6 address:

1 Navigate to Users > Local Users.

2 Click the configure icon next to the user you want to configure.

3 Select the Policies page.

4 Click Add Policy...

5 In the Apply Policy To field, click the IPv6 Address option.

6 Define a name for the policy in the Policy Name field.

7 Type an IPv6 address in the IPv6 Address field in the form 2001::1:2:3:4.

8 In the Port Range/Port Number field, optionally enter a port range or an individual port.

9 In the Service drop-down list, click on a service object.

10 In the Status drop-down list, click on an access action, either Allow or Deny.

11 Click Accept.

Adding a Policy for an IPv6 Network

To add a policy for an IPv6 Network:

1 In the Apply Policy To field, click the IPv6 Network option.

2 Define a name for the policy in the Policy Name field.
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3 Type a starting IPv6 address in the IPv6 Network Address field.

4 Type a prefix value in the IPv6 Prefix field, such as 64 or 112.

5 In the Port Range/Port Number field, optionally enter a port range or an individual port.

6 In the Service drop-down list, click on a service option.

7 In the Status drop-down list, click on an access action, either Allow or Deny.

8 Click Accept.

Adding or Editing User Bookmarks
The Bookmarks page provides configuration options to add and edit user bookmarks. In addition to the main 
procedure that follows, see the following:

To define user bookmarks:

1 In the Edit User Settings window, click the Bookmarks page.

2 Click Add Bookmark. The Add Bookmark window displays.

When user bookmarks are defined, the user sees the defined bookmarks from the Secure Mobile Access 
Virtual Office home page.

3 Type a descriptive name for the bookmark in the Bookmark Name field.

4 Enter the fully qualified domain name (FQDN) or the IPv4 or IPv6 address of a host machine on the LAN 
in the Name or IP Address field. In some environments you can enter the host name only, such as when 
creating a VNC bookmark in a Windows local network.

If a Port number is included with an IPv6 address in the Name or IP Address field, the IPv6 address must 
be enclosed in square brackets, for example: [2008::1:2:3:4]:6818. 
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Some services can run on non-standard ports, and some expect a path when connecting. Depending on 
the choice in the Service field, format the Name or IP Address field 

Bookmark Name or IP Address Formats by Service Type

Service Type Format Example for Name or IP Address Field

RDP - HTML5
RDP - Native

IP Address
IPv6 Address
IP:Port (non-standard)
FQDN
Host name

10.20.30.4
2008::1:2:3:4
10.20.30.4:6818
JBJONES-PC.sv.us.sonicwall.com
JBJONES-PC

VNC
VNC - HTML5

IP Address
IPv6 Address
IP:Port (mapped to session)
FQDN
Host name
NOTE: Do not use session or 
display number instead of port.

10.20.30.4
2008::1:2:3:4
10.20.30.4:5901 (mapped to session 1)
JBJONES-PC.sv.us.sonicwall.com
JBJONES-PC
NOTE: Do not use 10.20.30.4:1
TIP: For a bookmark to a Linux server, see the Tip 
below this table.

Citrix
(Citrix Web 
Interface)
Citrix - HTML5
Citrix - Native
Citrix - ActiveX

IP Address
IPv6 Address
IP:Port
IP:Path or File
IP:Port:Path or File
FQDN
URL:Path or File
URL:Port
URL:Port:Path or File
Note: Port refers to the HTTP(S) 
port of Citrix Web Interface, not 
to the Citrix client port.

172.55.44.3
2008::1:2:3:4
172.55.44.3:8080 or [2008::1:2:3:4]:8080
172.55.44.3/folder/file.html
172.55.44.3:8080/report.pdf
www.citrixhost.company.net
www.citrixhost.net/folder/
www.citrixhost.company.com:8080
www.citrixhost.com:8080/folder/index.html

HTTP
HTTPS

URL
IP Address of URL
IPv6 Address
URL:Path or File
IP:Path or File
URL:Port
IP:Port
URL:Port:Path or File
IP:Port:Path or File

www.sonicwall.com
204.212.170.11
2008::1:2:3:4
www.sonicwall.com/index.html
204.212.170.11/folder/
www.sonicwall.com:8080
204.212.170.11:8080 or [2008::1:2:3:4]:8080
www.sonicwall.com:8080/folder/index.html
204.212.170.11:8080/index.html
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5 Optionally, you can enter a friendly description to be displayed in the bookmark table by filling in the 
Description field.

6 Optionally, you can enter a comma-separated list of categories where this bookmark appears in the 
Categories field. For example: Favorites, Tab1, Tab 2. Note that standard tabs, such as Desktop, Web, 
Terminal, or Mobile, do not need to be specified. 

7 Set whether users are can edit or delete bookmarks from the Virtual Office portal by making a selection 
for Allow user to edit/delete. You can select to Allow, Deny, or to Use the user policy setting.

8 Select one of the service types from the Service drop-down list. 

File Shares 
(CIFS)

Host\Folder\
Host\File
FQDN\Folder
FQDN\File
IP\Folder\
IP\File

server-3\sharedfolder\
server-3\inventory.xls
server-3.company.net\sharedfolder\
server-3company.net\inventory.xls
10.20.30.4\sharedfolder\
10.20.30.4\status.doc
NOTE: Use backslashes even on Linux or Mac 
computers; these use the Windows API for file 
sharing.

FTP IP Address
IPv6 Address
IP:Port (non-standard)
FQDN
Host name

10.20.30.4
2008::1:2:3:4
10.20.30.4:6818 or [2008::1:2:3:4]:6818
JBJONES-PC.sv.us.sonicwall.com
JBJONES-PC

Telnet
Telnet - HTML5

IP Address
IPv6 Address
IP:Port (non-standard)
FQDN
Host name

10.20.30.4
2008::1:2:3:4
10.20.30.4:6818 or [2008::1:2:3:4]:6818
JBJONES-PC.sv.us.sonicwall.com
JBJONES-PC

SSHv2 IP Address
IPv6 Address
IP:Port (non-standard)
FQDN
Host name

10.20.30.4
2008::1:2:3:4
10.20.30.4:6818 or [2008::1:2:3:4]:6818
JBJONES-PC.sv.us.sonicwall.com
JBJONES-PC

Bookmark Name or IP Address Formats by Service Type (Continued)

Service Type Format Example for Name or IP Address Field
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For the specific service you select from the Service drop-down list, additional fields might appear. Use 
the following information for the chosen service to complete the building of the bookmark:

• Terminal Services (RDP) or Terminal Services (RDP - HTML5)

• Virtual Network Computing (VNC)

• Citrix Portal (Citrix)

• Web (HTTP)

• Secure Web (HTTPS)

• External Web Site

• Mobile Connect

• File Shares (CIFS)

• File Transfer Protocol (FTP)

• SSH File Transfer Protocol (SFTP)

• Telnet

• Secure Shell Version 2 (SSHv2)

Terminal Services (RDP) or Terminal Services (RDP - 
HTML5)

• In the Screen Size drop-down list, select the default terminal services screen size to be used 
when users execute this bookmark. (Option available for all Terminal Services.)

Because different computers support different screen sizes, when you use a remote desktop 
application, you should select the size of the screen on the computer from which you are running 
a remote desktop session. Additionally, you might want to provide a path to where your 
application resides on your remote computer by typing the path in the Application Path field.

• In the Colors drop-down list, select the default color depth for the terminal service screen when 
users execute this bookmark. (Option available for all Terminal Services.)

• Select an Access Type Selection. Smart or Manual. 
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• Smart: Allows the firmware to decide which mode to launch on the client.

When creating a new unified bookmark, Smart is selected by default. Auto-detection is 
processed using bookmark-specific default modes while launching the bookmark.

• Manual: Provides options to configure the modes, their priorities, and the choose method. 
At least one mode should be enabled in the selection box.

The launch sequence is as follows: HTML5 and Native. Selecting Manual allows you to 
change, enable, or disable the launch methods. If you select Native to launch the RDP 
bookmark, then the SMA Connect Agent launches the RDP Client on the local machine to 
do the RDP connection.

The up and down arrows are used to adjust the launch priority. Fork and tick are used to 
disable or enable the modes. Disabled modes are put at the bottom of the list with a gray 
font color.

The Choose during Launch option is not enabled by default under the Manual mode. In 
this setting, while launching the bookmark, the first available mode in the configured list is 
run at once after auto-detection.

After the Choose during Launch option is enabled, while launching the unified bookmark, 
if there are multiple modes available for the client, a menu is provided from which you can 
choose within a five second count-down. When only one mode is available, the bookmark 
is also run immediately.

If the Remember my choice option is selected during the launch time, the selected mode 
is remembered through a cookie. 

That means, when next launching the bookmark, the remembered mode is run directly 
within two seconds. Clicking anywhere in the HTML can 'forget' the remembered mode so 
you can re-choose.

Editing or deleting the bookmark in the same browser can also reset the remembered 
mode.

• Select Enable wake-on-LAN to enable waking up a computer over the network connection. 
Selecting this check box causes the following new fields to be displayed: (Options available for all 
Terminal Services.)

• MAC/Ethernet Address – Enter one or more MAC addresses, separated by spaces, of 
target hosts to wake.

• Wait time for boot-up (seconds) – Enter the number of seconds to wait for the target 
host to fully boot up before cancelling the WoL operation.

• Send WOL packet to host name or IP address – To send the WoL packet to the hostname 
or IP of this bookmark, select Send WOL packet to host name or IP address that can be 
applied in tandem with a MAC address of another machine to wake.
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• Optionally enter the local path for this application in the Application and Path field and specify 
the folder in the Start in the following folder field. The remote application feature displays a 
single application to the user. The value might also be the alias of the remote application.

• Enter the Command-line Arguments for the RemoteApp. (Option available for ActiveX only.)

• In the Start in the following folder field, optionally enter the local folder in which to execute 
application commands. (Option available for ActiveX only.)

• Select Login as console/admin session to allow login as console or admin. Login as admin 
replaces login as console in RDC 6.1 and newer. (Option available for all Terminal Services.)

• Select the Server is TS Farm if users are connecting to a TS Farm or Load Balanced server. 

In Windows 2012, there is a new way to do the redirection (load balance). The RDP client can 
connect to the broker server directly, and then the broker server returns the redirection 
information to the client. The RDP client can connect to the RDP Host in the “Collection.”

When you access the Windows 2012 RD Web, download the RDP file by clicking the item on the 
page. The RDP file contains a line with the following string:

“loadbalanceinfo:s:tsv://MS Terminal Services Plugin.1.<CollectionName>”

The <CollectionName> is the collection name in the user’s farm. This line is the “Load Balance 
Information.” The broker server needs this information to do the load balancing (redirection).

• Enter the Terminal Services Broker information in the Load Balance Info box, such as tsv://MS 
Terminal Services Plugin.1.SSLVPN. Maximum length is 1024 characters. For the 
bookmark with complex options (like RDP), options are mixed from all the modes and 
distinguished with tips like *non-html5, or *for html5.

By default, the bookmark only connects to the provided name and IP address. If you enable this 
feature, the SMA appliance obtains the redirected address and connects the user to the correct 
server. Note that Interactive Login might need to be disabled for this feature to work properly.

• For RDP - HTML5, select the Default Language from the drop-down menu.

• For Windows clients or on Mac clients running Mac OS X 10.5 or higher with RDC installed, 
expand Show advanced Windows options and select the check boxes to redirect the following 
features on the local network for use in this bookmark. For RDP - HTML5 or Native, few of the 
following Advanced Windows options are available:

• Desktop background

• Menu/window animation
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• Show window contents while dragging/resizing

• Redirect clipboard

• File Share

• Redirect drives

• Redirect SmartCards

• Bitmap caching

• Auto-reconnection

• Visual styles

• Remote copy

• Redirect printers 

• Redirect ports

• Display connection bar

• Select the Remote Audio option from the drop-down list. Audio redirection enables the 
user to play an audio clip on the server, either remotely or locally. Valid selections are Play 
on this computer, Play on remote computer, or Do not play. Note that this feature is 
currently supported by Chrome, Firefox, and Safari. 

• If the client application is RDP6, you can select any of the following options: (Option available for 
all Terminal Services)

• Font smoothing

• Span monitors

• Desktop composition

• Dual monitors

• Remote application

• Select the Connection Speed from the drop-down list (low-speed broadband or high speed 
broadband) for optimized performance. (Option available for all Terminal Services.)

• Select the action from the drop-down list that happens in the event that the Server 
Authentication fails. Server authentication verifies that you are connecting to the intended 
remote computer. The strength of the verification required to connect is determined by your 
system security policy. (Option available for all Terminal Services.)

• Click Import RDP Options. When the RDP file finishes downloading, open it with a text editor 
(such as Notepad) and select the entire file content. Copy the content and paste the text into the 
text field in Import RDP Options. Click OK. The feature selects the support options to import into 
the bookmark.

The following table lists the RDP options and the RDP file options.

Bookmark field RDP option

Name or IP Address full address:s:<value>

Screen Size desktopheight:i:<value>
desktopwidth:i:<value>

Colors session bpp:i:<value>

Load Balance Info loadbalanceinfo:s:<value>

Desktop Background disable wallpaper:i:<value>

Auto-Reconnection autoreconnection enabled:i:<value>



SonicWall Secure Mobile Access 10.2 Administration Guide
Users Configuration 292

• Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the RDP server. Enable the 
Use Login Domain for SSO option to pass the user’s domain to the RDP server. Windows 2008 
and newer servers might require this option to be enabled. (Option available for all Terminal 
Services.)

Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark.

Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices. 
(Option available for all Terminal Services.)

Limitations to Terminal Services Farm Bookmarks from Virtual Office

Verify access and configuration is setup properly outside the remote access appliance first by connecting with 
NetExtender then running your RDP client to connect as if you would were you inside your network. If 
NetExtender is unable to connect properly there is likely another device or setting on the network that needs to 
be configured properly. 

Refer to your server's guide or contact Microsoft for additional help regarding Terminal Server settings if the 
provided instructions do not work for you to change the settings.

• Interactive Login might need to be disabled. The windows login notice prevents the proxy from obtaining 
the correct redirection server.

• Run gpedit.msc and go to Computer Configuration > Windows Settings > Local Policies > Security 
Options and look for Interactive logon: Message title for users attempting to log on and Interactive 
logon: Message text for users attempting to logon and ensure both are blank. 

• Multiple RDP Sessions might need to be disabled. Multiple RDP sessions might cause more than one 
redirection preventing the bookmark proxy from being able to connect to the correct server. Restricting 
the user to on session in the Group policy prevents from occurring.

Menu/Window Animation disable menu anims:i:<value>

Visual Styles disable themes:i:<value>

Show Window contents while dragging/resizing disable full window drag:i:<value>

Redirect clipboard & Remote Copy redirectclipboard:i:<value>

Redirect printers redirectprinters:i:<value>

Redirect drives redirectdrives:i:<value>

Redirect ports redirectcomports:i:<value>

Redirect SmartCards redirectsmartcards:i:<value>

Display connection bar displayconnectionbar:i:<value>

Bitmap caching bitmapcachepersistenable:i:<value>

Remote audio audiomode:i:<value>

Font smoothing allow font smoothing:i:<value>

Span monitors span monitors:i:<value>

Dual monitors use multimon:i:<value>

Desktop composition allow desktop composition:i:<value>

Remote Application remoteapplicationmode:i:<value>

Choose your connection speed to optimize 
performance

connection type:i:<value>

Bookmark field  (Continued) RDP option (Continued)
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• Run gpedit.msc on the remote server and go to Computer Configuration > Administrative Templates > 
Windows Components > Remote Desktop Services > Remote Desktop Session Host > Connections and 
set the Restrict Remote Desktop Services user to a single Remote Desktop Services session to Enabled.

• Note that we create a new session request when connecting to the RDP server and are unable to clear 
the old session through the bookmark. There might be some issues with your server setup depending on 
your available licenses and how disconnected sessions are handled.

• Ensure SSO is correct if that option is enabled. Improper SSO credentials prevents the bookmark from 
accessing the server properly. If you are running into issues, try disabling SSO and ensuring the proper 
credentials are entered for connection.

• HTML5 RDP Client is recommended for usage for users connecting from systems unable to take 
advantage of a native RDP client. Most modern browsers support the Web Sockets feature required for 
connection and should be available on the systems that do not have a native RDP client.

Virtual Network Computing (VNC)
• Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 

credentials from the current Secure Mobile Access session for log in to the RDP server. Enable the 
Use Login Domain for SSO option to pass the user’s domain to the RDP server.

• In the Encoding drop-down list, select one of:

• Raw – Pixel data is sent in left-to-right scanline order, and only rectangles with changes are 
sent after the original full screen has been transmitted.

• RRE – Rise-and-Run-length-Encoding uses a sequence of identical pixels that are 
compressed to a single value and repeat count. This is an efficient encoding for large 
blocks of constant color.

• CoRRE – A variation of RRE, using a maximum of 255x255 pixel rectangles, allowing for 
single-byte values to be used. More efficient than RRE except where very large regions are 
the same color.

• Hextile – Rectangles are split up in to 16x16 tiles of raw or RRE data and sent in a 
predetermined order. Best used in high-speed network environments such as within the 
LAN.

• Zlib – Simple encoding using the zlib library to compress raw pixel data, costing a lot of 
CPU time. Supported for compatibility with VNC servers that might not understand Tight 
encoding which is more efficient than Zlib in nearly all real-life situations.
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• Tight – The default and the best encoding to use with VNC over the Internet or other 
low-bandwidth network environments. Uses zlib library to compress pre-processed pixel 
data to maximize compression ratios and minimize CPU usage.

• In the Compression Level drop-down list, select the level of compression as Default or from 1 to 
9 where 1 is the lowest compression and 9 is highly compressed. 

• The JPEG Image Quality option is not editable and is set at 6.

• In the Cursor Shape Updates drop-down list, select Enable, Ignore, or Disable. The default is 
Ignore.

• Select Use CopyRect to gain efficiency when moving items on the screen. 

• Select Restricted Colors (256 Colors) for more efficiency with slightly less depth of color.

• Select Reverse Mouse Buttons 2 and 3 to switch the right-click and left-click buttons.

• Select View Only to disable keyboard and mouse events in the desktop window. 

• Select Share Desktop to allow multiple users to view and use the same VNC desktop.

• Select Display Bookmark to Mobile Connect clients to enable bookmark viewing on Mobile 
Connect clients. Mobile Connect must be running version 2.0 or newer to view and access this 
bookmark. 

Citrix Portal (Citrix)
1 In the Resource Window Size drop-down list, select the default Citrix portal screen size to be used when 

users execute this bookmark. 

2 Select an Access Type Selection. Smart or Manual. 

• Smart: Allows the firmware to decide which mode to launch on the client.

When creating a new unified bookmark, Smart is selected by default. Auto-detection is processed 
using bookmark-specific default modes while launching the bookmark.

• Manual: Provides options to configure the modes, their priorities, and the choose method. At 
least one mode should be enabled in the selection box.

The launch sequence is as follows: HTML5, Native, and ActiveX. Selecting Manual allows you to 
change, enable, or disable the launch methods. If you select Native to launch the Citrix 
bookmark, then the SMA Connect Agent launches the Citrix Receiver on the local machine to do 
the Citrix connection.

The up and down arrows are used to adjust the launch priority. Fork and tick are used to disable 
or enable the modes. Disabled modes are put at the bottom of the list with a gray font color.
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The Choose during Launch option is not enabled by default under the Manual mode. In this 
setting, while launching the bookmark, the first available mode in the configured list is run at 
once after auto-detection.

After the Choose during Launch option is enabled, while launching the unified bookmark, if there 
are multiple modes available for the client, a menu is provided from which you can choose within 
a five second count-down. When only one mode is available, the bookmark is also run 
immediately.

If the Remember my choice option is selected during the launch time, the selected mode is 
remembered through a cookie. 

That means, when next launching the bookmark, the remembered mode is run directly within 
two seconds. Clicking anywhere in the HTML can 'forget' the remembered mode so you can 
re-choose.

Editing or deleting the bookmark in the same browser can also reset the remembered mode.

When no modes are able to run on the client with the configuration, the following notice appears.

• Optionally select HTTPS Mode to use HTTPS to securely access the Citrix Portal.

• Optionally, select Always use specified Citrix ICA Server and specify the IP address in the ICA 
Server Address field that appears. This setting allows you to specify the Citrix ICA Server address 
for the Citrix ICA session. By default, the bookmark uses the information provided in the ICA 
configuration on the Citrix server.

• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

Web (HTTP)

• Optionally select Automatically log in and select Use SSL VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the Web server. Select Use 
custom credentials to enter a custom username, password, and domain for this bookmark. . 

• Select Forms-based Authentication to configure Single Sign-On for forms-based authentication. 
Configure the User Form Field to be the same as the ‘name’ and ‘id’ attribute of the HTML 
element representing User Name in the Login form, for example: <input type=text 
name=’userid’>. Configure the Password Form Field to be the same as the ‘name’ or ‘id’ 
attribute of the HTML element representing Password in the Login form, for example: <input 
type=password name=’PASSWORD’ id=’PASSWORD’ maxlength=128>.
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• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

Secure Web (HTTPS)

• Optionally select Automatically log in and select Use SSL VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the secure Web server. 
Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark. 

• Select Forms-based Authentication to configure Single Sign-On for forms-based authentication. 
Configure the User Form Field to be the same as the ‘name’ and ‘id’ attribute of the HTML 
element representing User Name in the Login form, for example: <input type=text 
name=’userid’>. Configure the Password Form Field to be the same as the ‘name’ or ‘id’ 
attribute of the HTML element representing Password in the Login form, for example: <input 
type=password name=’PASSWORD’ id=’PASSWORD’ maxlength=128>.

• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

External Web Site

• Select HTTPS Mode to use SSL to encrypt communications with this Web site.

• Select Disable Security Warning if you do not want to see any security warnings when accessing 
this Web site. Security warnings are normally displayed when this bookmark refers to anything 
other than an Application Offloaded Web site.

• Select Automatically log in to enable the virtual host domain SSO for this bookmark. If the host in 
the bookmark refers to a portal with the same shared domain as this portal, selecting this check 
box allows you to automatically be logged in with this portal’s credential. 

• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

Mobile Connect
• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.
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File Shares (CIFS) 
• To restrict access on the client UI, select Set user to access the specific files/folders. To 

completely restrict access, navigate to the Services > Policies page to set a policy for access 
constraints. 

• Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the RDP server. Enable the 
Use Login Domain for SSO option to pass the user’s domain to the RDP server.

Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark. For more information about custom credentials, 

Enable Display Bookmark to Mobile Connect clients to send bookmark information to Mobile 
Connect clients.

When creating a File Share, do not configure a Distributed File System (DFS) server on a Windows 
Domain Root system. Because the Domain Root allows access only to Windows computers in the 
domain, doing so disables access to the DFS file shares from other domains. The SMA appliance is 
not a domain member and is not able to connect to the DFS shares.

DFS file shares on a stand-alone root are not affected by this Microsoft restriction.

File Transfer Protocol (FTP)
• Expand Show advanced server configuration to select an alternate value in the Character 

Encoding drop-down list. The default is Standard (UTF-8).

• Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the FTP server. 

• Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark. Enable Display Bookmark to Mobile Connect clients to send bookmark information 
to Mobile Connect clients.

When creating a File Share, do not configure a Distributed File System (DFS) server on a Windows 
Domain Root system. Because the Domain Root allows access only to Windows computers in the 
domain, doing so disables access to the DFS file shares from other domains. The SMA appliance is 
not a domain member and is not able to connect to the DFS shares.

DFS file shares on a stand-alone root are not affected by this Microsoft restriction.

SSH File Transfer Protocol (SFTP)
• Expand Show advanced server configuration to select an alternate value in the Character 

Encoding drop-down list. The default is Standard (UTF-8).

• Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the FTP server. Select Use 
custom credentials to enter a custom username, password, and domain for this bookmark. 

• Enable Display Bookmark to Mobile Connect clients to send bookmark information to Mobile 
Connect clients.

Telnet
• Single sign-on is supported for Telnet bookmarks. The bookmark must be configured enabling the 

Automatically log in option in the bookmark settings. If the correct username and password are 
set, the session is logged in automatically.
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• Optionally select Automatically log in and select Use SSL VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the secure Web server. 
Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark. For more information about custom credentials, 

• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

Secure Shell Version 2 (SSHv2)
Single sign-on is supported for SSH bookmarks. The bookmark must be configured enabling the Automatically 
log in option in the bookmark settings. If the correct username and password are set, the session is logged in 
automatically.

For the SSHv2 HTML5 bookmark, SSO is supported for both user name and password authentication. If SSO has 
failed, a menu pops-up to allow you to decide whether to manually fill in the credentials or cancel the log in.

1 Optionally select Automatically log in and select Use SSL VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the Web server. Select Use 
custom credentials to enter a custom username, password, and domain for this bookmark. . 

2 Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

3 Click Accept to update the configuration. After the configuration has been updated, the new user 
bookmark is displayed in the Edit Local User window.

Creating a Citrix Bookmark for a Local User
Citrix bookmarks are supported on Windows, MacOS, and Linux. Citrix support requires Internet connectivity in 
order to download the ActiveX or Java client from the Citrix Web site. Citrix is accessed from Internet Explorer 
using ActiveX by default, or from other browsers using Java. Java can be used with IE by selecting an option in 
the Bookmark configuration. The server automatically decides which Citrix client version to use.

To configure a Citrix bookmark for a user:

1 Navigate to Users > Local Users and click the configure icon next to the user.

2 In the Edit Local User page, select the Bookmarks page.

3 Click Add Bookmark...

4 Enter a name for the bookmark in the Bookmark Name field.

5 Enter the name or IP address of the bookmark in the Name or IP Address field.

6 Optionally enter a friendly Description to be displayed in the bookmark table.

7 Optionally enter a comma-separated list of Tabs where this bookmark should appear. Standard tabs 
(Desktop, Web, Files, Terminal, and Mobile) do not need to be specified. For example; Favorites, Tab 1, 
Tab 2.

8 From the Service drop-down list, select Citrix Portal (Citrix). The display changes.

9 Select a Resource Window Size selection from the drop-down list. 

10 Select an Access Type Selection. Smart or Manual. 

• Smart: Allows the firmware to decide which mode to launch on the client.

When creating a new unified bookmark, Smart is selected by default. Auto-detection is processed 
using bookmark-specific default modes while launching the bookmark.
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• Manual: Provides options to configure the modes, their priorities, and the choose method. At 
least one mode should be enabled in the selection box.

The launch sequence is as follows: HTML5, Native, and ActiveX. Selecting Manual allows you to 
change, enable, or disable the launch methods. If you select Native to launch the Citrix 
bookmark, then the SMA Connect Agent launches the Citrix Receiver on the local machine to do 
the Citrix connection.

The up and down arrows are used to adjust the launch priority. Fork and tick are used to disable 
or enable the modes. Disabled modes are put at the bottom of the list with a gray font color.

The Choose during Launch option is not enabled by default under the Manual mode. In this 
setting, while launching the bookmark, the first available mode in the configured list is run at 
once after auto-detection.

After the Choose during Launch option is enabled, while launching the unified bookmark, if there 
are multiple modes available for the client, a menu is provided from which you can choose within 
a five second count-down. When only one mode is available, the bookmark is also run 
immediately.

If the Remember my choice option is selected during the launch time, the selected mode is 
remembered through a cookie. 

That means, when next launching the bookmark, the remembered mode is run directly within 
two seconds. Clicking anywhere in the HTML can 'forget' the remembered mode so you can 
re-choose.

Editing or deleting the bookmark in the same browser can also reset the remembered mode.

When no modes are able to run on the client with the configuration, the following notice appears.

11 Select the box next to HTTPS Mode to securely access the Citrix portal. 

12 Optionally, select Always use specified Citrix ICA Server and specify the IP address in the ICA Server 
Address field that appears. This setting allows you to specify the Citrix ICA Server address for the Citrix 
ICA session. By default, the bookmark uses the information provided in the ICA configuration on the 
Citrix server.

• Windows - The SMA Connect Agent tries to open the ICA file to launch the Citrix Receiver. If the 
Citrix Receiver is not installed, the system pops up a message.

• Macintosh - The SMA Connect Agent searches for the “Citrix Receiver” App; to be sure you have 
installed the App. The SMA Connect Agent launches the “Citrix Receiver” to make the Citrix 
connection. If you have not yet installed the App, the SMA Connect Agent pops up an alert 
message for you to start the installation.

13 Click Accept.

Creating Bookmarks with Custom SSO 
Credentials
The administrator can configure custom Single Sign On (SSO) credentials for each user, group, or globally in 
HTTP(S), RDP (ActiveX, VNC), File Shares (CIFS), and FTP bookmarks. This feature is used to access resources 
such as HTTP, RDP and FTP servers that need a domain prefix for SSO authentication. Users can log in to the SMA 
appliance as username, and click a customized bookmark to access a server with domain\username. Either 
straight textual parameters or dynamic variables might be used for the Username and Domain. For the 
Password field, enter the custom password to be passed, or leave the field blank to pass the current user’s 
password to the bookmark.
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To configure custom SSO credentials and t Single Sign-On for Forms-based Authentication (FBA):

1 Create or edit a Citrix, HTTP(S), RDP, File Shares (CIFS), or FTP bookmark 

2 For a Citrix bookmark, enable the Automatically log in option. Only Forms-based Authentication can be 
used for a Citrix SSO bookmark. 

In the Bookmarks page, select the Use Custom Credentials option.

3 In the Username and Domain fields, enter the custom text to be passed to the bookmark, or use 
dynamic variables, as follows: 

4 In the Password field, enter the custom password to be passed, or leave the field blank to pass the 
current user’s password to the bookmark.

5 Select Forms-based Authentication to configure Single Sign-On for Forms-based authentication.

• User Form Field - This should be the same as the ‘name’ and ‘ID’ attribute of the HTML element 
representing the User Name in the login form, for example:

<input type=text name=’userid’>

• Password Form Field - This should be the same as the ‘name’ or the ‘ID’ attribute of the HTML 
element representing Password in the login form, for example:

<input type=password name=’PASSWORD’ id=’PASSWORD’ maxlength=128>

6 Check Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

7 Click Accept.

After launching the Citrix bookmark, you can automatically log in to the Citrix StoreFront portal as shown in the 
following image and it is ready to use the XenApp or XenDesktop.

Configuring Login Policies
The Login Policies page provides configuration options for policies that allow or deny users with specific IP 
addresses from having login privileges to the SMA appliance. 

To allow or deny specific users from logging into the appliance:

1 Navigate to the Users > Local Users page. 

2 Click the configure icon for the user you want to configure. The Edit Local User page is displayed.

Dynamic variables

Text Usage Variable Example Usage

Login Name %USERNAME% US\%USERNAME%

Domain Name %USERDOMAIN% %USERDOMAIN%\%USERNAME%

Group Name %USERGROUP% %USERGROUP%\%USERNAME%

IP Address %IPADDR% %IPADDR%\%USERNAME%
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3 Click the Login Policies page. The Edit Local User - Login Policies page is displayed.

 

4 To block the specified user or users from logging into the appliance, select Disable login.

5 Optionally select Enable from the Enable client certificate enforcement drop-down menu, to require 
the use of client certificates for login. By selecting this option, you require the client to present a client 
certificate for strong mutual authentication. Two additional fields appear:

• Verify user name matches Common Name (CN) of client certificate - Select this check box to 
require that the user’s account name match their client certificate.

• Verify partial DN in subject - Use the following variables to configure a partial DN that matches 
the client certificate:

• User name: %USERNAME%

• Domain name: %USERDOMAIN%

• Active Directory user name: %ADUSERNAME%

• Wildcard: %WILDCARD%

6 To require the use of one-time passwords for the specified user to log in to the appliance, select Require 
one-time passwords.

7 In the One-Time Password drop-down list, select Use domain setting, Enable, or Disable. The default is 
Use domain setting.

8 From the One-Time Password drop-down menu, select one of the following:

• Use domain setting - Take the action specified by the domain setting. Use domain setting is the 
default setting for this option. 

• Enabled - Enable this action for the user. Overrides the domain setting. 

When you select this option three additional fields appear:

• User discretion - Allow user to edit one-time password settings from the Users > Local 
Users > Edit Local User page. Users have the option of selecting one or both of the 
following one-time password methods:

• Use E-mail allows the user to select Use E-mail to enable this one-time password 
method.

• Use Mobile App allows the user to Use Mobile App to enable this one-time 
password method.

• Use E-mail - Optionally select Use E-mail to enable this one-time password method. The Email 
domain: window appears, in which you can enter an email address to send the one-time 
password.



SonicWall Secure Mobile Access 10.2 Administration Guide
Users Configuration 302

• Use Mobile App - Optionally select Use Mobile App to enable this one-time password method to 
force users to use a one-time password. Users can use Google Authenticator, Duo Mobile, or any 
other compliant two-factor authentication service.

• Disabled - Disable this action for the user. Overrides the domain setting.

9 Optionally click CLER APP INFO to clear mobile app binding information.

10 To apply the policy you selected to a source IP address, select an access policy (Allow or Deny) in the 
Login From Defined Addresses drop-down list under Login Policies by Source IP Address, and then 
click Add under the list box. The Define Address window is displayed.

11 In the Define Address window, select one of the source address type options from the Source Address 
Type drop-down list.

• IP Address - Enables you to select a specific IP address.

• IP Network - Enables you to select a range of IP addresses. If you select this option, a Network 
Address field and Subnet Mask field appear in the Define Address window.

• IPv6 Address - This enables you to select a specific IPv6 address.

• IPv6 Network - This enables you to select a range of IPv6 addresses. If you select this option, a 
IPv6 Network field and Prefix field appear in the Define Address window. 

12 Provide appropriate IP address(es) for the source address type you selected.

• IP Address - Type a single IP address in the IP Address field.

• IP Network - Type an IP address in the Network Address field and then supply a subnet mask 
value that specifies a range of addresses in the Subnet Mask field.

• IPv6 Address - Type an IPv6 address, such as 2007::1:2:3:4.

• IPv6 Network - Type the IPv6 network address into the IPv6 Network field, in the form 
2007:1:2::. Type a prefix into the Prefix field, such as 64.

13 Click Add. The address or address range is displayed in the Defined Addresses list in the Edit User 
Settings window. As an example, if you selected a range of addresses with 10.202.4.32 as the network 
address and 255.255.255.240 (28 bits) as the subnet mask value, the Defined Addresses list displays 
10.202.4.32–10.202.4.47. In this case, 10.202.4.47 would be the broadcast address. Whatever login 
policy you selected is now applied to addresses in this range.

14 To apply the policy you selected to a client browser, select an access policy (Allow or Deny) in the Login 
From Defined Browsers drop-down list under Login Policies by Client Browser, and then click Add 
under the list. The Define Browser window is displayed.

15 In the Define Browser window, type a browser definition in the Client Browser field and then click Add. 
The browser name appears in the Defined Browsers list.

16 Click Accept. The new login policy is saved.

Denying Mobile App Binding when Login is 
Attempted from any External Network
If an administrator has enabled Mobile App for Time-based One Time Password (TOTP) Two Factor 
Authentication and has specified networks such as corporate network to bind the mobile App during Virtual 
Office login, users will see the mobile-binding QR code only when login is attempted from any of the networks 
specified by the administrator.
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To specify the networks to which users should be connected to bind their mobile app during login:

1 Log in to the management interface of the SMA appliance and navigate to Users > Local Users.

2 Hover over a user and click the Edit icon.

3 Click Login Policies tab and enable One-Time Password.

4 Enable Use Mobile App.

5 In the Allow Bind Network box, specify the IP address of the network that the user should be connected 
to so that the user can see the QR code to bind the mobile application during login.

You can specify multiple networks in the Allow Bind Network box using ‘;’ as a separator between 
network IP addresses. If you specify multiple networks, the user should be connected to any one of the 
specified networks to complete mobile app binding.

6 Click Submit.

If login is attempted from any network that isn’t one among the networks specified in Allow Bind Network, 
the user will not see the QR code to bind the mobile app.

Reusing Mobile App Binding Text Code
If an administrator enables Allow Sharing TOTP key option for an SMA appliance, the mobile app binding text 
code for binding a mobile app with a user account can be reused when binding mobile app with other user 
accounts, thereby OTP generated in a single mobile-app account can be used for authentication during login of 
all the users that shared binding key.

The Allow Sharing TOTP key option is controlled by an internal setting. For information about enabling this 
option, contact SonicWall Technical Support at https://www.sonicwall.com/support/contact-support.

NOTE: If you leave the Allow Bind Network box blank, the mobile app can be bound when login to 
Virtual Office is attempted from any network.

https://www.sonicwall.com/support/contact-support
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To share the TOTP key among users:

1 When binding mobile application with an SMA user account, save the text code link, and complete 
binding.

2 In the MOBILE APP BINDING screen for other users, paste the saved text code in the Code box, and click 
VERIFY.

The QR code gets updated.
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3 Enter the OTP generated in the mobile app and click VERIFY to complete binding.

After the mobile application is bound to multiple users with the same binding key, OTP from the mobile 
application can be used to complete Virtual Office login authentication of all the users that shared binding 
key.

Flexibility in Choosing Two-Factor 
Authentication method for NetExtender Login

User can now choose the required OTP Authentication method: Email, SMS, or Mobile APP for NetExtender 
login authentication if the administrator enables One-Time Password in Login Policies.

To enable a user to choose OTP authentication method for NetExtender login:

1 In the SMA management interface, navigate to Users > Local Users.

2 Hover over a user and click the Edit icon.

3 Click Login Policies.

4 Enable One-Time Password.

5 To configure the methods that users can choose to complete authentication, you can do one of the 
following:

• Select the OTP methods as required: E-mail, Mobile App, and/or Short message.

• Enable User discretion and select the required methods.

6 Click Submit.

If One-Time Password is enabled and the OTP methods are specified by the administrator, users can select any 
one of the OTP methods to complete authentication when connecting to the NetExtender.

NOTE: This feature is supported only on NetExtender for Windows and not on NetExtender for Linux.
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If User-discretion option is enabled by the administrator, user needs to enable One-time password and 
configure the required OTP authentication method(s). 

.

Here’s an example of the authentication prompt displayed during NetExtender connection when all the OTP 
methods are selected:

Configuring End Point Control for Users
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To configure the End Point Control profiles used by a local user:

1 Navigate to the Users > Local Users page.

2 Click the configure icon next to the user to be configured for EPC. The Edit Local User window is 
displayed.

3 Click the EPC page. The EPC window is displayed.

4 Configure EPC user settings and add or remove device profiles.

Configuring Capture ATP

The Capture ATP page provides configuration options for enabling Capture ATP. The Capture ATP settings are 
divided into the following sections:

• General Settings

• File Type Settings

• File Size Settings

• Custom Blocking Behavior

General Settings

To configure Virtual Assist general settings:

1 Navigate to the Users > Local Users > Edit Local User page and select the Capture tab. The Edit Local 
Users page displays. 

2 From the General Settings Enable Capture ATP service drop-down menu, select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Enabled - Enable this action for the user. Overrides the group setting.
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• Disabled - Disable this action for all members of the group. Overrides the global setting.

3 Click ACCEPT to save settings.

File Type Settings
To configure file type settings:

1 Navigate to the Users > Local Users > Edit Local User page and select the Capture tab. The Edit Local 
Users page displays. 

2 From the File Type Settings drop-down menu, select one of the following:

• Use group setting - Take the action specified by the group setting. 

• Use custom setting- Take the action specified by the custom setting.

3 Click ACCEPT to save settings.

File Size Settings
To configure file size settings:

1 Navigate to the Users > Local Users > Edit Local User page and select the Capture tab. The Edit Local 
Users page displays. 

2 To specify the maximum size of the file that will be sent to Capture ATP service, enter a value in the 
Maximum size for a file window. Valid maximum size is 0 - 10 MB for user level and group level, and 1 - 
10 MB for global level.

• If the value is set to 0 at user level, SMA uses the maximum file size of the group setting.

• If the value is set to 0 at group level, SMA uses the maximum file size of the global setting.

3 If a file size is less than the maximum value, the file is sent to Capture ATP service to check.

4 From the File Size Settings drop-down menu, select one of the following:

• Use group setting - Take the action specified by the group setting. 
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• Use custom setting- Take the action specified by the custom setting.

5 Click ACCEPT to save settings.

Custom Blocking Behavior

To configure custom blocking behavior:

1 From the Block uploads when there is a failure communicating with the Capture ATP service 
drop-down menu, select from the following:

• Use group setting - Take the action specified by the group setting. 

• Use custom setting- Take the action specified by the custom setting.

2 Click ACCEPT to save settings.

Users > Local Groups
This section provides an overview of the Users > Local Groups page and a description of the configuration tasks 
available on this page.

Topics: 

• Deleting a Group

• Adding a New Group

• Editing Group Settings

• LDAP Attribute Information

• Group Configuration for Active Directory and RADIUS Domains

• Creating a Citrix Bookmark for a Local User

The Users > Local Groups page allows the administrator to add and configure groups for granular control of 
user access by specifying a group name and domain. 

Note that a group is automatically created when you create a domain. You can create domains in the Portals > 
Domains page. You can also create a group directly from the Users > Local Groups page.

Group memberships are split into two groups, ‘primary’ and ‘additional’. 
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Primary groups - Used to assign simple policies, such as timeouts and the ability to add/edit bookmarks. 
Advanced policies, such as URL or network object policies, might come from primary or additional groups.

Additional Groups - Multiple additional groups could be assigned, but in the case of conflicting policies, the 
primary group takes precedence over any additional groups. 

Keep in mind that users can only belong to groups within a single domain.

Deleting a Group
To delete a group, click the delete icon  in the row for the group that you wish to remove in the Local Groups 
table on the Users > Local Groups page. The deleted group no longer appears in the list of defined groups.

Adding a New Group
Note that a group is automatically created when you create a domain. You can create domains in the Portals > 
Domains page. You can also create a group directly from the Users > Local Groups page.

The Users > Local Groups window contains two default objects:

• Global Policies - Contains access policies for all nodes in the organization.

• LocalDomain - The LocalDomain group is automatically created to correspond to the default 
LocalDomain authentication domain. This is the default group to which local users are added, unless 
otherwise specified.

To create a new group:

1 Navigate to the Users > Local Groups page. The Local Groups page displays. 

1 Click Add Group. The Add Local Group window is displayed.

2 In the Add Local Group window, enter a descriptive name for the group in the Group Name field.

3 Select the appropriate domain from the Domain drop-down list. The domain is mapped to the group.

4 Click Accept to update the configuration. After the group has been added, the new group is added to the 
Local Groups window.

All of the configured groups are displayed in the Users > Local Groups page, listed in alphabetical order.
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Editing Group Settings
To edit the settings for a group, click the configure icon  in the row for the group that you wish to edit in the 
Local Groups table on the Users > Local Groups page. The Edit Group Settings window contains eight pages: 
General, Portal, Clients, Routes, Policies, Bookmarks, EPC, and Capture.

Topics: 

• Editing General Local Group Settings

• Enabling Routes for Groups

• Adding Group Policies

• Editing a Policy for a File Share

• Configuring Group Bookmarks

• Configuring Group End Point Control

Editing General Local Group Settings
The General page provides configuration options for a group’s inactivity timeout value and single sign-on 
settings. 

To modify the general group settings:

1 In the left column, navigate to the Users > Local Groups.

2 Click the configure icon next to the group you want to configure. The General page of the Edit Group 
Settings window displays. The General Group Settings section displays the following non-configurable 
fields: Group Name and Domain Name.

3 To set the inactivity timeout for the group, meaning that users are signed out of the Virtual Office after 
no activity on their computer for the specified time period, enter the number of minutes of inactivity to 
allow in the Inactivity Timeout field. Set to 0 to use the global timeout.

4 To set the session limit timeout for the group, meaning that users are signed out of the Virtual Office 
after the session remains idle for a specified period of time, select one of the following options:

• Use Global Setting: Select this option to use the global policy settings to control session limit 
timeout. The default value is 0.
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• Custom: Select this option to set the value for session limit timeout. The default value is 0.

5 Under Single Sign-On Settings, select one of the following options from the Use SSL-VPN account 
credentials to log into bookmarks drop-down menu:

• Use Global Policy: Select this option to use the global policy settings to control single sign-on 
(SSO) for bookmarks.

• User-controlled (enabled by default for new users): Select this option to allow users to enable or 
disable single sign-on (SSO) for bookmarks. This setting enables SSO by default for new users.

• User-controlled (disabled by default for new users): Select this option to allow users to enable 
or disable single sign-on (SSO) for bookmarks. This setting disables SSO by default for new users.

• Enabled: Select this option to enable single sign-on for bookmarks.

• Disabled: Select this option to disable single sign-on for bookmarks.

6 Click Accept to save the configuration changes. 

Enabling Routes for Groups
The Routes page allows the administrator to add and configure client routes. IPv6 client routes are supported 
on SMA appliances.

To enable multiple routes for a group:

1 Navigate to Users > Local Groups.

2 Click the configure icon next to the group you want to configure.

3 In the Edit Local Group page, go to the Client Routes section.

4 In the Tunnel All Mode drop-down list, select one of the following:

• Use global setting - Take the action specified by the global setting. 

• Enabled - Force all traffic for this user, including traffic destined to the remote users’ local 
network, over the Secure Mobile Access NetExtender tunnel. Affects all members of the group. 
Overrides the global setting.

• Disabled - Disable this action for all members of the group. Overrides the global setting.

5 Click Add Client Route.

6 On the Add Client Route screen, enter a destination network in the Destination Network field. For 
example, enter the IPv4 network address 10.202.0.0. For IPv6, enter the IPv6 network address in the 
form 2007::1:2:3:0.
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7 For an IPv4 destination network, type the subnet mask in the Subnet Mask/Prefix field using decimal 
format (255.0.0.0, 255.255.0.0, or 255.255.255.0). For an IPv6 destination network, type the prefix, such 
as 112.

8 On the Add Client Route screen, click Accept.

9 On the Edit Local Group page, click Accept.

Enabling Group Client Routes

To enable global client routes for groups that are already created:

1 Navigate to Users > Local Groups.

2 Click the configure icon next to the group you want to configure.

3 In the Client Routes section, select Add Global Client Routes.

4 Click Accept.

Enabling Tunnel All Mode for Local Groups
This feature is for external users, who inherit the settings from their assigned group upon login. Tunnel all mode 
ensures that all network communications are tunneled securely through the Secure Mobile Access tunnel. 

To enable tunnel all mode:

1 Navigate to Users > Local Groups.

2 Click the configure icon next to the group you want to configure.

3 In the Edit Local Group section, select Enable from the Tunnel All Mode drop-down list.

4 Click Accept.

Adding Group Policies
With group access policies, all traffic is allowed by default. Additional allow and deny policies could be created 
by destination address or address range and by service type.

The most specific policy takes precedence over less specific policies. For example, a policy that applies to only 
one IP address has priority over a policy that applies to a range of IP addresses. If there are two policies that 
apply to a single IP address, then a policy for a specific service (for example RDP) takes precedence over a policy 
that applies to all services.

User policies take precedence over group policies and group policies take precedence over global policies, 
regardless of the policy definition. A user policy that allows access to all IP addresses takes precedence over a 
group policy that denies access to a single IP address.
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To define group access policies:

1 Navigate to Users > Local Groups.

2 Click the configure icon next to the group you want to configure.

3 In the Edit Local Group page, select the Policies page.

4 On the Policies page, click Add Policy. The Add Policy screen is displayed.

5 Define a name for the policy in the Policy Name field.

6 In the Apply Policy To drop-down list, select whether the policy is applied to an individual host, a range 
of addresses, all addresses, a network object, a server path, or a URL object. You can also select an 
individual IPv6 host, a range of IPv6 addresses, or all IPv6 addresses. The Add Policy window changes 
depending on what type of object you select in the Apply Policy To drop-down list.

• IP Address - If your policy applies to a specific host, enter the IP address of the local host machine 
in the IP Address field. Optionally enter a port range (80-443) or a single port number into the 
Port Range/Port Number field.

• IP Network - If your policy applies to a range of addresses, enter the beginning IP address in the 
IP Network Address field and the subnet mask that defines the IP address range in the Subnet 
Mask field. Optionally enter a port range (4100-4200) or a single port number into the Port 
Range/Port Number field. 

• Network Object - If your policy applies to a predefined network object, select the name of the 
object from the Network Object drop-down list. A port or port range can be specified when 
defining a Network Object. 

• Server Path - If your policy applies to a server path, select one of the following radio buttons in 
the Resource field: 

• Share (Server path) - When you select this option, type the path into the Server Path field.

• Network (Domain list)

• Servers (Computer list)

• URL Object - If your policy applies to a predefined URL object, type the URL into the URL field. 

• All IPv6 Address - If your policy applies to all IPv6 addresses, you do not need to enter any IP 
address information.

• IPv6 Address - If your policy applies to a specific host, enter the IPv6 address of the local host 
machine in the IPv6 Address field. Optionally enter a port range (for example, 4100-4200) or a 
single port number into the Port Range/Port Number field. 
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• IPv6 Network - If your policy applies to a range of addresses, enter the beginning IPv6 address in 
the IPv6 Network Address field and the prefix that defines the IPv6 address range in the IPv6 
Prefix field. Optionally enter a port range (for example, 4100-4200) or a single port number into 
the Port Range/Port Number field.

7 Select the desired Protocol. The available value options in the Protocol field include: TCP, UDP, ICMP, and 
ALL. You can select multiple items among TCP, UDP, and ICMP. However, when ALL is selected, all others 
options are deselected.

8 Select the service type in the Service menu. If you are applying a policy to a network object, the service 
type is defined in the network object.

9 Select Allow or Deny from the Status drop-down list to either permit or deny SMA connections for the 
specified service and host machine.

10 Click Accept to update the configuration. After the configuration has been updated, the new group 
policy is displayed in the Edit Local Group window. The group policies are displayed in the Group Policies 
list in the order of priority, from the highest priority policy to the lowest priority policy.

Editing a Policy for a File Share

To edit file share access policies:

1 Navigate to Users > Local Groups.

2 Click the configure icon next to the group you want to configure.

3 Select the Policies page.

4 Click Add Policy...

5 Select Server Path from the Apply Policy To drop-down list.

6 Type a name for the policy in the Policy Name field.

7 Select a Resource from the drop-down list.

8 Share (Server path) for the resource type.

9 In the Server Path field, enter the server path in the format servername/share/path or servername 
\share\path. The prefixes \\, //, \ and / are acceptable.

10 Select Allow or Deny from the Status drop-down list.

11 Click Accept.
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Configuring Group Bookmarks
SMA appliance bookmarks provide a convenient way for Secure Mobile Access users to access computers on the 
local area network that they connect to frequently. Group bookmarks apply to all members of a specific group. 

To define group bookmarks:

1 Navigate to the Users > Local Groups window.

2 Click the configure icon for the group for which you want to create a bookmark. The Edit Local Group 
page is displayed.

3 On the Bookmarks page, click Add Bookmark. The Add Bookmark screen is displayed.

4 Enter a string that is the name of the bookmark in the Bookmark Name field.

5 Enter the fully qualified domain name (FQDN) or the IPv4 or IPv6 address of a host machine on the LAN 
in the Name or IP Address field. In some environments you can enter the host name only, such as when 
creating a VNC bookmark in a Windows local network.

For HTTP and HTTPS, you can add a custom port and path, for example, servername:port/path. For VNC, 
Telnet, and SSH, you can add a custom port, for example, servername:port.

6 Enter a friendly description in the Description field to be displayed in the Bookmarks table.

7 Select one of the service types from the Service drop-down list. For the specific service you select from 
the Service drop-down list, additional fields might appear. Use the following information for the chosen 
service to complete the building of the bookmark.

Terminal Services (RDP), Terminal Services (RDP-HTML5) or Terminal 
Services (RDP-Native)

1 In the Screen Size drop-down menu, select the default terminal services screen size to be used when 
users execute this bookmark. Because different computers support different screen sizes, when you use 
a remote desktop application, you should select the size of the screen on the computer from which you 
are running a remote desktop session. Additionally, you might want to provide a path to where your 
application resides on your remote computer by typing the path in the Application and Path field.

• In the Colors drop-down list, select the default color depth for the terminal service screen when 
users execute this bookmark.

2 Select an Access Type Selection. Smart or Manual. 
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• Smart: Allows the firmware to decide which mode to launch on the client.

When creating a new unified bookmark, Smart is selected by default. Auto-detection is processed 
using bookmark-specific default modes while launching the bookmark.

• Manual: Provides options to configure the modes, their priorities, and the choose method. At 
least one mode should be enabled in the selection box.

The launch sequence is as follows: HTML5 and Native. Selecting Manual allows you to change, 
enable, or disable the launch methods. If you select Native to launch the RDP bookmark, then the 
SMA Connect Agent launches the RDP Receiver on the local machine to do the RDP connection.

The up and down arrows are used to adjust the launch priority. Fork and tick are used to disable 
or enable the modes. Disabled modes are put at the bottom of the list with a gray font color.

The Choose during Launch option is not enabled by default under the Manual mode. In this 
setting, while launching the bookmark, the first available mode in the configured list is run at 
once after auto-detection.

After the Choose during Launch option is enabled, while launching the unified bookmark, if there 
are multiple modes available for the client, a menu is provided from which you can choose within 
a five second count-down. When only one mode is available, the bookmark is also run 
immediately.

If the Remember my choice option is selected during the launch time, the selected mode is 
remembered through a cookie. 

That means, when next launching the bookmark, the remembered mode is run directly within 
two seconds. Clicking anywhere in the HTML can 'forget' the remembered mode so you can 
re-choose.

Editing or deleting the bookmark in the same browser can also reset the remembered mode.

When no modes are able to run on the client with the configuration, the following notice appears.

3 Optionally enter the local path for this application in the Application and Path field.

4 Select Enable wake-on-LAN to enable waking up a computer over the network connection. Selecting 
this check box causes the following new fields to be displayed:

• MAC/Ethernet Address – Enter one or more MAC addresses, separated by spaces, of 
target hosts to wake.

• Wait time for boot-up (seconds) – Enter the number of seconds to wait for the target 
host to fully boot up before cancelling the WoL operation.

• Send WOL packet to host name or IP address – To send the WoL packet to the hostname 
or IP of this bookmark, select Send WOL packet to host name or IP address that can be 
applied in tandem with a MAC address of another machine to wake.

5 In the Start in the following folder field, optionally enter the local folder in which to execute 
application commands.
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6 Optionally enter the local path for this application in the Application and Path field and specify the 
folder in the Start in the following folder field. The remote application feature displays a single 
application to the user. The value can also be the alias of the remote application.

7 Enter the Command-line Arguments for the RemoteApp. (Option available for ActiveX or Java only.)

8 In the Start in the following folder field, optionally enter the local folder in which to execute 
application commands. (Option available for ActiveX or Java only.)

9 Select Login as console/admin session to allow login as console or admin. Login as admin replaces login 
as console in RDC 6.1 and newer. (Option available for all Terminal Services.)

10 Select Server is TS Farm if users are connecting to a TS Farm or Load Balanced server. Enter the Terminal 
Services Broker information in the Load Balance Info box, such tsv://MS Terminal Services Plugin. 1. 
CollectionName. Maximum length is 1024 characters. For the bookmark with complex options (like RDP), 
options are mixed from all the modes and distinguished with tips like *non-html5, or *for html5.

11 By default, the bookmark only connects to the provided name and IP address. If you enable this feature, 
the SMA appliance obtains the redirected address and connects the user to the correct server. Note that 
Interactive Login might need to be disabled for this feature to work properly. 

12 For RDP - HTML5, select the Default Language from the drop-down menu. 

13 For Windows clients or on Mac clients running Mac OS X 10.5 or higher with RDC installed, expand Show 
advanced Windows options and select the check boxes for to redirect the following features on the 
local network for use in this bookmark: 

• Redirect Printers - 

• Redirect Ports

• Redirect Clipboard

• Redirect Drives

• Redirect SmartCards

• Redirect Plug and Play Devices

14 Select the check boxes for any of the following additional features for use in this bookmark session: 

• Display connection bar

• Desktop background

• Menu/window animation

• Show window contents while dragging/resizing

• Auto-reconnection

• Bitmap caching

• Visual styles

• Select the Remote Audio option from the drop-down list. Audio redirection enables the 
user to play an audio clip on the server, either remotely or locally. Valid selections are Play 
on this computer, Play on remote computer, or Do not play. Note that this feature is 
currently supported by Chrome, Firefox, and Safari. 

• For RDP - HTML5, the following Advanced Windows options are available:

• Desktop background

• Menu/window animation

• Show window contents while dragging/resizing

• Enable Compression
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• Visual Styles

• Select the Remote Audio option from the drop-down list. Audio redirection enables the 
user to play an audio clip on the server, either remotely or locally. Valid selections are Play 
on this computer, Play on remote computer, or Do not play. Note that this feature is 
currently supported by Chrome, Firefox, and Safari.

15 If the client application is RDP6, you can select any of the following options: (Option available for all 
Terminal Services)

• Font smoothing 

16 Select the Connection Speed from the drop-down list for optimized performance. (Option available for 
all Terminal Services.)

17 Select the action from the drop-down list that happens in the event that the Server Authentication fails. 
Server authentication verifies that you are connecting to the intended remote computer. The strength of 
the verification required to connect is determined by your system security policy. (Option available for all 
Terminal Services.)

18 Optionally select Automatically log in and select Use SSL-VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the RDP server. Enable the Use 
Login Domain for SSO option to pass the user’s domain to the RDP server. Windows 2008 and newer 
servers could require this option to be enabled. (Option available for all Terminal Services.)

Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark.

19 Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices. 
(Option available for all Terminal Services.)

Virtual Network Computing (VNC)
1 In the Encoding drop-down list, select one of the following:

• Raw – Pixel data is sent in left-to-right scanline order, and only rectangles with changes are 
sent after the original full screen has been transmitted.

• RRE – Rise-and-Run-length-Encoding uses a sequence of identical pixels that are 
compressed to a single value and repeat count. This is an efficient encoding for large 
blocks of constant color.

• CoRRE – A variation of RRE, using a maximum of 255x255 pixel rectangles, allowing for 
single-byte values to be used. More efficient than RRE except where very large regions are 
the same color.

• Hextile – Rectangles are split up in to 16x16 tiles of raw or RRE data and sent in a 
predetermined order. Best used in high-speed network environments such as within the 
LAN.

• Zlib – Simple encoding using the zlib library to compress raw pixel data, costing a lot of 
CPU time. Supported for compatibility with VNC servers that might not understand Tight 
encoding which is more efficient than Zlib in nearly all real-life situations.

• Tight – The default and the best encoding to use with VNC over the Internet or other 
low-bandwidth network environments. Uses zlib library to compress pre-processed pixel 
data to maximize compression ratios and minimize CPU usage.

2 In the Compression Level drop-down list, select the level of compression as Default or from 1 to 9 
where 1 is the lowest compression and 9 is highly compressed. 

3 The JPEG Image Quality option is not editable and is set at 6.

4 In the Cursor Shape Updates drop-down list, select Enable, Ignore, or Disable. The default is Ignore.



SonicWall Secure Mobile Access 10.2 Administration Guide
Users Configuration 320

5 Select Use CopyRect to gain efficiency when moving items on the screen. 

6 Select Restricted Colors (256 Colors) for more efficiency with slightly less depth of color.

7 Select Reverse Mouse Buttons 2 and 3, to switch the right-click and left-click buttons.

8 Select View Only if the user is not making any changes on the remote system.

9 Select Share Desktop to allow multiple users to view and use the same VNC desktop.

10 Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

Citrix Portal (Citrix)
1 In the Resource Window Size drop-down list, select the default Citrix portal screen size to be used when 

users execute this bookmark. 

2 Select an Access Type Selection. Smart or Manual. 

• Smart: Allows the firmware to decide which mode to launch on the client.

When creating a new unified bookmark, Smart is selected by default. Auto-detection is processed 
using bookmark-specific default modes while launching the bookmark.

• Manual: Provides options to configure the modes, their priorities, and the choose method. At 
least one mode should be enabled in the selection box.

The launch sequence is as follows: HTML5, Native, and ActiveX. Selecting Manual allows you to 
change, enable, or disable the launch methods. If you select Native to launch the Citrix 
bookmark, then the SMA Connect Agent launches the Citrix Receiver on the local machine to do 
the Citrix connection. Native can provide advanced features when launched on Windows and OS 
X platforms after installing the SMA Connect Agent and Citrix Receiver.

The up and down arrows are used to adjust the launch priority. Fork and tick are used to disable 
or enable the modes. Disabled modes are put at the bottom of the list with a gray font color.

The Choose during Launch option is not enabled by default under the Manual mode. In this 
setting, while launching the bookmark, the first available mode in the configured list is run at 
once after auto-detection.

After the Choose during Launch option is enabled, while launching the unified bookmark, if there 
are multiple modes available for the client, a menu is provided from which you can choose within 
a five second count-down. When only one mode is available, the bookmark is also run 
immediately.

If the Remember my choice option is selected during the launch time, the selected mode is 
remembered through a cookie. 

That means, when next launching the bookmark, the remembered mode is run directly within 
two seconds. Clicking anywhere in the HTML can 'forget' the remembered mode so you can 
re-choose.

Editing or deleting the bookmark in the same browser can also reset the remembered mode.

When no modes are able to run on the client with the configuration, the following notice appears.

• Optionally select HTTPS Mode to use HTTPS to securely access the Citrix Portal.
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• Optionally, select Always use specified Citrix ICA Server and specify the IP address in the ICA 
Server Address field that appears. This setting allows you to specify the Citrix ICA Server address 
for the Citrix ICA session. By default, the bookmark uses the information provided in the ICA 
configuration on the Citrix server.

• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

Web (HTTP)
• Optionally select Automatically log in and select Use SSL VPN account credentials to forward 

credentials from the current Secure Mobile Access session for log in to the RDP server. Enable the 
Use Login Domain for SSO option to pass the user’s domain to the RDP server

Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark. For more information about custom credentials, 

Select Forms-based Authentication to configure Single Sign-On for forms-based authentication. 
Configure the User Form Field to be the same as the ‘name’ and ‘id’ attribute of the HTML 
element representing User Name in the Login form, for example: <input type=text 
name=’userid’>. Configure the Password Form Field to be the same as the ‘name’ or ‘id’ 
attribute of the HTML element representing Password in the Login form, for example: <input 
type=password name=’PASSWORD’ id=’PASSWORD’ maxlength=128>.

• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

Secure Web (HTTPS)
• Optionally select Automatically log in and select Use SSL VPN account credentials to forward 

credentials from the current Secure Mobile Access session for log in to the RDP server. Enable the 
Use Login Domain for SSO option to pass the user’s domain to the RDP server

Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark. For more information about custom credentials, 

Select Forms-based Authentication to configure Single Sign-On for forms-based authentication. 
Configure the User Form Field to be the same as the ‘name’ and ‘id’ attribute of the HTML 
element representing User Name in the Login form, for example: <input type=text 
name=’userid’>. Configure the Password Form Field to be the same as the ‘name’ or ‘id’ 
attribute of the HTML element representing Password in the Login form, for example: <input 
type=password name=’PASSWORD’ id=’PASSWORD’ maxlength=128>.

• Select the Display Bookmark to Mobile Connect clients to display the bookmark on mobile 
devices.

External Web Site
• Select HTTPS Mode to use SSL to encrypt communications with this Web site.

• Select Disable Security Warning if you do not want to see any security warnings when accessing 
this Web site. Security warnings are normally displayed when this bookmark refers to anything 
other than an Application Offloaded Web site.

• Select Automatically log in to enable the virtual host domain SSO for this bookmark. If the host in 
the bookmark refers to a portal with the same shared domain as this portal, selecting this check 
box allows you to automatically be logged in with this portal’s credential. 

• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.
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Mobile Connect
• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

File Shares (CIFS)
• To restrict access on the client UI, select Set user to access the specific files/folders. To 

completely restrict access, navigate to the Services > Policies page to set a policy for access 
constraints. 

•  Optionally select Automatically log in and select Use SSL VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the RDP server. Enable the 
Use Login Domain for SSO option to pass the user’s domain to the RDP server.

Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark. For more information about custom credentials, 

Enable Display Bookmark to Mobile Connect clients to send bookmark information to Mobile 
Connect clients.

When creating a File Share, do not configure a Distributed File System (DFS) server on a Windows 
Domain Root system. Because the Domain Root allows access only to Windows computers in the 
domain, doing so disables access to the DFS file shares from other domains. The SMA appliance is 
not a domain member and is not able to connect to the DFS shares.

DFS file shares on a stand-alone root are not affected by this Microsoft restriction.

File Transfer Protocol (FTP) and SSH File Transfer Protocol (SFTP)
• Expand Show advanced server configuration to select an alternate value in the Character 

Encoding drop-down list. The default is Standard (UTF-8).

• Optionally select Automatically log in and select Use SSL VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the FTP server. Select Use 
custom credentials to enter a custom username, password, and domain for this bookmark. For 
more information about custom credentials, Telnet HTML5 Settings

• Optionally select Automatically log in and select Use SSL VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the secure Web server. 
Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark. .

• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.

Secure Shell Version 2 (SSHv2) HTML5 Settings
• Select the Default Font Size. Supported options range from 12 to 99 points.

• Optionally select Automatically log in and select Use SSL VPN account credentials to forward 
credentials from the current Secure Mobile Access session for log in to the secure Web server. 
Select Use custom credentials to enter a custom username, password, and domain for this 
bookmark. 

SSHv2 Common Settings
• Optionally select Automatically accept host key. This option allows the browser to keep the 

server’s public host key in local storage automatically.

• Select Display Bookmark to Mobile Connect clients to display the bookmark on mobile devices.
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• Click Accept to update the configuration. After the configuration has been updated, the new 
group bookmark displays in the Edit Local Group page.

Configuring Group End Point Control

To configure the End Point Control profiles used by local groups:

1 Navigate to either the Users > Local Users or Users > Local Groups page.

2 Click the configure icon next to the group to be configured for EPC. The Edit Local Group window is 
displayed.

3 Click the EPC page. The EPC window is displayed.

4 Configure EPC group settings and add or remove device profiles,Group Configuration for LDAP 
Authentication Domains

Lightweight Directory Access Protocol (LDAP) is a standard for querying and updating a directory. Because LDAP 
supports a multilevel hierarchy (for example, groups or organizational units), the SMA appliance can query this 
information and provide specific group policies or bookmarks based on LDAP attributes. By configuring LDAP 
attributes, the SMA appliance administrator can leverage the groups that have already been configured in an 
LDAP or Active Directory database, rather than needing to manually recreate the same groups in the SMA 
appliance. 

After an LDAP authentication domain is created, a default LDAP group is created with the same name as the 
LDAP domain name. Although additional groups can be added or deleted from this domain, the default LDAP 
group cannot be deleted. If the user for which you created LDAP attributes enters the Virtual Office home page, 
the bookmark you created for the group the user is in displays in the Bookmarks Table.

For an LDAP group, you can define LDAP attributes. For example, you can specify that users in an LDAP group 
must be members of a certain group or organizational unit defined on the LDAP server. Or you can specify a 
unique LDAP distinguished name.

To add an LDAP attribute for a group so that a user has a bookmark assigned when entering the 
Virtual Office environment, complete the following steps:

1 Navigate to the Portals > Domains page and click Add Domain to display the Add New Domain 
window.

2 Select LDAP from the Authentication Type menu. The LDAP domain configuration fields are displayed.



SonicWall Secure Mobile Access 10.2 Administration Guide
Users Configuration 324

3 Enter a descriptive name for the authentication domain in the Domain Name field. This is the domain 
name users select in order to log in to the Secure Mobile Access user portal. It can be the same value as 
the Server address field.

4 Enter the IP address or domain name of the server in the Server address field.

5 Enter the search base for LDAP queries in the LDAP baseDN field. An example of a search base string is 
CN=Users,DC=yourdomain,DC=com. 

6 Enter a Server address that has been delegated control of the container that server is in.

7 Enter the user name along with the corresponding password in the Login user name and Login 
password fields.

8 Enter a Backup Server address.

9 Enter the backup user name along with the corresponding backup password in the Login user name and 
Login password fields

10 Select the name of the portal in the Portal name field. Additional layouts can be defined in the Portals > 
Portals page.

11 Select Allow password changes (if allowed by LDAP server) if you want to be able to change user’s 
passwords. The admin account must be used when changing user passwords.

12 Optionally select Use SSL/TLS. This option allows for the needed SSL/TLS encryption to be used for 
Active Directory password exchanges. This check box should be enabled when setting up a domain using 
Active Directory authentication.
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13 Optionally select Enable client certificate enforcement to require the use of client certificates for login. 
By checking this box, you require the client to present a client certificate for strong mutual 
authentication. Two additional fields appear:

• Verify user name matches Common Name (CN) of client certificate - Select this check box to 
require that the user’s account name match their client certificate.

• Verify partial DN in subject - Use the following variables to configure a partial DN that matches 
the client certificate:

• User name: %USERNAME%

• Domain name: %USERDOMAIN%

• Active Directory user name: %ADUSERNAME%

• Wildcard: %WILDCARD%

14 Select Delete external user accounts on logout to delete users who are not logged into a domain 
account after they log out.

15 Select Only allow users listed locally to allow only users with a local record in the Active Directory to 
login.

16 Select Auto-assign groups at login to assign users to a group when they log in.

Users logging into Active Directory domains are automatically assigned in real time to Secure Mobile 
Access groups based on their external AD group memberships. If a user’s external group membership has 
changed, their Secure Mobile Access group membership automatically changes to match the external 
group membership.

17 Optionally, select One-time passwords to enable the One Time Password feature. A drop-down list 
appears, in which you can select if configured, required for all users, or using domain name. These 
are defined as:

• if configured - Only users who have a One Time Password email address configured uses the One 
Time Password feature.

• required for all users - All users must use the One Time Password feature. Users who do not have 
a One Time Password email address configured are not allowed to login.

• using domain name - Users in the domain uses the One Time Password feature. One Time 
Password emails for all users in the domain are sent to username@domain.com.

18 If you selected if configured or required for all users in the One-time passwords drop-down list, the 
Active Directory AD e-mail attribute drop-down list appears, in which you can select mail, mobile, 
pager, userPrincipalName, or custom. These are defined as:

• mail - If your AD server is configured to store email addresses using the “mail” attribute, select 
mail.

• mobile or pager - If your AD server is configured to store mobile or pager numbers using either of 
these attributes, select mobile or pager, respectively. Raw numbers cannot be used, however, 
SMS addresses can.

• userPrincipalName - If your AD server is configured to store email addresses using the 
“userPrincipalName” attribute, select userPrincipalName. 

• custom - If your AD server is configured to store email addresses using a custom attribute, select 
custom. If the specified attribute cannot be found for a user, the email address assigned in the 
individual user policy settings is used. If you select custom, the Custom attribute field appears. 
Type the custom attribute that your AD server uses to store email addresses. If the specified 
attribute cannot be found for a user, the email address is taken from their individual policy 
settings.
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If you select using domain name, an E-mail domain field appears following the drop-down list. Type in 
the domain name where one-time password emails are sent (for example, abc.com).

19 Select the type of user from the User Type drop-down list. All users logging in through this domain are 
treated as this user type. The choices depend on user types defined already. Some possible choices are:

• External User – Users logging into this domain are treated as normal users without administrative 
privileges.

• External Administrator – Users logging into this domain are treated as administrators, with local 
Secure Mobile Access admin credentials. These users are presented with the admin login page.

This option allows the Secure Mobile Access administrator to configure a domain that allows 
Secure Mobile Access admin privileges to all users logging into that domain. 

SonicWall Inc. recommends adding filters that allow administrative access only to those users 
who are in the correct group. You can do so by editing the domain on the Users > Local Groups 
page.

• Read-only Administrator – Users logging into this domain are treated as read-only 
administrators and can view all information and settings, but cannot apply any changes to the 
configuration. These users are presented with the admin login page.

20 Click Accept to update the configuration. After the domain has been added, the domain is added to the 
table on the Portals > Domains page.

21 Navigate to the Users > Local Groups page and click the configure icon. The Edit Group Settings page is 
displayed, with fields for LDAP attributes on the General page.

 

22 On the General page, you can optionally fill out one or multiple LDAP Attribute fields with the 
appropriate names where name=value is the convention for adding a series of LDAP attributes. To see a 
full list of LDAP attributes, refer to the SonicWall Inc. LDAP Attribute document.

As a common example, fill out an attribute field with the memberOf= attribute which can bundle the 
following common variable types:

CN= - the common name. DN= - the distinguished name. DC= - the domain component.

You need to provide quote delimiters around the variables you bundle in the memberOf line. You 
separate the variables by commas. An example of the syntax using the CN and DC variables would be:

memberOf="CN=<string>, DC=<string>"

An example of a line you might enter into the LDAP Attribute field, using the CN and DC variables would 
be:

memberOf="CN=Terminal Server Computers,CN=Users,DC=sonicwall,DC=net"
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23 Type an inactivity timeout value (in minutes) in the Inactivity Timeout field. Enter 0 (zero) to use the 
global inactivity timeout setting.

24 Under Single Sign-On Settings, in the Automatically log into bookmarks list, select one of the 
following:

• Use global policy – Use the global policy for using SSO to log in to bookmarks.

• User-controlled (enabled by default for new users) – Enable SSO to log in to bookmarks for 
new users, and allow users to change this setting.

• User-controlled (disabled by default for new users) – Disable SSO to log in to bookmarks for 
new users, and allow users to change this setting.

• Enabled – Enable SSO to log in to bookmarks

• Disabled – Disable SSO to log in to bookmarks

25 Click Accept when done.

LDAP Attribute Information
When configuring LDAP attributes, the following information could be helpful:

• If multiple attributes are defined for a group, all attributes must be met by LDAP users.

• LDAP authentication binds to the LDAP tree using the same credentials as are supplied for 
authentication. When used against Active Directory, this requires that the login credentials provided 
match the CN (common name) attribute of the user rather than SMAAccountName (login name). For 
example, if your Active Directory login name is gkam and your full name is guitar kam, when logging 
into the SMA appliance with LDAP authentication, the username should be provided in the following 
ways: If a login name is supplied, that name is used to bind to the tree. If the field is blank, you need to 
login with the full name. If the field is filled in with a full login name, users login with the 
SMAAccountName.

• If no attributes are defined, then any user authorized by the LDAP server can be a member of the group.

• If multiple groups are defined and a user meets all the LDAP attributes for two groups, then the user is 
considered part of the group with the most LDAP attributes defined. If the matching LDAP groups have 
an equal number of attributes, then the user is considered a member of the group based on the 
alphabetical order of the groups.

• If an LDAP user fails to meet the LDAP attributes for all LDAP groups configured on the SMA appliance, 
then the user is not able to log in to the portal. So the LDAP attributes feature not only allows the 
administrator to create individual rules based on the LDAP group or organization, it also allows the 
administrator to only allow certain LDAP users to log in to the portal.

Topics: 

• Example of LDAP Users and Attributes

• Sample LDAP Attributes

• Querying an LDAP Server

Example of LDAP Users and Attributes
If a user is manually added to a LDAP group, then the user setting takes precedence over LDAP attributes. 

For example, an LDAP attribute objectClass=“Person” is defined for group Group1 and an LDAP attribute 
memberOf=“CN=WINS Users,DC=sonicwall,DC=net” is defined for Group2. 
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If user Jane is defined by an LDAP server as a member of the Person object class, but is not a member of the 
WINS Users group, Jane is a member of SMA appliance Group1. 

But if the administrator manually adds the user Jane to SMA appliance Group2, then the LDAP attributes is 
ignored and Jane is a member of Group2.

Sample LDAP Attributes
You can enter up to four LDAP attributes per group. The following are some example LDAP attributes of Active 
Directory LDAP users:

name="Administrator"
memberOf="CN=Terminal Server Computers,CN=Users,DC=sonicwall,DC=net"
objectClass="user"
msNPAllowDialin="FALSE"

Querying an LDAP Server
If you would like to query your LDAP or Active Directory server to find out the LDAP attributes of your users, 
there are several different methods. From a machine with ldap search tools (for example a Linux machine with 
OpenLDAP installed) run the following command: 

ldapsearch -h 10.0.0.5 -x -D

"cn=demo,cn=users,dc=sonicwall,dc=net" -w demo123 –b

"dc=sonicwall,dc=net" > /tmp/file

Where:

• 10.0.0.5 is the IP address of the LDAP or Active Directory server

• cn=demo,cn=users,dc=sonicwall,dc=net is the distinguished name of an LDAP user

• demo123 is the password for the user demo

• dc=sonicwall,dc=net is the base domain that you are querying

• > /tmp/file is optional and defines the file where the LDAP query results are saved.

Group Configuration for Active Directory and 
RADIUS Domains
For authentication to RADIUS or Active Directory servers (using Kerberos), you can individually define AAA users 
and groups. This is not required, but it enables you to create separate policies or bookmarks for individual AAA 
users.

When a user logs in, the SMA appliance validates with the appropriate Active Directory or RADIUS server that 
the user is authorized to login. If the user is authorized, the SMA appliance checks to see if a user exists in the 
SMA appliance database for users and groups. If the user is defined, then the policies and bookmarks defined 
for the user applies.

For example, if you create a RADIUS domain in the SMA appliance called “Miami RADIUS server,” you can add 
users to groups that are members of the “Miami RADIUS server” domain. These user names must match the 
names configured in the RADIUS server. Then, when users log in to the portal, policies, bookmarks and other 
user settings applies to the users. If the AAA user does not exist in the SMA appliance, then only the global 
settings, policies and bookmarks applies to the user.
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Topics: 

• Bookmark Support for External (Non-Local) Users

• Adding a RADIUS Group

• Adding an Active Directory Group

Bookmark Support for External (Non-Local) Users
The Virtual Office bookmark system allows bookmarks to be created at both the group and user levels. The 
administrator can create both group and user bookmarks which are propagated to applicable users, while 
individual users can create only personal bookmarks.

Because bookmarks are stored within the SMA appliance’s local configuration files, it is necessary for group and 
user bookmarks to be correlated to defined group and user entities. When working with local (LocalDomain) 
groups and users, this is automated since the administrator must manually define the groups and users on the 
appliance. Similarly, when working with external (non-LocalDomain, for example, RADIUS or LDAP) groups, the 
correlation is automated since creating an external domain creates a corresponding local group.

However, when working with external (non-LocalDomain) users, a local user entity must exist so that any 
user-created (personal) bookmarks can be stored within the Secure Mobile Access configuration files. The need 
to store bookmarks on the SMA appliance itself is because LDAP and RADIUS external domains do not provide a 
direct facility to store such information as bookmarks.

Rather than requiring administrators to manually create local users for external domain users to use personal 
bookmarks, the SMA appliance automatically creates a corresponding local user entity upon user login. 
Bookmarks can be added to the locally-created user. 

For example, if a RADIUS domain called myRADIUS is created, and RADIUS user jdoe logs on to the SMA 
appliance, the moment jdoe adds a personal bookmark, a local user called jdoe is created on the SMA appliance 
as type External, and can then be managed like any other local user by the administrator. The external local user 
remains until deleted by the administrator.

Adding a RADIUS Group
The RADIUS Groups page allows the administrator to enable user access to the SMA appliance based on 
existing RADIUS group memberships. By adding one or more RADIUS groups to a Secure Mobile Access group, 
only users associated with specified RADIUS group(s) are allowed to login. 

To add a RADIUS group:

1 In the Users > Local Groups page, click Configure for the RADIUS group you want to configure.

2 In the RADIUS Groups page and click Add Group... The Add RADIUS Group page displays.

3 Enter the RADIUS Group name in the corresponding field. The group name must match the RADIUS 
Filter-Id exactly.

4 Click Accept. The group displays in the RADIUS Groups section.

Adding an Active Directory Group
The AD Groups page allows the administrator to enable user access to the SMA appliance based on existing AD 
group memberships. By adding one or more AD groups to a Secure Mobile Access group, only users associated 
with specified AD group(s) are allowed to login.
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To add an AD group:

1 In the Users > Local Groups page, click Configure for the AD group you want to configure.

2 In the AD Groups page and click Add Group... The Add Active Directory Group page displays.

3 Enter the Active Directory Group name in the corresponding field.

4 Optionally, select Associate with AD group if you wish to associate the Secure Mobile Access group with 
your AD group. This step can also be completed at a later time in the Edit Group page under the AD 
Groups page.

5 Click Accept. The group displays in the Active Directory Groups section. The process of adding a group 
can take several moments. Do not click Add more than one time during this process.

Creating a Citrix Bookmark for a Local Group
To configure a Citrix bookmark for a user:

1 Navigate to Users > Local Groups.

2 Click the configure icon next to the group you want to configure.

3 In the Edit Group Settings window, select the Bookmarks tab.

4 Click Add Bookmark...

5 Enter a name for the bookmark in the Bookmark Name field.

6 Enter the name or IP address of the bookmark in the Name or IP Address field.

7 From the Service drop-down list, select Citrix Portal (Citrix). 

8 Select the Resource Window Size from the drop-down list. 

9 Select an Access Type Selection. Smart or Manual. 

• Smart: Allows the firmware to decide which mode to launch on the client.

When creating a new unified bookmark, Smart is selected by default. Auto-detection is processed 
using bookmark-specific default modes while launching the bookmark.

• Manual: Provides options to configure the modes, their priorities, and the choose method. At 
least one mode should be enabled in the selection box.

The launch sequence is as follows: HTML5, Native, and ActiveX. Selecting Manual allows you to 
change, enable, or disable the launch methods. If you select Native to launch the Citrix 
bookmark, then the SMA Connect Agent launches the Citrix Receiver on the local machine to do 
the Citrix connection.

The up and down arrows are used to adjust the launch priority. Fork and tick are used to disable 
or enable the modes. Disabled modes are put at the bottom of the list with a gray font color.

The Choose during Launch option is not enabled by default under the Manual mode. In this 
setting, while launching the bookmark, the first available mode in the configured list is run at 
once after auto-detection.

After the Choose during Launch option is enabled, while launching the unified bookmark, if there 
are multiple modes available for the client, a menu is provided from which you can choose within 
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a five second count-down. When only one mode is available, the bookmark is also run 
immediately.

If the Remember my choice option is selected during the launch time, the selected mode is 
remembered through a cookie. 

That means, when next launching the bookmark, the remembered mode is run directly within 
two seconds. Clicking anywhere in the HTML can 'forget' the remembered mode so you can 
re-choose.

Editing or deleting the bookmark in the same browser can also reset the remembered mode.

When no modes are able to run on the client with the configuration, the following notice appears.

10 Optionally select HTTPS Mode to enable HTTPS mode. 

11 Optionally, select Always use specified Citrix ICA Server and specify the IP address in the ICA Server 
Address field that appears. This setting allows you to specify the Citrix ICA Server address for the Citrix 
ICA session. By default, the bookmark uses the information provided in the ICA configuration on the 
Citrix server.

12 Click Accept.

Global Configuration
SMA appliance global configuration is defined from the Local Users or Local Groups environment. To view 
either, click the Users option in the left navigation menu, then click either the Local Users or Local Groups 
option. 

Topics: 

• Edit Global Policies

• Edit a Policy for a File Share

• Edit Global Bookmarks

• Edit EPC Settings

To edit global settings: 

1 Navigate to either the Users > Local Users or Users > Local Groups window.

2 Click the configure icon next to Global Policies. The Edit Global Policies window is displayed.

3 On the General tab, to set the inactivity timeout for all users or groups, meaning that users are signed 
out of the Virtual Office after the specified time period, enter the number of minutes of inactivity to 
allow in the Inactivity Timeout field.

4 To allow users to add new bookmarks, select Allow from the Allow User to Add Bookmarks drop-down 
menu. To prevent users from adding new bookmarks, select Deny.

5 To allow users to edit or delete user-owned bookmarks, select Allow from the Allow User to 
Edit/Delete Bookmarks drop-down menu. To prevent users from editing or deleting user-owned 
bookmarks, select Deny.

6 In the Automatically log into bookmarks drop-down list, select one of the following options:
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• User-controlled (enabled by default for new users): Select this option to allow users to enable 
or disable single sign-on (SSO) automatic login for bookmarks. This setting enables automatic 
login by default for new users.

• User-controlled (disabled by default for new users): Select this option to allow users to enable 
or disable single sign-on (SSO) automatic login for bookmarks. This setting disables automatic 
login by default for new users.

• Enabled: Select this option to enable automatic login for bookmarks.

• Disabled: Select this option to disable automatic login for bookmarks.

7 Click Accept to save the configuration changes.

8 Navigate to the NetExtender / Mobile Connect tab.

9 To set a client address range, enter a beginning address in the Client Address Range Begin field and an 
ending address in the Client Address Range End field.

10 To set a client IPv6 address range, enter a beginning IPv6 address in the Client IPv6 Address Range 
Begin field and an ending IPv6 address in the Client IPv6 Address Range End field.

11 In the Exit Client After Disconnect drop-down list, select Enabled or Disabled.

12 In the Uninstall Client After Exit drop-down list, select Enabled or Disabled.

13 In the Create Client Connection Profile drop-down list, select Enabled or Disabled.

14 In the User Name & Password Caching drop-down list, select one of the following:

• Allow saving of user name only - Allow caching of the user name on the client. Users only need 
to enter their password when starting NetExtender.

• Allow saving of user name & password - Allow caching of the user name and password on the 
client. Users are automatically logged in when starting NetExtender, after the first login.

• Prohibit saving of user name & password - Do not allow caching of the user name and 
password on the client. Users are required to enter both user name and password when starting 
NetExtender.

15 Navigate to the Routes tab.

16 In the Tunnel All Mode drop-down list, select Enabled to force all traffic for the user, including traffic 
destined to the remote user’s local network, over the Secure Mobile Access NetExtender tunnel. Tunnel 
All Mode is disabled by default.

17 To add a client route, click Add Client Route...

18 In the Add Client Route window, enter a destination network in the Destination Network field. For 
example, enter the IPv4 network address 10.202.0.0. For IPv6, enter the IPv6 network address in the 
form 2007::1:2:3:0.

19 For an IPv4 destination network, type the subnet mask in the Subnet Mask/Prefix field using decimal 
format (255.0.0.0, 255.255.0.0, or 255.255.255.0). For an IPv6 destination network, type the prefix, such 
as 112.

20 Click Accept to save the configuration changes.

21 Navigate to the Policies tab.

22 To add a policy, click Add Policy...

23 In the Apply Policy To drop-down list, select one of the following: IP Address, IP Address Range, All 
Addresses, Network Object, Server Path, URL Object, All IPv6 Address, IPv6 Address, or IPv6 
Address Range.

24 Enter a name for the policy in the Policy Name field.
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25 In the fields that appear based on your Apply Policy To settings, fill in the appropriate information. For 
example, if you select IP Address in the Apply Policy To drop-down list, you need to supply the IP 
Address in the IP Address field and the service in the Service drop-down list. If you select IPv6 Address 
Range, enter the beginning IPv6 address in the IPv6 Network Address field and the prefix that defines 
the IPv6 address range in the IPv6 Prefix field. Optionally enter a port range (80-443) or a single port 
number into the Port Range/Port Number field. This field is available when you select IP Address, IP 
Address Range, IPv6 Address, or IPv6 Address Range in the Apply Policy To drop-down list.

26 Select the desired Protocol. The available value options in the Protocol field include: TCP, UDP, ICMP, and 
ALL. You can select multiple items among TCP, UDP, and ICMP. However, when ALL is selected, all others 
options are deselected.

27 Click Accept to save the configuration changes.

28 Click the Bookmarks tab.

29 To add a bookmark, click Add Bookmark...

30 Enter a bookmark name in the Bookmark Name field.

31 Enter the bookmark name or IP address in the Name or IP Address field.

32 Select one of the following services from the Service drop-down list: Terminal Services (RDP), Virtual 
Network Computing (VNC), Citrix Portal (Citrix), Web (HTTP), Secure Web (HTTPS), File Shares 
(CIFS), File Transfer Protocol (FTP), SSH File Transfer Protocol (SFTP), Telnet, or Secure Shell Version 
2 (SSHv2).

33 In the fields that appear based on your Service settings, fill in the appropriate information. For example, 
if you select Terminal Services (RDP), you need to select the desired screen size from the Screen Size 
drop-down list.

34 Click Accept to save the configuration changes.

Edit Global Policies
To define global access policies:

1 Navigate to either the Users > Local Users or Users > Local Groups window.

2 Click the configure icon next to Global Policies. The Edit Global Settings window is displayed.

3 On the Policies tab, click Add Policy. 

.

4 In the Apply Policy To drop-down list, select one of the following: IP Address, IP Network, All 
Addresses, Network Object, Server Path, URL Object, All IPv6 Address, IPv6 Address, or IPv6 
Network.

5 Type a name for the policy in the Policy Name field.
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• If your policy applies to a specific IPv4 host, select the IP Address option from the Apply Policy 
To drop-down list and enter the IPv4 address of the local host machine in the IP Address field.

• If your policy applies to a range of IPv4 addresses, select the IP Network option from the Apply 
Policy To drop-down list and enter the IPv4 network address in the IP Network Address field and 
the subnet mask in the Subnet Mask field.

• If your policy applies to a specific IPv6 host, select the IPv6 Address option from the Apply Policy 
To drop-down list and enter the IPv6 address of the local host machine in the IPv6 Address field.

• If your policy applies to a range of IPv6 addresses, select the IPv6 Network option from the 
Apply Policy To drop-down list and enter the IPv6 network address in the IPv6 Network Address 
field and the IPv6 prefix in the IPv6 Prefix field.

6 Select the desired Protocol. The available value options in the Protocol field include: TCP, UDP, ICMP, and 
ALL. You can select multiple items among TCP, UDP, and ICMP. However, when ALL is selected, all others 
options are deselected.

7 Optionally enter a port range (80-443) or a single port number into the Port Range/Port Number field. 
This field is available when you select IP Address, IP Address Range, IPv6 Address, or IPv6 Address 
Range in the Apply Policy To drop-down list.

8 Select the service type in the Service drop-down list. If you are applying a policy to a network object, the 
service type is defined in the network object.

9 Select ALLOW or DENY from the Status drop-down list to either permit or deny SMA connections for the 
specified service and host machine.

10 Click Accept to update the configuration. After the configuration has been updated, the new policy is 
displayed in the Edit Global Settings window. The global policies are displayed in the policy list in the 
Edit Global Settings window in the order of priority, from the highest priority policy to the lowest 
priority policy.

Edit a Policy for a File Share
To edit file share access policies:

1 Navigate to either the Users > Local Users or Users > Local Groups window.

2 Click the configure icon next to Global Policies. The Edit Global Settings window is displayed.

3 Select the Policies tab.

4 Click Add Policy.

5 Select Server Path from the Apply Policy To drop-down list.

6 Type a name for the policy in the Policy Name field.

7 In the Resource field, select one of the following radio buttons for the type of resource:

• Share (Server path)

• Network (Domain list)

• Servers (Computer list)

8 In the Server Path field, enter the server path in the format servername/share/path or 
servername\share\path. The prefixes \\, //, \ and / are acceptable.

9 Select PERMIT or DENY from the Status drop-down list.

10 Click Accept.
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Edit Global Bookmarks
To edit global bookmarks:

1 Navigate to either the Users > Local Users or Users > Local Groups page.

2 Click the configure icon next to Global Policies. The Edit Global Policies window is displayed.

3 Click Add Bookmark. An Add Bookmark window is displayed.

4 To edit a bookmark, enter a descriptive name in the Bookmark Name field.

5 Enter the domain name or the IP address of a host machine on the LAN in the Name or IP Address field.

6 Select the service type in the Service drop-down list.

7 Click Accept to update the configuration. After the configuration has been updated, the new global 
bookmark is displayed in the bookmarks list in the Edit Global Settings window.

Edit EPC Settings
To configure global End Point Control profiles for local groups or users:

1 Navigate to either the Users > Local Users or Users > Local Groups page.

2 Click the configure icon next to Global Policies. The Edit Global Policies window is displayed.

3 Click the EPC tab. The EPC window is displayed.

4 Configure EPC global settings and add or remove device profiles.S
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Log Configuration

This section provides information and configuration tasks specific to the Log pages on the SonicWall Secure 
Mobile Access web-based management interface.

Topics: 

• Log > View

• Log > View Overview

• Log > Settings Overview

• Log > Categories

• Log > Analyzer Overview

Log > View
The SMA appliance supports web-based logging, syslog logging and email alert messages. In addition, The SMA 
appliance can be configured to email the event log file to the Secure Mobile Access administrator before the log 
file is cleared. 

Log > View Overview
The Log > View page allows the administrator to view the Secure Mobile Access event log. The event log can 
also be automatically sent to an email address for convenience and archiving. 
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The Log > View page displays log messages in a sortable, searchable table. The SMA appliance can store up to 
1GB of log data in the log file system with a limit of 50MB for each log file. Each log entry contains the date and 
time of the event and a brief message describing the event. After the log file reaches the log size limit, the log 
entry is cleared and optionally emailed to the Secure Mobile Access administrator.

Log > Settings Overview
The Log > Settings page allows the administrator to configure log alert and syslog server settings. Syslog is an 
industry-standard logging protocol that records system and networking activity. The syslog messages are sent in 
WELF (WebTrends Enhanced Log Format), so most standard firewalls and networking reporting products can 
accept and interpret the log files. The syslog service transmits syslog messages to external syslog server(s) 
listening on UDP port 514. 
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Topics: 

• Log and Alert Levels

• Syslog Settings

• Event Logging and Alerts

• Configuring Log Settings

• Configuring the Mail Server

Log and Alert Levels
The Log & Alert Levels section allows the administrator to select categories for Syslog, Event log, and Alerts. The 
categories are: emergency, alert, critical, error, warning, notice, info, and debug.

Syslog Settings
The Syslog Settings section allows the administrator to specify the primary and secondary Syslog servers. 

Event Logging and Alerts
The Event Logging and Alerts section allows the administrator to configure email alerts by specifying the email 
address for logs to be sent to, the mail server, mail from address, and the frequency to send alert emails. You 
can schedule a day and hour at which to email the event log, or schedule a weekly email, or send the email 
when the log is full. You can enable SMTP authentication and configure the user name and password along with 
the SMTP port.
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Configuring Log Settings
To configure log and alert settings, complete the following steps:

1 To begin configuring event log, syslog and alert settings, navigate to the Log > Settings page.

2 In the Log & Alert Levels section, define the severity level of log messages that are identified as log 
(event log), alert, or syslog messages. Log levels are organized from most to least critical. If a level is 
selected for a specific logging service, then that log level and more critical events are logged. For 
example, if the Error level is selected for the Log service, then all Emergency, Alert, Critical, and Error 
events are stored in the internal log file.

3 Enter the IP address or fully qualified domain name (FQDN) of your syslog server in the Primary Syslog 
Server field. Leave this field blank if you do not require syslog logging. 

4 If you have a backup or second syslog server, enter the server’s IP address or domain name in the 
Secondary Syslog Server field.

5 Designate when log files are cleared and emailed to an administrator in the Send Event Logs field. If the 
option When Full is selected, the event log is emailed when it reaches the maximum file size of 50MB. 
The log file is then cleared. If Daily is selected, select the hour at which to email the event log. If Weekly 
is selected, select the day of the week and the hour. If Daily or Weekly are chosen, the log file is still sent 
if the log file is full before the end of the period. In the Log > View page, you can click Clear Log to 
delete the current event log. The event log is not emailed in this case.

6 To receive event log files through email, enter your full email address (username@domain.com) in the 
Email Event Logs to field in the Event Logging and Alerts region. The event log file is emailed to the 
specified email address before the event log is cleared. If this field is left blank, log files are not emailed.

7 To receive alert messages through email, enter your full email address (username@domain.com) or an 
email pager address in the Email Alerts to field. An email is sent to the email address specified if an alert 
event occurs. If this field is left blank, alert messages are not emailed.

8 To email log files or alert messages, enter the domain name or IP address of your mail server in the Mail 
Server field. If this field is left blank, log files and alert messages are not emailed.

9 Specify a Mail From Address in the corresponding field. This address appears in the from field of all log 
and alerts emails.

10 To use SMTP authentication when sending log files, select Enable SMTP Authentication. The display 
changes to expose related fields. Enter the user name, password, and the SMTP port to use. The default 
port is 25.

11 Click Accept to update your configuration settings.

Configuring the Mail Server
In order to receive notification email and to enable to the One Time Password feature, it is imperative that you 
configure the mail server from the Log > Settings page. If you fail to configure your mail server prior to using 
the One Time Password feature, you will receive an error message:

To configure the mail server:

1 Log in to the Secure Mobile Access management interface using administrator credentials.

2 Navigate to Log > Settings. 

3 Type the email address where you want logs sent to in the Email Events Logs to field.

4 Type the email address where you want alerts sent to in the Email Alerts to field.
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5 Type the IP address for the mail server you are using in the Mail Server field.

6 Type the email address for outgoing mail from your SMA appliance in the Mail From Address field.

7 Click Accept in the lower right corner.

Log > Categories
This section provides an overview of the Log > Categories page and a description of the various categories of 
event messages that can be viewed in the log. This page allows for each category to be enabled or disabled by 
the administrator. This capability can be particularly helpful when used to filter the log during the debug 
process.

Administrators can enable or disable check boxes for each of the following log categories:

• Authentication

• Authorization & Access

• GMS

• NetExtender

• System

• Web Application Firewall

• High Availability

• Geo IP & Botnet Filter

• End Point Security

• Device Management

• Reverse Proxy
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After all selections have been made, click Accept in the upper right corner of the screen to finish configuring the 
desired categories.

Log > Analyzer Overview
The Log > Analyzer page allows the administrator to add the SMA appliance to an Analyzer server for 
installations that have SonicWall Inc. Analyzer available, or are managed by the SonicWall Inc. Global 
Management System (GMS) version 7.0 or higher appliance management software. This feature requires an 
Analyzer license key. 

SonicWall Inc. Analyzer is a software application that creates dynamic, web-based network reports. The 
Analyzer Reporting Module generates both real-time and historical reports to offer a complete view of all 
activity through SonicWall Inc. network security appliances. With Analyzer Reporting, you can monitor network 
access, enhance security, and anticipate future bandwidth needs. The Analyzer Reporting Module:

• Displays bandwidth use by IP address and service

• Identifies inappropriate Web use

• Provides detailed reports of attacks

• Collects and aggregates system and network errors

• Shows VPN events and problems

• Presents visitor traffic to your Web site

• Provides detailed daily logs to analyze specific events.

To add the SMA appliance to an Analyzer server and enable Analyzer reporting:

1 Navigate to the Log > Analyzer page in the Secure Mobile Access web-based management interface.

2 In the Analyzer Settings section, click the Add. The Add Analyzer Server screen displays.

3 In the Add Analyzer Server screen, enter the Hostname or IP Address of your Analyzer server.

4 Enter the Port which your Analyzer server communicates with managed devices. The default is 514.

5 Click Accept to add this server.

NOTE: This feature requires an Analyzer license key. 
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6 To start Analyzer report logging for the server you just added, select Enable Analyzer. 
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Virtual Office Configuration

This section provides information and configuration tasks specific to the Virtual Office page on the Secure 
Mobile Access web-based management interface.

Topics: 

• Virtual Office

• SMA Connect Agent

Virtual Office
This section provides an overview of the Virtual Office page and a description of the configuration tasks 
available on this page.

• Virtual Office Overview

• Using the Virtual Office

Virtual Office Overview
The Virtual Office option is located in the navigation bar of the Secure Mobile Access management interface.
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The Virtual Office option launches the Virtual Office user portal in a separate Web browser window. The 
Virtual Office is a portal that users can access to create and access bookmarks, file shares, NetExtender sessions, 
Secure Virtual Assist, and Secure Virtual Meeting.

Using the Virtual Office
To use the Virtual Office:

1 From the Secure Mobile Access web-based management interface, click Virtual Office in the navigation 
bar.

2 A new browser window opens to the Virtual Office home page.

The Logout button does not appear in the Virtual Office when you are logged on as an administrator. To 
log out, you must close the browser window.

3 From the Virtual Office home page, you can:

• Launch and install Secure Mobile Access Connect Agents

• Launch and install NetExtender

• Use File Shares

• Launch a Virtual Assist session

• Add and configure bookmarks

• Add and configure bookmarks for offloaded portals

• Follow bookmark links

• Import certificates

• Get Virtual Office help

NOTE: When you launch the Virtual Office from the Secure Mobile Access web-based 
management interface, you are automatically logged in with your administrator credentials.
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• Configure a system for Secure Virtual Access mode, if allowed by administrator

• Configure passwords

• Configure single sign-on options

SMA Connect Agent
The Browser Plug-ins (NPAPI and ActiveX) are used to launch native applications such as Net-Extender, Virtual 
Assist, EPC, and so on. For security reasons, popular browsers block theses Plug-ins. The Chrome browser, for 
example, has disabled all NPAPI Plug-ins, and the newest Microsoft Edge browser does not support ActiveX. As 
such, the ease-of-use ability of launching directly from the browser is no longer functional, and a new method 
for seamless launching is necessary.

There is another application to launch that opens a specific Scheme URL. There are some Schemes already 
defined in the Windows/OS X, such as mailto. The SMA Connect Agent uses the Scheme URL to replace the 
Browser Plug-ins. The SMA Connect Agent is like a bridge that receives the Scheme URL requests and launches 
the specific native application.

To launch the Citrix Receiver through a Citrix bookmark, you must first install the SMA Connect Agent.

Topics:
• Supported Operating Systems

• Downloading and Installation

• Setting up the SMA Connect Agent

Supported Operating Systems
The SMA Connect Agent supports Windows (7, 8, and 10) as well as the Macintosh (OS X) operating systems.

Downloading and Installation
On the Welcome page, the download and install notification displays when you need to use the EPC or PDA 
features:

NOTE: For detailed configuration information about the Virtual Office user portal and these tasks, 
refer to the Secure Mobile Access User Guide.
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On the Portal page, the download and install notification displays when the user attempts to launch 
Net-Extender, Virtual Assist, Virtual Meeting, RDP Bookmark (Native), or Citrix Bookmark (Native):

• Download - Click Download to download and install SMA Connect Agent. After that, users can click 
Installed to tell the browser to 'remember' that the SMA Connect Agent has been installed, or click 
Continue just to bypass the page and log in to the StoreFront.

• Installed - the notification does not appear again.

• Continue - closes the notification and continues the action.

• [Details] - opens a window to introduce the SMA Connect Agent.

After the download is complete, it includes the Installer. The Windows installer is SMAConnectAgent.msi, 
the Macintosh installer is SMAConnectAgent.dmg. The Windows installer needs your permission to install, 
the Macintosh installer guides you to put the SMA Connect Agent in the /Application directory.

Setting up the SMA Connect Agent

Proxy Configuration
SMA supports proxy deployment, where all client browsers are configured to redirect to a proxy server, but an 
appliance sits between the client browsers and the proxy server. All SMA features are supported in this scenario, 
including supporting domain exclusions when the domain is part of a virtual hosting server, or in some cloud 
deployments, wherein the same server IP can be used by multiple domains.

Additionally, typical data center server farms are fronted with a load balancer and/or reverse SSL Proxy to 
offload SSL processing on the servers. For a load balancer fronting the servers and doing decryption, the 
appliance usually only sees the IP of the load balancer, and the load balancer decrypts the content and 
determines the specific server to assign this connection to. DPI-SSL now has a global policy option to disable an 
IP-based exclusion cache. The exclusions continue to work even when the IP-based exclusion cache is off. The 
SMA Connect Agent can setup the proxy by user.

There are four options to setup the proxy configuration:

• No Proxy - When no proxy server is configured, IPv6 attributes are discarded. 

• Use system proxy settings - 

• Manual proxy configuration - 
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• Automatic proxy configuration URL - 

Logs
There is a Log tray on the system tool bar. You can right-click the tray and select the popup menu to view the 
logs.

Browser Warning
When the Scheme URL tries to launch the SMA Connect Agent, the browser could popup a warning message to 
confirm that you want to launch the SMA Connect Agent:

With a Firefox warning window, press OK to launch the SMA Connect Agent.
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To launch the Citrix Native Bookmark, after logging in to the StoreFront, launch any Citrix desktops or 
applications such as other Citrix bookmarks. A browser confirmation message might appear.

In a Chrome warning window, press Launch Application to launch the Citrix or SMA Connect Agent.

In an Internet Explorer warning window, press Allow to launch the SMA Connect Agent.

End Point Control (EPC)
The SMA Connect Agent supports doing an EPC check from the browser. If you enable the EPC check in the login 
page, the browser launches the specific Scheme URL requesting the SMA Connect Agent do the EPC check.

The SMA Connect Agent checks the EPC Service on the machine. If the EPC Service is not on the local machine or 
if there is a newer version on the Appliance, the SMA Connect Agent downloads/Installs or upgrades the EPC 
Service. After installing or upgrading, the SMA Connect Agent does the EPC check.

If the EPC feature (Appliance side) enables the “Show EPC failed message in detail at client side,” the SMA 
Connect Agent records the detailed fail message in the log. Then, you can view the tray Log. 
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PDA (Personal Device Authorization)
The SMA Connect Agent helps the PDA feature get the local machine's information. In the login page, if the user 
enables the PDA feature, the browser launches the SMA Connect Agent. SMA Connect gets the information of 
the local machine and sends the information to the appliance.

SonicWall Application
On the portal page, there are buttons you can click to launch supported SonicWall Applications, including 
Net-Extender, Virtual Assist, and Virtual Meeting.

Net-Extender cannot run on Macintosh. Therefore, the SMA Connect Agent does not support the Net-Extender 
connection on Macintosh.
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Using Online Help

This appendix describes how to use the Online Help on the Secure Mobile Access web-based management 
interface. This appendix also contains information about context-sensitive help.

Online Help Button
Online Help is located in upper right corner of the Secure Mobile Access management interface.

Online Help launches the online help in a separate Web browser. Online Help links to the main page of the 
online help document. 

 Using Context Sensitive Help
Context-sensitive help is available on most pages of the Secure Mobile Access web-based management 
interface. Click the context-sensitive help button in the top right corner of the page to get help that corresponds 
to the Secure Mobile Access management page you are using. Clicking the context-sensitive help button 
launches a separate browser window to the corresponding documentation.

The same help icon appears next to certain fields and check boxes throughout the Secure Mobile Access 
management interface. When you hover your mouse cursor over one of these help icons, a tooltip is displayed 
containing important information about configuring the associated option.
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Configuring the SMA Appliance with a
Third-Party Gateway

This appendix shows methods for configuring various third-party firewalls for deployment with a Secure Mobile 
Access (SMA) appliance.

Topics:
• Cisco PIX Configuration for SMA Appliance Deployment

• Linksys WRT54GS

• WatchGuard Firebox X Edge

• NetGear FVS318

• Netgear Wireless Router MR814 SSL configuration

• Check Point AIR 55

Cisco PIX Configuration for SMA Appliance 
Deployment
Topics:

• Before you Begin

• Method One – SMA Appliance on LAN Interface

• Method Two – SMA Appliance on DMZ Interface

Before you Begin
Make sure you have a management connection to the PIX’s console port, or the ability to Telnet/SSH into one of 
the PIX’s interfaces. You will need to know the PIX’s global and enable-level passwords in order to access the 
device and issue changes to the configuration. If you do not have these, contact your network administrator 
before continuing. 

SonicWall Inc. recommends updating the PIX’s OS to the most recent version if your PIX can support it. This 
document was validated on a Cisco PIX 515e running PIX OS 6.3.5 and is the recommended version for 
interoperation with an SMA appliance. You need a valid Cisco SmartNET maintenance contract for your Cisco PIX 
and a CCO log in to obtain newer versions of the PIX OS. 

NOTE: The WAN/DMZ/LAN IP addresses used in the deployment method examples that follow are not 
valid and need to be modified to reflect your networking environment. 
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Management Considerations for the Cisco Pix
Both deployment methods described in the sections that follow use the PIX’s WAN interface IP address as the 
means of external connectivity to the internal SMA appliance. The PIX has the ability to be managed through 
HTTP/S, but cannot have their default management ports (80,443) reassigned in the recommended PIX OS 
version. Because of this, the HTTP/S management interface must be deactivated. To deactivate the HTTP/S 
management interface, issue the command ‘clear http’. 

Method One – SMA Appliance on LAN Interface
1 From a management system, log in to the SMA appliance’s Secure Mobile Access management interface. 

By default the management interface is X0 and the default IP address is 192.168.200.1. 

2 Navigate to the Network > Interfaces page and click on the configure icon for the X0 interface. On the 
pop-up that appears, change the X0 address to 192.168.100.2 with a mask of 255.255.255.0. When 
done, click OK to save and activate the change.

3 Navigate to the Network > Routes page and change the Default Gateway to 192.168.100.1 When done, 
click Accept in the upper-right corner to save and activate the change.

4 Navigate to the NetExtender > Client Addresses page. You need to enter a range of IP addresses for the 
192.168.100.0/24 network that are not in use on your internal LAN network; if your network has an 
existing DHCP server or the PIX is running a DHCP server on its internal interface, you need to make sure 
not to conflict with these addresses. For example: enter 192.168.100.201 in the field next to Client 
Address Range Begin:, and enter 192.168.100.249 in the field next to Client Address Range End:. 
When done, click Accept in the upper-right corner to save and activate the change.

5 Navigate to the NetExtender > Client Routes page. Add a client route for 192.168.100.0. If there is an 
entry for 192.168.200.0, delete it. 

6 Navigate to the Network > DNS page and enter your internal network’s DNS addresses, internal domain 
name, and WINS server addresses. These are critical for NetExtender to function correctly. When done, 
click Accept in the upper-right corner to save and activate the change.

7 Navigate to the System > Restart page and click Restart… 

8 Install the SMA appliance’s X0 interface on the LAN network of the PIX. Do not hook any of the 
appliance’s other interfaces up.

9 Connect to the PIX’s management CLI by way of the console port, telnet, or SSH and enter configure 
mode. 

10 Issue the command ‘clear http’ to shut off the PIX’s HTTP/S management interface.

11 Issue the command ‘access-list sslvpn permit tcp any host x.x.x.x eq www’ (replace x.x.x.x with the 
WAN IP address of your PIX)

12 Issue the command ‘access-list sslvpn permit tcp any host x.x.x.x eq https’ (replace x.x.x.x with the 
WAN IP address of your PIX)

13 Issue the command ‘static (inside,outside) tcp x.x.x.x www 192.168.100.2 www netmask 
255.255.255.255 0 0’ (replace x.x.x.x with the WAN IP address of your PIX)

14 Issue the command ‘static (inside,outside) tcp x.x.x.x https 192.168.100.2 https netmask 
255.255.255.255 0 0’ (replace x.x.x.x with the WAN IP address of your PIX)

15 Issue the command ‘access-group sslvpn in interface outside’ 

16 Exit config mode and issue the command ‘wr mem’ to save and activate the changes.

NOTE: If you have a separate static WAN IP address to assign to the SMA appliance, you do not have to 
deactivate the HTTP/S management interface on the PIX.
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17 From an external system, attempt to connect to the SMA appliance using both HTTP and HTTPS. If you 
cannot access the SMA appliance, check all previous steps and test again.

Final Config Sample – Relevant Programming in Bold:
PIX Version 6.3(5)
interface ethernet0 auto
interface ethernet1 auto
interface ethernet2 auto shutdown
nameif ethernet0 outside security0
nameif ethernet1 inside security100
nameif ethernet2 dmz security4
enable password SqjOo0II7Q4T90ap encrypted
passwd SqjOo0II7Q4T90ap encrypted
hostname tenaya
domain-name vpntestlab.com
clock timezone PDT -8
clock summer-time PDT recurring
fixup protocol dns maximum-length 512
fixup protocol ftp 21
fixup protocol h323 h225 1720
fixup protocol h323 ras 1718-1719
fixup protocol http 80
fixup protocol rsh 514
fixup protocol rtsp 554
fixup protocol sip 5060
fixup protocol sip udp 5060
fixup protocol skinny 2000
fixup protocol smtp 25
fixup protocol sqlnet 1521
fixup protocol tftp 69
names
access-list sslvpn permit tcp any host 64.41.140.167 eq www
access-list sslvpn permit tcp any host 64.41.140.167 eq https
pager lines 24
logging on
logging timestamp
logging buffered warnings
logging history warnings
mtu outside 1500
mtu inside 1500
mtu dmz 1500
ip address outside 64.41.140.167 255.255.255.224
ip address inside 192.168.100.1 255.255.255.0
no ip address dmz
ip audit info action alarm
ip audit attack action alarm
pdm history enable
arp timeout 14400
global (outside) 1 interface
nat (inside) 1 192.168.100.0 255.255.255.0 0 0
static (inside,outside) tcp 64.41.140.167 www 192.168.100.2 www netmask 
255.255.255.255 0 0
static (inside,outside) tcp 64.41.140.167 https 192.168.100.2 https netmask 
255.255.255.255 0 0
access-group sslvpn in interface outside
route outside 0.0.0.0 0.0.0.0 64.41.140.166 1
timeout xlate 3:00:00
timeout conn 1:00:00 half-closed 0:10:00 udp 0:02:00 rpc 0:10:00 h225 1:00:00
timeout h323 0:05:00 mgcp 0:05:00 sip 0:30:00 sip_media 0:02:00
timeout sip-disconnect 0:02:00 sip-invite 0:03:00
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timeout uauth 0:05:00 absolute
aaa-server TACACS+ protocol tacacs+
aaa-server TACACS+ max-failed-attempts 3
aaa-server TACACS+ deadtime 10
aaa-server RADIUS protocol radius
aaa-server RADIUS max-failed-attempts 3
aaa-server RADIUS deadtime 10
aaa-server LOCAL protocol local
ntp server 192.43.244.18 source outside prefer
no snmp-server location
no snmp-server contact
snmp-server community SF*&^SDG
no snmp-server enable traps
floodguard enable
telnet 0.0.0.0 0.0.0.0 inside
telnet timeout 15
ssh 0.0.0.0 0.0.0.0 outside
ssh 0.0.0.0 0.0.0.0 inside
ssh timeout 15
console timeout 20
dhcpd address 192.168.100.101-192.168.100.199 inside
dhcpd dns 192.168.100.10
dhcpd lease 600
dhcpd ping_timeout 750
dhcpd domain vpntestlab.com
dhcpd enable inside
terminal width 80
banner motd Restricted Access. Please log in to continue.
Cryptochecksum:422aa5f321418858125b4896d1e51b89
: end
tenaya#

Method Two – SMA Appliance on DMZ Interface
This method is optional and requires that the PIX have an unused third interface, such as a PIX 515, PIX 525, or 
PIX 535. We are using the default numbering scheme of the SMA appliance.

1 From a management system, log in to the SMA appliance’s Secure Mobile Access management interface. 
By default the management interface is X0 and the default IP address is 192.168.200.1. 

2 Navigate to the Network > Routes page and make sure the Default Gateway is set to 192.168.200.2 
When done, click Accept in the upper-right corner to save and activate the change.

3 Navigate to the NetExtender > Client Addresses page. Enter 192.168.200.201 in the field next to 
Client Address Range Begin:, and enter 192.168.200.249 in the field next to Client Address Range 
End:’. When done, click Accept in the upper-right corner to save and activate the change.

4 Navigate to the NetExtender > Client Routes page. Add a client route for 192.168.100.0 and 
192.168.200.0.

5 Navigate to the Network > DNS page and enter your internal network’s DNS addresses, internal domain 
name, and WINS server addresses. These are critical for NetExtender to function correctly. When done, 
click Accept in the upper-right corner to save and activate the change.

6 Navigate to the System > Restart page and click Restart… 

7 Install the SMA appliance’s X0 interface on the unused DMZ network of the PIX. Do not hook any of the 
appliance’s other interfaces up.

8 Connect to the PIX’s management CLI by way of console port, telnet, or SSH and enter configure mode. 
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9 Issue the command ‘clear http’ to shut off the PIX’s HTTP/S management interface.

10 Issue the command ‘interface ethernet2 auto’ (or whatever interface you are using)

11 Issue the command ‘nameif ethernet2 dmz security4’ (or whatever interface you are using)

12 Issue the command ‘ip address dmz 192.168.200.2 255.255.255.0’

13 Issue the command ‘nat (dmz) 1 192.168.200.0 255.255.255.0 0 0’

14 Issue the command ‘access-list sslvpn permit tcp any host x.x.x.x eq www’ (replace x.x.x.x with the 
WAN IP address of your PIX)

15 Issue the command ‘access-list sslvpn permit tcp any host x.x.x.x eq https’ (replace x.x.x.x with the 
WAN IP address of your PIX)

16 Issue the command ‘access-list dmz-to-inside permit ip 192.168.200.0 255.255.255.0 192.168.100.0 
255.255.255.0’

17 Issue the command ‘access-list dmz-to-inside permit ip host 192.168.200.1 any’

18 Issue the command ‘static (dmz,outside) tcp x.x.x.x www 192.168.200.1 www netmask 
255.255.255.255 0 0’ (replace x.x.x.x with the WAN IP address of your PIX)

19 Issue the command ‘static (dmz,outside) tcp x.x.x.x https 192.168.200.1 https netmask 
255.255.255.255 0 0’ (replace x.x.x.x with the WAN IP address of your PIX)

20 Issue the command ‘static (inside,dmz) 192.168.100.0 192.168.100.0 netmask 255.255.255.0 0 0’

21 Issue the command ‘access-group sslvpn in interface outside’

22 Issue the command ‘access-group dmz-to-inside in interface dmz’

23 Exit config mode and issue the command ‘wr mem’ to save and activate the changes.

24 From an external system, attempt to connect to the SMA appliance using both HTTP and HTTPS. If you 
cannot access the SMA appliance, check all previous steps and test again.

Final Config Sample – Relevant Programming in Bold:
PIX Version 6.3(5)
interface ethernet0 auto
interface ethernet1 auto
interface ethernet2 auto
nameif ethernet0 outside security0
nameif ethernet1 inside security100
nameif ethernet2 dmz security4
enable password SqjOo0II7Q4T90ap encrypted
passwd SqjOo0II7Q4T90ap encrypted
hostname tenaya
domain-name vpntestlab.com
clock timezone PDT -8
clock summer-time PDT recurring
fixup protocol dns maximum-length 512
fixup protocol ftp 21
fixup protocol h323 h225 1720
fixup protocol h323 ras 1718-1719
fixup protocol http 80
fixup protocol rsh 514
fixup protocol rtsp 554
fixup protocol sip 5060
fixup protocol sip udp 5060
fixup protocol skinny 2000
fixup protocol smtp 25
fixup protocol sqlnet 1521
fixup protocol tftp 69
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names
access-list sslvpn permit tcp any host 64.41.140.167 eq www
access-list sslvpn permit tcp any host 64.41.140.167 eq https
access-list dmz-to-inside permit ip 192.168.200.0 255.255.255.0 192.168.100.0 
255.255.255.0
access-list dmz-to-inside permit ip host 192.168.200.1 any
pager lines 24
logging on
logging timestamp
logging buffered warnings
mtu outside 1500
mtu inside 1500
mtu dmz 1500
ip address outside 64.41.140.167 255.255.255.224
ip address inside 192.168.100.1 255.255.255.0
ip address dmz 192.168.200.2 255.255.255.0
ip audit info action alarm
ip audit attack action alarm
pdm history enable
arp timeout 14400
global (outside) 1 interface
nat (inside) 1 192.168.100.0 255.255.255.0 0 0
nat (dmz) 1 192.168.200.0 255.255.255.0 0 0
static (dmz,outside) tcp 64.41.140.167 www 192.168.200.1 www netmask 255.255.255.255 
0 0
static (dmz,outside) tcp 64.41.140.167 https 192.168.200.1 https netmask 
255.255.255.255 0 0
static (inside,dmz) 192.168.100.0 192.168.100.0 netmask 255.255.255.0 0 0
access-group sslvpn in interface outside
access-group dmz-to-inside in interface dmz
route outside 0.0.0.0 0.0.0.0 64.41.140.166 1
timeout xlate 3:00:00
timeout conn 1:00:00 half-closed 0:10:00 udp 0:02:00 rpc 0:10:00 h225 1:00:00
timeout h323 0:05:00 mgcp 0:05:00 sip 0:30:00 sip_media 0:02:00
timeout sip-disconnect 0:02:00 sip-invite 0:03:00
timeout uauth 0:05:00 absolute
aaa-server TACACS+ protocol tacacs+
aaa-server TACACS+ max-failed-attempts 3
aaa-server TACACS+ deadtime 10
aaa-server RADIUS protocol radius
aaa-server RADIUS max-failed-attempts 3
aaa-server RADIUS deadtime 10
aaa-server LOCAL protocol local
ntp server 192.43.244.18 source outside prefer
floodguard enable
telnet 0.0.0.0 0.0.0.0 inside
telnet timeout 15
ssh 0.0.0.0 0.0.0.0 outside
ssh timeout 15
console timeout 20
dhcpd address 192.168.100.101-192.168.100.199 inside
dhcpd dns 192.168.100.10
dhcpd lease 600
dhcpd ping_timeout 750
dhcpd domain vpntestlab.com
dhcpd enable inside
terminal width 80
banner motd Restricted Access. Please log in to continue.
Cryptochecksum:81330e717bdbfdc16a140402cb503a77
: end
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Linksys WRT54GS
The SMA appliance should be configured on the LAN switch of the Linksys wireless router. This guide assumes 
that your Linksys is assigned a single WAN IP, through DHCP by the cable ISP and is using the default LAN IP 
address scheme of 192.168.1.0/24.

To configure your Linksys for operation with the SMA appliance, you must forward the SSL (443) port to the IP 
address of the SMA appliance.

1 Log in to the Linksys device.

2 Navigate to the Applications & Gaming tab.

3 Enter the following information:

4 With the configuration complete, click Save Settings on the bottom of the page.

The Linksys is now ready for operations with the SMA appliance.

WatchGuard Firebox X Edge
This guide assumes that your WatchGuard Firebox X Gateway is configured with an IP of 192.168.100.1 and your 
SMA appliance is configured with an IP of 192.168.100.2.

Before you get started, take note of which port the WatchGuard is using for management. If the WatchGuard is 
not being managed on HTTPS (443), perform the following steps. If the WatchGuard is being managed on HTTPS 
(443) you should first review the notes within this guide.

NOTE: Version 2.07.1 firmware or newer is recommended for this setup.

Information to be added to Applications & Gaming tab

Application SMA The name for the port forwarded application.

Port Range Start 443 The starting port number used by the application.

Port Range End 443 The ending port number used by the application.

Protocol TCP The SMA application uses TCP.

IP Address 192.168.1.10 The IP address assigned to the SMA appliance.

Enable Checked Select the check box to enable the SSL port forwarding.

NOTE: The steps that follow are similar for WatchGuard SOHO6 series firewall.
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1 Open browser and enter the IP address of the WatchGuard Firebox X Edge appliance (such as 
192.168.100.1). When successful, you’ll be brought to the “System Status” page (See the following).

2 If the WatchGuard’s management interface is already configured to accept HTTPS on port 443 you need 
to change the port in order to be able to manage both the SMA and WatchGuard appliances. 

3 Navigate to Administration > System Security.

WatchGuard Administration > System Security Dialog Box

4 Clear Use non-secure HTTP instead of secure HTTPS for administrative Web site.

5 Change the HTTP Server Port to 444 and click Submit.

The WatchGuard is now managed from the WAN on port 444. It should be accessed as follows: 
https://<watchguard wan ip>:444
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6 In the left navigation menu, Navigate to Firewall > Incoming.

7 For the HTTPS Service, set Filter to Allow and enter the WAN IP of the SMA appliance (192.168.100.2) in 
the Service Host field.

8 Click Submit at the bottom of the page. 

Your Watchguard Firebox X Edge is now ready for operations with the SMA appliance.

NetGear FVS318
This guide assumes that your NetGear FVS318 Gateway is configured with an IP of 192.168.100.1 and your SMA 
appliance is configured with an IP of 192.168.100.2.

1 Click Remote Management from the left index of your Netgear management interface. 

In order for the SMA appliance to function with your Netgear gateway device, you must verify that the 
NetGear’s management port does not conflict with the management port used by the SMA appliance.

2 Clear the Allow Remote Management box.

3 Click Accept to save changes.

4 Navigate to Add Service in the left navigation.

5 Click Add Custom Service.

NOTE: If Remote Management of the NetGear is desired, you must leave the box checked 
and change the default port (8080 is recommended)
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6 To create a service definition, enter the following information:

7 Navigate to Ports in the left navigation.

Click Add.

8 Select HTTPS from the Service Name drop-down list.

9 Select ALLOW always in the Action drop-down list.

10 Enter the WAN IP address of the SMA appliance (ex.192.168.100.2) in the Local Server Address field.

11 Click Accept to save changes.

Your Netgear gateway device is now ready for operations with the SMA appliance.

Name HTTPS

Type TCP/UDP

Start Port 443

Finish Port 443
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Netgear Wireless Router MR814 SSL 
configuration
This guide assumes that your NetGear Wireless Router is configured with an IP of 192.168.100.1 and your SMA 
appliance is configured with an IP of 192.168.100.2.

1 Navigate to Advanced > Port Management in the left index of your Netgear management interface.

2 Click Add Custom Service in the middle of the page.

3 Enter a service name in the Service Name field (ex. SMA)

4 Enter 443 in the Starting Port field.

5 Enter 443 in the Ending Port field.

6 Enter the WAN IP address of the SMA appliance (ex.192.168.100.2) in the Local Server Address field.

7 Click Accept.

Your Netgear wireless router is now ready for operations with the SMA appliance.

Check Point AIR 55
Topics:

• Setting up an SMA Appliance with Check Point AIR 55

• Static Route

• ARP
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Setting up an SMA Appliance with Check Point AIR 55
The first thing necessary to do is define a host-based network object. This is done under the file menu “Manage” 
and “Network Objects.”

Check Point Host Node Object Dialog Box

Next, select the NAT tab for the object you have created.

Check Point NAT Properties Dialog Box

NOTE: The object is defined as existing on the internal network. Should you decide to locate the SMA 
appliance on a secure segment (sometimes known as a demilitarized zone) then subsequent firewall rules 
have to pass the necessary traffic from the secure segment to the internal network. 
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Here you should enter the external IP address (if it is not the existing external IP address of the firewall). The 
translation method to be selected is static. Clicking OK automatically creates the necessary NAT rule shown in 
the following section.

Check Point NAT Rule Window

Static Route
Most installations of Check Point AIR55 require a static route. This route sends all traffic from the public IP 
address for the SMA appliance to the internal IP address.

#route add 64.41.140.167 netmask 255.255.255.255 192.168.100.2

ARP
Check Point AIR55 contains a feature called auto-ARP creation. This feature automatically adds an ARP entry for 
a secondary external IP address (the public IP address of the SMA appliance). If running Check Point on a Nokia 
security platform, Nokia recommends that users disable this feature. As a result, the ARP entry for the external 
IP address must be added manually within the Nokia Voyager interface.

Finally, a traffic or policy rule is required for all traffic to flow from the Internet to the SMA appliance.

Check Point Policy Rule Window

Again, should the SMA appliance be located on a secure segment of the Check Point firewall, a second rule 
allowing the relevant traffic to flow from the SMA appliance to the internal network is necessary.
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Printer Redirection

This appendix provides information on installing a specific printer driver redirection, the “MS Publisher 
Imagesetter.” HTML5 RDP support a specific Printer Redirection if the Remote Desktop Session Host server has 
the driver installed. HTML5 RDP can redirect the printer to the client side. The user can select the Redirection 
Printer to print files to a PDF. After the PDF is created, a file pop-up viewer appears. You can “Print Preview” the 
PDF file or print the file directly.

To install the MS Publisher Imagesetter on Windows 7:

1 Go to Windows Control Panel and click Devices and Printers.

2 Click Add a printer.

3 Select Add a local printer.
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4 Select Use an existing port and then FILE: (Print to File) in the drop-down box.

5 Click Next.

6 Select Generic from the Manufacturer list. Then select MS Publisher Imagesetter from the Printers list.

7 Click Next.

8 Select Use the driver that is currently installed.

9 Click Next.

10 Use the default settings for the Printer name, “MS Publisher Imagesetter.”

11 Click Next.
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12 Select the option that best suits your sharing criteria.

13 Click Next.

14 Click Finish. You should find your new printer in the “Printers and Faxes” area.

Enable the Redirection Printers
1 Enable the Redirection Printers in the “Show Advanced Windows Options” of the bookmark. After the 

Redirection Printer is enabled, you can find the “SonicWall Secure RDP Printer” in the remote server’s 
printer list.

2 Select the printer to print the file. The browser might attempt to block the pop-up window. Select 
“Always allow pop-ups from https://...” (the server address).

3 You can now preview the file and print it on the local printer.

Time-Zone Redirection
HTML5 RDP can also redirect the local time-zone to the remote server. The remote server should enable this 
feature.

The following steps show how to enable time-zone redirection in Windows 2008 R2:

1 Open Local Group Policy Editor or Group Policy Management.

2 Use the following path:

Computer Configuration > (Policies) > Administrative Templates > Windows Components > Remote 
Desktop Services > Remote Desktop Session Host > Device and Resource Redirection > Allow time zone 
redirection.

3 Double click the printer name and select Enabled. 

4 Click OK.

After enable the setting on the remote server, you can see the local time-zone is redirected to the 
remote server.
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5 Time zone redirection is possible only when connecting to at least a Windows Server 2003 terminal 
server with a client that is using RDP 5.1 or later.
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Use Cases

This appendix provides the following use cases:

• Importing CA Certificates on Windows

• Creating Unique Access Policies for AD Groups

Importing CA Certificates on Windows
Two certificates are imported in this use case, a goDaddy certificate and a server certificate. See the following 
sections:

• Importing a goDaddy Certificate on Windows

• Importing a Server Certificate on Windows

Importing a goDaddy Certificate on Windows
In this use case, we format a goDaddy Root CA Certificate on a Windows system and then import it to our Secure 
Mobile Access (SMA) appliance.

1 Double-click on the goDaddy.p7b file to open the Certificates window, and navigate to the goDaddy 
certificate. 
The .p7b format is a PKCS#7 format certificate file, a very common certificate format.
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2 Double-click the certificate file and select the Details tab.

3 Click Copy to File. The Certificate Export Wizard launches.

4 In the Certificate Export Wizard, click Next.

5 Select Base-64 encoded X.509 (.CER) and then click Next.

6 In the File to Export screen, type the file name in as goDaddy.cer and then click Next.
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7 In the Completing the Certificate Export Wizard screen, verify the path and format and then click Finish.

8 Click OK in the confirmation dialog box.

The certificate is exported in base-64 encoded format. You can view it in a text editor.

9 In the Secure Mobile Access management interface, navigate to System > Certificates.

10 In the Additional CA Certificates section, click Import CA Certificate. The Import Certificate window 
appears.

11 In the Import Certificate window, click Browse and navigate to the goDaddy.cer file on your Windows 
system and double-click it.
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12 Click Upload. The certificate is listed in the Additional CA Certificates table.

13 Navigate to System > Restart and restart the SMA/SRA appliance for the CA certificate to take effect.

Importing a Server Certificate on Windows
In this use case, we import a Microsoft CA server certificate to a Windows system. In this case, the purpose is to 
use an SSL certificate for application offloading to a mail server.

The server certificate is mail.chaoslabs.nl. This certificate needs to be exported in base-64 format as the 
server.crt file that is put in a .zip file and uploaded as a Server Certificate. 

The private key is not included in the .p7b file. The private key needs to be exported from wherever it is and 
saved in a base-64 format and included in a server.key file in the .zip file.

1 Double-click on the mail.chaoslabs.nl.pb7 file and navigate to the certificate.

2 Double-click the certificate file and select the Details tab.

3 Click Copy to File.

4 In the Certificate Export Wizard, select Base-64 encoded X.509 (.CER).

5 Click Next and save the file as server.crt on your Windows system.

The certificate is exported in base-64 encoded format.

6 Add the server.crt file to a .zip file.

7 Separately save the private key in base-64 format as server.key.

8 Add the server.key file to the .zip file that contains server.crt.

9 Upload the .zip file to the server as a Server Certificate.

Creating Unique Access Policies for AD Groups
In this use case, we add Outlook Web Access (OWA) resources to the SMA appliance, and need to configure the 
access policies for users in multiple Active Directory (AD) groups. We will create a local group for each AD group 
and apply separate access policies to each local group. 

While Active Directory allows users to be members in multiple groups, the SMA appliance only allows each user 
to belong to a single group. It is this group that determines the access policies assigned to the user. 
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When importing a user from AD, the user is placed into the local Secure Mobile Access group with which they 
have the most AD groups in common. For example: Bob belongs to the Users, Administrators, and Engineering 
AD groups. If one Secure Mobile Access group is associated with Users, and another is associated with both 
Administrators and Engineering, Bob is assigned to the Secure Mobile Access group with both Administrators 
and Engineering because it matches more of his own AD groups. 

The goal of this use case is to show that Secure Mobile Access firmware supports group-based access policies by 
configuring the following:

• Allow Acme Group in Active Directory to access the 10.200.1.102 server using SSH

• Allow Mega Group in Active Directory to access Outlook Web Access (OWA) at 10.200.1.10

• Allow IT Group in Active Directory to access both SSH and OWA resources defined previously

• Deny access to these resources to all other groups

This example configuration is provided courtesy of Vincent Cai, June 2008.

Network Topology

Perform the tasks in order of the following sections:

• Creating the Active Directory Domain

• Adding a Global Deny All Policy

• Creating Local Groups

• Adding the SSHv2 PERMIT Policy

• Adding the OWA PERMIT Policies

• Verifying the Access Policy Configuration

Creating the Active Directory Domain
This section describes how to create the Secure Mobile Access Local Domain, SNWL_AD. SNWL_AD is associated 
with the Active Directory domain of the OWA server.

1 Log in to the Secure Mobile Access management interface and navigate to the Portals > Domains page.
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2 Click Add Domain. The Add Domain window appears.

3 In the Authentication type drop-down list, select Active Directory.

4 In the Domain name field, type SNWL_AD. 

5 In the Active Directory domain field, type the AD domain name, in.loraxmfg.com.

6 In the Server address field, type the IP address of the OWA server, 10.200.1.10.

7 Click Add.

8 View the new domain in the Portals > Domains page.

Adding a Global Deny All Policy
This procedure creates a policy that denies access to the OWA resources to all groups, except groups configured 
with an explicit Permit policy.

The Secure Mobile Access default policy is Allow All. In order to have more granular control, we add a Deny All 
policy here. Later, we can add Permit policies for each group, one at a time.

1 Navigate to the Users > Local Users page.

2 Click Configure  in the Global Policies row. The Edit Global Policies window appears.

3 In the Edit Global Policies window, click the Policies tab.
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4 Click Add Policy. The Add Policy window appears.

5 Select IP Network from the Apply Policy To drop-down list.

6 In the Policy Name field, type the descriptive name IP Network Deny All.

7 In the IP Network Address field, type the network address, 10.200.1.0.

8 In the Subnet Mask field, type the mask in decimal format, 255.255.255.0.

9 In the Service drop-down list, select All Services.

10 In the Status drop-down list, select Allow.

11 Click Add.

12 In the Edit Global Policies window, verify the Deny All policy settings and then click OK.

Creating Local Groups
This procedure creates Local Groups that belong to the SNWL_AD domain on the SMA appliance. We create one 
local group for each Active Directory group. 

Adding the Local Groups
1 Navigate to the Users > Local Groups page and click Add Group. The Add Local Group window 

appears. We will add three local groups, corresponding to our Active Directory groups.

2 In the Add Local Group window, type Acme_Group into the Group Name field.

3 Select SNWL_AD from the Domain drop-down list.

4 Click Add.

5 On the Users > Local Groups page, click Add Group to add the second local group.
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6 In the Add Local Group window, type Mega_Group into the Group Name field.

7 Select SNWL_AD from the Domain drop-down list.

8 Click Add.

9 On the Users > Local Groups page, click Add Group to add the second local group.

10 In the Add Local Group window, type IT_Group into the Group Name field.

11 Select SNWL_AD from the Domain drop-down list.

12 Click Add.

13 View the added groups on the Users > Local Groups page. 

Configuring the Local Groups
In this procedure, we will edit each new local group and associate it with the corresponding Active Directory 
Group.

1 Click Configure in the Acme_Group row. The Edit Group Settings window appears.

2 In the Edit Group Settings window, click the AD Groups tab.

3 On the AD Groups tab, click Add Group.
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4 In the Edit Active Directory Group window, select Acme Group from the Active Directory Group 
drop-down list.

5 Click Edit. 

Acme Group is listed in the Active Directory Groups table on the AD Groups tab.

6 In the Edit Group Settings window, click OK.

7 On the Users > Local Groups page, click Configure in the Mega_Group row. The Edit Group Settings 
window appears.

8 In the Edit Group Settings window, click the AD Groups tab and then click Add Group.

9 In the Edit Active Directory Group window, select Mega Group from the Active Directory Group 
drop-down list and then click Edit.

Mega Group is listed in the Active Directory Groups table on the AD Groups tab.

10 In the Edit Group Settings window, click OK.

11 On the Users > Local Groups page, click Configure in the IT_Group row. The Edit Group Settings 
window appears.

12 In the Edit Group Settings window, click the AD Groups tab and then click Add Group.

13 In the Edit Active Directory Group window, select IT Group from the Active Directory Group 
drop-down list and then click Edit.

IT Group is listed in the Active Directory Groups table on the AD Groups tab.

14 In the Edit Group Settings window, click OK.

At this point, we have created the three Local Groups and associated each with its Active Directory 
Group.

Adding the SSHv2 PERMIT Policy
In this section, we will add the SSHv2 PERMIT policy for both Acme_Group and IT_Group to access the 
10.200.1.102 server using SSH.

This procedure creates a policy for the Secure Mobile Access Local Group, Acme_Group, and results in SSH 
access for members of the Active Directory group, Acme Group.

Repeat this procedure for IT_Group to provide SSH access to the server for members of the Active Directory 
group, IT Group.

1 On the Users > Local Groups page, click Configure in the Acme_Group row. The Edit Group Settings 
window appears.

2 In the Edit Group Settings window, click the Policies tab.
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3 On the Policies tab, click Add Policy.

4 In the Add Policy window, select IP Address in the Apply Policy To drop-down list.

5 In the Policy Name field, enter the descriptive name, Allow SSH.

6 In the IP Address field, enter the IP address of the target server, 10.202.1.102.

7 In the Services drop-down list, select Secure Shell Version 2 (SSHv2).

8 In the Status drop-down list, select ALLOW, and then click Accept.

Adding the OWA PERMIT Policies
In this section, we will add two OWA PERMIT policies for both Mega_Group and IT_Group to access the OWA 
service using Secure Web (HTTPS).

This procedure creates a policy for the Secure Mobile Access Local Group, Mega_Group, and results in OWA 
access for members of the Active Directory group, Mega Group. 

To access the Exchange server, adding a PERMIT policy to the 10.200.1.10/exchange URL Object itself is not 
enough. Another URL Object policy is needed that permits access to 10.200.1.10/exchweb, because some 
OWA Web contents are located in the exchweb directory.

Repeat this procedure for IT_Group to provide OWA access for members of the Active Directory group, IT 
Group.

The OWA policies are applied to Exchange server URL Objects rather than server IP addresses since OWA is a 
Web service.

1 In the Users > Local Groups page, click Configure in the Mega_Group row. We will create two PERMIT 
policies for Mega_Group to allow access to the OWA Exchange server. 

2 In the Edit Group Settings window, click the Policies tab, and then click Add Policy.

3 In the Add Policy window, select URL Object in the Apply Policy To drop-down list.

4 In the Policy Name field, enter the descriptive name, OWA.

5 In the Service drop-down list, select Secure Web (HTTPS).

NOTE: In this configuration, members of IT_Group and Mega_Group are denied access to the 
https://owa-server/public folder, because these groups have access only to the /exchange and /exchweb 
subfolders.
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6 In the URL field, enter the URL of the target application, 10.200.1.10/exchange.

7 In the Status drop-down list, select ALLOW, and then click Accept.

8 In the Edit Group Settings window on the Policies tab, click Add Policy.

9 In the Add Policy window, select URL Object in the Apply Policy To drop-down list.

10 In the Policy Name field, enter the descriptive name, OWA exchweb.

11 In the Service drop-down list, select Secure Web (HTTPS).

12 In the URL field, enter the URL of the target application, 10.200.1.10/exchweb.

13 In the Status drop-down list, select ALLOW, and then click Accept.

14 We are finished with the policies for Mega_Group. Repeat this procedure for IT_Group to provide OWA 
access for members of the Active Directory group, IT Group.

Verifying the Access Policy Configuration
At this point:

• Acme_Group users are allowed to access SSH to 10.200.1.102

• Mega_Group users are allowed to access OWA at 10.200.1.10

• IT_Groups users are allowed to access both SSH and OWA as defined previously

The configuration can be verified by logging in as different AD group members to the SNWL_AD domain on the 
SMA appliance, and attempting to access the resources.

Test Result: Try Acmeuser Access
Acmeuser logs into the SNWL_AD domain.
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The Users > Status page shows that acmeuser is a member of the local group, Acme_Group.

Acmeuser can access SSH, as expected.

Acmeuser tries to access to other resources like OWA 10.200.1.10, but is denied, as expected. 

Test Result: Try Megauser Access
Megauser logs into the SNWL_AD domain.
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The Users > Status page shows that megauser is a member of the local group, Mega_Group.

Megauser can access OWA resources, as expected.

Megauser tries to access SSH, but is denied, as expected.

Test Result: Try Ituser Access
Ituser logs into the SNWL_AD domain. The Users > Status page shows that ituser is a member of the local 
group, IT_Group.
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Ituser can access SSH to 10.200.1.102, as expected. 

Ituser can access OWA resources, as expected.
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NetExtender Troubleshooting

See the following tables with troubleshooting information for the SonicWall Secure Mobile Access (SMA) 
NetExtender utility. 

NetExtender Cannot Be Installed

Problem Solution

NetExtender cannot be installed. 1 Check your OS Version, NetExtender only supports Windows Vista or 
higher, Mac OS X 10.5 or higher with Apple Java 1.6.0_10 or higher, 
and Linux OpenSUSE in addition to Fedora Core and Ubuntu. An 
i386-compatible Linux distribution is required, along with Sun Java 
1.6.0_10+.

2 Check that the user has administrator privilege, NetExtender can only 
install/work under the user account with administrator privileges.

3 Check if ActiveX has been blocked by Internet Explorer or third-party 
blockers.

4 If the problem still exists, obtain the following information and send 
to support: 

• The version of Secure Mobile Access NetExtender Adapter 
from Device Manager.

• The log file located at C:\Program 
files\SonicWall\SMA\NetExtender.dbg.

• The event logs in the Event Viewer found under the 
Windows Control Panel Administrator Tools folder. 

Select Applications and System events and use the Action 
/Save Log File as… menu to save the events in a log file.
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NetExtender Connection Entry Cannot Be Created

Problem Solution

NetExtender connection entry 
cannot be created.

1 Navigate to Device Manager and check if the Secure Mobile Access 
NetExtender Adapter has been installed successfully. If not, delete 
the adapter from the device list, reboot the machine and install 
NetExtender again.

2 Navigate to Windows Service manager under Control Panel > 
Administrator Tools > Services. Look for the Remote Access Auto 
Connection Manager and Remote Access Connection Manager to 
see if those two services have been started. If not, set them to 
automatic start, reboot the machine, and install NetExtender again.

3 Check if there is another dial-up connection in use. If so, disconnect 
the connection, reboot the machine and install NetExtender again.

4 If problem still exists, obtain the following information and send 
them to support: 

• The version of Secure Mobile Access NetExtender Adapter 
from Device Manager.

• The log file located at C:\Program 
files\SonicWall\SMA\NetExtender.dbg.

• The event logs in Control Panel > Administrator Tools > 
Event Viewer. Select Applications and System events 
and use the Action /Save Log File as… menu to save the 
events in a log file.

NetExtender Cannot Connect

Problem Solution

NetExtender cannot connect. 1 Navigate to Device Manager and check if the Secure Mobile Access 
NetExtender Adapter has been installed successfully. If not, delete 
the adapter from the device list, reboot the machine and install 
NetExtender again.

2 Navigate to Network connections to check if the Secure Mobile 
Access NetExtender Dialup entry has been created. If not, reboot the 
machine and install NetExtender again.

3 Check if there is another dial-up connection in use, if so, disconnect 
the connection and reboot the machine and connect NetExtender 
again.

4 If problem still exists, obtain the following information and send 
them to support: 

• The version of Secure Mobile Access NetExtender Adapter 
from Device Manager.

• The log file located at C:\Program 
files\SonicWall\SMA\NetExtender.dbg.

• The event logs in Control Panel > Administrator Tools > 
Event Viewer. Select Applications and System events 
and use the Action /Save Log File as… menu to save the 
events in a log file.
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NetExtender BSOD After Connected

Problem Solution

NetExtender BSOD after connected. 1 Uninstall NetExtender, reboot machine, reinstall the latest version 
NetExtender.

2 Obtain the following information and send them to support: 

• The version of Secure Mobile Access NetExtender Adapter 
from Device Manager.

• The log file located at C:\Program 
files\SonicWall\SMA\NetExtender.dbg.

• Windows memory dump file located at 
C:\Windows\MEMORY.DMP. If you cannot find this file, 
then you should open System Properties, click Startup 
and Recovery Settings under the Advanced tab. Select 
Complete Memory Dump, Kernel Memory Dump or 
Small Memory Dump in the Write Debugging 
Information drop-down list. Of course, you should also 
reproduce the BSOD to get the dump file.

• The event logs in Control Panel > Administrator Tools > 
Event Viewer. Select Applications and System Events 
and use the Action /Save Log File as… menu to save the 
events in a log file.
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Frequently Asked Questions

This appendix contains frequently asked questions (FAQs) about the Secure Mobile Access (SMA) or Secure 
Remote Access (SRA) appliance. 

• Hardware FAQ

1) What are the hardware specs for the SRA 4600 and SRA 1600?

2) What are the SMA 500v Virtual Appliance virtualized environment requirements?

3) Do the SMA/SRA appliances have hardware-based SSL acceleration onboard?

4) What operating system do the SMA/SRA appliances run?

5) Can I put multiple SMA/SRA appliances behind a load-balancer?

6) What are the maximum number of connections allowed on the different SMA/SRA 
appliances?

• Digital Certificates and Certificate Authorities FAQ

1) What do I do if when I log in to the SMA/SRA appliance my browser gives me an error, or if 
my Java components give me an error?

2) I get the following message when I log in to my SMA/SRA appliance – what do I do?

3) I get the following message when I log in to my SMA/SRA appliance using Firefox– what do 
I do?

4) When I launch any of the Java components it gives me an error – what should I do?

5) Do I have to purchase a SSL certificate?

6) What format is used for the digital certificates?

7) Are wild card certificates supported?

8) What CA’s certificates can I use with the SMA/SRA appliance?

9) Does the SMA/SRA appliance support chained certificates?

10) Any other tips when I purchase the certificate for the SMA/SRA appliance?

11) Can I use certificates generated from a Microsoft Certificate Server?

12) Why can’t I import my new certificate and private key?

13) Why do I see the status “pending” after importing a new certificate and private key?

14) Can I have more than one certificate active if I have multiple virtual hosts?

15) I imported the CSR into my CA’s online registration site but it’s asking me to tell them what 
kind of Webserver it’s for. What do I do?

16) Can I store the key and certificate?

17) Does the SMA/SRA appliance support client-side digital certificates?

18) When client authentication is required my clients cannot connect even though a CA 
certificate has been loaded. Why?
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• NetExtender FAQ

1) Does NetExtender work on other operating systems than Windows?

2) Which versions of Windows does NetExtender support?

3) Can I block communication between NetExtender clients?

4) Can NetExtender run as a Windows service?

5) What range do I use for NetExtender IP client address range?

6) What do I enter for NetExtender client routes?

7) What does the ‘Tunnel All Mode’ option do?

8) Is there any way to see what routes the SMA/SRA appliance is sending NetExtender?

9) After I install the NetExtender is it uninstalled when I leave my session?

10) How do I get new versions of NetExtender?

11) How is NetExtender different from a traditional IPSec VPN client, such as SonicWall Inc.’s 
Global VPN Client (GVC)?

12) Is NetExtender encrypted?

13) Is there a way to secure clear text traffic between the SMA/SRA appliance and the server?

14) What is the PPP adapter that is installed when I use the NetExtender?

15) What are the advantages of using the NetExtender instead of a Proxy Application?

16) Does performance change when using NetExtender instead of proxy?

17) The SMA/SRA appliance is application dependent; how can I address non-standard 
applications?

18) Why is it required that an ActiveX component be installed?

19) Does NetExtender support desktop security enforcement, such as AV signature file 
checking, or Windows registry checking?

20) Does NetExtender work with the 64-bit version of Microsoft Windows?

21) Does NetExtender work 32-bit and 64-bit version of Microsoft Windows 7?

22) Does NetExtender support client-side certificates?

23) My firewall is dropping NetExtender connections from my SonicWall SMA/SRA as being 
spoofs. Why?

• General FAQ

1) Is the SMA/SRA appliance a true reverse proxy?

2) What browser and version do I need to successfully connect to the SMA/SRA appliance?

3) What needs to be activated on the browser for me to successfully connect to the SMA/SRA 
appliance?

4) What version of Java do I need?

5) What operating systems are supported?

6) Why does the ‘File Shares’ component not recognize my server names?

7) Does the SMA/SRA appliance have an SPI firewall?

8) Can I access the SMA/SRA appliance using HTTP?

9) What is the most common deployment of the SMA/SRA appliances?
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10) Why is it recommended to install the SMA/SRA appliance in one-port mode with a 
SonicWall Inc. security appliance?

11) Is there an installation scenario where you would use more than one interface or install 
the appliance in two-port mode?

12) Can I cascade multiple SMA/SRA appliances to support more concurrent connections?

13) Why can’t I log in to the Secure Mobile Access management interface of the SMA/SRA 
appliance?

14) Can I create site-to-site VPN tunnels with the SMA/SRA appliance?

15) Can the SonicWall Inc. Global VPN Client (or any other third-party VPN client) connect to 
the SMA/SRA appliance?

16) Can I connect to the SMA/SRA appliance over a modem connection?

17) What SSL ciphers are supported by the SMA/SRA appliance?

18) Is AES supported in the SMA/SRA appliance?

19) Can I expect similar performance (speed, latency, and throughput) as my IPSec VPN?

20) Is Two-factor authentication (RSA SecurID, etc) supported?

21) Does the SMA/SRA appliance support VoIP?

22) Is Syslog supported?

23) Does NetExtender support multicast?

24) Are SNMP and Syslog supported?

25) Does the SMA/SRA appliance have a Command Line Interface (CLI)?

26) Can I Telnet or SSH into the SMA/SRA appliance?

27) What does the Web cache cleaner do?

28) Why didn’t the Web cache cleaner work when I exited the Web browser?

29) What does the ‘encrypt settings file’ check box do?

30) What does the ‘store settings’ button do?

31) What does the ‘create backup’ button do?

32) What is ‘SafeMode’?

33) How do I access the SafeMode menu?

34) Can I change the colors of the portal pages?

35) What authentication methods are supported?

36) I configured my SMA/SRA appliance to use Active Directory as the authentication method, 
but it fails with a very strange error message. Why?

37) I created a FTP bookmark, but when I access it, the filenames are garbled – why?

38) Where can I get a VNC client?

39) Are the SRA 4600/1600 appliances fully supported by GMS or Analyzer?

40) Does the SMA/SRA appliance support printer mapping?

41) Can I integrate the SMA/SRA appliance with wireless?

42) Can I manage the appliance on any interface IP address of the SMA/SRA appliance?

43) Can I allow only certain Active Directory users access to log in to the SMA/SRA appliance?
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44) Does the HTTP(S) proxy support the full version of Outlook Web Access (OWA Premium)?

45) Why are my RDP sessions dropping frequently?

46) Can I create my own services for bookmarks rather than the services provided in the 
bookmarks section?

47) Why can’t I see all the servers on my network with the File Shares component?

48) What port is the SMA/SRA appliance using for the Radius traffic?

49) Do the SMA/SRA appliances support the ability for the same user account to login 
simultaneously?

50) Does the SMA/SRA appliance support NT LAN Manager (NTLM) Authentication?

51) I cannot connect to a web server when Windows Authentication is enabled. I get the 
following error message when I try that: ‘It appears that the target web server is using an 
unsupported HTTP(S) authentication scheme through the SMA/SRA that currently 
supports only basic and digest authentication schemes. Contact the administrator for 
further assistance.’ - why?

52) Why do Java Services, such as Telnet or SSH, not work through a proxy server?

53) There is no port option for the service bookmarks – what if these are on a different port 
than the default?

54) There is no port option for the service bookmarks – what if these are on a different port 
than the default?

55) What if I want a bookmark to point to a directory on a Web server?

56) When I access Microsoft Telnet Server using a telnet bookmark it does not allow me to 
enter a user name -- why?

57) What versions of Citrix are supported?

58) What applications are supported using Application Offloading?

59) Is SSHv2 supported?

60) Should I create a Global Deny ALL policy?

Hardware FAQ
1 What are the hardware specs for the SMA 400 and SMA 200?

Answer:

Interfaces

SMA 200: (2) gigabit Ethernet, (2) USB, (1) console

SMA 400: (4) gigabit Ethernet, (2) USB, (1) console

Processors

SMA 200: 1.74 GHz Intel Atom™ C2358 Dual Core Processor

SMA 400: 2.40 GHz Intel Atom™ C2358 Quad Core Processor

Memory (RAM)

SMA 200: 2 GB

SMA 400: 4 GB
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Flash Memory

SMA 200: 2 GB (CFAST)

SMA 400: 2 GB (CFAST)

Power Supply

SMA 200: Fixed Internal, 60W adaptor

SMA 400: Fixed Internal, 60W adaptor

Max Power Consumption

SMA 200: 26.9 W

SMA 400: 31.9 W

Total Heat Dissipation

SMA 200: 92 BTU

SMA 400: 109 BTU

Dimensions

SMA 200: 17.00 x 10.13 x 1.75 in (43.18 x 25.73 x 4.45 cm)

SMA 400: 17.00 x 10.13 x 1.75 in (43.18 x 25.73 x 4.45 cm)

Weight

SMA 200: 11 lbs (5 kg)

SMA 400: 11 lbs (5 kg)

Major Regulatory Compliance

SMA 200/400: 

FCC Class A, ICES Class A, CE, C-Tick, VCCI Class A, KCC, ANATEL, BSMI, NOM, UL, cUL, 
TUV/GS, CB

Environment:

Temperature:

SMA 200/400: 32-105ª F, 0-40ª C

Relative Humidity:

SMA 200/400: 5-95 percent RH non-condensing

MTBF

SMA 200: 7.060 years

SMA 400: 6.870 years

2 What are the hardware specs for the SRA 4600 and SRA 1600?

Answer:

Interfaces

SRA 1600: (2) gigabit Ethernet, (2) USB, (1) console

SRA 4600: (4) gigabit Ethernet, (2) USB, (1) console

Processors

SRA 1600: 1.66 GHz Intel Atom Processor, x86 

SRA 4600: 1.66 GHz Intel Atom Dual Core Processor, x86 



Secure Mobile Access 10.2 Administration Guide
Frequently Asked Questions 392

Memory (RAM)

SRA 1600: 1 GB

SRA 4600: 2 GB

Flash Memory

SRA 1600: 1 GB

SRA 4600: 1 GB

Power Supply

SRA 1600: Internal, 100-240Vac, 50-60Mhz

SRA 4600: Internal, 100-240Vac, 50-60Mhz

Max Power Consumption

SRA 1600: 47 W

SRA 4600: 50 W

Total Heat Dissipation

SRA 1600: 158 BTU

SRA 4600: 171 BTU

Dimensions

SRA 1600: 17.00 x 10.13 x 1.75 in (43.18 x 25.73 x 4.45 cm)

SRA 4600: 17.00 x 10.13 x 1.75 in (43.18 x 25.73 x 4.45 cm)

Weight

SRA 1600: 9.5 lbs (4.3 kg)

SRA 4600: 9.5 lbs (4.3 kg)

Major Regulatory Compliance

SRA 1600/4600: 

FCC Class A, EMI/EMC, FCC, CE, VCCI Class A, UL, cUL, TUV/GS, CB

Environment:

Temperature:

SRA 1600/4600: 32-105ª F, 0-40ª C

Relative Humidity:

SRA 1600/4600: 5-95 percent RH non-condensing

MTBF

SRA 1600: 18.3 years

SRA 4600: 17.8 years

3 What are the SMA 500v Virtual Appliance virtualized environment requirements?

Hypervisor: VMWare ESXi (version 5.0 and newer)

Appliance size (on disk): 2 GB
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Allocated memory: 2 GB

4 Do the SMA/SRA appliances have hardware-based SSL acceleration onboard?

Answer: The SRA 4600 and SRA 1600 do not have a hardware-based SSL accelerator processor, however, 
the SMA 400/200 processor includes AES NI instructions to accelerate AES encryption.

5 What operating system do the SMA/SRA appliances run?

Answer: The appliance runs SonicWall Inc.’s own hardened Linux distribution.

6 Can I put multiple SMA/SRA appliances behind a load-balancer?

Answer: Yes, this should work fine as long as the load-balancer or content-switch is capable of tracking 
sessions based upon SSL Session ID persistence, or cookie-based persistence.

7 What are the maximum number of connections allowed on the different SMA/SRA appliances?

Reference the SMA/SRA Max Count Table:

NOTE: The SMA 500v Virtual Appliance is not supported on VMware ESXi 4.0 and 4.1. If you deploy 
the Virtual Appliance on one of these ESXi versions, it should still work, but you might see some 
warning messages.

SMA/SRA Max Count Table

Type Max Supported 
on SMA 200

Max Supported 
on SMA 400

Max Supported 
on SRA 1600

Max Supported 
on SRA 4600

Max Supported 
on SMA 500v 
Virtual 
Appliance

Portal entries 32 64 32 64 64

Domain entries 32 64 32 64 64

Group entries 512 512 512 512 512

User entries 1,000 2,000 1,000 2,000 2,000

NetExtender 
global client 
routes

100 100 100 100 100

NetExtender 
group client 
routes

100 100 100 100 100

NetExtender 
user client 
routes

100 100 100 100 100

Maximum 
concurrent 
users

200 1024 200 1024 1024

Maximum 
concurrent Nx 
connections

50 500 100 500 500

Route entries 32 32 32 32 32

Host entries 32 32 32 32 32

Bookmark 
entries

500 500 500 500 500

User Policy 
entries

64 64 64 64 64
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Digital Certificates and Certificate Authorities 
FAQ

1 What do I do if when I log in to the SMA/SRA appliance my browser gives me an error, or if my Java 
components give me an error?

Answer: These errors can be caused by any combination of the following three factors:

• The certificate in the SMA/SRA appliance is not trusted by the browser

• The certificate in the SMA/SRA appliance could be expired.

• The site requested by the client Web browser does not match the site name embedded in the 
certificate.

Web browsers are programmed to issue a warning if the previous three conditions are not met precisely. 
This security mechanism is intended to ensure end-to-end security, but often confuses people into 
thinking something is broken. If you are using the default self-signed certificate, this error appears every 
time a Web browser connects to the SMA/SRA appliance. However, it is just a warning and can be safely 

Group Policy 
entries

64 64 64 64 64

Global Policy 
entries

64 64 64 64 64

Policy address 
entries

32 32 32 32 32

Network 
Objects

128 128 128 128 128

‘Address’ 
Network 
Objects

32 32 32 32 32

‘Network’ 
Network 
Objects

64 64 64 64 64

‘Service’ 
Network 
Objects

64 64 64 64 64

SMB shares 1,024 1,024 1,024 1,024 1,024

SMB nodes 1,024 1,024 1,024 1,024 1,024

SMB 
workgroups

8 8 8 8 8

Concurrent FTP 
sessions

8 8 8 8 8

Log size 250 KB 250 KB 250 KB 250 KB 250 KB

SMA/SRA Max Count Table (Continued)

Type Max Supported 
on SMA 200

Max Supported 
on SMA 400

Max Supported 
on SRA 1600

Max Supported 
on SRA 4600

Max Supported 
on SMA 500v 
Virtual 
Appliance
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ignored, as it does not affect the security negotiated during the SSL handshake. If you do not want this 
error to happen, you should purchase and install a trusted SSL certificate onto the SMA/SRA appliance.

2 I get the following message when I log in to my SMA/SRA appliance – what do I do?

Answer: It’s the same problem as noted in the previous topic, but this is the new “improved” security 
warning screen in Microsoft Internet Explorer. Whereas before IE5.x and IE6.x presented a pop-up that 
listed the reasons why the certificate is not trusted, IE simply returns a generic error page which 
recommends that the user close the page. The user is not presented with a direct ‘Yes’ option to 
proceed, and instead has to click on the embedded Continue to this Website (not recommended) link. 
For these reasons, it is strongly recommended that all SMA/SRA appliances, going forward, have a 
trusted digital certificate installed.

3 I get the following message when I log in to my SMA/SRA appliance using Firefox– what do I do?

Answer: Much like the errors shown previously for Internet Explorer, Firefox has a unique error message 
when any certificate problem is detected. The conditions for this error are the same as for the previous 
Internet Explorer errors.

To get past this screen, click the Or you can add an exception link at the bottom, then click Add 
Exception that appears. In the Add Security Exception window that opens, click Get Certificate, ensure 
that Permanently store this exception is checked, and finally, click Confirm Security Exception. See 
the following:
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To avoid this inconvenience, it is strongly recommended that all SMA/SRA appliances, going forward, 
have a trusted digital certificate installed.

4 When I launch any of the Java components it gives me an error – what should I do?

Answer: See the previous section. This occurs when the certificate is not trusted by the Web browser, or 
the site name requested by the browser does not match the name embedded in the site certificate 
presented by the SMA/SRA appliance during the SSL handshake process. This error can be safely ignored.

5 Do I have to purchase a SSL certificate?

Answer: Although the level of encryption is not compromised, users accepting an untrusted certificate 
introduces the risk of Man-in-the-Middle attacks. SonicWall Inc. recommends installing only trusted 
certificates or installing the default self-signed certificate in all the clients. 

6 What format is used for the digital certificates?

Answer: X509v3.

7 Are wild card certificates supported?

Answer: Yes.

8 What CA’s certificates can I use with the SMA/SRA appliance?

Answer: Any CA certificate should work if the certificate is in X509v3 format, including Verisign, Thawte, 
Baltimore, RSA, and so on.

9 Does the SMA/SRA appliance support chained certificates?

Answer: Yes, it does. On the System > Certificates page, complete the following:

• Under “Server Certificates,” click Import Certificate and upload the SSL server certificate and key 
together in a .zip file. The certificate should be named ‘server.crt’. The private key should be 
named ‘server.key’.
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• Under “Additional CA Certificates,” click Import Certificate and upload the intermediate CA 
certificate(s). The certificate should be PEM encoded in a text file.

After uploading any intermediate CA certificates, the system should be restarted. The web server needs 
to be restarted with the new certificate included in the CA certificate bundle.

10 Any other tips when I purchase the certificate for the SMA/SRA appliance?

Answer: We recommend you purchase a multi-year certificate to avoid the hassle of renewing each year 
(most people forget and when the certificate expires it can create an administrative nightmare). It is also 
good practice to have all users that connect to the SMA/SRA appliance run Windows Update (also known 
as Microsoft Update) and install the ‘Root Certificates’ update.

11 Can I use certificates generated from a Microsoft Certificate Server?

Answer: Yes, but to avoid a browser warning, you should install the Microsoft CA’s root certificate into all 
Web browsers that connect to the appliance.

12 Why can’t I import my new certificate and private key?

Answer: Be sure that you upload a .zip file containing the PEM formatted private key file named 
“server.key” and the PEM formatted certificate file named “server.crt.” The .zip file must have a flat file 
structure (no directories) and contain only “server.key” and “server.crt” files. The key and the certificate 
must also match, otherwise the import fails.

13 Why do I see the status “pending” after importing a new certificate and private key?

Answer: Click the ‘configure’ icon next to the new certificate and enter the password you specified when 
creating the Certificate Signing Request (CSR) to finalize the import of the certificate. After this is done, 
you can successfully activate the certificate on the SMA/SRA appliance.

14 Can I have more than one certificate active if I have multiple virtual hosts?

Answer: It is possible to select a certificate for each Portal under the Portals > Portals: Edit Portal - 
Virtual Host tab. The portal Virtual Host Settings fields allow you to specify separate IP address, and 
certificate per portal. If the administrator has configured multiple portals, it is possible to associate a 
different certificate with each portal. For example, sslvpn.test.sonicwall.com might also be reached by 
pointing the browser to virtualassist.test.sonicwall.com. Each of those portal names can have its own 
certificate. This is useful to prevent the browser from displaying a certificate mismatch warning, such as 
“This server is abc, but the certificate is xyz, are you sure you want to continue?” 

15 I imported the CSR into my CA’s online registration site but it’s asking me to tell them what kind of 
Webserver it’s for. What do I do?

Answer: Select ‘Apache’.

16 Can I store the key and certificate?

Answer: Yes, the key is exported with the CSR during the CSR generation process. It’s strongly 
recommended that you can keep this in a safe place with the certificate you receive from the CA. This 
way, if the SMA/SRA appliance ever needs replacement or suffers a failure, you can reload the key and 
cert. You can also always export your settings from the System > Settings page.

17 Does the SMA/SRA appliance support client-side digital certificates?

Answer: Yes, client certificates are enforced per Domain or per User on the Users > Local Users: Edit User 
– Login Policies tab. 

• Per Domain/Per User client certificate enforcement settings:

• Option to Verify the user name matches the Common Name (CN) of the client certificate

• Option to Verify partial DN in the client certificate subject (optional). The following 
variables are supported:

User name: %USERNAME%
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Domain name: %USERDOMAIN%

Active Directory user name: %ADUSERNAME%

Wildcard: %WILDCARD%

• Support for Microsoft CA Subject Names where CN=<Full user name>, for example CN=John Doe. 
Client certificate authentication attempts for users in Active Directory domains should have the 
CN compared against the user’s full name in AD.

• Detailed client certificate authentication failure messages and log messages are available in the 
Log > View page.

• Certificate Revocation List (CRL) Support. Each CA Certificate now supports an optional CRL 
through file import or periodic import through URL.

The client certificate must be loaded into the client’s browser. Also, remember that any 
certificates in the trust chain of the client certificates must be installed onto the SMA/SRA 
appliance.

18 When client authentication is required my clients cannot connect even though a CA certificate has been 
loaded. Why?

Answer: After a CA certificate has been loaded, the SMA/SRA appliance must be rebooted before it is 
used for client authentication. Failures to validate the client certificate also causes failures to logon. 
Among the most common are certificate is not yet valid, certificate has expired, login name does not 
match common name of the certificate, certificate not sent.

NetExtender FAQ
1 Does NetExtender work on other operating systems than Windows?

Answer: Yes. See the following supported platforms:

Mac Requirements:

• Mac OS X 10.6.8+

• Apple Java 1.6.0_10+ (can be installed/upgraded by going to Apple Menu > Software Update; 
should be pre-installed on OS X 10.6.8+)

Linux Requirements:

• i386-compatible distribution of Linux

• Sun Java 1.6.0_10+

• Fedora 14+

• Suse: Tested successfully on 10.3

• Ubuntu 11.04+

Separate NetExtender installation packages are also downloadable from MySonicWall.com for each 
release.

2 Which versions of Windows does NetExtender support?

Answer: NetExtender supports Windows 10.

3 Can I block communication between NetExtender clients?

Answer: Yes, this can be achieved with the User/Group/Global Policies by adding a ‘deny’ policy for the 
NetExtender IP range.

4 Can NetExtender run as a Windows service?
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Answer: NetExtender can be installed and configured to run as a Windows service that allows systems to 
log in to domains across the NetExtender client.

5 What range do I use for NetExtender IP client address range?

Answer: This range is the pool that incoming NetExtender clients are assigned – NetExtender clients 
actually appear as though they are on the internal network – much like the Virtual Adapter capability 
found in SonicWall Inc.’s Global VPN Client. You should dedicate one IP address for each active 
NetExtender session, so if you expect 20 simultaneous NetExtender sessions to be the maximum, create 
a range of 20 open IP addresses. Make sure that these IP addresses are open and are not used by other 
network appliances or contained within the scope of other DHCP servers. For example, if your SMA/SRA 
appliance is in one-port mode on the X0 interface using the default IP address of 192.168.200.1, create a 
pool of addresses from 192.168.200.151 to 192.168.200.171. You can also assign NetExtender IPs 
dynamically using the DHCP option.

6 What do I enter for NetExtender client routes?

Answer: These are the networks that are sent to remote NetExtender clients and should contain all 
networks that you wish to give your NetExtender clients access to. For example, if your SMA/SRA 
appliance was in one-port mode, attached to a SonicWall Inc. NSA 3500 appliance on a DMZ using 
192.168.200.0/24 as the subnet for that DMZ, and the SonicWall Inc. NSA 3500 had two LAN subnets of 
192.168.168.0/24 and 192.168.170.0/24, you would enter those two LAN subnets as the client routes to 
provide NetExtender clients access to network resources on both of those LAN subnets.

7 What does the ‘Tunnel All Mode’ option do?

Answer: Activating this feature causes the SMA/SRA appliance to push down two default routes that tell 
the active NetExtender client to send all traffic through the SMA/SRA appliance. This feature is useful in 
environments where the SMA/SRA appliance is deployed in tandem with a SonicWall Inc. security 
appliance running all UTM services, as it allows you to scan all incoming and outgoing NetExtender user 
traffic for viruses, spyware, intrusion attempts, and content filtering.

8 Is there any way to see what routes the SMA/SRA appliance is sending NetExtender?

Answer: Yes, right-click on the NetExtender icon in the taskbar and select route information. You can 
also get status and connection information from this same menu.

9 After I install the NetExtender is it uninstalled when I leave my session?

Answer: By default, when NetExtender is installed for the first time it stays resident on the system, 
although this can be controlled by selecting the Uninstall On Browser Exit > Yes option from the 
NetExtender icon in the taskbar while it is running. If this option is checked, NetExtender removes itself 
when it is closed. It can also be uninstalled from the “Add/Remove Program Files” in Control Panel. 
NetExtender remains on the system by default to speed up subsequent login times.

10 How do I get new versions of NetExtender?

Answer: New versions of NetExtender are included in each SonicWall Inc. Secure Mobile Access 
firmware release and have version control information contained within. If the SMA/SRA appliance has 
been upgraded with new software, and a connection is made from a system using a previous, older 
version of NetExtender, it is automatically upgraded to the new version.

There is one exception to the automatic upgrading feature: it is not supported for the MSI version of 
NetExtender. If NetExtender was installed with the MSI package, it must be upgraded with a new MSI 
package. The MSI package is designed for the administrator to deploy NetExtender through Active 
Directory, allowing full version control through Active Directory.

11 How is NetExtender different from a traditional IPSec VPN client, such as SonicWall Inc.’s Global VPN 
Client (GVC)?

Answer: NetExtender is designed as an extremely lightweight client that is installed through a Web 
browser connection, and utilizes the security transforms of the browser to create a secure, encrypted 
tunnel between the client and the SMA/SRA appliance. 
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12 Is NetExtender encrypted?

Answer: Yes, it uses whatever cipher the NetExtender client and SMA/SRA appliance negotiate during 
the SSL connection.

13 Is there a way to secure clear text traffic between the SMA/SRA appliance and the server?

Answer: Yes, you can configure the Microsoft Terminal Server to use encrypted RDP-based sessions, and 
use HTTPS reverse proxy.

14 What is the PPP adapter that is installed when I use the NetExtender?

Answer: This is the transport method NetExtender uses. It also uses compression (MPPC). You can elect 
to have it removed during disconnection by selecting this from the NetExtender menu.

15 What are the advantages of using the NetExtender instead of a Proxy Application?

Answer: NetExtender allows full connectivity over an encrypted, compressed PPP connection allowing 
the user to directly to connect to internal network resources. For example, a remote user could launch 
NetExtender to directly connect to file shares on a corporate network.

16 Does performance change when using NetExtender instead of proxy?

Answer: Yes. NetExtender connections put minimal load on the SMA/SRA appliances, whereas many 
proxy-based connections might put substantial strain on the SMA/SRA appliance. Note that HTTP proxy 
connections use compression to reduce the load and increase performance. Content received by Secure 
Mobile Access from the local Web server is compressed using gzip before sending it over the Internet to 
the remote client. Compressing content sent from the SMA/SRA saves bandwidth and results in higher 
throughput. Furthermore, only compressed content is cached, saving nearly 40-50 percent of the 
required memory. Note that gzip compression is not available on the local (clear text side) of the 
SMA/SRA appliance, or for HTTPS requests from the remote client.

17 The SMA/SRA appliance is application dependent; how can I address non-standard applications?

Answer: You can use NetExtender to provide access for any application that cannot be accessed using 
internal proxy mechanisms - HTTP, HTTPS, FTP, RDP5, Telnet, and SSHv2. Application Offloading can also 
be used for Web applications. In this way, the SMA/SRA appliance functions similar to an SSL off loader 
and proxies Web applications pages without the need for URL rewriting. 

18 Why is it required that an ActiveX component be installed?

Answer: NetExtender is installed through an ActiveX-based plug-in from Internet Explorer. Users using 
Firefox browsers can install NetExtender through an XPI installer. NetExtender can also be installed 
through an MSI installer. Download the NetExtender MSI installer from MySonicWall.com.

19 Does NetExtender support desktop security enforcement, such as AV signature file checking, or Windows 
registry checking?

Answer: Not at present, although these sorts of features are planned for future releases of NetExtender.

20 Does NetExtender work with the 64-bit version of Microsoft Windows?

Answer: Yes, NetExtender supports 64-bit Windows 7 and Vista.

21 Does NetExtender work 32-bit and 64-bit version of Microsoft Windows 7?

Answer: Yes, NetExtender supports 32-bit and 64-bit Windows 7.

22 Does NetExtender support client-side certificates?

Answer: Yes, Windows NetExtender client supports client certificate authentication from the 
stand-alone client. Users can also authenticate to the Secure Mobile Access portal and then launch 
NetExtender. 

23 My firewall is dropping NetExtender connections from my SonicWall SMA/SRA as being spoofs. Why?
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Answer: If the NetExtender addresses are on a different subnet than the X0 interface, a rule needs to be 
created for the firewall to know that these addresses are coming from the SMA/SRA appliance. 

General FAQ
1 Is the SMA/SRA appliance a true reverse proxy?

Answer: Yes, the HTTP, HTTPS, CIFS, FTP are web-based proxies, where the native Web browser is the 
client. VNC, RDP, Citrix, SSHv2, SSHv2, and Telnet use browser-delivered HTML5 clients. NetExtender on 
Windows uses a browser-delivered client. 

2 What browser and version do I need to successfully connect to the SMA/SRA appliance?

Answer: Currently supported browsers and versions are listed in the Browser Requirements section of 
this document.

3 What needs to be activated on the browser for me to successfully connect to the SMA/SRA appliance?

Answer:

• TLS 

• Enable cookies

• Enable pop-ups for the site

• Enable Java

• Enable Javascript

• Enable ActiveX

4 What version of Java do I need?

Answer: You should install SUN’s JRE 1.6.0_10 or higher (available at http://www.java.com) to use some 
of the features on the SMA/SRA appliance. On Google Chrome, you need Java 1.6.0 update 10 or higher.

5 What operating systems are supported?

Answer:

• Microsoft Vista

• Microsoft Windows 7

• Apple OSX 10.6.8 and newer

• Linux kernel 2.6.x and newer

6 Why does the ‘File Shares’ component not recognize my server names?

Answer: If you cannot reach your server by its NetBIOS name, there might be a problem with name 
resolution. Check your DNS and WINS settings on the SMA/SRA appliance. You might also try manually 
specifying the NetBIOS name to IP mapping in the Network > Host Resolution section, or you could 
manually specify the IP address in the UNC path, for example \\192.168.100.100\sharefolder.

Also, if you get an authentication loop or an error, is this File Share a DFS server on a Windows domain 
root? When creating a File Share, do not configure a Distributed File System (DFS) server on a Windows 
Domain Root system. Because the Domain Root allows access only to Windows computers in the 
domain, doing so disables access to the DFS file shares from other domains. The SMA/SRA appliance is 
not a domain member and is not able to connect to the DFS shares. DFS file shares on a stand-alone root 
are not affected by this Microsoft restriction.

7 Does the SMA/SRA appliance have an SPI firewall?

http://www.java.com
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Answer: No. It must be combined with a SonicWall Inc. security appliance or other third-party 
firewall/VPN device.

8 Can I access the SMA/SRA appliance using HTTP?

Answer: No, it requires HTTPS. HTTP connections are immediately redirected to HTTPS. You might wish 
to open both 80 and 443, as many people forget to type https: and instead type 
http://. If you block 80, it is not redirected.

9 What is the most common deployment of the SMA/SRA appliances?

Answer: One-port mode, where only the X0 interface is utilized, and the appliance is placed in a 
separated, protected “DMZ” network/interface of a SonicWall Inc. security appliance, such as a 
SonicWall Inc. TZ or NSA appliance.

10 Why is it recommended to install the SMA/SRA appliance in one-port mode with a SonicWall Inc. security 
appliance?

Answer: This method of deployment offers additional layers of security control plus the ability to use 
SonicWall Inc.’s Unified Threat Management (UTM) services, including Gateway Anti-Virus, 
Anti-Spyware, Content Filtering and Intrusion Prevention, to scan all incoming and outgoing NetExtender 
traffic.

11 Is there an installation scenario where you would use more than one interface or install the appliance in 
two-port mode?

Answer: Yes, when it would be necessary to bypass a firewall/VPN device that might not have an 
available third interface, or a device where integrating the SMA/SRA appliance might be difficult or 
impossible.

12 Can I cascade multiple SMA/SRA appliances to support more concurrent connections?

Answer: No, this is not supported.

13 Why can’t I log in to the Secure Mobile Access management interface of the SMA/SRA appliance?

Answer: The default IP address of the appliance is 192.168.200.1 on the X0 interface. If you cannot reach 
the appliance, try cross-connecting a system to the X0 port, assigning it a temporary IP address of 
192.168.200.100, and attempt to log in to the SMA/SRA appliance at https://192.168.200.1. Then verify 
that you have correctly configured the DNS and default route settings on the Network pages.

14 Can I create site-to-site VPN tunnels with the SMA/SRA appliance?

Answer: No, it is only a client-access appliance. If you require this, you need a SonicWall Inc. TZ, NSA. or 
SuperMassive series security appliance.

15 Can the SonicWall Inc. Global VPN Client (or any other third-party VPN client) connect to the SMA/SRA 
appliance?

Answer: No, only NetExtender and proxy sessions are supported.

16 Can I connect to the SMA/SRA appliance over a modem connection?

Answer: Yes, although performance is slow, even over a 56K connection it is usable.

17 What SSL ciphers are supported by the SMA/SRA appliance?

Answer: Starting with 7.5 firmware or newer, SonicWall Inc. only uses HIGH security ciphers with TLSv1, 
TLSv1.1, and TLSv1.2. In 8.0 firmware or newer, SSL Perfect Forward Secrecy (PFS) is supported. 

18 Is AES supported in the SMA/SRA appliance?

Answer: Yes, if your browser supports it.

19 Can I expect similar performance (speed, latency, and throughput) as my IPSec VPN?

Answer: Yes, actually you might see better performance as NetExtender uses multiplexed PPP 
connections and runs compression over the connections to improve performance.
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20 Is Two-factor authentication (RSA SecurID, etc) supported?

Answer: Yes, this is supported.

21 Does the SMA/SRA appliance support VoIP?

Answer: Yes, over NetExtender connections.

22 Is Syslog supported?

Answer: Yes.

23 Does NetExtender support multicast?

Answer: Not at this time. Look for this in a future firmware release.

24 Are SNMP and Syslog supported?

Answer: Syslog forwarding to up to two external servers is supported in the current software release. 
SNMP is supported beginning in the 5.0 release. MIBs can be downloaded from MySonicWall.

25 Does the SMA/SRA appliance have a Command Line Interface (CLI)?

Answer: Yes, the SMA/SRA appliances have a simple CLI when connected to the console port. The SMA 
500v Virtual Appliance is also configurable with the CLI. The Secure Mobile Access CLI allows 
configuration of only the X0 interface on the SMA/SRA appliances or SMA 500v Virtual Appliance. 

26 Can I Telnet or SSH into the SMA/SRA appliance?

Answer: No, neither Telnet or SSH are supported in the current release of the SMA/SRA appliance 
software as a means of management (this is not to be confused with the Telnet and SSH proxies that the 
appliance does support).

27 What does the Web cache cleaner do?

Answer: The Web cache cleaner is an ActiveX-based applet that removes all temporary files generated 
during the session, removes any history bookmarks, and removes all cookies generated during the 
session. 

28 Why didn’t the Web cache cleaner work when I exited the Web browser?

Answer: In order for the Web cache cleaner to run, you must click Logout. If you close the Web browser 
using any other means, the Web cache cleaner cannot run.

29 What does the ‘encrypt settings file’ check box do?

Answer: This setting encrypts the settings file so that if it is exported it cannot be read by unauthorized 
sources. Although it is encrypted, it can be loaded back onto the SMA/SRA appliance (or a replacement 
appliance) and decrypted. If this box is not selected, the exported settings file is clear-text and can be 
read by anyone.

30 What does the ‘store settings’ button do?

Answer: By default, the settings are automatically stored on a SMA/SRA appliance any time a change to 
programming is made, but this can be shut off if desired. If this is disabled, all unsaved changes to the 
appliance are lost. This feature is most useful when you are unsure of making a change that could result 
in the box locking up or dropping off the network. If the setting is not immediately saved, you can 
power-cycle the box and it returns to the previous state before the change was made.

31 What does the ‘create backup’ button do?

Answer: This feature allows you to create a backup snapshot of the firmware and settings into a special 
file that can be reverted to from the management interface or from SafeMode. SonicWall Inc. strongly 
recommends creating system backup right before loading new software, or making significant changes to 
the programming of the appliance. 

32 What is ‘SafeMode’?
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Answer: SafeMode is a feature of the SMA/SRA appliance that allows administrators to switch between 
software image builds and revert to older versions in case a new software image turns out to cause 
issues. In cases of software image corruption, the appliance boots into a special interface mode that 
allows the administrator to choose which version to boot, or load a new version of the software image.

33 How do I access the SafeMode menu?

Answer: In emergency situations, you can access the SafeMode menu by holding in Reset on the 
SMA/SRA appliance (the small pinhole button located on the front of the SMA/SRA appliances) for 12-14 
seconds until the ‘Test’ LED begins quickly flashing yellow. After the SMA/SRA appliance has booted into 
the SafeMode menu, assign a workstation a temporary IP address in the 192.168.200.x subnet, such as 
192.168.200.100, and attach it to the X0 interface on the SMA/SRA appliance. Then, using a modern Web 
browser (Microsoft IE6.x+, Mozilla 1.4+), access the special SafeMode GUI using the appliance’s default 
IP address of 192.168.200.1. You are able to boot the appliance using a previously saved backup 
snapshot, or you can upload a new version of software with Upload New Software image.

34 Can I change the colors of the portal pages?

Answer: This is not supported in the current releases, but is planned for a future software release.

35 What authentication methods are supported?

Answer: Local database, RADIUS, Active Directory, and LDAP.

36 I configured my SMA/SRA appliance to use Active Directory as the authentication method, but it fails 
with a very strange error message. Why?

Answer: The appliances must be precisely time-synchronized with each other or the authentication 
process fails. Ensure that the SMA/SRA appliance and the Active Directory server are both using NTP to 
keep their internal clocks synchronized.

37 I created a FTP bookmark, but when I access it, the filenames are garbled – why?

Answer: If you are using a Windows-based FTP server, you should change the directory listing style to 
‘UNIX’ instead of ‘MS-DOS’. 

38 Where can I get a VNC client?

Answer: SonicWall Inc. has done extensive testing with RealVNC. It can be downloaded at: 

http://www.realvnc.com/download.html

39 Are the SRA 4600/1600 appliances fully supported by GMS or Analyzer?

Answer: Yes. 

40 Does the SMA/SRA appliance support printer mapping?

Answer: Yes, this is supported with the ActiveX-based RDP client only. The Microsoft Terminal Server 
RDP connector must be enabled first for this to work. You might need to install the correct printer driver 
software on the Terminal Server you are accessing.

41 Can I integrate the SMA/SRA appliance with wireless?

Answer: Yes, refer to the SonicWall Inc. Secure Wireless Networks Integrated Solutions Guide, available 
through Elsevier, http://www.elsevierdirect.com/.

42 Can I manage the appliance on any interface IP address of the SMA/SRA appliance?

Answer: Yes, you can manage on any of the interface IP addresses.

43 Can I allow only certain Active Directory users access to log in to the SMA/SRA appliance?

Answer: Yes. On the Users > Local Groups page, edit a group belonging to the Active Directory domain 
used for authentication and add one or more AD Groups under the AD Groups tab.

44 Does the HTTP(S) proxy support the full version of Outlook Web Access (OWA Premium)?

http://www.realvnc.com/download.html
http://www.elsevierdirect.com/index.jsp
http://www.elsevierdirect.com/index.jsp
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Answer: Yes.

45 Why are my RDP sessions dropping frequently?

Answer: Try adjusting the session and connection timeouts on both the SMA/SRA appliance and any 
appliance that sits between the endpoint client and the destination server. If the SMA/SRA appliance is 
behind a firewall, adjust the TCP timeout upwards and enable fragmentation.

46 Can I create my own services for bookmarks rather than the services provided in the bookmarks section?

Answer: This is not supported in the current release of software but could be supported in a future 
software release.

47 Why can’t I see all the servers on my network with the File Shares component?

Answer: The CIFS browsing protocol is limited by the server's buffer size for browse lists. These browse 
lists contain the names of the hosts in a workgroup or the shares exported by a host. The buffer size 
depends on the server software. Windows personal firewall has been known to cause some issues with 
file sharing even when it is stated to allow such access. If possible, try disabling such software on either 
side and then test again.

48 What port is the SMA/SRA appliance using for the Radius traffic?

Answer: It uses port 1812.

49 Do the SMA/SRA appliances support the ability for the same user account to login simultaneously?

Answer: Yes. On the portal layout, you can enable or disable ‘Enforce login uniqueness’ option. If this 
box is unchecked, users can log in simultaneously with the same username and password.

50 Does the SMA/SRA appliance support NT LAN Manager (NTLM) Authentication?

Answer: No.

51 I cannot connect to a web server when Windows Authentication is enabled. I get the following error 
message when I try that: ‘It appears that the target web server is using an unsupported HTTP(S) 
authentication scheme through the SMA/SRA that currently supports only basic and digest 
authentication schemes. Contact the administrator for further assistance.’ - why?

Answer: In SRA 3.5 and earlier releases, the HTTP proxy does not support Windows Authentication 
(formerly called NTLM). Only basic authentication is supported.

52 Why do Java Services, such as Telnet or SSH, not work through a proxy server?

Answer: When the Java Service is started it does not use the proxy server. Transactions are done directly 
to the SMA/SRA appliance.

53 There is no port option for the service bookmarks – what if these are on a different port than the 
default?

Answer: You can specify in the IP address box an ‘IPaddress:portid’ pair for HTTP, HTTPS, Telnet, Java, 
and VNC.

54 What if I want a bookmark to point to a directory on a Web server?

Answer: Add the path in the IP address box: IP/mydirectory/.

55 When I access Microsoft Telnet Server using a telnet bookmark it does not allow me to enter a user name 
-- why?

Answer: This is not currently supported on the appliance.

56  What versions of Citrix are supported?

Answer: Citrix Portal Bookmarks have been tested and verified to support the following Citrix 
Application Virtualization platforms through the Citrix Web Interface:

Servers: 
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• XenApp 7.6 (HTML5 and ActiveX only)

• XenApp 6.5

• XenApp 6.0

• XenApp 5.0

Clients: 

• Receiver for Windows 4.2, 4.1, or 4.0

• Receiver for Java 10.1.006

• XenApp Web Plugiin version 14.2, 14.1, 14.0

For browsers requiring Java to run Citrix, you must have Sun Java 1.6.0_10 or higher.

57 What applications are supported using Application Offloading?

Answer: Application Offloading should support any application using HTTP/HTTPS. SMA/SRA has limited 
support for applications using Web services and no support for non-HTTP protocols wrapped within 
HTTP.

One key aspect to consider when using Application Offloading is that the application should not contain 
hard-coded self-referencing URLs. If these are present, the Application Offloading proxy rewrites the 
URLs. Because Web site development does not usually conform to HTML standards, the proxy can only 
do a best-effort translation when rewriting these URLs. Specifying hard-coded, self-referencing URLs is 
not recommended when developing a Web site because content developers must modify the Web pages 
whenever the hosting server is moved to a different IP or hostname.

For example, if the backend application has a hard-coded IP and scheme within URLs as follows, then 
Application Off-loading needs to rewrite this URL. 

<a href="http://1.1.1.1/doAction.cgi?test=foo">

This can be done by enabling the Enable URL Rewriting for self-referenced URLs setting for the 
Application Off-loading Portal, but all the URLs might not be rewritten, depending on how the Web 
application has been developed. (This limitation is usually the same for other WAF/SMA vendors 
employing reverse proxy mode.)

58 Is SSHv2 supported?

Answer: Yes, this is supported.

59 Should I create a Global Deny ALL policy?

Answer: Yes, SonicWall Inc. recommends that administrators set up a Global Deny ALL policy that allows 
access to only trusted hosts. This prevents outbound requests to malicious hosts from Secure Mobile 
Access. For more information on how to set up a Global Deny ALL policy, see Adding a Policy on page 186.

http://1.1.1.1/doAction.cgi?test=foo
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Using the Command Line Interface

The Command Line Interface (CLI) is a text-only mechanism for interacting with a computer operating system or 
software by typing commands to complete specific tasks. It is a critical part of the deployment of the SMA 500v 
Virtual Appliance, where basic networking needs to be configured from the console.

While the SMA physical appliance products have a default IP address and network configuration that requires a 
client’s network settings to be reconfigured to connect, the network settings in an existing VMware virtual 
environment might conflict with the SMA appliance defaults. The CLI utility remedies this by allowing basic 
configuration of the network settings when deploying the Virtual Appliance.

For the SMA physical appliances, console access is achieved by connecting a computer to the serial port. Use the 
following settings:

• Baud: 115200

• Data Bits: 8

• Parity: None

• Stop Bits: 1

• No flow control

For the Virtual Appliance, the following login prompt is displayed after the firmware has fully booted:

In the following examples, user input is highlighted in bold to indicate text entered by the user. 

To access the CLI, login as admin. The password is the same as the password for the admin account that is 
configured on the appliance. The default is password.

sslvpn login: admin
Password: password

If the incorrect password is entered, the login prompt is displayed again. If the correct password is entered, the 
CLI is launched.

NOTE: The SonicWall Inc. Secure Mobile Access CLI allows configuration of only the X0 interface on SMA 
200/400, SMA 210/410, SMA 500v for ESXi, SMA 500v for Hyper-V, SMA 500v for AWS, and SMA 500v for 
Azure. 

NOTE: To use the CLI on a serial connection or in an SSH management session, you need to use a terminal 
emulation application (such as Tera Term) or an SSH Client application (such as PuTTY). You can find 
suitable, free terminal emulators on the Internet.
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For hardware and Virtual Appliances, basic system information and network settings are displayed along with 
the main menu, as in the following example:

You can press Ctrl-C at any time to log out and exit the CLI, returning to the login prompt. 

The main menu has four selections:

1 Setup Wizard – This option launches a simple wizard to change the basic network settings, starting with 
the X0 IP Address, X0 subnet mask, default gateway, primary and secondary DNS, and the hostname. The 
following CLI output illustrates an example where each field is changed:

X0 IP Address (default 192.168.200.1): 192.168.200.201
X0 Subnet Mask (default 255.255.255.0): 255.255.0.0
Default Gateway (default 192.168.200.2): 192.168.200.1
Primary DNS: 10.50.128.52
Secondary DNS (optional, enter "none" to disable): 4.2.2.2
Hostname (default sslvpn): sslvpn

New Network Settings:
X0 IP Address:       192.168.200.201
X0 Subnet mask:      255.255.0.0
Default Gateway:     192.168.200.1
Primary DNS:         10.50.128.52
Secondary DNS:       4.2.2.2
Hostname:            sslvpn

Would you like to save these changes (y/n)?

If a field is not filled out, the prior value is retained, allowing you to change only a single field. After each 
field has been prompted, the new network settings are shown and a confirmation message is given for 
the user to review and verify the changes before applying them. The following shows the result when 
you save the changes:

Would you like to save these changes (y/n)? y
Saving changes...please wait....
Changes saved!
Press <Enter> to continue...
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After saving the changes, press Enter to return to the original display of the System Information and 
Network Settings and verify that the changes have taken effect:

If no changes are saved, the following message is displayed and pressing Enter returns to the initial 
display of the System Information and Network Settings:

No changes have been made.
Press <Enter> to continue...

2 Reboot – Selecting this option displays a confirmation prompt and then reboots:

Reboot
Are you sure you want to reboot (y/n)? 

3 Restart SSL-VPN Services – This option displays a confirmation prompt and then restarts the Web server 
and the related Secure Mobile Access daemon services. This command is equivalent to issuing the 
EasyAccessCtrl restart command.

Restart SSL-VPN Services
Are you sure you want to restart the SSL-VPN services (y/n)? y

Restarting SSL-VPN services...please wait.
Stopping SMM: [  OK  ]
Stopping Firebase :[  OK  ]
Stopping FTP Session:[  OK  ]
Stopping HTTPD: [  OK  ]
Cleaning Apache State: [  OK  ]
Stopping Graphd :[  OK  ]

Cleaning Temporary files........
Starting SMM: [  OK  ]
Starting firebase: [  OK  ]
Starting httpd: [  OK  ]
Starting ftpsession: [  OK  ]
Starting graphd: [  OK  ]

Restart completed...returning to main menu...

4 Logout – The logout option ends the CLI session and returns to the login prompt.

NOTE: When applying settings that change the IP address, there might be a delay of up to 
five seconds as the interface settings are updated.
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SafeMode
SafeMode is a limited Web management interface that provides a way to upload firmware from your computer 
and reboot the appliance.

The SafeMode feature allows you to recover quickly from uncertain configuration states with a simplified 
management interface that includes the same settings available on the System > Settings page.

You can get to the SafeMode CLI, by pressing the SafeMode switch to reboot to SafeMode, and then logging in 
as admin. The password is the same as the password for the admin account that is configured on the appliance. 
The default is password.

sma500 login: admin
Password: password
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When an incorrect password is entered, the login prompt is displayed again. When the correct password is 
entered, the SafeMode CLI is launched.

The numbered options explain themselves. Select the number of the option you would like to perform. For the 
first option, to Manage Firmware Images, press 1. The following screen appears with five additional options.
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The five additional options explain themselves. Select the number of the option you would like to perform. For 
the first option, to Boot Current Firmware, press 1. The following screen appears with three additional options.

The three additional options explain themselves. Select the number of the option you would like to perform.

For more instructions on how to restart your SMA in SafeMode, refer to the Getting Started Guide for your 
particular appliance.10.2
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Using SMS Email Formats

This section provides a list of SMS (Short Message Service) formats for worldwide cellular carriers. Find the 
correct format for your carrier from the following list, using your own phone number before the @ sign.

SMS formats based on carrier

Carrier SMS Format

3River Wireless 4085551212@sms.3rivers.net 

AirTel 4085551212@airtelmail.com

AT&T Wireless 4085551212@mobile.att.net

Andhra Pradesh Airtel 4085551212@airtelap.com

Andhra Pradesh Idea Cellular 4085551212@ideacellular.net

Alltel PC 4085551212@message.alltel.com

Alltel 4085551212@alltelmessage.com

Arch Wireless 4085551212@archwireless.net

BeeLine GSM 4085551212@sms.beemail.ru 

BeeLine (Moscow) 4085551212@sms.gate.ru

Bell Canada 4085551212@txt.bellmobility.ca

Bell Canada 4085551212@bellmobility.ca 

Bell Atlantic 4085551212@message.bam.com 

Bell South 4085551212@sms.bellsouth.com 

Bell South 4085551212@wireless.bellsouth.com 

Bell South 4085551212@blsdcs.net

Bite GSM (Lithuania) 4085551212@sms.bite.lt 

Bluegrass Cellular 4085551212@sms.bluecell.com 

BPL mobile 4085551212@bplmobile.com

Celcom (Malaysia) 4085551212@sms.celcom.com.my

Cellular One 4085551212@mobile.celloneusa.com 

Cellular One East Cost 4085551212@phone.cellone.net 

Cellular One South West 4085551212@swmsg.com 

Cellular One 4085551212@mobile.celloneusa.com

Cellular One 4085551212@cellularone.txtmsg.com 

Cellular One 4085551212@cellularone.textmsg.com 

Cellular South 4085551212@csouth1.com

CenturyTel 4085551212@messaging.centurytel.net 

Cingular 4085551212@mobile.mycingular.net 

Cingular Wireless 4085551212@mycingular.textmsg.com
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Comcast 4085551212@comcastpcs.textmsg.com 

CZECH EuroTel 4085551212@sms.eurotel.cz 

CZECH Paegas 4085551212@sms.paegas.cz 

Chennai Skycell / Airtel 4085551212@airtelchennai.com

Chennai RPG Cellular 4085551212@rpgmail.net

Comviq GSM Sweden 4085551212@sms.comviq.se

Corr Wireless Communications 4085551212@corrwireless.net

D1 De TeMobil 4085551212@t-d1-sms.de

D2 Mannesmann Mobilefunk 4085551212@d2-message.de

DT T-Mobile 4085551212@t-mobile-sms.de 

Delhi Airtel 4085551212@airtelmail.com

Delhi Hutch 4085551212@delhi.hutch.co.in

Dobson-Cellular One 4085551212@mobile.cellularone.com 

Dobson Cellular Systems 4085551212@mobile.dobson.net 

Edge Wireless 4085551212@sms.edgewireless.com 

E-Plus (Germany) 4085551212 @eplus.de

EMT 4085551212@sms.emt.ee

Eurotel (Czech Republic) 4085551212@sms.eurotel.cz 

Europolitan Sweden 4085551212@europolitan.se 

Escotel 4085551212@escotelmobile.com

Estonia EMT 4085551212@sms-m.emt.ee 

Estonia RLE 4085551212@rle.ee

Estonia Q GSM 4085551212@qgsm.ee

Estonia Mobil Telephone 4085551212@sms.emt.ee 

Fido 4085551212@fido.ca 

Georgea geocell 4085551212@sms.ge 

Goa BPLMobil 4085551212@bplmobile.com 

Golden Telecom 4085551212@sms.goldentele.com

Golden Telecom (Kiev, Ukraine only) 4085551212@sms.gt.kiev.ua

GTE 4085551212@messagealert.com

GTE 4085551212@airmessage.net 

Gujarat Idea 4085551212@ideacellular.net 

Gujarat Airtel 4085551212@airtelmail.com 

Gujarat Celforce / Fascel 4085551212@celforce.com 

Goa Airtel 4085551212@airtelmail.com 

Goa BPLMobil 4085551212@bplmobile.com

Goa Idea Cellular 4085551212@ideacellular.net 

Haryana Airtel 4085551212@airtelmail.com

Haryana Escotel 4085551212@escotelmobile.com

Himachal Pradesh Airtel 4085551212@airtelmail.com 

SMS formats based on carrier (Continued)

Carrier SMS Format
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Houston Cellular 4085551212@text.houstoncellular.net 

Hungary Pannon GSM 4085551212@sms.pgsm.hu

Idea Cellular 4085551212@ideacellular.net 

Inland Cellular Telephone 4085551212@inlandlink.com

ISRAel Orange IL 4085551212- @shiny.co.il

Karnataka Airtel 4085551212@airtelkk.com 

Kerala Airtel 4085551212@airtelmail.com

Kerala Escotel 4085551212@escotelmobile.com

Kerala BPL Mobile 4085551212@bplmobile.com 

Kyivstar (Kiev Ukraine only) 4085551212@sms.kyivstar.net

Kyivstar 4085551212@smsmail.lmt.lv 

Kolkata Airtel 4085551212@airtelkol.com

Latvia Baltcom GSM 4085551212@sms.baltcom.lv

Latvia TELE2 4085551212@sms.tele2.lv

LMT 4085551212@smsmail.lmt.lv

Madhya Pradesh Airtel 4085551212@airtelmail.com

Maharashtra Idea Cellular 4085551212@ideacellular.net 

MCI Phone 408555121 @mci.com

Meteor 4085551212@mymeteor.ie 

Metro PCS 4085551212@mymetropcs.com 

Metro PCS 4085551212@metorpcs.sms.us 

MiWorld 4085551212@m1.com.sg 

Mobileone 4085551212@m1.com.sg 

Mobilecomm 4085551212@mobilecomm.net 

Mobtel 4085551212@mobtel.co.yu 

Mobitel (Tanazania) 4085551212@sms.co.tz 

Mobistar Belgium 4085551212@mobistar.be 

Mobility Bermuda 4085551212@ml.bm 

Movistar (Spain) 4085551212@correo.movistar.net 

Maharashtra Airtel 4085551212@airtelmail.com

Maharashtra BPL Mobile 4085551212@bplmobile.com

Manitoba Telecom Systems 4085551212@text.mtsmobility.

Mumbai Orange 4085551212@orangemail.co.in

MTS (Russia) 4085551212@sms.mts.ru

MTC 4085551212@sms.mts.ru

Mumbai BPL Mobile 4085551212@bplmobile.com

MTN (South Africa only) 4085551212@sms.co.za

MiWorld (Singapore) 4085551212@m1.com.sg

NBTel 4085551212@wirefree.informe.ca 

Netcom GSM (Norway) 4085551212@sms.netcom.no

SMS formats based on carrier (Continued)

Carrier SMS Format
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Nextel 4085551212@messaging.nextel.com 

Nextel 4085551212@nextel.com.br

NPI Wireless 4085551212@npiwireless.com 

Ntelos 4085551212number@pcs.ntelos.com 

One Connect Austria 4085551212@onemail.at 

OnlineBeep 4085551212@onlinebeep.net 

Omnipoint 4085551212@omnipointpcs.com

Optimus (Portugal) 4085551212@sms.optimus.pt

Orange - NL / Dutchtone 4085551212@sms.orange.nl 

Orange 4085551212@orange.net 

Oskar 4085551212@mujoskar.cz

Pacific Bell 4085551212@pacbellpcs.net

PCS One 4085551212@pcsone.net

Pioneer / Enid Cellular 4085551212@msg.pioneerenidcellular.com 

PlusGSM (Poland only) 4085551212@text.plusgsm.pl

P&T Luxembourg 4085551212@sms.luxgsm.lu

Poland PLUS GSM 4085551212@text.plusgsm.pl

Primco 4085551212@primeco@textmsg.com

Primtel 4085551212@sms.primtel.ru 

Public Service Cellular 4085551212@sms.pscel.com 

Punjab Airtel 4085551212@airtelmail.com 

Qwest 4085551212@qwestmp.com 

Riga LMT 4085551212@smsmail.lmt.lv

Rogers AT&T Wireless 4085551212@pcs.rogers.com 

Safaricom 4085551212@safaricomsms.com

Satelindo GSM 4085551212@satelindogsm.com 

Simobile (Slovenia) 4085551212@simobil.net 

Sunrise Mobile 4085551212@mysunrise.ch

Sunrise Mobile 4085551212@freesurf.ch

SFR France 4085551212@sfr.fr

SCS-900 4085551212@scs-900.ru 

Southwestern Bell 4085551212@email.swbw.com

Sonofon Denmark 4085551212@note.sonofon.dk

Sprint PCS 4085551212@messaging.sprintpcs.com

Sprint 4085551212@sprintpaging.com

Swisscom 4085551212@bluewin.ch 

Swisscom 4085551212@bluemail.ch

Telecom Italia Mobile (Italy) 4085551212@posta.tim.it

Telenor Mobil Norway 4085551212@mobilpost.com

Telecel (Portugal) 4085551212@sms.telecel.pt

SMS formats based on carrier (Continued)

Carrier SMS Format
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Tele2 4085551212@sms.tele2.lv

Tele Danmark Mobil 4085551212@sms.tdk.dk

Telus 4085551212@msg.telus.com

Telenor 4085551212@mobilpost.no

Telia Denmark 4085551212@gsm1800.telia.dk

TIM 4085551212 @timnet.com

TMN (Portugal) 4085551212@mail.tmn.pt

T-Mobile Austria 4085551212@sms.t-mobile.at 

T-Mobile Germany 4085551212@t-d1-sms.de

T-Mobile UK 4085551212@t-mobile.uk.net

T-Mobile USA 4085551212@tmomail.net

Triton 4085551212@tms.suncom.com

Tamil Nadu Aircel 4085551212@airsms.com

Tamil Nadu BPL Mobile 4085551212 @bplmobile.com

UMC GSM 4085551212@sms.umc.com.ua

Unicel 4085551212@utext.com

Uraltel 4085551212@sms.uraltel.ru 

US Cellular 4085551212@email.uscc.net 

US West 4085551212@uswestdatamail.com 

Uttar Pradesh (West) Escotel 4085551212@escotelmobile.com

Verizon 4085551212@vtext.com

Verizon PCS 4085551212@myvzw.com

Virgin Mobile 4085551212@vmobl.com

Vodafone Omnitel (Italy) 4085551212@vizzavi.it 

Vodafone Italy 4085551212@sms.vodafone.it

Vodafone Japan 4085551212@pc.vodafone.ne.j

Vodafone Japan 4085551212@h.vodafone.ne.jp

Vodafone Japan 4085551212@t.vodafone.ne.jp

Vodafone Spain 4085551212@vodafone.es 

Vodafone UK 4085551212@vodafone.net 

West Central Wireless 4085551212@sms.wcc.net

Western Wireless 4085551212@cellularonewest.com

SMS formats based on carrier (Continued)

Carrier SMS Format



SonicWall Secure Mobile Access 10.2 Administration Guide
Support Information

I

418

Support Information

This appendix contains the following sections:

• GNU General Public License (GPL) Source Code

• Limited Hardware Warranty

• End User License Agreement

GNU General Public License (GPL) Source 
Code
SonicWall Inc. provides a machine-readable copy of the GPL open source on a CD. To obtain a complete 
machine-readable copy, send your written request, along with a certified check or money order in the amount 
of US $25.00 payable to “SonicWall, Inc.” to: 

General Public License Source Code Request 
SonicWall, Inc. Attn: Jennifer Anderson

1033 McCarthy Blvd
Milpitas, CA 95035

Limited Hardware Warranty
All SonicWall Inc. appliances come with a 1-year Limited Hardware Warranty which provides delivery of critical 
replacement parts for defective parts under warranty. Visit the Warranty Information page for details on your 
product’s warranty:
https://support.sonicwall.com/essentials/support-offerings

SonicWall Inc., Inc. warrants that commencing from the delivery date to Customer (but in any case commencing 
not more than ninety (90) days after the original shipment by SonicWall Inc.), and continuing for a period of 
twelve (12) months, that the product is free from defects in materials and workmanship under normal use. This 
Limited Warranty is not transferable and applies only to the original end user of the product. SonicWall Inc. and 
its suppliers' entire liability and Customer's sole and exclusive remedy under this limited warranty will be 
shipment of a replacement product. At SonicWall Inc.'s discretion, the replacement product may be of equal or 
greater functionality and may be of either new or like-new quality. SonicWall Inc.'s obligations under this 
warranty are contingent upon the return of the defective product according to the terms of SonicWall Inc.'s 
then-current Support Services policies. 

This warranty does not apply if the product has been subjected to abnormal electrical stress, damaged by 
accident, abuse, misuse or misapplication, or has been modified without the written permission of SonicWall 
Inc.. 

DISCLAIMER OF WARRANTY. EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED CONDITIONS, 
REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OR 
CONDITION OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, SATISFACTORY 

https://support.sonicwall.com/essentials/support-offerings
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QUALITY OR ARISING FROM A COURSE OF DEALING, LAW, USAGE, OR TRADE PRACTICE, ARE HEREBY EXCLUDED 
TO THE MAXIMUM EXTENT ALLOWED BY APPLICABLE LAW. TO THE EXTENT AN IMPLIED WARRANTY CANNOT BE 
EXCLUDED, SUCH WARRANTY IS LIMITED IN DURATION TO THE WARRANTY PERIOD. BECAUSE SOME STATES OR 
JURISDICTIONS DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO 
HAVE OTHER RIGHTS WHICH VARY FROM JURISDICTION TO JURISDICTION. This disclaimer and exclusion shall 
apply even if the express warranty set forth above fails of its essential purpose.

DISCLAIMER OF LIABILITY. SonicWall'S SOLE LIABILITY IS THE SHIPMENT OF A REPLACEMENT PRODUCT AS 
DESCRIBED IN THE ABOVE LIMITED WARRANTY. IN NO EVENT SHALL SonicWall OR ITS SUPPLIERS BE LIABLE FOR 
ANY DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF PROFITS, BUSINESS 
INTERRUPTION, LOSS OF INFORMATION, OR OTHER PECUNIARY LOSS ARISING OUT OF THE USE OR INABILITY TO 
USE THE PRODUCT, OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, INCIDENTAL, OR PUNITIVE DAMAGES 
HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY ARISING OUT OF THE USE OF OR INABILITY 
TO USE HARDWARE OR SOFTWARE EVEN IF SonicWall OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. In no event shall SonicWall or its suppliers' liability to Customer, whether in 
contract, tort (including negligence), or otherwise, exceed the price paid by Customer. The foregoing limitations 
shall apply even if the above-stated warranty fails of its essential purpose. BECAUSE SOME STATES OR 
JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

End User License Agreement
PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THIS PRODUCT. BY DOWNLOADING, INSTALLING OR 
USING THIS PRODUCT, YOU ACCEPT AND AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT. FOR 
DELIVERIES OUTSIDE THE UNITED STATES OF AMERICA, PLEASE GO TO 
HTTPS://WWW.SONICWALL.COM/LEGAL/EUPA.ASPX TO VIEW THE APPLICABLE VERSION OF THIS AGREEMENT 
FOR YOUR REGION. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT OR THE 
APPLICABLE VERSION OF THIS AGREEMENT FOR YOUR REGION, DO NOT DOWNLOAD, INSTALL OR USE THIS 
PRODUCT.

This SonicWall End User Product Agreement (the “Agreement”) is made between you, the Customer 
(“Customer” or “You”) and the Provider, as defined below.

1 Definitions. Capitalized terms not defined in context shall have the meanings assigned to them below: 

a “Affiliate” means any legal entity controlling, controlled by, or under common control with a 
party to this Agreement, for so long as such control relationship exists.

b “Appliance” means a computer hardware product upon which Software is pre-installed and 
delivered. 

c “Documentation” means the user manuals and documentation that Provider makes available for 
the Products, and all copies of the foregoing.

d “Maintenance Services” means Provider’s maintenance and support offering for the Products as 
identified in the Maintenance Services Section below.

e “Partner” means the reseller or distributor that is under contract with Provider or another 
Partner and is authorized via such contract to resell the Products and/or Maintenance Services. 

f “Provider” means, (i) for the US and Taiwan, SonicWall Inc., with its principal place of business 
located at 4 Polaris Way, Aliso Viejo, CA 92656 USA and (ii) for Europe, Middle East, Africa, and 
Asia (other than Taiwan) SonicWall International Ltd. City Gate Park Mahon, Cork, Ireland. 

g “Products” means the Software and Appliance(s) provided to Customer under this Agreement.

h “Software” means the object code version of the software that is delivered on the Appliance and 
any other software that is later provided to Customer as well as any new versions and releases to 

HTTPS://WWW.SONICWALL.COM/LEGAL/EUPA.ASPX
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such software that are made available to Customer pursuant to this Agreement, and all copies of 
the foregoing.

2 Software License. 

a General. Subject to the terms of this Agreement, Provider grants to Customer, and Customer 
accepts from Provider, a non-exclusive, non-transferable (except as otherwise set forth herein) 
and non-sublicensable license to access and use the quantities of each item of Software 
purchased from Provider or a Partner within the parameters of the license type (“License 
Type(s)”) described below in the quantities purchased (“License”). Except for MSP Licenses (as 
defined below), Customer shall only use the Software to support the internal business operations 
of itself and its worldwide Affiliates.

b License Types. The License Type for the Software initially delivered on the Appliance is “per 
Appliance”. Software licensed per Appliance may be used only on the Appliance on which it is 
delivered, but without any other quantitative limitations. Software that is purchased on a 
subscription, or periodic basis is licensed by User or by Managed Node. A “User” is each person 
with a unique login identity to the Software. A “Managed Node” is any object managed by the 
Software including, but not limited to firewalls, devices, and other items sold by Provider.

c Software as a Service When Customer purchases a right to access and use Software installed on 
equipment operated by Provider or its suppliers (the “SaaS Software”), (i) the License for such 
SaaS Software shall be granted for the duration of the term stated in the order (the “SaaS Term”), 
as such SaaS Term may be extended by automatic or agreed upon renewals, and (ii) the terms set 
forth in the SaaS Provisions Section of this Agreement shall apply to all access to and use of such 
Software. If any item of Software to be installed on Customer’s equipment is provided in 
connection with SaaS Software, the License duration for such Software shall be for the 
corresponding SaaS Term, and Customer shall promptly install any updates to such Software as 
may be provided by Provider.

d MSP License. 

“Management Services” include, without limitation, application, operating system, and database 
implementation, performance tuning, and maintenance services provided by Customer to its 
customers (each, a “Client”) where Customer installs copies of the Software on its Clients’ 
equipment or provides its Clients access to the Products. Customer shall be granted a License to 
use the Software and the associated Documentation to provide Management Services (the “MSP 
License”). Each MSP License is governed by the terms of this Agreement and any additional terms 
agreed to by the parties. 

If the Product is to be used by Customer as a managed service provider, then Customer shall 
ensure that (i) Customer makes no representations or warranties related to the Products in excess 
of SonicWall's representations or warranties contained in this Agreement, (ii) each Client only 
uses the Products and Documentation as part of the Management Services provided to it by 
Customer, (iii) such use is subject to the restrictions and limitations contained in this Agreement, 
including, but not limited to those in the Export Section of this Agreement, and (iv) each Client 
cooperates with Provider during any compliance review that may be conducted by Provider or its 
designated agent. At the conclusion of any Management Services engagement with a Client, 
Customer shall promptly remove any Appliance and Software installed on its Client’s computer 
equipment or require the Client to do the same. Customer agrees that it shall be jointly and 
severally liable to Provider for the acts and omissions of its Clients in connection with their use of 
the Software and Documentation and shall, at its expense, defend Provider against any action, 
suit, or claim brought against Provider by a Client in connection with or related to Customer’s 
Management Services and pay any final judgments or settlements as well as Provider’s expenses 
in connection with such action, suit, or claim. 

e Evaluation/Beta License. If Software is obtained from Provider for evaluation purposes or in beta 
form, Customer shall be granted a License to use such Software and the associated 
Documentation solely for Customer’s own non-production, internal evaluation purposes (an 
“Evaluation License”). Each Evaluation License shall be granted for an evaluation period of up to 
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thirty (30) days beginning (i) five (5) days after the Appliance is shipped or (ii) from the date that 
access is granted to the beta Software or the SaaS Software, plus any extensions granted by 
Provider in writing (the “Evaluation Period”). There is no fee for an Evaluation License during the 
Evaluation Period, however, Customer is responsible for any applicable shipping charges or taxes 
which may be incurred, and any fees which may be associated with usage beyond the scope 
permitted herein. Beta Software licensed hereunder may include pre-release features and 
capabilities which may not be available in SonicWall’s generally available commercial versions of 
the Software. SonicWall retains the right during the term to modify, revise, or remove SonicWall 
beta software from Customer's premises. Customer acknowledges that SonicWall owns all 
modifications, derivative works, changes, expansions or improvements to beta software, as well 
as all reports, testing data or results, feedback, benchmarking or other analysis completed in 
whole or in part in conjunction with usage of beta software. NOTWITHSTANDING ANYTHING 
OTHERWISE SET FORTH IN THIS AGREEMENT, CUSTOMER UNDERSTANDS AND AGREES THAT 
EVALUATION AND BETA SOFTWARE IS PROVIDED “AS IS”, WHERE IS, WITH ALL FAULTS AND THAT 
SONICWALL DOES NOT PROVIDE A WARRANTY OR MAINTENANCE SERVICES FOR EVALUATION OR 
BETA LICENSES, AND SONICWALL BEARS NO LIABILITY FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
PUNITIVE, SPECIAL OR CONSEQUENTIAL DAMAGES RESULTING FROM USE (OR ATTEMPTED USE) 
OF THE EVALUATION OR BETA SOFTWARE THROUGH AND AFTER THE EVALUATION PERIOD AND 
HAS NO DUTY TO PROVIDE SUPPORT TO CUSTOMER FOR SUCH SOFTWARE. BETA SOFTWARE MAY 
CONTAIN DEFECTS AND A PRIMARY PURPOSE OF LICENSING THE BETA SOFTWARE IS TO OBTAIN 
FEEDBACK ON THE SOFTWARE’S PERFORMANCE AND THE IDENTIFICATION OF DEFECTS. 
CUSTOMER IS ADVISED TO SAFEGUARD IMPORTANT DATA, TO USE CAUTION AND NOT TO RELY IN 
ANY WAY ON THE CORRECT FUNCTIONING OR PERFORMANCE OF THE BETA SOFTWARE AND/OR 
ACCOMPANYING MATERIALS.

f Use by Third Parties. Customer may allow its services vendors and contractors (each, a “Third 
Party User”) to access and use the Products and Documentation provided to Customer hereunder 
solely for purposes of providing services to Customer, provided that Customer ensures that (i) the 
Third Party User’s access to or use of the Products and Documentation is subject to the 
restrictions and limitations contained in this Agreement, including, but not limited to those in the 
Export Section, (ii) the Third Party User cooperates with Provider during any compliance review 
that may be conducted by Provider or its designated agent, and (iii) the Third Party Users 
promptly removes any Software installed on its computer equipment upon the completion of the 
Third Party’s need to access or use the Products as permitted by this Section. Customer agrees 
that it shall be liable to Provider for those acts and omissions of its Third Party Users which, if 
done or not done by Customer, would be a breach of this Agreement. 

3 Restrictions. Customer may not reverse engineer, decompile, disassemble, or attempt to discover or 
modify in any way the underlying source code of the Software, or any part thereof unless and to the 
extent (a) such restrictions are prohibited by applicable law and (b) Customer has requested 
interoperability information in writing from Provider and Provider has not provided such information in a 
timely manner. In addition, Customer may not (i) modify, translate, localize, adapt, rent, lease, loan, 
create or prepare derivative works of, or create a patent based on the Products, Documentation or any 
part thereof, (ii) resell, sublicense or distribute the Products or Documentation, (iii) provide, make 
available to, or permit use of the Products, in whole or in part, by any third party (except as expressly set 
forth herein), (iv) use the Products or Documentation to create or enhance a competitive offering or for 
any other purpose which is competitive to Provider, (v) remove Software that was delivered on an 
Appliance from the Appliance on which it was delivered and load such Software onto a different 
appliance without Provider’s prior written consent, or (vi) perform or fail to perform any other act which 
would result in a misappropriation or infringement of Provider’s intellectual property rights in the 
Products or Documentation. Each permitted copy of the Software and Documentation made by 
Customer hereunder must contain all titles, trademarks, copyrights and restricted rights notices as in the 
original. Customer understands and agrees that the Products may work in conjunction with third party 
products and Customer agrees to be responsible for ensuring that it is properly licensed to use such third 
party products. Notwithstanding anything otherwise set forth in this Agreement, the terms and 
restrictions set forth herein shall not prevent or restrict Customer from exercising additional or different 
rights to any open source software that may be contained in or provided with the Products in accordance 
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with the applicable open source software licenses which shall be either included with the Products or 
made available to Customer upon request. Customer may not use any license keys or other license 
access devices not provided by Provider, including but not limited to “pirate keys”, to install or access the 
Software. 

4 Proprietary Rights. Customer understands and agrees that (i) the Products are protected by copyright 
and other intellectual property laws and treaties, (ii) Provider, its Affiliates and/or its licensors own the 
copyright, and other intellectual property rights in the Products, (iii) the Software is licensed, and not 
sold, (iv) this Agreement does not grant Customer any rights to Provider’s trademarks or service marks, 
and (v) Provider reserves any and all rights, implied or otherwise, which are not expressly granted to 
Customer in this Agreement. 

5 Title. Provider, its Affiliates and/or its licensors own the title to all Software. 

6 Payment. Customer agrees to pay to Provider (or, if applicable, the Partner) the fees specified in each 
order, including any applicable shipping fees. Customer will be invoiced promptly following delivery of 
the Products or prior to the commencement of any Renewal Maintenance Period and Customer shall 
make all payments due to Provider in full within thirty (30) days from the date of each invoice or such 
other period (if any) stated in an order. Provider reserves the right to charge Customer a late penalty of 
1.5% per month (or the maximum rate permitted by law, whichever is the lesser) for any amounts 
payable to Provider by Customer that are not subject to a good faith dispute and that remain unpaid 
after the due date until such amount is paid.

7 Taxes. The fees stated in an order from Provider or a Partner may not include taxes. If Provider is required 
to pay sales, use, property, value-added or other taxes based on the Products or Maintenance Services 
provided under this Agreement or on Customer’s use of Products or Maintenance Services, then such 
taxes shall be billed to and paid by Customer. This Section does not apply to taxes based on Provider’s or 
a Partner’s income.

8 Termination. 

a This Agreement or the Licenses granted hereunder may be terminated (i) by mutual written 
agreement of Provider and Customer or (ii) by either party for a breach of this Agreement by the 
other party (or a Third Party User) that the breaching party fails to cure to the non-breaching 
party’s reasonable satisfaction within thirty (30) days following its receipt of notice of the breach. 
Notwithstanding the foregoing, in the case of MSP Licenses, if Customer or its Client breaches this 
Agreement two (2) times in any twelve (12) consecutive month period, the breaching party shall 
not have a cure period for such breach and Provider may terminate this Agreement immediately 
upon providing written notice to the breaching party.

b Upon termination of this Agreement or expiration or termination of a License for any reason, all 
rights granted to Customer for the applicable Software shall immediately cease and Customer 
shall immediately: (i) cease using the applicable Software and Documentation, (ii) remove all 
copies, installations, and instances of the applicable Software from all Appliances, Customer 
computers and any other devices on which the Software was installed, and ensure that all 
applicable Third Party Users and Clients do the same, (iii) return the applicable Software to 
Provider together with all Documentation and other materials associated with the Software and 
all copies of any of the foregoing, or destroy such items, (iv) cease using the Maintenance Services 
associated with the applicable Software, (v) pay Provider or the applicable Partner all amounts 
due and payable up to the date of termination, and (vi) give Provider a written certification, 
within ten (10) days, that Customer, Third Party Users, and Clients, if applicable, have complied 
with all of the foregoing obligations. 

c Any provision of this Agreement that requires or contemplates execution after (i) termination of 
this Agreement, (ii) a termination or expiration of a License, or (iii) the expiration of a SaaS Term, 
is enforceable against the other party and their respective successors and assignees 
notwithstanding such termination or expiration, including, without limitation, the Restrictions, 
Payment, Taxes, Termination, Survival, Warranty Disclaimer, Infringement Indemnity, Limitation of 
Liability, Confidential Information, Compliance Verification, and General Sections of this 
Agreement. Termination of this Agreement or a License shall be without prejudice to any other 
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remedies that the terminating party or a Partner may have under law, subject to the limitations 
and exclusions set forth in this Agreement.

9 Export. Customer acknowledges that the Products and Maintenance Services are subject to the export 
control laws, rules, regulations, restrictions and national security controls of the United States and other 
applicable foreign agencies (the “Export Controls”) and agrees to abide by the Export Controls. Customer 
hereby agrees to use the Products and Maintenance Services in accordance with the Export Controls, 
and shall not export, re-export, sell, lease or otherwise transfer the Products or any copy, portion or 
direct product of the foregoing in violation of the Export Controls. Customer is solely responsible for 
obtaining all necessary licenses or authorizations relating to the export, re-export, sale, lease or transfer 
of the Products and for ensuring compliance with the requirements of such licenses or authorizations. 
Customer hereby (i) represents that Customer, and if Customer is providing services under the MSP 
License herein each of its Clients, is not an entity or person to which shipment of Products, or provision 
of Maintenance Services, is prohibited by the Export Controls; and (ii) agrees that it shall not export, 
re-export or otherwise transfer the Products to (a) any country subject to a United States trade embargo, 
(b) a national or resident of any country subject to a United States trade embargo, (c) any person or 
entity to which shipment of Products is prohibited by the Export Controls, or (d) anyone who is engaged 
in activities related to the design, development, production, or use of nuclear materials, nuclear facilities, 
nuclear weapons, missiles or chemical or biological weapons. Customer shall, at its expense, defend 
Provider and its Affiliates from any third party claim or action arising out of any inaccurate 
representation made by Customer regarding the existence of an export license, Customer’s failure to 
provide information to Provider to obtain an export license, or any allegation made against Provider due 
to Customer’s violation or alleged violation of the Export Controls (an “Export Claim”) and shall pay any 
judgments or settlements reached in connection with the Export Claim as well as Provider’s costs of 
responding to the Export Claim.

10 Maintenance Services. 

a Description. During any Maintenance Period, Provider shall: 

(i) Make available to Customer new versions and releases of the Software, if and when Provider 
makes them generally available without charge as part of Maintenance Services. 

(ii) Respond to communications from Customer that report Software failures not previously 
reported to Provider by Customer. Nothing in the foregoing shall operate to limit or restrict follow 
up communication by Customer regarding Software failures. 

(iii) Respond to requests from Customer’s technical coordinators for assistance with the 
operational/technical aspects of the Software unrelated to a Software failure. Provider shall have 
the right to limit such responses if Provider reasonably determines that the volume of such 
non-error related requests for assistance is excessive or overly repetitive in nature.

(iv) Provide access to Provider’s software support web site at https://support.sonicwall.com (the 
“Support Site”). 

(v) For Customers that have purchased Maintenance Services continuously since the purchase of 
such License, provide the repair and return program described on the Support Site for the 
Appliance on which the Software is delivered.

Maintenance Services are available during regional business support hours (“Business Hours”) as 
indicated on the Support Site, unless Customer has purchased 24x7 Support. The list of Software 
for which 24x7 Support is available and/or required is listed in the Global Support Guide on the 
Support Site. 

The Maintenance Services for Software that Provider has obtained through an acquisition or 
merger may, for a period of time following the effective date of the acquisition or merger, be 
governed by terms other than those in this Section. The applicable different terms, if any, shall be 
stated on the Support Site.

b Maintenance Period. The first period for which Customer is entitled to receive Maintenance 
Services begins on the date of the registration of the Product at Provider’s registration portal (the 

https://support.sonicwall.com
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“Registration”) and ends twelve (12) months thereafter (the “Initial Maintenance Period”). 
Following the Initial Maintenance Period, Maintenance Services for the Product(s) may then be 
renewed for additional terms of twelve (12) or more months (each, a “Renewal Maintenance 
Period”) For purposes of this Agreement, the Initial Maintenance Period and each Renewal 
Maintenance Period shall be considered a “Maintenance Period.” For the avoidance of doubt, 
this Agreement shall apply to each Renewal Maintenance Period. Cancellation of Maintenance 
Services will not terminate Customer’s rights to continue to otherwise use the Products. 
Maintenance fees shall be due in advance of each Renewal Maintenance Period and shall be 
subject to the payment requirements set forth in this Agreement. The procedure for reinstating 
Maintenance Services for the Products after it has lapsed is posted at 
https://support.sonicwall.com/essentials/support-guide. Maintenance Services are optional and 
only provided if purchased separately. 

For SaaS Software, the Maintenance Period is equal to the duration of the applicable SaaS Term. 
For non-perpetual Licenses or for non-perpetual MSP Licenses, the Maintenance Period is equal 
to the duration of the License.

11 Warranties and Remedies. 

a Software Warranties. Provider warrants that, during the applicable Warranty Period (as defined 
in subsection (c) below), 

(i) the operation of the Software, as provided by Provider, will substantially conform to its 
Documentation (the “Operational Warranty”); 

(ii) the Software, as provided by Provider, will not contain any viruses, worms, Trojan Horses, or 
other malicious or destructive code designed by Provider to allow unauthorized intrusion upon, 
disabling of, or erasure of the Software, except that the Software may contain a key limiting its 
use to the scope of the License granted, and license keys issued by Provider for temporary use are 
time-sensitive (the “Virus Warranty”); 

(iii) it will make commercially reasonable efforts to make the SaaS Software available twenty-four 
hours a day, seven days a week except for scheduled maintenance, the installation of updates, 
those factors that are beyond the reasonable control of Provider, Customer’s failure to meet any 
minimum system requirements communicated to Customer by Provider, and any breach of this 
Agreement by Customer that impacts the availability of the SaaS Software (the “SaaS Availability 
Warranty”).

b Appliance Warranties. Provider warrants that, during the applicable Warranty Period, the 
Appliance will operate in a manner which allows the SNWL Software, respectively, to be used in 
substantial conformance with the Documentation (the ““Appliance Warranty”,).

c Warranty Periods. The “Warranty Period” for each of the above warranties (except for E-class 
appliances which do not include a Software warranty, shall be as follows: (i) for the Operational 
Warranty as it applies to Software and the Virus Warranty, ninety (90) days following the initial 
Registration of the Software; (ii) for the Operational Warranty as it applies to SaaS Software and 
the SaaS Availability Warranty, the duration of the SaaS Term; and (iv) for the Appliance Warranty, 
one (1) year following the date the Appliance is registered with Provider. 

d Remedies. Any breach of the foregoing warranties must be reported by Customer to Provider 
during the applicable Warranty Period. Customer’s sole and exclusive remedy and Provider’s sole 
obligation for any such breach shall be as follows:

(i) For a breach of the Operational Warranty that impacts the use of Software, Provider shall 
correct or provide a workaround for reproducible errors in the Software that caused the breach 
within a reasonable time considering the severity of the error and its effect on Customer or, at 
Provider’s option, refund the license fees paid for the nonconforming Software upon return of 
such Software to Provider and termination of the related License(s) hereunder.

(ii) For a breach of the Operational Warranty that impacts the use of SaaS Software, Provider shall 
correct or provide a workaround for reproducible errors in the Software that caused the breach 
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and provide a credit or refund of the fees allocable to the period during which the Software was 
not operating in substantial conformance with the applicable Documentation.

(iii) For a breach of the Virus Warranty, Provider shall replace the Software with a copy that is in 
conformance with the Virus Warranty. 

(v) For a breach of the SaaS Availability Warranty, Provider shall provide a credit or refund of the 
fees allocable to the period during which the SaaS Software was not available for use.

e Warranty Exclusions. The warranties set forth in this Section shall not apply to any 
non-conformance (i) that Provider cannot recreate after exercising commercially reasonable 
efforts to attempt to do so; (ii) caused by misuse of the applicable Product or by using the Product 
in a manner that is inconsistent with this Agreement or the Documentation; or (iii) arising from 
the modification of the Product by anyone other than Provider. 

f Third Party Products. Certain Software may contain features designed to interoperate with 
third-party products. If the third-party product is no longer made available by the applicable 
provider, Provider may discontinue the related product feature. Provider shall notify Customer of 
any such discontinuation, however Customer will not be entitled to any refund, credit or other 
compensation as a result of the discontinuation. 

g Warranty Disclaimer. THE EXPRESS WARRANTIES AND REMEDIES SET FORTH IN THIS SECTION 
ARE THE ONLY WARRANTIES AND REMEDIES PROVIDED BY PROVIDER HEREUNDER. TO THE 
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, ALL OTHER WARRANTIES OR REMEDIES ARE 
EXCLUDED, WHETHER EXPRESS OR IMPLIED, ORAL OR WRITTEN, INCLUDING ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR ANY PARTICULAR PURPOSE, 
NON-INFRINGEMENT, SATISFACTORY QUALITY, AND ANY WARRANTIES ARISING FROM USAGE OF 
TRADE OR COURSE OF DEALING OR PERFORMANCE. PROVIDER DOES NOT WARRANT 
UNINTERRUPTED OR ERROR-FREE OPERATION OF THE PRODUCTS.

h High-Risk Disclaimer. CUSTOMER UNDERSTANDS AND AGREES THAT THE PRODUCTS ARE NOT 
FAULT-TOLERANT AND ARE NOT DESIGNED OR INTENDED FOR USE IN ANY HIGH-RISK OR 
HAZARDOUS ENVIRONMENT, INCLUDING WITHOUT LIMITATION, THE OPERATION OF NUCLEAR 
FACILITIES, AIRCRAFT NAVIGATION, AIR TRAFFIC CONTROL, LIFE SUPPORT MACHINES, WEAPONS 
SYSTEMS, OR ANY OTHER APPLICATION WHERE THE FAILURE OR MALFUNCTION OF ANY 
PRODUCT CAN REASONABLY BE EXPECTED TO RESULT IN DEATH, PERSONAL INJURY, SEVERE 
PROPERTY DAMAGE OR SEVERE ENVIRONMENTAL HARM (A “HIGH RISK ENVIRONMENT”). 
ACCORDINGLY, (I) CUSTOMER SHOULD NOT USE THE PRODUCTS IN A HIGH RISK ENVIRONMENT, 
(II) ANY USE OF THE PRODUCTS BY CUSTOMER IN A HIGH RISK ENVIRONMENT IS AT CUSTOMER’S 
OWN RISK, (III) PROVIDER, ITS AFFILIATES AND SUPPLIERS SHALL NOT BE LIABLE TO CUSTOMER IN 
ANY WAY FOR USE OF THE PRODUCTS IN A HIGH RISK ENVIRONMENT, AND (IV) PROVIDER MAKES 
NO WARRANTIES OR ASSURANCES, EXPRESS OR IMPLIED, REGARDING USE OF THE PRODUCTS IN 
A HIGH RISK ENVIRONMENT.

12 Infringement Indemnity. Provider shall indemnify Customer from and against any claim, suit, action, or 
proceeding brought against Customer by a third party to the extent it is based on an allegation that the 
Software directly infringes any patent, copyright, trademark, or other proprietary right enforceable in the 
country in which Provider has authorized Customer to use the Software, including, but not limited to the 
country to which the Software is delivered to Customer, or misappropriates a trade secret in such 
country (a “Claim”). Indemnification for a Claim shall consist of the following: Provider shall (a) defend or 
settle the Claim at its own expense, (b) pay any judgments finally awarded against Customer under a 
Claim or any amounts assessed against Customer in any settlements of a Claim, and (c) reimburse 
Customer for the reasonable administrative costs or expenses, including without limitation reasonable 
attorneys’ fees, it necessarily incurs in responding to the Claim. Provider’s obligations under this 
Infringement Indemnity Section are conditioned upon Customer (i) giving prompt written notice of the 
Claim to Provider, (ii) permitting Provider to retain sole control of the investigation, defense or 
settlement of the Claim, and (iii) providing Provider with cooperation and assistance as Provider may 
reasonably request in connection with the Claim. Provider shall have no obligation hereunder to defend 
Customer against any Claim (a) resulting from use of the Software other than as authorized by this 
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Agreement, (b) resulting from a modification of the Software other than by Provider, (c) based on 
Customer’s use of any release of the Software after Provider recommends discontinuation because of 
possible or actual infringement and has provided a non-infringing version at no charge, or (d) to the 
extent the Claim arises from or is based on the use of the Software with other products, services, or data 
not supplied by Provider if the infringement would not have occurred but for such use. If, as a result of a 
Claim or an injunction, Customer must stop using any Software (“Infringing Software”), Provider shall at 
its expense and option either (1) obtain for Customer the right to continue using the Infringing Software, 
(2) replace the Infringing Software with a functionally equivalent non-infringing product, (3) modify the 
Infringing Software so that it is non-infringing, or (4) terminate the License for the Infringing Software 
and (A) for non-SaaS Software, accept the return of the Infringing Software and refund the license fee 
paid for the Infringing Software, pro-rated over a sixty (60) month period from the date of initial delivery 
of such Software, or (B) for SaaS Software, discontinue Customer’s right to access and use the Infringing 
Software and refund the unused pro-rated portion of any license fees pre-paid by Customer for such 
Software. This Section states Provider’s entire liability and its sole and exclusive indemnification 
obligations with respect to a Claim and Infringing Software. 

13 Limitation of Liability. EXCEPT FOR (A) ANY BREACH OF THE RESTRICTIONS OR CONFIDENTIAL 
INFORMATION SECTIONS OF THIS AGREEMENT, (B) AMOUNTS CONTAINED IN JUDGMENTS OR 
SETTLEMENTS WHICH PROVIDER OR CUSTOMER IS LIABLE TO PAY TO A THIRD PARTY UNDER THE 
INFRINGEMENT INDEMNITY SECTION OF THIS AGREEMENT AND CUSTOMER IS LIABLE TO PAY ON 
BEHALF OF OR TO PROVIDER UNDER THE CONDUCT, EXPORT, MSP LICENSE, AND USE BY THIRD PARTIES 
SECTIONS OF THIS AGREEMENT, OR (C) ANY LIABILITY TO THE EXTENT LIABILITY MAY NOT BE EXCLUDED 
OR LIMITED AS A MATTER OF APPLICABLE LAW, IN NO EVENT SHALL CUSTOMER OR ITS AFFILIATES, OR 
PROVIDER, ITS AFFILIATES OR SUPPLIERS BE LIABLE FOR (X) ANY INDIRECT, INCIDENTAL, SPECIAL OR 
CONSEQUENTIAL LOSS OR DAMAGE OF ANY KIND OR (Y) LOSS OF REVENUE, LOSS OF ACTUAL OR 
ANTICIPATED PROFITS, LOSS OF BUSINESS, LOSS OF CONTRACTS, LOSS OF GOODWILL OR REPUTATION, 
LOSS OF ANTICIPATED SAVINGS, LOSS OF, DAMAGE TO OR CORRUPTION OF DATA, HOWSOEVER 
ARISING, WHETHER SUCH LOSS OR DAMAGE WAS FORESEEABLE OR IN THE CONTEMPLATION OF THE 
PARTIES AND WHETHER ARISING IN OR FOR BREACH OF CONTRACT, TORT (INCLUDING NEGLIGENCE), 
BREACH OF STATUTORY DUTY, OR OTHERWISE.

EXCEPT FOR (A) ANY BREACH OF THE SOFTWARE LICENSE, RESTRICTIONS, OR CONFIDENTIAL 
INFORMATION SECTIONS OF THIS AGREEMENT, OR ANY OTHER VIOLATION OF THE OTHER PARTY’S 
INTELLECTUAL PROPERTY RIGHTS; (B) PROVIDER’S EXPRESS OBLIGATIONS UNDER THE INFRINGEMENT 
INDEMNITY SECTION OF THIS AGREEMENT AND CUSTOMER’S EXPRESS OBLIGATIONS UNDER THE 
CONDUCT, EXPORT, MSP LICENSE, AND USE BY THIRD PARTIES SECTIONS OF THIS AGREEMENT, (C) 
PROVIDER’S COSTS OF COLLECTING DELINQUENT AMOUNTS WHICH ARE NOT THE SUBJECT OF A GOOD 
FAITH DISPUTE; (D) A PREVAILING PARTY’S LEGAL FEES PURSUANT TO THE LEGAL FEES SECTION OF THIS 
AGREEMENT; OR (E) ANY LIABILITY TO THE EXTENT LIABILITY MAY NOT BE EXCLUDED OR LIMITED AS A 
MATTER OF APPLICABLE LAW, THE MAXIMUM AGGREGATE AND CUMULATIVE LIABILITY OF CUSTOMER 
AND ITS AFFILIATES, AND PROVIDER, ITS AFFILIATES AND SUPPLIERS, FOR DAMAGES UNDER THIS 
AGREEMENT, WHETHER ARISING IN OR FOR BREACH OF CONTRACT, TORT (INCLUDING NEGLIGENCE), 
BREACH OF STATUTORY DUTY, OR OTHERWISE, SHALL BE AN AMOUNT EQUAL TO (Y) THE GREATER OF 
THE FEES PAID AND/OR OWED (AS APPLICABLE) BY CUSTOMER OR ITS AFFILIATES FOR THE PRODUCTS 
THAT ARE THE SUBJECT OF THE BREACH OR FIVE HUNDRED DOLLARS ($500.00),EXCEPT FOR (Z) 
MAINTENANCE SERVICES OR A PRODUCT SUBJECT TO RECURRING FEES, FOR WHICH THE MAXIMUM 
AGGREGATE AND CUMULATIVE LIABILITY SHALL BE THE GREATER OF THE AMOUNT PAID AND/OR OWED 
(AS APPLICABLE) FOR SUCH MAINTENANCE SERVICE OR PRODUCT DURING THE TWELVE (12) MONTHS 
PRECEDING THE BREACH OR FIVE HUNDRED DOLLARS ($500.00). THE PARTIES AGREE THAT THESE 
LIMITATIONS OF LIABILITY ARE AGREED ALLOCATIONS OF RISK CONSTITUTING IN PART THE 
CONSIDERATION FOR PROVIDER PROVIDING PRODUCTS AND SERVICES TO CUSTOMER, AND SUCH 
LIMITATIONS WILL APPLY NOTWITHSTANDING THE FAILURE OF THE ESSENTIAL PURPOSE OF ANY LIMITED 
REMEDY AND EVEN IF A PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LIABILITIES OR 
FAILURES.

Provider’s Affiliates and suppliers and Customer’s Affiliates shall be beneficiaries of this Limitation of 
Liability Section and Customer’s Clients and Third Party Users are entitled to the rights granted under the 
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MSP License and Use by Third Parties Sections of this Agreement; otherwise, no third party beneficiaries 
exist under this Agreement. Provider expressly excludes any and all liability to Third Party Users, Clients 
and to any other third party.

14 Confidential Information. 

a Definition. “Confidential Information” means information or materials disclosed by one party 
(the “Disclosing Party”) to the other party (the “Receiving Party”) that are not generally available 
to the public and which, due to their character and nature, a reasonable person under like 
circumstances would treat as confidential, including, without limitation, financial, marketing, and 
pricing information, trade secrets, know-how, proprietary tools, knowledge and methodologies, 
the Software (in source code and/or object code form), information or benchmark test results 
regarding the functionality and performance of the Software, any Software license keys provided 
to Customer, and the terms and conditions of this Agreement. 

Confidential Information shall not include information or materials that (i) are generally known to 
the public, other than as a result of an unpermitted disclosure by the Receiving Party after the 
date that Customer accepts the Agreement (the “Effective Date”); (ii) were known to the 
Receiving Party without an obligation of confidentiality prior to receipt from the Disclosing Party; 
(iii) the Receiving Party lawfully received from a third party without that third party’s breach of 
agreement or obligation of trust; (iv) are protected by Provider in accordance with its obligations 
under the Protected Data Section below, or (v) are or were independently developed by the 
Receiving Party without access to or use of the Disclosing Party’s Confidential Information. 

b Obligations. The Receiving Party shall (i) not disclose the Disclosing Party’s Confidential 
Information to any third party, except as permitted in subsection (c) below and (ii) protect the 
Disclosing Party’s Confidential Information from unauthorized use or disclosure by exercising at 
least the same degree of care it uses to protect its own similar information, but in no event less 
than a reasonable degree of care. The Receiving Party shall promptly notify the Disclosing Party of 
any known unauthorized use or disclosure of the Disclosing Party’s Confidential Information and 
will cooperate with the Disclosing Party in any litigation brought by the Disclosing Party against 
third parties to protect its proprietary rights. For the avoidance of doubt, this Section shall apply 
to all disclosures of the parties’ Confidential Information as of the Effective Date, whether or not 
specifically arising from a party’s performance under this Agreement.

c Permitted Disclosures. Notwithstanding the foregoing, the Receiving Party may disclose the 
Disclosing Party’s Confidential Information without the Disclosing Party’s prior written consent to 
any of its Affiliates, directors, officers, employees, consultants, contractors or representatives 
(collectively, the “Representatives”), but only to those Representatives that (i) have a “need to 
know” in order to carry out the purposes of this Agreement or to provide professional advice in 
connection with this Agreement, (ii) are legally bound to the Receiving Party to protect 
information such as the Confidential Information under terms at least as restrictive as those 
provided herein, and (iii) have been informed by the Receiving Party of the confidential nature of 
the Confidential Information and the requirements regarding restrictions on disclosure and use as 
set forth in this Section. The Receiving Party shall be liable to the Disclosing Party for the acts or 
omissions of any Representatives to which it discloses Confidential Information which, if done by 
the Receiving Party, would be a breach of this Agreement. 

Additionally, it shall not be a breach of this Section for the Receiving Party to disclose the 
Disclosing Party’s Confidential Information as may be required by operation of law or legal 
process, provided that the Receiving Party provides prior notice of such disclosure to the 
Disclosing Party unless expressly prohibited from doing so by a court, arbitration panel or other 
legal authority of competent jurisdiction.

15 Protected Data. For purposes of this Section, “Protected Data” means any information or data that is 
provided by Customer to Provider during this Agreement that alone or together with any other 
information relates to an identified or identifiable natural person or data considered to be personal data 
as defined under Privacy Laws, and “Privacy Laws” means any applicable law, statute, directive or 
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regulation regarding privacy, data protection, information security obligations and/or the processing of 
Protected Data.

Except as permitted herein or to the extent required by Privacy Laws or legal process, Provider shall 
implement reasonable technical and organizational measures to prevent unauthorized disclosure of or 
access to Protected Data by third parties, and shall only store and process Protected Data as may be 
required to fulfill its obligations under this Agreement. If Provider complies with Customer’s written 
instructions with respect to the Protected Data, Provider shall have no liability to Customer for any 
breach of this Section resulting from such compliance. Provider shall promptly notify Customer of any 
disclosure of or access to the Protected Data by a third party in breach of this Section and shall cooperate 
with Customer to reasonably remediate the effects of such disclosure or access. Provider further affirms 
to Customer that it has adequate agreements in place incorporating the EU standard contractual clauses 
for the transfer of Protected Data from the European Union (“EU”) to a country outside the EU. 

Customer hereby (i) represents that it has the right to send the Protected Data to Provider, (ii) consents 
for Provider to store and use the Protected Data worldwide for the sole purpose of performing its 
obligations under this Agreement, (iii) agrees that the Protected Data may be accessed and used by 
Provider and its Representatives worldwide as may be needed to support Provider’s standard business 
operations, and (iv) agrees that Protected Data consisting of Customer contact information (e.g., email 
addresses, names) provided as part of Maintenance Services may be sent to Provider’s third party service 
providers as part of Provider’s services improvement processes. 

16 Compliance Verification. Customer agrees to maintain and use systems and procedures to accurately 
track, document, and report its installations, acquisitions and usage of the Software. Such systems and 
procedures shall be sufficient to determine if Customer’s deployment of the Software or, if applicable, 
use of the SaaS Software is within the quantities, terms, and maintenance releases to which it is entitled. 
Provider or its designated auditing agent shall have the right to audit Customer's deployment of the 
Software or, if applicable, use of the SaaS Software for compliance with the terms and conditions of this 
Agreement. Any such audits shall be scheduled at least ten (10) days in advance and shall be conducted 
during normal business hours at Customer's facilities. Customer shall provide its full cooperation and 
assistance with such audit and provide access to the applicable records and computers. Without limiting 
the generality of the foregoing, as part of the audit, Provider may request, and Customer agrees to 
provide, a written report, signed by an authorized representative, listing Customer's then current 
deployment of the Software and/or the number of individuals that have accessed and used SaaS 
Software. If Customer's deployment of the Software or, if applicable, use of the SaaS Software is found to 
be greater than its purchased entitlement to such Software, Customer will be invoiced for the 
over-deployed quantities at Provider’s then current list price plus the applicable Maintenance Services 
and applicable over-deployment fees. All such amounts shall be payable in accordance with this 
Agreement. Additionally, if the unpaid fees exceed five percent (5%) of the fees paid for the applicable 
Software, then Customer shall also pay Provider's reasonable costs of conducting the audit. The 
requirements of this Section shall survive for two (2) years following the termination of the last License 
governed by this Agreement.

17 SaaS Provisions. 

a Data. Customer may store data on the systems to which it is provided access in connection with 
its use of the SaaS Software (the “SaaS Environment”). Provider may periodically make back-up 
copies of Customer data, however, such back-ups are not intended to replace Customer’s 
obligation to maintain regular data backups or redundant data archives. Customer is solely 
responsible for collecting, inputting and updating all Customer data stored in the SaaS 
Environment, and for ensuring that it does not (i) knowingly create and store data that actually or 
potentially infringes or misappropriates the copyright, trade secret, trademark or other 
intellectual property right of any third party, or (ii) use the SaaS Environment for purposes that 
would reasonably be seen as obscene, defamatory, harassing, offensive or malicious.. Provider 
shall have the right to delete all Customer data stored in connection with the use of the SaaS 
Software thirty (30) days following any termination of this Agreement or any License to SaaS 
Software granted hereunder. 
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Customer represents and warrants that it has obtained all rights, permissions and consents 
necessary to use and transfer all Customer and/or third party data within and outside of the 
country in which Customer or the applicable Customer Affiliate is located (including providing 
adequate disclosures and obtaining legally sufficient consents from Customer’s employees, 
customers, agents, and contractors). If Customer transmits data to a third-party website or other 
provider that is linked to or made accessible by the SaaS Software, Customer will be deemed to 
have given its consent to Provider enabling such transmission and Provider shall have no liability 
to Customer in connection with any claims by a third party in connection with such transmission.

b Conduct. In connection with the use of SaaS Software, Customer may not (i) attempt to use or 
gain unauthorized access to Provider’s or to any third-party's networks or equipment; (ii) permit 
other individuals or entities to copy the SaaS Software; (iii) provide unauthorized access to or use 
of any SaaS Software or the associated access credentials; (iv) attempt to probe, scan or test the 
vulnerability of the SaaS Software, the SaaS Environment, or a system, account or network of 
Provider or any of Provider’s customers or suppliers; (v) interfere or attempt to interfere with 
service to any user, host or network; (vi) engage in fraudulent, offensive or illegal activity of any 
nature or intentionally engage in any activity that infringes the intellectual property rights or 
privacy rights of any individual or third party; (vii) transmit unsolicited bulk or commercial 
messages; (viii) intentionally distribute worms, Trojan horses, viruses, corrupted files or any 
similar items; (ix) restrict, inhibit, or otherwise interfere with the ability of any other person, 
regardless of intent, purpose or knowledge, to use or enjoy the SaaS Software (except for tools 
with safety and security functions); or (x) restrict, inhibit, interfere with or otherwise disrupt or 
cause a performance degradation to any Provider (or Provider supplier) facilities used to provide 
the SaaS Environment. Customer shall cooperate with Provider’s reasonable investigation of SaaS 
Environment outages, security issues, and any suspected breach of this Section, and shall, at its 
expense, defend Provider and its Affiliates from any claim, suit, or action by a third party (a “Third 
Party Claim”) alleging harm to such third party caused by Customer’s breach of any of the 
provisions of this Section. Additionally, Customer shall pay any judgments or settlements reached 
in connection with the Third Party Claim as well as Provider’s costs of responding to the Third 
Party Claim. 

c Suspension. Provider may suspend Customer’s use of SaaS Software (a) if so required by law 
enforcement or legal process, (b) in the event of an imminent security risk to Provider or its 
customers, or (c) if continued use would subject Provider to material liability. Provider shall make 
commercially reasonable efforts under the circumstances to provide prior notice to Customer of 
any such suspension.

18 General. 

a Governing Law and Venue. This Agreement shall be governed by and construed in accordance 
with the laws of the State of California, without giving effect to any conflict of laws principles that 
would require the application of laws of a different state. Any action seeking enforcement of this 
Agreement or any provision hereof shall be brought exclusively in the state or federal courts 
located in the Santa Clara County, California. Each party hereby agrees to submit to the 
jurisdiction of such courts. The parties agree that neither the United Nations Convention on 
Contracts for the International Sale of Goods, nor the Uniform Computer Information Transaction 
Act (UCITA) shall apply to this Agreement, regardless of the states in which the parties do business 
or are incorporated. 

b Assignment. Except as otherwise set forth herein, Customer shall not, in whole or part, assign or 
transfer any part of this Agreement, the Licenses granted under this Agreement or any other 
rights, interest or obligations hereunder, whether voluntarily, by contract, by operation of law or 
by merger (whether that party is the surviving or disappearing entity), stock or asset sale, 
consolidation, dissolution, through government action or order, or otherwise without the prior 
written consent of Provider. Any attempted transfer or assignment by Customer that is not 
permitted by this Agreement shall be null and void. 

c Severability. If any provision of this Agreement shall be held by a court of competent jurisdiction 
to be contrary to law, such provision will be enforced to the maximum extent permissible by law 
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to effect the intent of the parties and the remaining provisions of this Agreement will remain in 
full force and effect. Notwithstanding the foregoing, the terms of this Agreement that limit, 
disclaim, or exclude warranties, remedies or damages are intended by the parties to be 
independent and remain in effect despite the failure or unenforceability of an agreed remedy. The 
parties have relied on the limitations and exclusions set forth in this Agreement in determining 
whether to enter into it.

d Use by U.S. Government. The Software is a “commercial item” under FAR 12.201. Consistent with 
FAR section 12.212 and DFARS section 227.7202, any use, modification, reproduction, release, 
performance, display, disclosure or distribution of the Software or Documentation by the U.S. 
government is prohibited except as expressly permitted by the terms of this Agreement. In 
addition, when Customer is a U.S. government entity, the language in Subsection (ii) of the 
Infringement Indemnity Section of this Agreement and the Injunctive Relief Section of this 
Agreement shall not be applicable.

e Notices. All notices provided hereunder shall be in writing and may be delivered by email, in the 
case of Provider to legal@sonicwall.com and in the case of Customer to the email address 
Provider has on file for Customer. All notices, requests, demands or communications shall be 
deemed effective upon delivery in accordance with this paragraph.

f Disclosure of Customer Status. Provider may include Customer in its listing of customers and, 
upon written consent by Customer, announce Customer's selection of Provider in its marketing 
communications. 

g Waiver. Performance of any obligation required by a party hereunder may be waived only by a 
written waiver signed by an authorized representative of the other party, which waiver shall be 
effective only with respect to the specific obligation described therein. Any waiver or failure to 
enforce any provision of this Agreement on one occasion will not be deemed a waiver of any 
other provision or of such provision on any other occasion.

h Injunctive Relief. Each party acknowledges and agrees that in the event of a material breach of 
this Agreement, including but not limited to a breach of the Software License, Restrictions or 
Confidential Information Sections of this Agreement, the non-breaching party shall be entitled to 
seek immediate injunctive relief, without limiting its other rights and remedies.

i Force Majeure. Each party will be excused from performance for any period during which, and to 
the extent that, it is prevented from performing any obligation or service as a result of causes 
beyond its reasonable control, and without its fault or negligence, including without limitation, 
acts of God, strikes, lockouts, riots, acts of war, epidemics, communication line failures, and 
power failures. For added certainty, this Section shall not operate to change, delete, or modify 
any of the parties’ obligations under this Agreement (e.g., payment), but rather only to excuse a 
delay in the performance of such obligations. 

j Equal Opportunity. Provider is a federal contractor and Affirmative Action employer (M/F/D/V) as 
required by the Equal Opportunity clause C.F.R. § 60-741.5(a).

k Headings. Headings in this Agreement are for convenience only and do not affect the meaning or 
interpretation of this Agreement. This Agreement will not be construed either in favor of or 
against one party or the other, but rather in accordance with its fair meaning. When the term 
“including” is used in this Agreement it will be construed in each case to mean “including, but not 
limited to.”

l Legal Fees. If any legal action is brought to enforce any rights or obligations under this Agreement, 
the prevailing party shall be entitled to recover its reasonable attorneys’ fees, court costs and 
other collection expenses, in addition to any other relief it may be awarded.

m Entire Agreement. This Agreement is intended by the parties as a final expression of their 
agreement with respect to the subject matter thereof and may not be contradicted by evidence 
of any prior or contemporaneous agreement unless such agreement is signed by both parties. In 
the absence of such an agreement, this Agreement shall constitute the complete and exclusive 
statement of the terms and conditions and no extrinsic evidence whatsoever may be introduced 

mailto:legal@sonicwall.com
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in any proceeding that may involve the Agreement. Each party acknowledges that in entering into 
the Agreement it has not relied on, and shall have no right or remedy in respect of, any statement, 
representation, assurance or warranty (whether made negligently or innocently) other than as 
expressly set out in the Agreement. In those jurisdictions where an original (non-faxed, 
non-electronic, or non-scanned) copy of an agreement or an original (non-electronic) signature 
on agreements such as this Agreement is required by law or regulation, the parties hereby agree 
that, notwithstanding any such law or regulation, a faxed, electronic, or scanned copy of and a 
certified electronic signature on this Agreement shall be sufficient to create an enforceable and 
valid agreement. This Agreement, may only be modified or amended t by a writing executed by a 
duly authorized representative of each party. No other act, document, usage or custom shall be 
deemed to amend or modify this Agreement. 
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Glossary

A
Active Directory (AD)

A centralized directory service system produced by Microsoft that automates network management 
of user data, security and resources, and enables interoperation with other directories. Active 
Directory is designed especially for distributed networking environments.

C
Common Internet File System (CIFS)

A protocol that defines a standard for remote file access, allowing users with different platforms and 
computers to share files without installing special software.

F
File Shares

SonicWall Inc.'s network file browsing feature on the SMA appliance. This uses the Web browser to 
browse shared files on the network.

L
Lightweight Directory Access Protocol (LDAP)

An Internet protocol that email and other programs use to retrieve data from a server.

O
One-time Password

A randomly-generated, single-use password. One-time Password can be used to refer to a particular 
instance of a password, or to the feature as a whole.

S
Simple Mail Transfer Protocol (SMTP)

A protocol for sending email messages between servers.

Secure Socket Layer Virtual Private Network (SMA)
A remote access tool that utilizes a Web browser to provide clientless access to private applications.

V
Virtual Office

The user interface of the SMA appliance. 

W
Windows Internet Naming Service (WINS)

A system that determines the IP address associated with a network computer.
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SonicWall Support

Technical support is available to customers who have purchased SonicWall products with a valid maintenance 
contract.

The Support Portal provides self-help tools you can use to solve problems quickly and independently, 24 hours a 
day, 365 days a year. To access the Support Portal, go to https://www.sonicwall.com/support.

The Support Portal enables you to:

• View knowledge base articles and technical documentation

• View and participate in the Community forum discussion at 
https://community.sonicwall.com/technology-and-support 

• View video tutorials

• Access MySonicWall

• Learn about SonicWall professional services

• Review SonicWall Support services and warranty information

• Register for training and certification

• Request technical support or customer service

To contact SonicWall Support, visit https://www.sonicwall.com/support/contact-support. 

https://community.sonicwall.com/technology-and-support 
https://community.sonicwall.com/technology-and-support 
https://community.sonicwall.com/technology-and-support 
https://community.sonicwall.com/technology-and-support 
https://www.sonicwall.com/support/contact-support
https://www.sonicwall.com/support
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